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Chapter 166

Using the 
Fairlight Page
The completely redesigned Fairlight Audio Core engine allows 
for simultaneous playback of up to 2000 tracks. It also utilizes 
intelligent load balancing for maximum plugin support.

Fairlight’s increased track count meets the demanding needs of both clients and immersive 
formats, such as Dolby Atmos. Major studio films and series television require high track counts 
to accommodate complex mixes and the export of multiple deliverables. Immersive formats, 
such as Dolby Atmos, multiply the necessary track counts with their demands for deliverables 
from 7.1 up to 22.2.

This chapter covers the basic user interface controls found on the Fairlight page, where they are 
and what they do, in order to give you an overall orientation of how to work with this integrated 
audio environment.
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The Fairlight Page User Interface
In single monitor mode, the Fairlight page offers an optimized environment for handling the audio 
tracks of your project, with an expanded mixer and custom monitoring controls that make it easy to 
edit and manipulate your audio media and evaluate and adjust the levels of your program in order to 
create a smooth and harmonious mix.

The Fairlight page
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The Interface Toolbar
At the very top of the Fairlight page is a toolbar with buttons that let you show and hide different parts 
of the user interface. These buttons are as follows, from left to right:

The Interface toolbar

Media Pool: Shows and hides the Media Pool, from which you can edit audio clips into the 
Fairlight page Timeline.

Effects Library: Opens the Audio FX panel of the Effects Library, from which you can 
apply Fairlight FX, or AU or VST audio effects to clips or tracks in the Timeline.

Index: Shows and hides the Index and its Edits, Tracks and Markers panels.

	— Edit panel: A list of all edit events in visible tracks of the Timeline. 

	— Tracks panel: Lets you manage the tracks of the Timeline, showing and hiding which 
ones you want to work with. 

	— The Markers panel: Lets you see every marker in the Timeline, along with associated 
data. Browse through your markers all at once to quickly find the information you need.

Sound Library: Shows and hides the Sound Library panel. There are search and filter 
fields to locate desired sounds, and is a playback window to audition the sounds prior to 
editing into the 

ADR: Shows and hides the ADR panel of Fairlight. Here you will find tabbed controls for 
List, Record, and Setup that control the functions of the ADR panel.

Mixer: Shows and hides the Mixer, to the right of the Timeline, that lets you adjust various 
effects and levels associated with each track of the Timeline in order to create your mix.

Meters: Shows and hides the Monitoring audio meters and viewer at the top of the 
Fairlight page.

Metadata: Shows and hides the clip metadata Inspector. 

Inspector: Show and hides the Inspector, from which you can edit 
different clip attributes.

The Audio Timeline
The heart of the Fairlight page, the Audio Timeline, presents the audio channels and tracks of the 
currently selected Timeline. Each audio track may contain multiple lanes depending on its Track Type, 
or format. 
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The clips edited into the Timeline appear within each track, with any multichannel elements within 
each clip occupying as many lanes as that track type has available (for example, 2 channel stereo, 
or 6 channels for 5.1). At the left of each track is a header area that contains a number of controls. 

These multi-lane audio tracks appear differently from the Edit page, which is optimized for 
straightforward audio-for-video editing, and shows any multichannel files on single lane tracks with 
composite waveforms.

The Audio page Timeline cannot be closed.

The Audio page Timeline 

Controls in the Audio Timeline
The Audio Timeline has the following controls.

	— Timecode fields and Range buttons: Four timecode fields show the current timecode value 
corresponding to the position of the playhead (at the very top), the Range In point, the Range 
Out point, and the Range duration. Clicking the Range In and Range Out buttons (to the left of the 
timecode fields) set these points and their corresponding timecode value.

Timecode fields and Range 
buttons in the Fairlight page
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	— Transport controls: The bar defining the top of the Timeline contains the Fairlight page’s audio-
specific transport controls, which differ from those found on the Media, Edit, Color, and Deliver 
pages due to its inclusion of recording capabilities. These include Fast Reverse, Fast Forward, Play 
Forward, Stop, Record, Loop, and the Automation toolbar display icon.

Fairlight page transport controls

	— Automation toolbar: Clicking this button opens a secondary toolbar with all the controls you 
need to configure the recording of mixer automation. For more details on Automation,  
see Chapter 174, “Mix Automation.”

Fairlight page automation toolbar

	— Monitoring controls: At the far right of the transport controls, a set of three monitoring controls 
let you quickly control the output volume of your mix. The speaker icon is an Enable/Disable 
button allowing for muting audio playback. The icon turns red when audio is muted. The slider 
lets you change the monitor volume and has a decibel indicator of the amount of level that has 
increased or decreased. The DIM button lets you temporarily reduce the monitored volume being 
output in order to have a quick chat with your client about sports or the state of the world while 
keeping half an ear on the mix. The slider turns yellow when audio monitoring is dimmed. Dim and 
Mute commands are also available from the Fairlight menu.

The monitoring controls

	— Timeline Ruler: The Timeline Ruler shows the program’s timecode. The playhead indicates 
the current frame (and can display the sample) where you’re working in the Timeline, and the 
playhead has a handle that appears within the Timeline Ruler. Dragging within the Timeline Ruler 
moves the playhead. When you add markers to the Timeline, these markers appear within the 
Timeline Ruler as well.

	— Playhead: Shows the current frame and sample of playback, and provides a visual representation 
of where you are while playing, shuttling, and jogging through the Timeline. Also used as a 
reference point for editing operations. The large timecode display at the upper left-hand corner of 
the Timeline shows the position of the playhead.

	— Audio tracks: The Fairlight page of DaVinci Resolve supports multiple audio tracks, and each 
audio track may contain multiple lanes with which to accommodate the audio channels that are 
contained within multi-channel audio clips using track mappings such as stereo, 5.1, 7.1, Atmos, 
or Adaptive (1–24 channels). Audio clips that have been edited into the Timeline appear within the 
tracks, with the recorded channels occupying as many lanes as that clip has available. At the left of 
each track is a header area that contains a number of controls.
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The Fairlight timeline is divided into tracks and lanes; track 
A1 is a mono track, and has a single lane for mono audio, 
and track A2 is stereo and has two lanes for stereo audio.

Track header 
The track header contains different controls for selecting, locking/unlocking, and soloing/muting 
tracks, and also informational fields showing for the track number, how many clips appear on that 
track and the track type.

The track header controls of 
the Fairlight page timeline

	— Track color: Each track can be color-coded with one of 16 different colors. These color codes 
correspond to the Edit page Mixer, and to the Fairlight page Mixer, Tracks Index and Audio 
Meters. You can choose a new color for any track by right-clicking the track header and 
choosing from the Change Track Color submenu. You can set multiple tracks to the same color 
by dragging over contiguous track headers, or by Command-clicking on discontiguous track 
headers of multiple tracks to select them, and then right-clicking and choosing a color from 
the Change Track Color submenu.

	— Track number: Indicates the number of each track.

	— Track name: Each track has a name that defaults to the track number, such as Track 1, 
Track 2. However, you can click any track’s name and edit it to be whatever you like. For 
example, you can rename each track with the type of audio you’re editing onto it, such as 
Production, Ambience, SFX, or Music. These track names are also used to identify each track’s 
channel in the Mixer, in the middle of each channel strip (each channel strip’s track number is 
simultaneously displayed at the top).

	— Audio channel type indicator: Audio tracks also show which channel configuration that track 
uses, listing the number of channels for mono, stereo, 5.1, 7.1, Atmos, adaptive, and others.

	— Fader value: A field displays the current fader setting at the position of the playhead, in dB. 
This value corresponds to the track’s fader level on the Mixer panel. You can drag this value up 
or down and the fader will follow.

	— Lock Track button: When a track is locked, clips can’t be replaced, moved, or otherwise 
edited, although clips on locked tracks can be graded when in the Color page. The lock shows 
closed when track contents are locked and open when unlocked.

	— Arm button: This button arms recording onto that track.
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	— Solo button: Disables all other tracks but the current one, enabling you to quickly hear a 
single track in isolation. This affects rendering, so if one or more tracks are soloed, the muted 
tracks won’t be output or rendered.

	— Mute button: Temporarily disables audio on that track so it’s not monitored or output. This 
affects rendering, so if one or more tracks are muted, they won’t appear in the rendered output.

	— Audio meters: Each track has audio meters in the track header that let you see levels 
during playback.

	— Toolbar editing tools: The toolbar contains both modal and command buttons to let you work on 
your projects. More detail on these appears in the following section.

	— Vertical and horizontal scroll bars: If your project is longer than the current width of the 
Timeline, or the number of audio tracks is taller than the current height of the Timeline, these 
scroll bars let you drag to navigate around your program. When the view is scrolled horizontally, 
the playhead moves along with the track waveforms, so may temporarily move out of view—if you 
start playback, the playhead jumps back into view. You can also scroll vertically using the scroll 
wheel (or other scroll control) of your mouse or other pointing device, and can scroll horizontally 
by holding the Command key down while using your scroll control.

	— Individual Timeline track resizing: Any track in the Timeline can be individually resized by 
right-clicking anywhere within that track’s header control area and choosing a track height from 
the Lock Track Height To submenu of the contextual menu. You can choose a fixed size including 
Micro, Mini, Medium, Large, Extra Large, and Custom. When you choose a fixed track height, 
vertical zooming no longer affects that track until you change that track’s “Lock Track Height to” 
option back to None. You can also highlight several or all tracks and set the track height to one 
size. All highlighted tracks will change to that particular size unless changed again, either globally 
or individually.

Resizing an individual audio timeline track 
using contextual menu options

Zooming Audio Waveform Height
You can zoom into or out of the audio waveforms shown in each clip of one or more tracks, to make 
them taller or shorter, or you can reset them to their default sizes. This doesn’t change the audio 
levels of clips in affected tracks, it just lets you make the audio waveforms easier to see.

3526Fairlight  |  Chapter 166  Using the Fairlight Page



To zoom audio waveform height using your scroll wheel:

Hold down Command-Option, and roll the scroll wheel or control up or down to resize all waveforms in 
all tracks.

You can also use commands that are accessed in the top menu View > Zoom Audio Waveform for any 
track on the Timeline. You can select one or multiple tracks to resize their waveforms all at once. There 
are three sets of commands in the menu:

	— Reset

	— Zoom Increase Height

	— Zoom Decrease Height

Right-clicking any clip in the Timeline allows you to access the Track Waveform Zoom submenu with 
even more zoom options.

Audio Editing Modes
The Fairlight page has two audio editing modes: Overwrite Mode and Layered Audio Editing Mode.

Overwrite Mode
As the name suggests, if one a portion of a clip overlaps another clip during an edit, the area that is 
affected on the underlying clip is non-destructively deleted to accommodate the incoming clip. If the 
overlapping clip is moved or deleted, the underlying clip remains truncated.

Any area that is removed by this process is still present in the original clip and can be exposed by 
trimming the start or end (depending on what you’ve affected). 

Overwrite is the default mode and is best for most generalized editing.   

Overwrite edit showing original clips (left), right hand clip dragged left (middle) and resulting overlap (right)

Layered Audio Editing
Layered Audio Editing is a special audio editing mode that lets you superimpose multiple audio clips 
in the same track, with audio clips edited into the top layers muting overlapping sections of audio clips 
appearing on lower layers. With layered audio editing enabled (Timeline > Layered Audio Editing), 
superimposed audio clips are treated similarly to superimposed video clips that have opacity set to 
100%, with clips on top obscuring (or muting) clips underneath. You can separately toggle this on and 
off in the View menu > Show Audio Track Layers.

This mode is very useful for any situation where you’re combining segments of multiple takes together 
(“comping”) to create a single voiceover, audio vocal track, ADR, or dramatic performance, as you can 
choose which segments to use via their superimposed position in the stack of clips appearing in that 
track, while preserving the other takes underneath in case you might want them later. 
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However, it’s important to understand that if delete any clip on a layer that is “above” another, the 
lower layer will then “poke through.” This can involve extra housekeeping when editing, and is one of 
the reasons that Overwrite Editing mode is the default mode.

TIP: Layered Audio Editing mode can be used on audio tracks on the Edit page as well. 

Layered Audio Editing and Show Audio Track Layers enabled

Layered Audio Editing with Show Audio Track Layers disabled. All layers are folded into a single view.

Flatten Audio Layers
After working with Layered Audio Editing, it can be useful to create a “comp” (composite) of a 
performance in order to have a single element that reflects the final desired result. Timeline > Flatten 
Audio Layers allows you to create a single edit without layers where the clip boundaries are preserved. 
Choosing this command will cut across each layered clip at the in/out points and flatten them into a 
single layer.

After choosing Flatten Audio Layers, audio layers showing (so blank space above).
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NOTE:  If you are exporting to an AAF, you’ll want to turn off layered audio editing, as only 
the first, lowest layer is exported. If you had already been using layered audio editing, you 
can first use Flatten Audio Layers, then perform your AAF export. Keep in mind that if you 
have created any layered crossfades, only fades on the incoming clip are retained.

Switching Among Multiple Timelines
Timelines can be organized like any other clip in the Media Pool. To open or switch among timelines, 
use the following procedures. Each Timeline retains the view settings last made within it, including 
track heights, zoom settings, etc.

To switch timelines, do one of the following:

	— In the Edit, Cut or Fairlight page Media Pool, double-click a timeline.

	— In the Edit page Timeline Viewer, choose a timeline from the Timelines drop-down menu at the 
top of the viewer.

	— In the Color page, choose a timeline from the Timelines drop-down menu at the top of the viewer.

	— In the Fairlight page, choose a timeline from the Timelines drop-down menu to the left of the 
transport controls.

Toolbar
The Toolbar has buttons that let you choose modes of functionality and other buttons that let you 
execute commands such as placing markers and flags.

Icons in the Fairlight Page toolbar when the Automation button is highlighted in the transport bar

Timeline View Options drop-down menu: Contains a variety of controls with which to 
customize the display of clips and set navigation and scrolling options in the Timeline.

Grid View Options drop-down menu: Contains a variety of controls with which to cus

Pointer Mode: The default mode in which you can move and resize clips in the Timeline, 
roll edits, and do other basic editing tasks. While this mode can be used with the pointer, 
it’s designed for letting you make automatic selections of clips at the position of the 
playhead in selected tracks, using keyboard shortcuts or the Fairlight Editing console.

Range Mode: An editing mode in which you can select partial regions of one or more 
clips for partial editing. It’s designed for letting you make automatic selections using 
In and Out points to define regions of selected tracks, using keyboard shortcuts or the 
Fairlight Editing console.
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Focus Mode: In Focus mode you can access Multi Tool behavior depending on 
cursor position:

	— The Selection tool (I-beam) appears when you move the cursor over the upper 
area of the waveform track “lane,” and lets you make time range selections of clips or 
automation keyframe data (depending on the track view).

	— The Hand tool appears when you move the cursor over the lower area of the 
waveform lane, and lets you select a clip or clips by clicking, move them by dragging, or 
apply Cut, Copy, and Paste operations. This tool is available in the other modes as well.

	— The Trim tool (Up/Down arrows) appears when you move the cursor close to the clip 
gain line, and lets you trim the automaton curve for clip gain or keyframe levels. When 
trimming an automation parameter, a tooltip shows the level along with the delta to the 
original value. Trim tool cursors for trimming clip boundaries to trim clip start or end, or 
perform rolling trims are also available. This tool is available in the other modes as well.

Pencil: A tool with which you can write automation data using the pointer as a pencil. 
The Pencil tool appears when automation is enabled.

Razor: Click to add a cut to every clip on an unlocked track that intersects the position of 
the playhead.

Snapping: Enables or disables clip snapping. When turned on, clip In and Out points, 
markers, and the playhead all snap to one another for reference while you’re editing.

Linked Selection: When you select an edit point with both video and audio components, 
and Linked Selection is enabled, both the video and audio edit points are selected, so 
when you apply a video transition to an edit, a crossfade is added to the audio.

Automation Follows Edit: Enables or disables automation that is unique to a timeline to 
be embedded into the clips so that when cutting and pasting new instances of them in the 
Timeline they retain the levels, panning, filter settings, etc. This is extremely useful when 
making multiple instances of the same audio clips throughout an edit. The Automation 
Follow Edit button appears when automation is enabled.

Flag Clip/Flag Colors drop-down menu: Flags identify clips, and indicate all clips that 
correspond to the same item of media in the Media Pool. Clips can have multiple flags. 
Clicking the Flag button automatically adds a flag to whichever clip is currently selected in 
the Timeline. A drop-down menu to the right lets you choose differently colored flags, and 
clear all flags from the currently selected clip.

Add Marker/Marker Colors drop-down menu: Markers identify specific frames of 
individual clips. Clicking the Add Marker button adds a marker of the currently displayed color 
to the clip at the position of the playhead in the Timeline. A drop-down menu to the right lets 
you choose differently colored markers, and clear all markers from the currently selected clip.

Transient Detection: Enables transient detection on a track’s set of clips. Once enabled, 
a transient button appears on tracks to enable the transients on the track’s clips to be 
easily identified and navigated. When the Jump to Transient button is enabled, the Up and 
Down arrow keys navigate transients within a clip.
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Vertical Slider: Lets you adjust the vertical zoom level of tracks.

Horizontal Slider: Lets you adjust the horizontal zoom level of the Timeline.

Timeline View Options

Selecting the Audio Timeline View options

Track Display Options

Video Tracks: This button lets you display or hide the video tracks in the current Timeline, 
for use as a reference while you work. 

Full Waveforms: This button lets you toggle full waveforms on and off, optionally hiding 
the divider bar that keeps the waveform separate from the file name area of each audio 
clip, so the waveform occupies the full space of each audio bar in the Timeline.

Waveform Borders: This button lets you toggle waveform outlines on and off, drawing a 
dark border around the edges of each waveform to make them easier to see. 

Gain Line: This button lets you toggle the clip gain indicator line on and off. Also available 
in the Fairlight Menu > Show Clip Gain Line.

Navigation Options

Jump to Clip: When toggled this lets you jump from clip to clip using the Up 
or Down Arrow keys.
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Jump to Fade: When toggled this lets you jump from fade to fade using the Up or 
Down Arrow keys.

Jump to Marker: When toggled this lets you jump from marker to marker using the 
Up or Down Arrow keys.

Jump to Transient: When toggled this lets you jump from transient to transient using the 
Up or Down Arrow keys. Transient Detection must be turned on in the Timeline and the 
track for this navigation.

Timeline Scrolling

Fixed Playhead: This button lets you set the playhead to be fixed so that during 
playback the tracks scroll past the playhead as it remains in place, which is useful when 
working with the Fairlight control surface.

Page Scrolling: This button lets you set the playhead to scroll to the end of the current 
Timeline view and then start a new page at the end of the Timeline play. The rate of the 
page turn is dictated by zoom level of the Timeline.

No Scrolling: This button sets fixes the Timeline in place so that it will not update with 
the playhead. Depending on the zoom level, it is possible that the playhead will play 
offscreen with no timeline updating

NOTE:  These options are also available in the View menu > Timeline Scrolling.

Scroller

Video: This button lets you see video tracks scrolling in the bottom of the Fairlight 
timeline with the option of low, medium, or high viewing of the video media immediately 
surrounding the playhead.

Audio 1: An audio scroll bar and zoomed-in visual reference for the audio media 
immediately surrounding the playhead. A drop-down menu allows for the choice of what 
audio track will scroll.

Audio 2: An additional audio scroll bar and zoomed-in visual reference for the audio 
media immediately surrounding the playhead. A drop-down menu allows for the choice of 
what audio track will scroll.

Zoom Presets

Presets 1-7: These buttons let you choose from one of seven zoom levels.
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Grid View Options

Selecting the Grid View options;  
Timecode Time Scale options shown

Edit Grid Options
Show Grid: When toggled, this shows or hides the grid line on tracks  
under the Timeline.

Snap to Grid: When selected, inserting, moving, or trimming clips on tracks snap to the 
nearest grid line.

Time Scale Options
Timecode: When selected, the grid follows Timecode according to the 
selected resolution.

Tempo: When selected, the grid follows bars and beats.

Timecode Grid Resolution

When the Timecode Time Scale option is enabled, the Grid follows the selected Timecode Grid Resolution. 
The Timecode Grid resolution options include: 1 second, 1 Frame, 1/2 Frame, and 1/4 Frame.

Tempo Grid Options 

The following Tempo Grid options determine grid behavior when the Tempo option is selected:

	— Resolution: Lets you select the desired Grid resolution according to bars and beats: 
Bar, 1/2 Note, 1/4 Note, 1/8 Note, 1/16 Note.

	— Tempo: Lets you enter the tempo in BPM.

	— Time Signature: Lets you select one of the following as the time signature: 4/4, 3/4, 6/8.

	— Song Start: Lets you enter the Song Start Timecode location.
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Selecting the Grid View options;  
Tempo Time Scale options shown

Setting the Tempo Grid Start
To set the Tempo Grid start location:

	— Right-click at the desired location on the Timeline ruler.

	— Choose Set Tempo Grid start.

The first bar and beat of the tempo grid moves to that location. 

Setting the Tempo Grid start location

Setting the Tempo Grid from a Range Selection
To set the Tempo value for the Tempo Grid from a range selection:

	— Make a range selection in the Timeline.

	— Right-click anywhere in the Timeline ruler, and choose Set Tempo Grid BPM from the contextual menu. 

	— In the resulting Tempo Grid Setup window, enter the number of bars in the selection.

	— If desired, select Set Start from Playhead.

	— Click Set Tempo From Range.

	— Close the Tempo Grid Setup window.
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The tempo in the Tempo Grid Options settings updates accordingly.

Tempo Grid Setup window

TIP: When setting the tempo based on a range selection, choose a section of the music 
where it is easy to count out the bars/beats to set the range.

Customizing Clip Display 
in the Timeline
Choose Fairlight > View Clip Info Display to open a dialog where you can customize what information 
is shown at the bottom of each clip in the Fairlight timeline. This dialog has options for viewing no clip 
name, the file name, or the clip name, and for choosing from among a variety of metadata that you 
might want available to view as you work with clips in the Timeline.

Selecting the audio clip view options

Customizing the Timeline’s Display
There are a variety of ways you can customize the Timeline to better see what you’re working on.
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Playhead Modes
There are options for Page Scrolling (“Page”) and No Scrolling (“Disabled”) as outlined in the Timeline 
View Options section above. There is also the option for turning on the Fixed Playhead mode when 
you are not using Focus mode. This is available in the Timeline View Options drop-down menu, or 
choosing View > Timeline Scrolling > Fixed. When enabled, the playhead remains fixed in place, and 
the Timeline scrolls underneath it as you use the transport controls or JKL to play, shuttle, or scrub 
forward or back. 

NOTE: Fixed playhead scrolling is not currently available when using Focus mode.

Also, please keep in mind that when you have changed DaVinci Resolve > Keyboard 
Customization from the default DaVinci Resolve mapping to a different mapping, many 
default key commands are altered. For instance, the Pro Tools Keyboard Customization 
does not offer JKL transport.

Visible Video Tracks
A checkbox in the Timeline View Options drop-down menu of the toolbar lets you display small height 
video tracks in the Fairlight timeline for reference. This can be very useful as you can see which 
audio clips correspond to which video clips. The video clips can also be used as snapping targets for 
positioning audio.

When the Video Tracks option is on:

	— The Track Index can be used to choose which video tracks are visible.  

	— The video track(s) can be edited, both placement and clip trimming. 

	— Editing an embedded clip that contains both video and audio will add a clip with both audio and 
video in the appropriate corresponding tracks.

If the Video Tracks option is disabled, adding a clip with both video and audio to the timeline will add 
only audio to the corresponding tracks.

Showing video tracks on the Fairlight page
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Video and Audio Scrollers
Checkboxes in the Timeline View Options let you optionally show one Video Scroller and up to two 
Audio Scrollers at the bottom of the Fairlight timeline. 

Video and Audio Scrollers at the bottom of the Fairlight timeline

At the default Low zoom level, the Video Scroller provides a scrollable frame-by-frame filmstrip view of 
the video of your program, where one frame of the scroller equals one frame of your video. 

Each of the two Audio Scrollers, on the other hand, let you focus on a continuous waveform view of a 
particular audio track. Ch

What Are They Used For?
The Audio Scrollers always provide a zoomed-in view of 
specific audio tracks that you’re focused on, regardless of 
the zoom level of the Timeline tracks above. This means 
you can focus on subtle details of the audio of one or 
two tracks that you’re working on, while the rest of the 
Timeline shows you the overall stack of tracks with clips 
that are playing together at that moment.

Meanwhile, the Video Scroller always shows the exact 
frame of video that corresponds to the current moment 
in time, so it’s an aid to precision editing involving 
frame‑specific adjustments.

Audio Scrollers showing the 
drop-down menu that selects 
which track they display

Additionally, both the filmstrip and waveform viewers scroll continuously during playback, giving you a 
preview of what visual actions and audio cues are coming a few moments forward in time that you can 
refer to while performing automation or recording foley.

Repositioning the Scroller Playhead
While the scrollers are visible, the Scroller playhead can be dragged to the left or right in the Timeline 
to give you more or less preview room to the right.
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Zooming the Video Scroller
Right clicking on the Video scroller lets you choose a Low, Medium, or High zoom level. At Low, you 
get a frame-by-frame view of the program that feels like scrolling a strip of film on a Steenbeck flatbed 
editor. At Medium and High, you get a progressively abbreviated film strip that scrolls more quickly.

Scrolling the Fairlight Timeline Using the Scroller Tracks
Dragging the scroller tracks to the left or right smoothly scrubs through the Timeline in greater detail, 
regardless of the zoom level of the Timeline tracks above.

Mixer
The Audio Mixer provides a set of graphical controls you can use to assign track channels to output 
channels, adjust EQ and Dynamics, add filters and Fairlight FX, set levels and record automation, pan 
stereo, surround and immersive audio, and mute and solo tracks.

The Audio Mixer exposes two sets of channel strips with controls that correspond to the tracks in the 
Timeline. By default, the leftmost set of channel strips expose one set of controls for each track in the 
Timeline, while the rightmost set of channel strips expose another set of controls for each bus you’ve 
created to manage signal flow from the audio tracks to submixes and desired outputs.

TIP: You can right-click on a the number at the top of mixer channel strip to copy/paste 
settings, and also copy/past settings within the mini views of the channel dynamics and EQ 
as well. Also, effects plugins (Fairlight FX, AUs and VSTs) have local 3 dot Options menus at 
their top right that allow you to copy/paste settings.  

The Audio Mixer, with channel strips corresponding to the tracks in the Timeline

	— Track color: Each track can be differently color-coded using the right-click contextual menu on a 
track in the Timeline or Tracks Index, to help you keep organized.
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	— Track number: The number of the Timeline track corresponding to each channel strip appears here.

	— Input: A drop-down menu that lets you patch inputs, buses, utility signals, and configure the 
input settings of audio signals routed through Blackmagic Design or other hardware interfaces.

	— Track FX: Track effects are specialized effects that are built-in to each channel, routed directly 
from disk, then onwards to other effects processing. The two built-in Track FX are Voice Isolation 
and Dialogue Leveler. They are disabled by default. Voice Isolation is a DaVinci Neural Engine AI 
effect and is available in DaVinci Resolve Studio only.

	— Order: A drop-down menu that lets you choose the order of processing per track of the EQ, 
Dynamics, and Effects.

	— Effects: Fairlight FX, VST, and Audio Unit effects that you apply to tracks from the Effects Library 
appear here, with controls for enabling/disabling each effect, opening an effect’s floating user 
interface or Inspector controls, and deleting that effect.

	— Effects In: A button to globally mute or enable all insert effects on a track (Fairlight FX, AU 
or VST). Track FX and the built-in channel dynamics and EQ are not affected by this control.

	— Dynamics: Double-clicking exposes a set of dynamics controls with three sets of controls 
corresponding to an Expander or Gate, a Compressor, and a Limiter that can be used separately 
or in concert to manage the dynamics of the audio on that track.

The channel strip Dynamics control window

	— EQ: Double-clicking exposes a four-band parametric equalizer, with additional High and Low 
Pass filters, that has both graphical and numeric controls for boosting or attenuating different 
ranges of frequencies of audio on each track. You can select from among four types of EQ filtering 
from the Equalizer Type drop-down menu, with options for Earth (the default), Air, Ice, and Fire. 
These four equalizer types affect the Curves aspect and Q-factor of the transfer function. Each 
band has controls for the filter type (Bell, Lo-Shelf, Hi-Shelf, Notch), Frequency, Gain, and Q-factor 
(sharpness of the band), with the available controls for each band of EQ change depending on the 
filter type.
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The channel strip EQ window

	— Bus Sends: Click the + sign to add bus sends. Bus sends are only available if there are two or more 
available busses. Creating a bus send requires at least one additional bus other than the main 
output bus.

	— Pan: A pan control compatible with stereo and surround panning. You can drag within this control 
to adjust pan, or you can double-click to expose a pan window. What controls are available in the 
pan window depend on the mapping of the audio track, but both stereo and surround panning 
controls are available, with corresponding numeric controls.

The Pan control window

Option-double-clicking on the Pan control of the Mixer opens an alternate 3D Audio Pan window. 
Whereas the regular Pan window lets you do stereo and conventional 5.1 and 7.1 surround 
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panning, the 3D Audio Pan window lets you do the kind of spatial audio positioning enabled by 
advanced surround formats, such as Dolby Atmos, Auro 3D, and NHK 22.2.

The 3D Pan window

	— Bus Outputs: These buttons let you assign a track or bus to one or more of the output busses.

	— VCA: These buttons let you assign that track’s channels to VCAs 1-10, or assign from the larger 
pool of 128 total available VCAs via a secondary dialog box.

	— Track name: This mirrors the track name found in the header controls of the Timeline. You can 
customize a track’s name in the Mixer by double-clicking and typing in the name field.

	— Arm, Solo, and Mute buttons: Identical to the controls found in the track header controls of each 
timeline audio track. Arm enables recording for a track. Solo lets you mute all other tracks in order 
to play that track in isolation (along with any other Soloed tracks). Mute disables audio playback 
from that track. These controls are also available the Tracks Index.

	— dB display: Shows you the volume level, in decibels, that track is currently set to.

	— Automation Arm: Arm automation control per track. When enabled, will record automation 
in Latch mode when the transport runs. The control also shows red when a fader is moved. 
Automation can also be set to “Safe” or “Off” by right-clicking on this control.

	— Level Meter: This is a real time indicator showing a track’s signal level from -60db to 0db. The 
display and decay characteristics for audio metering can be set in Project Preferences > Fairlight > 
Audio Metering.

	— Fader: Each track’s main vertical faders let you adjust the level of that track and perform 
automation recording. Double-clicking the fader handle will reset it to the default level of 0. 
Holding the Shift key when adjusting a fader allows fine control of level with .1 dB resolution.

NOTE:  Starting with DaVinci Resolve 17.4, the mixer panel has changed from prior versions. 
Some of the items are in a different order than earlier versions. Also, when using the 
Fixed Legacy Busing option, then the bus structure as it applies to the Mixer panel also 
offers different busing usage. The redesigned Mixer panel makes a more efficient use of 
the Fairlight page but rest assured that no features have been removed, simply improved.
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The Monitoring Panel
The Monitoring panel that runs along the top of the Fairlight page shows all of the audio meters 
corresponding to the tracks in the Timeline, as well as the Master Output meter, Control Room meters, 
and a video viewer.

The Monitoring panel

At left, a row of audio meters corresponds to the channel strips of the Mixer, one meter for every 
audio track in the Timeline. Each track meter displays the number of channels that corresponds to 
that track’s audio format, with mono tracks having a single audio meter, stereo tracks having two, 5.1 
tracks having six, and so on. All of these track and bus meters (with the exception of the Loudness 
meters) display both peak and RMS (root mean square) levels against a dB scale.

To the right of the Track meters are the Bus meters, where all buses appear separated by type, each 
displaying a meter with the number channels that corresponds to the bus’s audio format. This way you 
can see the sum of all tracks that have been routed to a particular bus. 

The last set of meters, to the right of all others, are the Loudness meters, which consist of two sets of 
meters and a numerical readout section. The Control Room meter reflects that main output level from 
the program and the Loudness meter measures the mix’s loudness according to the user’s chosen 
scale. This lets you keep track of the “integrated loudness” of the overall mix, which is the standard 
that all contemporary mixing specifications refer to when specifying client deliverables.

The height of the monitoring panel can be adjusted by dragging the bottom of the panel.

Absolute and Relative Measurement Scales
While some users prefer to measure their levels to correspond to a relative scale of “0,” similar to 
a VU meter where the needle rides above the “0,” others want to see the absolute measure of the 
amplitude in LUFS and true peak. By default, the Loudness meter is set to relative scale, but you now 
have the option to choose between relative scale and absolute scale in the Loudness meter. 

Relative scale in the Loudness menu is relative to the selected scale, so a loudness unit of 0 
corresponds to the target of the chosen measure type. For instance, if EBU R128 is selected, whose 
target measure is -23dB LUFS, the “0” LU (Loudness Unit) is equal to -23dB. If ATSC A/85 is chosen, 
whose target is -24dB, then that becomes the corresponding equivalent of the relative LU of 0.

When using the absolute scale, the Loudness meter displays the increments to reflect the chosen 
measure type. In absolute scale the EBU R128 meter will display -23 instead of the relative scale’s 0.

3542Fairlight  |  Chapter 166  Using the Fairlight Page



The option in the Loudness panel reveals the various 
measure types as well as the option for absolute scale.

When working with large track counts, you can right-click on the panel and see a contextual menu that 
offers options for single or dual rows, as well as narrow or wide meters. You can also double click on 
the bus master meters on the right side to access a double row view for them. 

The double height Monitoring panel

Viewer
A small viewer at the far right of the Monitoring panel allows you to view video playback; it always 
shows the matching video frame at the position of the playhead.  

The Monitoring panel

	— The viewer can be resized within the monitoring panel by dragging the left or lower edge of its window. 

	— A button in the lower right-hand corner lets you expand the Viewer into its own floating window. 
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	— The Fairlight page has Cinema Mode viewing (Command-F) or through the Workspace menu, 
Workspace > Viewer Mode > Cinema Viewer. 

	— You can also use the Clean Feed mode view on a separate monitor by choosing Workspace > 
Video Clean Feed and choosing the target monitor for dedicated video playback.

	— You can choose to turn the Viewer off entirely in the Workspace > Fairlight Viewer submenu.

The Media Pool
In the Fairlight page, the Media Pool serves as the repository of all audio clips in your project, both 
clips that appear within the Timeline, and clips that you’ve added to your project but have not yet 
used. When you record audio into the Timeline, the resulting clips appear in the Media Pool as well, 
for future use. The Media Pool appears on all DaVinci Resolve pages, and contains all of the video clips 
and timelines within your project. 

The Bin list at the left shows a hierarchical list of folders called bins used for organizing your media, 
which can also used to organize your timelines. By default, the Media Pool consists of a single bin, 
named “Master,” but you can add more bins as necessary to organize timelines and clips by right-
clicking anywhere in the empty area of the Media Pool and choosing Add Bin. You can rename any bin 
by double-clicking on its name and typing a new one, or by right-clicking a bin’s name and choosing 
Rename Bin. The Bin list can be hidden or shown via the button at the upper left-hand corner of the 
Fairlight page toolbar.

The Media Pool in Thumbnail mode showing audio clips

The browser area to the right shows the contents of the currently selected bin in the bin list. Every 
clip you import, every timeline you create, and every AAF, XML, EDL and other file types you can 
import appear here. You can create or import as many timelines as you need within a single project.
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As elsewhere, the Media Pool can be displayed in either Metadata view, Thumbnail view, or List view. 
In List view, you can sort the contents by any one of a subset of the total metadata that’s available in 
the Metadata Editor of the Media page. Of particular interest to audio editors are columns for Clip 
Name, Reel Name, different timecode streams, Audio Channels, Format, Audio Codec, Date Added, 
Flags, and Duration.

For more information on using all of the features of the Media Pool, see Chapter 18, “Adding and 
Organizing Media with the Media Pool.” In the sections that follow, some key features of the Media Pool 
are summarized for your convenience.

Importing Media Into the 
Media Pool on the Fairlight Page
While adding clips to the Media Pool in the Media page provides the most organizational flexibility and 
features, if you find yourself in the Fairlight (or other) pages and you need to quickly import a few clips 
for immediate use, you can do so in a few different ways.

Add media by dragging one or more clips from the Finder to the 
Fairlight page Media Pool (macOS only):

1	 Select one or more clips in the Finder.

2	 Drag those clips into the Media Pool of DaVinci Resolve, or to a bin in the Bin list.

Those clips are added to the Media Pool of your project.

Use the File > Import > Media command:

1	 With the Fairlight page open, choose File > Import > Media.

2	 Use the Import dialog to select one or more clips to import, and click Open.

Use the Import Media command in the Fairlight page Media Pool:

1	 With the Fairlight page open, right-click anywhere in the Media Pool, and choose Import Media.

2	 Use the Import dialog to select one or more clips to import, and click Open.

Those clips are added to the Media Pool of your project.

For more information on importing media using the myriad features of the Media page,  
see Chapter 18, “Adding and Organizing Media with the Media Pool.”

Media Pool Preview Player
The Media Pool has a preview player at the top that provides a place to open selected source clips in 
the Media Pool, play them, add marks to log them, and set In and Out points in preparation for editing 
them into the Timeline via drag and drop. The Media Pool Preview Player effectively acts as a Source 
monitor for editing in the Fairlight page.

	— Various viewing controls populate the title bar at the top. A drop-down menu at the upper left lets 
you choose a zoom level for the audio waveform that’s displayed. To the right of that, a Timecode 
window shows you the duration of the clip or the duration that’s marked with In and Out points. 
Next to the right, a real-time performance indicator shows you playback performance. In the 
center, the title of the currently selected clip is shown, with a drop-down menu to the right that 
shows you the most recent 10 clips you’ve browsed. To the far right, a Timecode field shows you 
the current position of the playhead (right-clicking this opens a contextual menu with options to 
change the timecode that’s displayed, and to copy and paste timecode).
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	— The center of the Media Pool Preview Player shows you the waveforms in all channels of the 
currently selected clip, at whatever zoom level is currently selected.

	— Transport controls at the bottom consist of a jog bar for scrubbing, Stop, Play, and Loop buttons, 
and set In and Out buttons.

The preview player in the Media Pool

Bins, Power Bins, and Smart Bins
There are actually three kinds of bins in the Media Pool, and each appears in its own section of the 
Bin list. The Power Bin and Smart Bin areas of the Bin list can be shown or hidden using commands 
in the Media Pool Options menu (…): Show Smart Bins and Show Power Bins. Here are the differences 
between the different kinds of bins:

	— Bins: Simple, manually populated bins. Drag and drop anything you like into a bin, and that’s 
where it lives, until you decide to move it to another bin. Bins may be hierarchically organized, 
so you can create nested bins, one inside of the other, if you like. Creating new bins is as easy as 
right-clicking within the bin list and choosing Add Bin from the contextual menu.

	— Power Bins: Hidden by default. Power bins are shared among all of the projects in your current 
project library, making them ideal for shared title generators, graphics movies and stills, sound 
effects library files, music files, and other media that you want to be able to quickly and easily 
access from any project. You put whatever materials you want into Power Bins; it’s a manual 
process. To create a new Power Bin, show the Power Bins area of the Bin list, then right-click within 
it and choose Add Bin.

	— Smart Bins: These bins build “custom collections” of media that use metadata or analysis to 
automatically populate the bins dynamically, meaning that the contents will change depending on 
what the Smart Bin is set to focus on. For example, a sound effects Smart Bin will show only sound 
effects, and the bin’s contents will grow or shrink depending on the number of effects files that 
have been identified in the project, which may change over time. Smart Bins can allow very fast 
and efficient organizing of project contents. 

	— There are several automatically created Smart Bin types available (see Preferences > User > 
Edit Tab > Automatic Smart Bins).

	— You can choose to have Resolve’s Audio Classification analysis categorize your files 
(automatically creating “Collections” smart bins). Or, you can manually add metadata to 
your clips using the Metadata Editor, adding Scene, Shot, and Take information, keywords, 
comments and description text, and more to make it faster to find what you’re looking for 
when you need it. 
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	— You can create your own criteria for a Smart Bin. To create a new custom Smart Bin, make sure 
the Smart Bin area of the Bin list is showing, then right-click within it and choose Add Smart 
Bin. A dialog appears in which you can edit the name of that bin and the rules it uses to filter 
clips, then click Create Smart Bin.

NOTE:  To view Smart Bins other than Keywords and Collections, you must first enable 
any additional Smart Bin choices in Smart Bin Preferences > User > Edit Tab > Automatic 
Smart Bins.

Showing Bins in Separate Windows
If you right-click a bin in the Bin list, you can choose “Open As New Window” to open that bin into its 
own window. Each window is its own Media Pool, complete with its own Bin list, Power Bins and Smart 
Bins lists, and display controls. 

This is most useful when you have two displays connected to your workstation, as you can drag these 
separate bins to the second display while DaVinci Resolve is in single screen mode. If you hide the Bin 
list, not only do you get more room for clips, but you also prevent accidentally switching bins if you really 
want to only view a particular bin’s contents in that window. You can have as many additional Bin windows 
open as you care to, in addition to the main Media Pool that’s docked in the primary window interface.

Filtering Bins Using Color Tags
If you’re working on a project that has a lot of bins, you can apply color tags to identify particular 
bins with one of eight colors by right-clicking any bin and choosing the color you want from the Color 
Tag submenu.

For example, you can identify the bins that have clips you’re using most frequently with a red tag. 
A bin’s color tag then appears as a colored background behind that bin’s name.

Using color tags to 
 identify bins

Using Color Tag filtering  
to isolate the red bins
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Once you’ve tagged one or more Media Pool bins, you can use the Color Tag Filter drop-down menu 
(the drop-down control to the right of the Bin List button) to filter out all but a single color of bin.

To go back to seeing all available bins, choose Show All from the Color Tag Filter drop-down.

Sorting the Bin List
The Bin list (and Smart Bin list) of the Media Pool can be sorted by Bin Name, Date Created, Date 
Modified, in either ascending or descending order. Simply right-click anywhere within the Bin list and 
choose the options you want from the Sort by submenu of the contextual menu.

You can also choose User Sort from the same contextual menu, which lets you manually drag all bins 
in the Bin list to be in whatever order you like. As you drag bins in this mode, a red line indicates the 
new position that bin will occupy when dropped.

If you use User Sort in the Bin list to rearrange your bins manually, you can switch back and forth 
between any of the other sorting methods (Name, Date Created, Date Modified) and User Sort. 
Your manual User Sort order will be remembered, making it easy to use whatever method of bin 
sorting is most useful at the time, without losing your customized bin organization.

Dragging a bin to a new position 
in the Bin list in User Sort mode

The Audio Only  
Smart Bin

The Media Pool filter  
options in the option menu

Filtering Clips With Audio in the Fairlight Page
The Media Pool on the Cut, Edit, Color, Fusion and Fairlight pages can show Audio Only clips using the 
Collections smart bin labeled “Audio Only” found in the Collections are of Smart Bins. This makes it 
easy for you to find audio clips that you’re looking for, which may be hidden along with lots of video 
clips in the same bin.

If you’d like to work with some additional options, the Media Pool in the Fairlight page also has the 
ability to filter out audio-only clips, or video clips with audio, in the currently selected bin. To use this 
feature, click the Option menu of the Media Pool and choose Show All Clips, Show Audio Only Clips,  or 
Show Clips With Audio, Show Audio Waveforms, and Show Non-Rectified Audio Waveforms. 
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Effects Library
The Effects Library on the Fairlight page displays both the built-in Fairlight FX audio plugins that 
accompany DaVinci Resolve on macOS, Windows, and Linux, as well as whatever Audio FX are available 
on your workstation. 

	— Fairlight FX are built-in audio processing effects that are fully cross-platform on all platforms 
DaVinci Resolve supports. 

	— On macOS and Windows, DaVinci Resolve supports the use of third-party VST audio plugins. 

	— On macOS, DaVinci Resolve supports Audio Unit (AU) audio plugins.

The Effects Library

Once you install third-party effects on your 
workstation, they appear in this panel of the 
Effects Library alongside the Fairlight FX that 
are always available. Audio plugins let you 
apply effects to audio clips or as a real time 
process on an entire audio track (affecting all 
clips on that track), to add basic dynamics or 
tonal processing compression, limiting or EQ, 
noise reduction, or creative spatial effects like 
delay or reverb.

Similar to the Media Pool, the Effects Library’s 
Bin list can be opened or closed using a 
button at the top left.

Effects Library 
Favorites
To save an effect as a Favorite:

	— Hover over the far right of any effect to 
see a star

	— Click on the star to add the effect to the 
Favorites effects list. 

	— Favorites appear in a separate area on the 
lower left next to the Effects Library Bin list.

NOTE:  Items that are set as Favorites in the Effects Library list will also appear at the 
top of the Mixer’s Effects drop-down menu effects list.
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Stars indicate a flagged favorite effect, 
 all favorites are currently filtered

ADR
The Fairlight page of DaVinci Resolve has a sophisticated, yet intuitive interface for doing “ADR” 
(Automated Dialog Replacement). Comprehensive cue list management, industry-standard audio 
beeps and visual cues, sophisticated take management with star ratings and layered take organization 
help you manage your work while getting the best parts of each performance.

When open, the ADR interface consists of three panels to the left of the Timeline: a List panel, a Record 
panel, and a Setup panel.

The List Panel
This is where you create a list of cues you need to re-record, either from within the Fairlight page, 
or imported from a .csv file that someone provides you. It presents controls for adding, editing, 
importing, and exporting cues that you want to record.

The Setup panel of the ADR interface

The Record Panel
This is where you actually run the ADR recording session you’ve set up, using the dialog cues you’ve 
put into the Cue list. It presents controls for displaying and selecting which cues to record, previewing 
and initiating recording, and adding metadata to rate the different takes you’ve recorded and to keep 
track of which cues have been completed.
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The Record panel of the ADR Interface

The Setup Panel
The Setup panel is where you configure your ADR session. Choose your audio input, your record track 
and what tracks to monitor. Then access beeps, video streamers and onscreen text that the actors will 
see on the video output display to help them keep their performance in sync.

For more information on using the ADR panel, see Chapter 170, “ADR.”

The Setup panel of the ADR interface
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Sound Library Browser
A Sound Library panel is available from the Interface toolbar for browsing sound effects libraries 
that you have available to you, on your system or on network storage you may be connected to (for 
example, a SAN). It includes the capability of scanning specified file paths to catalog available sound 
files and their metadata, storing this data within the currently selected project library (or another 
project library that you select) to use when searching for the perfect sound effect within your library. 
Once you’ve cataloged your sound effects collection, it’s easy to search for sounds, preview what’s 
been found in the list, and edit the one you like best into the Timeline.

The Sound Library panel

TIP:  You can download the Fairlight sound library, a royalty-free collection of over 
500 professionally recorded foley sounds that you can use in your own projects, which are 
directly downloadable from the Sound Library panel. The Fairlight sound library features 
everything from atmospheric ambient sounds to foley sounds such as foot steps, hits, 
effects, and more. This free sound library is designed to work with the Fairlight FX Foley 
Sampler plugin, which lets you use a MIDI keyboard to trigger sounds so they can be 
recorded at precisely the right time in your program.
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Library Controls
Clicking the Library button (to the right of the Search field) reveals a menu that lets you choose which 
project library to use for searching (and cataloging) sound effects collections. Each network project 
library can have a different catalog.

NOTE:  the Sound Library results pane will be empty until a search is made.

Choosing a library to search

NOTE:  The Sound Library is now capable of using the Mapped Mount option in the 
Media Storage panel of the Preferences, in order to access sound effects located on 
remote volumes using other operating systems.

To catalog all audio files within a given file path for searching using the Sound Library:

1	 Using the Project Manager, create an empty network project library in which to store the sound 
effects catalog.

2	 Open a project, open the Edit or Fairlight pages, and open the Sound Library.

3	 (Optional) Click the Library button (to the right of the Search field), and select the project library 
you created using the drop-down menu that appears. The current project library is selected by 
default. If you’re working within a local project library instead, the top compatible project library in 
the list will be the default.

4	 Do one of the following:

a)	 If you’ve not yet connected a library of sound effects, an Add Library button appears in the 
center of the Sound Library. Click this button, and from the file dialog that appears, select the 
top-most directory of a file path that contains sound effects; if you’ve selected a directory with 
subdirectories inside, each subdirectory will be examined for content.

b)	 If you’re adding more sound effects to an existing library, then click the Option menu and 
choose Add Library. From the file dialog that appears, select the top-most directory of a file 
path that contains sound effects; if you’ve selected a directory with subdirectories inside, each 
subdirectory will be examined for content.

5	 Click Open.

A progress bar will show you how long the operation will take. When you’re finished, a dialog will 
appear letting you know how many clips were added to the current library.
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Display Controls and the Search Field
The Sound Library title bar has controls for sorting the sound effects list, showing it in List or Icon 
view, and an Option menu with various other settings and commands.

Display controls let you choose 
how the contents of the Sound 
Effects list are viewed

Underneath, a text field lets you enter search terms, while a drop-down menu to the right lets 
you choose whether to search the current project library for sound effects by name, description 
metadata, or all.

The Search field and Filter By menu

To search for a specific sound effect and edit it into the Timeline:

	— Type a search term into the Search field. The case of search terms is ignored, except for 
boolean operators.

To help you to eliminate false positives, the search field supports different kinds of searches, such as 
literal searches, and/or/not boolean searches, wildcard searches, and ranges of characters. 

NOTE:  If you want to perform Boolean searches, the Boolean operators must be typed in 
all upper caps, such as “AND,” “OR” and “NOT.” If lower case is used, “and,” “or” and “not” 
will be treated as search terms but as regular words.

Or/And/Not Searches
Simply typing words separated by a space is treated as a series of OR searches for each word 
independently of one another, either literally or as part of another word. For example, if you type 
either of the following:

car door 

car OR door

both yield the same results. Every sound effect in your library containing either the letters “car” 
or “door” (or both) will appear, whether these letters appear independently, or within other words. 
Results will include files such as “CarExDoorClose,” “Doormouse_Squeak,” “Carburetor dropped on 
cement,” and “Carpet Shake.”
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Using AND (it must be upper caps) lets you specify multiple criteria for a search, when each file 
that’s returned should contain every word you type somewhere within, in any order. For example, 
if you type:

car AND door

every sound effect in your library containing both the strings “car” and “door” will appear, 
even if these words appear either singly, in combination, or within other words, such as 
“NewCarDoorSlam” and “Carpet_Footsteps_Indoors,” and “GarageDoorHitsCar.”

Using NOT lets you omit sound effects that have a particular word. For example, if you type:

car NOT door

only sound effects with “car” will appear, and all sound effects with “door” will be omitted.

Literal Searches
Using quotations specifies a literal search for only the specified term, separated from other text by a 
space. For example, if you type:

“cat”

every sound effect in your library with the standalone word “cat” appears. Sound effects with 
“cats” and “caterpillar” will be omitted. Results will include “Space cat drone” or “Cat meowing.”

Wildcard and Range Searches
The * (asterisk) specifies a wildcard search of any number of characters. Adding an * between two 
search terms identifies any sound effect with the two search terms connected by any number or 
combination of characters with no spaces (even no characters). For example, if you type:

close*door

results include “Door-Wood Cheap-Wooden-Closet-Door-Kick-In-Flimsy-Rattle,” 
“ElevatorCabinCloseDoor,” and “LatchSwingCloseSqueakDoorSecur.” If you instead type:

door*close

results include “DoorHvyMetalCloseSlam,” “DoorLidWoodenChestCloseAntique,” and 
“ElevatorDoorCloseSlam.” If instead you type:

c*r

results include “lectrohummin,” “KiaShumaEXTBootCloseTrunkaka,” and “Ambience with 
Piana, Louder.”

The ? (question mark) specifies wildcard search specifying only a single character. The number of 
question marks you type specifies how many characters of wildcard searching you want to perform. 
For example, if you type:

door?close

you may get no results at all, unless you have a sound effect named “door-close.” However, 
if you type:

door????close

results include “DoorWoodClose” since the word wood is four letters, matching the number of 
wildcard letters you’ve specified.
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TIP: typing “***” will show all of the files in your Sound Library

Preview and Audition Controls
Selecting an item in the Sound Effect list loads it into the preview player where you can play it or 
audition it in your timeline using the controls underneath the search field.

	— Clip name: The name of the current clip you’ve selected.

	— Next/Previous buttons: Two buttons let you select the next or previous sound effect clip in the 
Sound Effect list.

	— Duration display: Shows the duration of the current clip, or of the section of the clip marked with 
In and Out points.

	— Playhead timecode display: The playhead’s current position.

	— Waveform overview display: The waveform of the entire sound effect appears here, providing a 
zoomed out view of the selected clip. All channels are summed together in this display.

	— Zoomed in waveform display: A zoomed-in section of the selected clip that lets you see more 
waveform detail for setting In, Out, and Sync points.

	— Jog bar: Lets you navigate through or scrub around the clip.

	— Transport controls: Play, stop and loop buttons let you control playback, although you can also 
use the space bar and JKL controls. Right-click the Stop button to switch it into “Stop and Go to 
Last Position” mode.

	— Marking controls: The Sync Point button lets you mark a specific frame on the sound effect that 
you want to sync to the Timeline’s current playhead position when you use the Audition controls. 
The In and Out buttons let you mark which portions of the sound effect clip you want to edit into 
the Timeline.

	— Audition controls: The Audition button puts you into Audition mode, where the currently 
selected sound effect clip is automatically placed at the position of the playhead in the currently 
selected Timeline track. You can then move over to the timeline and listen to the clip in your 
mix. Cancel and Confirm buttons let you choose whether you want to remove the clip from the 
Timeline and try again with another clip, or leave the sound effect clip in.

To audition clips you’ve selected in the Sound Library in the Timeline:

1	 Select a sound effect clip you’ve found from the list that you want to audition in the Timeline.

2	 (Optional) In the Sound Library, use the scrubber bar to move the playhead to the part of the 
sound effect that you want to sync to, and click the Sync Point button to place a sync mark on 
that clip. For example, if you’re syncing the sound effect of a car door closing, you might sync the 
first frame of the door fully closed to the peak of the “slam” sound effect, rather than any door 
squeaking earlier in the sound effect.

3	 (Optional) Set In and Out points to define the range of the sound effect you want to 
potentially use.

4	 Select a track you want to preview the sound effect in by clicking its track header or Mixer 
channel strip.

5	 Position the playhead at the place in the Timeline you want to place your clip.
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6	 Click the Audition button in the Sound Library. That clip now appears, temporarily, in the Timeline, 
and you can play through that section of the Timeline to see how you like the sound effect in 
context with the rest of the mix.

7	 If you like the sound effect, click Confirm to keep it in the Timeline. If you don’t, click Cancel, and it 
will disappear from the Timeline.

NOTE: In order Use the Audition function, a track has to be selected first. 

Additionally, if you select another sound effect after auditioning, without first confirming 
the prior sound, the Audition process is cancelled, and the prior sound is removed 
from the timeline. 

Sound Effect List
All sound effect clips that match the current search criteria appear in this scrollable list. Double-
clicking anywhere on an item of this list plays that sound effect in its entirety.

	— Clip Name: The name of that sound effect file in the storage system.

	— Description: Any metadata that’s embedded within the files of professionally created sound 
effect libraries appears here.

	— Duration: The duration of that sound effect file.

	— Audio Channel: The number of channels in that sound effect file.

	— Star rating: A clickable control you can use to rate sound effects within DaVinci Resolve. Star 
rating information is not saved outside of DaVinci Resolve.

	— Waveform: The overall waveform of the entire sound effect library is stretched or compressed 
within the available width of the Sound Library, regardless of the actual duration of each clip.

Index
The Index provides a handy interface for listing all of the clips in the current edit, all the tracks in the 
current Timeline, and all the markers in the current Timeline. Using these lists, multiple items can be 
selected, tracks can be managed, and marker notes can be consulted with ease. Each of these three 
categories of information is displayed in separate panels: the Edit Index, Tracks, and Markers.

Edit Index
Displays the Edit Index as seen in the Edit page. Each audio clip in the currently open Timeline 
corresponds to a row in the Edit Index, with columns for video track, Source In and Out, Record In and 
Out, Name, and other descriptive metadata. All selected clips (including clips that are automatically 
selected because they intersect the playhead) are selected in the Edit Index. The Option menu lets you 
filter the Edit Index by various criteria, for example showing only clips with a particular color of flag, 
marker, or color, only clips with speed effects, only clips with audio filters, or compound audio clips.
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The Tracks panel shows a row of information for each of the tracks in the Timeline

Tracks
Every track in the currently open Timeline corresponds to a row of controls and information in this 
panel. From left to right, each track has a color control, a visibility control, a number, a name, track 
controls, a format, ADC, Tags, and, if a VCA is used, the number of that VCA group. These controls 
can be used to hide or show tracks, color code them, rename them, turn track controls on singly 
or by dragging over several at a time, change their format, add to (or remove them from) the audio 
monitor list, and rearrange them (by dragging one or more rows up and down this list) and toggle the 
automatic delay compensation (ADC) on/off (on by default).

The Tracks panel shows a row of information  
for each of the tracks in the Timeline.

NOTE:  The ADC column (automatic delay compensation) has a check box allowing the 
enabling of ADC on a track-by-track basis.
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Audio Monitor Checkbox
A monitor checkbox appears for each bus or track in the Tracks list. When checked, that track or 
bus will appear in the Audio Monitoring drop-down menu as a choice for monitoring. All busses are 
checked on by default, and will appear in the list unless unchecked here.

MPEG-H Options in the Tracks Panel
If you have MPEG-H enabled for immersive audio authoring in the preference pane of Video and Audio 
I/O, additional columns appear in this panel.

When MPEG-H is enabled, the Tracks panel shows additional columns 
of information for defining each track in the Timeline.

These columns include:

	— Track Type: Allows definition of either a static component or a dynamic object. When dynamic is 
selected, the dynamic track-level pan automation from that track is also exported. Only a track can 
be set to dynamic. 

	— Kind: A content type label, such as Mixed content, Music, Dialogue, Effect, etc. When Kind is 
defined for a bus (rather than the default state of Undefined), that bus is automatically bounced 
during the export process. 

	— Language: The content-specific language for that track. 

	— Switch Group: Allows the track to be assigned to a user-defined switch group. A switch group 
allows the track to be grouped together with other tracks in the final content, forming a selectable 
item when rendered. For example, a switch group of dialogue, containing an English and a Chinese 
language track, could allow the user to select between these languages on playback. In order to 
define a switch group, click that track’s cell in the Switch Group column, and choose “Sw Groups…” 
to open the Switch Groups Manager window, which lets you create new switch groups.

 

The Switch Group Manager

3559Fairlight  |  Chapter 166  Using the Fairlight Page



Once one or more groups has been created, they’re available for selection in the drop-down menu 
of any cell in the SW Groups column. This lets you quickly make a variety of custom assignments.

The drop-down in the SW Group column

	— Presets: Allows a track to be assigned to a user-defined preset. For example, a Bed Mix and 
Language switch group could form one preset, while the same tracks and a spoken subtitle could 
form another. In order to define a Preset, click that track’s cell in the Presets column, and choose 
“Presets…” to open the Preset Manager window, which lets you create new Presets. 

The Preset Group Manager

Once one or more presets has been created, they’re available for enabling in the drop-down menu 
of any cell in the SW Groups column. Any track can be added to multiple presets, so the Presets 
drop-down contains one checkbox per preset so you can make multiple assignments.

The drop-down in the Presets column
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Once configured, the metadata from these presets form how the content is exported in the final 
deliverable, so there will be a set of presets that contain all configured components and switch groups.

Markers
The markers panel can be displayed in either thumbnail or list mode. In thumbnails mode, each 
marker in your timeline corresponds to a thumbnail displaying the timecode of its location underneath 
it, and the color of the marker to the left of the timecode location. In list view, each marker displays a 
row with the following information; marker number, frame (showing a thumbnail), marker name, start 
timecode, end timecode, duration, marker color, and notes.

The Markers panel shows a row of information for each of the markers in the Timeline.

Inspector
When you add an audio effect to a clip or a track, those effects appear in the Inspector when that clip 
or track is selected.

For details on the Inspector for the Fairlight page, See Chapter 172, “Audio Clip Specific Inspector 
Adjustments.”

Metadata Editor
In the File tab of the Inspector there is a Metadata Editor that lets you view and edit the metadata of 
selected clips in the Fairlight page.
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The Metadata Panel is located under the File 
tab in the Fairlight page Inspector

Test Tone Settings for 
Generating Tone, Noise, and Beeps
The Fairlight page has a general purpose oscillator, the settings of which you can customize by 
choosing Fairlight > Test Tones Settings. This opens the Test Tones Settings window that you can 
configure to generate tones, noise, or beeps using five sets of controls:

	— Enable/Disable Test Tones toggle: Lets you turn the Oscillator on or off system-wide.

	— Frequency control: Sets a custom frequency of oscillating tone, from 20 Hz to 15kHz. 
Defaults to 1kHz.

	— Frequency buttons: Lets you quickly select 100, 440, 1K, or 2K preset tones, or a continuous 
rising sweep of frequencies from 20 Hz to 15kHz.

	— Noise type buttons: Two buttons let you choose from White noise or Pink noise.

	— Level dial: Sets the output level for the tone or noise, from –50dB to +10dB. Defaults to –15 dB.

You can set up the Oscillator to output whatever kind of tone or noise you require, and then patch it 
to tracks for recording tones, or patch it to audio outputs for calibrating speakers. If you use the beep 
options of the ADR panel, those are performed via the Oscillator.
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To play the Test Tone out of your speakers:

1	 Choose Fairlight > Patch Input/Output to open the Patch Input/Output window.

2	 Choose System Generator from the Source drop-down menu, and choose Audio Outputs from the 
Destination drop-down menu.

3	 At the left, click the button of what you want to output, Osc (Oscillator) or Noise.

4	 At the right, click the connected audio outputs that you want to patch to, and click Patch. Tone or 
noise should immediately start playing out of your configured speakers. Depending on any 
particular track’s I/O settings, if you have patched the Osc through a track you may need to 
either Arm the track by pressing the R (record) button, or in the channel’s Path Settings press the 
Thru button, to have the signal pass through for output monitoring.

5	 To stop, select one of the patched buttons, and click Un-Patch.

To record a tone or noise from the Oscillator to an audio track:

1	 Choose Fairlight > Patch Input/Output to open the Patch Input/Output window.

2	 Choose System Generator from the Source drop-down menu, and choose Track Input from the 
Destination drop-down menu.

3	 At the left, click the button of what you want to output, Osc (Oscillator) or Noise.

4	 At the right, click the connected audio outputs that you want to patch to, and click Patch. Close the 
Patch Input/Output window.

5	 Click the Arm Record (R) button in the track header of the track you patched the Oscillator to. 
If your Main is properly patched to your outputs, you should hear the tone or noise, and that 
track’s audio meter should reflect the level being output by the Oscillator.

6	 Click the Record button of the transport controls to initiate recording of that tone to the patched 
track. Click the Stop button or press the Spacebar to halt recording when you’re done.

Generating Timecode
SMPTE timecode can be generated as an audio signal directly from DaVinci Resolve. The signal can be 
used to synchronize another Resolve system (requires a Fairlight SX36 audio interface), or any system 
that use the timecode audio as a reference. 

To generate timecode:

	— Choose Fairlight > Remote Control Settings.

	— In the dialog box that appears, set your desired time code start time (generally you’ll want the 
starting time code position to match whatever you have set as the start time for the current Timeline.

	— Turn on the SMPTE Timecode switch on the upper left. 

The Remote Control Settings dialog
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	— To patch the audio signal from the timecode generator to an output or recording path, choose 
Fairlight > Patch Input/Output. 

	— In the dialog that appears, choose System Generator from the Source Dropdown on the upper left.  

	— Choose Timecode from the source list on the left, and choose the destination you want to route 
timecode to.

Now, whenever you are playing the timeline, timecode is output to your destination until you press 
stop. You can disable timecode generation via the Remote Control Settings dialog.

Patching timecode from the System Generator Source list to Track Input destination

Pro Tools AAF Import
DaVinci Resolve can import AAF projects and media from Pro Tools, enabling you to move an audio 
project from a Pro Tools workstation to a Fairlight workstation. AAF import supports the import of 
embedded audio and track automation. To do so choose File > Import Timeline > Import AAF/EDL/XML.
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Dual Monitor Layout
The Audio page has a dual monitor layout that provides maximum space for the mixer and audio 
meters on one screen and a full-screen timeline on the other.

To enter dual screen mode:

	— Choose Workspace > Dual Screen > On.

The Fairlight page in dual screen mode

To switch which UI elements appear on which monitors:

	— Choose Workspace > Primary Display > Display 1 or Display 2, which reverses the contents of both 
monitors in dual screen mode.
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Customizing the Fairlight Page
The default layout is quite efficient for a number of tasks on most displays. You can always return 
to the default layout by choosing Workspace > Reset UI Layout. However, the Fairlight page can be 
customized to create more room for specific areas of the interface to accommodate different tasks.

To resize any area of the Fairlight page:

	— Drag the vertical or horizontal border between any two panels to enlarge one and shrink the other.

To resize the height of individual audio tracks:

	— Move the pointer to the bottom border of any audio track header, and when it becomes a resize 
cursor, drag that border up or down to resize that track. Each track can have an independent size 
when you do this. 

To resize any column of the Index: 

	— Move your pointer over the divider between any two columns and drag when the horizontal resize 
cursor appears.

To rearrange Index columns: 

	— Drag the header of any column to the left and right to move that column.

NOTE: if you want to retain the height view set for your tracks when a project is closed 
and re-opened, right-click on the track header and choose “Lock Track Height to.” You can 
choose “Custom” as the size for any track height you may want other than standard sizes. 

TIP: You can also use the option key to adjust heights for all selected tracks or Command-
option to adjust all selected tracks.

Fairlight Configuration Presets
You can store and recall complete configuration presets for the Fairlight page, or individual areas of it, 
using the Presets Library functions, found in Fairlight > Presets Library. For more more information on 
using the Presets Library, see Chapter 167, “Setting Up Tracks, Busses, and Patching.”
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Undo and Redo in DaVinci Resolve
No matter where you are in DaVinci Resolve, Undo and Redo commands let you back out of 
steps you’ve taken or commands you’ve executed, and reapply them if you change your mind. 
DaVinci Resolve is capable of undoing the entire history of things you’ve done since creating or 
opening a particular project. When you close a project, its entire undo history is purged. The next time 
you begin work on a project, its undo history starts anew.

Because DaVinci Resolve integrates so much functionality in one application, there are three separate 
sets of undo “stacks” to help you manage your work.

	— The Media, Edit and Fairlight pages share the same multiple-undo stack, which lets you backtrack 
out of changes made in the Media Pool, the Timeline, the Metadata Editor, and the Viewers.

	— Each clip in the Fusion page has its own undo stack so that you can undo changes you make to the 
composition of each clip, independently.

	— Each clip in the Color page has its own undo stack so that you can undo changes you make to 
grades in each clip, independently.

In all cases, there is no practical limit to the number of steps that are undoable (although there may be 
a limit to what you can remember). To take advantage of this, there are three ways you can undo work 
to go to a previous state of your project, no matter what page you’re in.

To simply undo or redo changes you’ve made one at a time:

	— Choose Edit > Undo (Command-Z) to undo the previous change.

	— Choose Edit > Redo (Shift-Command-Z) to redo to the next change.

	— On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

TIP:  If you have the DaVinci control panel, there is one other control that lets you control 
the undo stack more directly when using the trackballs, rings, and pots. Pressing RESTORE 
POINT manually adds a memory of the current state of the grade to the undo stack. Since 
discrete undo states are difficult to predict when you’re making ongoing adjustments with 
the trackball and ring controls, pressing RESTORE POINT lets you set predictable states of 
the grade that you can fall back on.

You can also undo several steps at a time using the History submenu and window.

To undo and redo using the History submenu:

1	 Open the Edit > History submenu, which shows (up to) the last twenty things you’ve done.

2	 Choose an item on the list to undo back to that point. The most recent thing you’ve done appears 
at the top of this list, and the change you’ve just made appears with a check next to it. Steps 
that have been undone but that can still be redone remain in this menu, so you can see what’s 
possible. However, if you’ve undone several changes at once and then you make a new change, 
you cannot undo any more and those steps disappear from the menu.

3567Fairlight  |  Chapter 166  Using the Fairlight Page



The History submenu, which lets you undo several steps at once

Once you’ve selected a step to undo to, the menu closes and the project updates to show you its 
current state.

To undo and redo using the Undo window:

1	 Choose Edit > History > Open History Window.

2	 When the History dialog appears, click an item on the list to undo back to that point. Unlike 
the menu, in this window the most recent thing you’ve done appears at the bottom of this list. 
Selecting a change here grays out changes that can still be redone, as the project updates to 
show you its current state.

The Undo history window that lets 
you browse the entire available 
undo stack of the current page

3	 When you’re done, close the History window.
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Chapter 167

Setting Up Tracks, 
Busses, and Patching
One of the first things you need to do when you’re setting 
up a new project for mixing in the Fairlight page is to define 
the audio tracks and busses you’’ll need to route and combine 
the elements of your mix. 

This chapter covers how to create audio tracks and how to use busses to manage your mixes in 
the most efficient possible way. However, the Fairlight page gives you the flexibility to add or change 
your set up at any time; you can also concentrate on being creative and deal with any required 
housekeeping as your mix evolves.

Fairlight’s FlexBus structure supports bus-to-bus, track-to-bus, or bus-to-track signal routing, 
along with expanded Dolby Atmos capabilities, including import, export, and manipulation of 
Atmos ADM files.
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Audio Tracks
Each audio track in a DaVinci Resolve timeline corresponds to a single channel strip on the Mixer’s left 
side. Depending on how an audio track has been configured, each audio track is assigned a specific 
audio format, such as mono, stereo, 5.1 or 7.1 surround, or Dolby Atmos. Track routing allows multiple 
audio channels within the clips on a track to be correctly routed to the proper audio output for 
monitoring and rendering via the lanes that can be seen within each track on the Fairlight timeline.

Audio tracks in DaVinci Resolve often contain multiple channels from a given clip, but how those 
individual audio channels are displayed depends on the page:

	— The Cut and Edit pages display a single clip “lane” per audio track in the Timeline, regardless 
of how many channels the clips on that track are representing. The waveform displayed is a 
composite, showing a mix of the various channels within the clip. 

	— This can make it easier to work with multichannel tracks without the distraction of viewing 
multiple channel lanes, which could make things look a lot “busier.” However, the tradeoff is that 
detailed activity on any of the various channels on that track are not seen.

	— The Fairlight page displays the same number of tracks as the Edit page, but each track on the 
Fairlight page is divided into lanes, which shows each individual channel of a clip’s audio. This 
additional visual information can help with editing and mixing.

(Top) 6 channel and stereo audio in the Cut and Edit pages represented by single 
composite tracks. (Bottom) The same audio in the Fairlight page shows the 6 channel 
and stereo tracks with multiple lanes that correspond to each of the file types. 
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Now that you understand how tracks work on the Fairlight page, the next important concept you need 
to understand in order to unlock the power of the Fairlight page is FlexBus, which lets you combine 
multiple audio tracks in different ways.

What Is a Bus?
A bus is simply a common signal connection point in an audio mixer. Busses can be mono, stereo, or 
any larger format, like 5.1 or Dolby Atmos 9.1.6 (where 16 audio signals are used). Bussed connections 
are mixed together into a single signal that can be controlled via a single bus channel strip. For 
example, by default a single bus called “Bus 1” combines the levels of every clip edited onto every track 
of a timeline into the mixed signal that is output to your speakers or headphones.

You can use busses in creative ways to organize mixing of tracks in a timeline. For example, if you 
have five audio tracks that have all of the edited dialogue audio clips for a particular program, you can 
route the output of all five dialogue tracks to a dedicated submix bus. This allows the combined levels 
from all the contributing dialogue tracks to be processed, adjusted, and mixed at once using a single 
channel strip’s controls.

You can use multiple busses to organize a mix, including routing submix busses into other “main 
busses.” Individual tracks can be routed to submix busses, then multiple submixes can be routed to 
one or more “main output” busses. For example, you could have four submix busses, one for German 
dialogue, one for English dialogue, one for Music, and one for Effects. You could route the German, 
Music, and Effects submix busses to a Main 1 bus to output the German version of the program, and 
route the English, Music, and Effects submix busses to a Main 2 bus to output the English language 
version of the program.

Surround Panning and Bussing 
When working on surround or immersive formats, audio tracks from the Timeline are routed to 
busses via each channel strip’s multi-format surround panner, so busses can be configured to 
accommodate specific audio formats, such as mono, stereo, LCRS, 5.1 surround, or 7.1 surround, 
and immersive formats, such as Atmos. By using multiple bus routing, you can even output different 
formats simultaneously.

Bus to Bus Routing and Mixing
Fairlight’s FlexBus structure offers complete user flexibility for bus types and signal routing, allowing 
completely user-definable bussing, and making it possible to patch outputs and/or sends in any 
way you need, as dictated by your project. Each track can output to up to ten busses and sends with 
additional level and pan controls to a further ten busses. Busses can be sent to other busses up to six 
layers deep, facilitating complex stem building, processing, and allowing discrete deliverables.

User-definable busses allow for bus-to-bus, bus-to-track, or track-to-bus routing, with each bus having 
the ability to pass signals from mono to fully immersive formats, such as Dolby Atmos. As with any and 
all of the track types in Fairlight, these bus types can be changed at any time if needed.
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The power of the FlexBus system is that it allows users to direct signals to many different places at 
one time, achieving complex mixing scenarios. Perhaps you need to generate two mixes that are 
identical in content but need to be of different output levels. You can designate two mix busses, 
one with an output level of -2dB true peak and one with an output level of -10dB true peak. The 
final mix signal is sent to one bus that is then broken into two more busses, one with a limiter set 
to -2dB and one set to -10 dB, creating these two different mixes at one time. 

The FlexBus structure allows for many different 
bus track types to be created or changed.

Using Legacy Fixed Busing
If you want to work using the previous method of Fixed Bus mapping, you can do so for new 
projects by opening the Fairlight panel of the Project Settings, and turning on the “Use fixed bus 
mapping” checkbox.

If your project has Fixed Bussing enabled and you want to change to FlexBus, then uncheck the 
“Use fixed bus mapping” checkbox. Note that once you have made the change it will not allow you to 
change it back to legacy bussing. For more information see Chapter 173, “Mixing in the Fairlight Page.”

Converting Older Fixed Bus Projects to FlexBus
Older Fixed Bus projects can be converted to FlexBus by doing the following:

	— Open Project Settings > Fairlight. 

	— Under the Bussing heading, uncheck “Use fixed bus mapping.”

	— A dialog will appear allowing you to convert the project to FlexBus.
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Busses in Nested Timelines
When you nest a timeline inside another timeline that has busses set up for mixing in the Fairlight 
page, all bus routings continue to work as intended within the nested timeline, which exposes all 
channels via the default main bus (Bus 1) in the enclosing timeline. In this sense, the audio of the 
nested timeline can be considered to be a submix that outputs its resulting audio to the audio track 
it’s edited onto. However, you can also decompose your nested timeline into its own bus structure 
within the main timeline you’ve imported into, exposing all of the original tracks as they were. This is 
a very powerful feature for combining work done at different times or by different contributors. (see 
Chapter 173, “Mixing in the Fairlight Page.” “Nested Audio Timelines” for more information.)

Exposing Bus Tracks in the Timeline
You can expose any bus as a track in the Timeline. This makes it possible to view and edit automation 
that is applied to parameters on that bus.

To show a bus in the Timeline:

1	 Enable the Toggle Automation button on the Fairlight toolbar. All busses are visible by default.

2	 If you want to hide any bus, open the Index, and click the eye button for the bus you want to hide 
in the Timeline.

3	 If you want to work with automaton on a bus, choose the desired automation curve you want to 
view from the drop-down menu in the track header controls.

Controlling Signal Flow
A good process for setting up editing and mixing in the Fairlight page is: 

	— Organize and configure the tracks on your timeline as required. For example, clips well organized 
on tracks, set track types, color, grouping, etc.

	— Create the busses needed to organize the desired signal flow in the mix.

	— Route the audio tracks, or any submix busses to the desired bus destinations for the mix layout.

Defining Audio Track Types
If you decide to create a new audio track, you have to choose what kind of audio track it will be. Right-
clicking in the bottom audio portion of the Timeline track header reveals a contextual sub-menu that 
lets you create different kinds of audio tracks.

	— Mono: Holds a single channel with only one lane.

	— Stereo: Holds stereo left and right channels, with two lanes.

	— 5.1: Holds the six channels corresponding to a 5.1 surround mix, for a total of six lanes. For 
broadcast, SMPTE specifies Left, Right, Center, LFE, Surround Left, and Surround Right. For cinema 
distribution these tracks are ordered Left, Center, Right, Left Surround, Right Surround, and LFE.

	— 7.1: Holds the eight channels corresponding to a 7.1 surround mix, for a total of eight lanes. For 
broadcast, SMPTE specifies Left, Right, Center, LFE, Left Surround, Right Surround, Back Left 
Surround, and Back Right Surround. For cinema distribution these tracks are ordered Left, Center, 
Right, Left Surround, Right Surround, Back Surround Left, Back Surround Right, and LFE.
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	— Dolby Atmos: There are several Atmos formats available: 5.1.2, 5.1.4, 7.1.2, 7.1.4, and 9.1.6. The 
naming of the channel configurations in the Dolby Atmos format includes the height channels in 
the nomenclature. Channel configurations are presented as three digits separated by periods, 
such as 7.1.4. The first digit describes the number of main, or ear-height monitoring channels that 
surround the listener. The second digit describes the number of subwoofer channels. The third 
digit describes the number of height channels, which are speakers positioned on, or in the case of 
a soundbar pointed to, the ceiling.

	— Adaptive: Capable of holding up to 24 audio channels, each with its own lane within the track. An 
adaptive audio track can hold clips with different combinations of channels, up to the maximum 
number of channels allowed within that track. The number of channels allowable on a particular 
Adaptive track is user-definable (1–24) at the time that track is created. If you edit a clip with more 
channels into an Adaptive track that was created to hold fewer channels, the extra clip channels 
are muted.

NOTE: The Dolby Atmos bus formats of 9.1.4, 9.16, and 22.2 are only available in 
DaVinci Resolve Studio and also require that Dolby Atmos be enabled in Preferences > Video 
and Audio I/O > Immersive Audio. 

Adding Tracks (Contextual Menu)
There are two commands related to adding tracks in the right-click contextual menu on any audio 
track’s header controls: 

	— Add Track: Adds a single audio track of the type you choose from a submenu. 

	— Add Tracks: Lets you insert as many tracks as you like, designating type and position.

Rearranging Tracks
You can rearrange tracks by right-clicking in a track’s header area and choosing either Move Track 
Up or Move Track Down in the contextual menu that appears. You can also move tracks in the 
Index by grabbing them and moving them to the desired position. This method works with multiple 
tracks at once.

Changing Track Type
If you had set up your timeline with one kind of audio track, but you discover you actually 
need a different type, you can change them at any time. Just right-click anywhere in that audio 
track’s Timeline header, and choose an option from the Change Track Type To submenu of the 
contextual menu.

Deleting Tracks
Right-click within a track’s Timeline header and choose Delete Track. If there are clips on a track you 
remove, they are also deleted from the Timeline, but preserved in the Media Pool.
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Right-clicking on a track or the track field reveals the 
Delete Tracks and Delete Empty Tracks functions

You can remove all empty audio tracks in the Fairlight timeline by right-clicking any track header 
and selecting Delete Empty Tracks from the contextual menu.

You can delete a multiple selection of tracks in the Fairlight timeline by right-clicking any selected 
track header and selecting Delete Tracks from the contextual menu.

Link Grouping
The Link Group function allows you to link mono tracks of material that are related and manipulate 
them as a one entity controlled by a single fader on a single channel strip. Only mono tracks 
can be used to create a link group; other track types such as stereo, 5.1, 7.1, Atmos, or Adaptive 
cannot be used. 

Unlike a multi-channel track with lanes, a link group of mono tracks functions as independent, editable 
tracks in the Timeline. However, each track is mapped when choosing a track type, using one of the 
standard multi-channel mappings (stereo, 5.1, 7.1, Adaptive).

Link groups are extremely useful. For example, if you’ve been given independent “.L/.R” sides of a 
stereo mix, or a set of six independent related audio files that need to be assembled as a single 5.1 
surround mix, or when you have surround channels that need to be specifically re-edited on a channel 
by channel basis.

To create a Link Group from individual mono tracks:

1	 Create two or more Mono audio tracks that you want to group together. If you need to create 
a link group with a specific channel mapping, such as 5.1, make sure you create enough tracks 
(in this case, 6).

2	 Choose Fairlight > Link Group.
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3	 When the Link Group dialog appears, mono audio tracks are represented by active buttons (all 
other track types are disabled, since they can’t be linked). Click to enable the button of every 
track you want to include in the link group you’re about to create. Which track type mappings are 
available to use for creating your group depends on how many tracks you’ve selected.

Selecting six tracks to use for creating a link group

4	 After you’ve selected all the tracks you need to, click one of the available “Link as” buttons below. 
In this example, six tracks have been selected, so you could click 5.1 Film or 5.1.

When you select enough tracks, you can create 
groups linked as specific surround mappings.

Afterwards, the tracks you selected should turn into a single block, showing they’ve been linked.

The Link Group window shows the link indicator line next to the track names.

Depending on the number of mono channels selected, Fairlight will offer possible linking 
options. For instance, when ten channels have been selected, both Atmos 7.1.2 and 5.1.4 are 
option choices.

The Link As option is dependent on the number of channels being linked.

5	 Close the Link Group window when you’re finished.

Once you’ve created a link group, the mono tracks in the timeline that you linked appear with a bar to 
the left in the track header that spans every track that’s linked. If the tracks are tall enough, they’ll also 
be labeled to identify which track corresponds to which. For example, with a 5.1 surround mapping, 
L, R, C, LFE, Ls, Rs, and so on. You also have the freedom to edit additional or different contributing 
elements of a surround mix into the appropriate track that represents that channel.
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Tracks in a linked group are labeled 
to identify which track corresponds 
to which surround channel

Working Separately with 
Multichannel Audio File Elements
If you’ve edited a multichannel audio clip onto a multichannel track, you can convert that track and its 
contents into a link group of mono tracks, each of which contains a single clip for that track’s channel. 
This can be useful if you need to fix a multi-channel surround audio clip with an incorrect track 
mapping. You can convert it into a linked group, at which point you can easily rearrange the channels.

To create a Linked Group from a single multichannel timeline:

	— Right-click the track header of a multichannel audio track, and choose Convert to Linked Group 
from the contextual menu. This automatically creates one new audio track for each channel, all of 
which are linked together. For example, converting a 5.1 audio track results in six new tracks with 
six individual audio clips (one for each channel), all of which are linked together.

If necessary, you can also unlink a linked group to turn it back into independent mono tracks.

To unlink a Link Group:

1	 Choose Fairlight > Link Group.

2	 When the Link Group dialog appears, select the link group you want to unlink.

3	 Click Unlink.

4	 Close the Link Group window when you’re finished.

3577Fairlight  |  Chapter 167  Setting Up Tracks, Busses, and Patching



SMPTE and Film order Standards

The variations of routing of the multichannel files are due to the path order of SMPTE or Film 
standards. They are:

	— 5.1 film order: L, C, R, Ls, Rs, LFE

	— 5.1 SMPTE order: L, R, C, LFE, Ls, Rs

	— 7.1 film order: L, C, R, Lss, Rss, Lsr, Rsr, LFE

	— 7.1 SMPTE order: L, R, C, LFE, Lss, Rss, Lsr, Rsr

Creating Busses
Choosing Fairlight > Bus Format opens the Bus Format window, which lets you create the busses you 
need (up to the limitations of your system) to organize the tracks and channels of your program.

The depth of options in the FlexBus system

The Bus list lets you rename the bus, choose the format of each bus (a drop-down menu appears 
in the Format column of each entry of the list), shows the number of channels associated with that 
bus, and lets you color-code each bus (a Color drop-down lets you choose that bus’s color). Simply 
click any item on the Bus list to select it, and choose different options from the Format and Color 
drop-down menus, or click on the User Name of any bus to select it, and type a custom name.

At the bottom of the list are three buttons that let you Add Bus, Duplicate, or Remove selected 
busses. When you’re done modifying the available busses, you can click OK to accept the changes 
and close the Bus Format window, or Cancel to close the window without any changes (although 
all pre-existing busses remain in place). The bottom button row also has a Used tally of what has 
been used and what is available for your workstation.
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Immersive Formats (Studio Version Only)
To turn on the immersive formats, go to Preferences > Video and Audio I/O > System > Immersive 
Audio, and choose from among the appropriate options. Once enabled, the various immersive bus 
formats are available in the Bus Format panel’s Bus list.

The legacy Bus Format window lets you add busses to the mixer.

Legacy Fixed Bussing
Working with the FlexBus topology is highly recommended for its flexibility. In addition, some newer 
features are only available using FlexBus. At some point, however, you may need to work with legacy 
Fixed Bussing in a new project. To use Fixed Bussing in a newly-created project, prior to adding any 
timeline, open Project Settings > Fairlight, and under the Bussing heading, check “Use fixed bus 
mapping.” Now all bussing is handled with the legacy Fixed Bus topology.

Bus formatting with Fixed Bus

The legacy Bus Format window has four buttons that let you create the various Fixed Bus types. 
Creating a new bus, whether it’s a Main, Sub, Aux, or Multi Track, adds the new bus to the list that 
appears beneath.

The legacy Bus list works the same as the FlexBus list with choices for rename, format, color code, and 
so on, and buttons that let you Duplicate or Remove selected busses.

When you’re done modifying the available busses, you can click OK to accept the changes and close 
the Bus Format window, or Cancel to close the window (although any busses you’ve made remain 
in place). The bottom button row also has a Used tally of what has been used and what is available for 
your workstation.
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Assigning Busses
Once you’ve created one or more busses, you can assign different tracks to specific busses or perhaps 
also busses to busses, busses to tracks, and the final Main bus destinations. 

Bus Assignment Using the Mixer
You can easily assign your track(s) to any available busses simply by using the plus (“+”) icon on a Mixer 
channel strip:

	— Select a mixer channel, and click on the plus (“+”) icon in the Bus Output or Bus Sends section. 

	— In the drop-down menu, choose the desired destination. 

	— A rectangle appears with the name of the bus, and the bus is now assigned. 

Bus routing drop-down 
menu on a channel strip

TIP: You can quickly assign a bus to any selected group of tracks, or to all tracks by holding 
down the Option key (all selected) or Command-option when making an assignment.

The Bus Assign Window
When you have a lot of busses or tracks to handle, the Bus Assign window lets you to easily manage 
connecting to all of them at once. Chose Fairlight > Bus Assign to open the window. Multiple bus 
assignments can be created within the dialog; these new assignments will be reflected in the Bus 
Outputs section on the channel strips in the Mixer.

The top shows the Send and the Out of all of the available busses, while the bottom shows a list of 
all available tracks and busses to connect to. The Bus Assign window defaults to List view, in which 
each bus and track is shown as a list, but by using the icon in the upper right of the window, it can be 
switched to Icon view, in which Available Tracks are shown as buttons.
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Making Bus Assignments

Assigning Using List View

Click a button in the Busses section to select the Send or Out of that bus, and then click on any 
destination in the tracks/busses list below, or drag over a group of tracks or busses to assign to all of 
them. When assigned, the bus number will appear in the Bus Sends or Bus Outputs column.

	— To assign every track, Sub, and Aux to a bus: Click a button in the Busses section to select that 
bus, and then click Assign All.

	— To clear all track assignments from a particular bus: Click a button in the Busses section to 
select that bus, and then click Unassign All.

When you’re done making bus assignments, click the Close button to close the dialog.

NOTE: While the dialog is open, you can undo any assignments you’ve made, one a 
time, or redo them, using Command-Z and Command Shift-Z respectively.

Bus Assign window
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Assigning Using Icon View

	— Click a button in the Busses section to select the Send or Out of that bus, and then either click on 
a target track button or drag a bounding box over all of the buttons for available tracks that you 
want to assign to that bus. 

	— Once assigned, the Available Tracks buttons display which bus they’ve been assigned to. When 
assigned, the Bus number will be followed by an “o” or an “s” to indicate if it’s the send or the out 
of that bus.

Assigning multiple tracks to a bus in 
Icon view by dragging a bounding box

Setting Signal Paths
While bus creation and assignment allows you to submix tracks or route from one bus to another, 
you often need to route signals from individual, external sources to a track or bus. For example, if you 
need to record audio to a track, you need to patch the audio input on your hardware to the track you 
want to record to. Making this type of connection is called “patching” in Fairlight and is accomplished 
using the Patch Input/Output window, which is available on the Fairlight, Edit and Deliver pages, 
providing patching changes on any of these.

Using the Patch Input/Output Window
Choosing Fairlight > Patch Input/Output opens the Patch Input/Output window, which can be 
displayed in either List (default) or Icon view. This window is split into two halves, with the left half 
containing whichever Source controls you choose and the right half containing whichever Destinations 
you choose.

Creating a Patch
By default, the Patch Input/Output window shows the available Audio Inputs as the Source and 
the Track Inputs as the destination. This makes it easy to patch whatever audio source (such as a 
microphone connected to a USB audio interface) to a specific audio track of the Timeline to prepare 
for recording. Patching and unpatching a source to a destination is straightforward. In the following 
screenshot, the Audio 1 Input from an audio interface is highlighted and is being patched to a track 
named “Walla.”
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The Patch Input/Output Window showing Source Audio Inputs and Destination Track Inputs

Patching a source to a destination:

1	 Choose a type of source from the Source drop-down menu at the upper left-hand side of the window.

2	 Click the item on the source list (or action button in Icon view) that you want to patch from on the 
left side of the Patch Input/Output window.

3	 Choose a destination from the Destination drop-down menu at the upper right-hand side of 
the window.

4	 Click the list item (or action button) of the destination you want to patch to on the right side.

5	 Click the Patch button at the bottom right of the window. The source and destination will both 
display the connection they’re patched to.

To unpatch a source and destination pair:

1	 Click a list item or action button corresponding to a source or destination you want to unpatch.

2	 	Click Unpatch.

Patching in Icon view

3583Fairlight  |  Chapter 167  Setting Up Tracks, Busses, and Patching



Choosing Source and Destination Controls
The Audio Source and Destination drop-down menus let you choose different categories of sources 
and destinations to patch together.

The following Source options are available:

	— Audio Inputs: The available physical audio inputs on your workstation, for example the Fairlight 
SX-36 audio interface, MADI, third party interfaces (for example, USB or Thunderbolt), or system 
audio. Useful when patching to record audio.

	— Bus Out: Any Busses.

	— Control Room Monitor Direct: Monitor system Direct out, routed post fold up/down matrix, 
pre the Monitor VolumeLevel/Dim/Mute.

	— Control Room Monitor Out: Monitor system output. Post fold up/down matrix and Monitor 
VolumeLevel/Dim/Mute.

	— System Generator: Provides various utility sources, which also include beeps and timecode generation:

	— System Generator: Provides a test oscillator or Noise generator with choice of white 
or pink noise. The System Generator controls appear in a floating window accessed via 
Fairlight > Test Tone Settings. 

	— Beeps: Refers to beeps generated by operations on the ADR panel, with controls in the 
ADR page setup. 

	— Timecode generator: Generates timecode when enabled and the transport runs, with 
controls provided in a floating window accessed via Fairlight > Remote Control.

	— Track Direct: Track Direct Out, can be pre or post the track fader, with an offset.

	— Track Reproduction: This is the track playback signal, directly from disk, before any processing.

	— Dolby Atmos Renderer: The output from the Dolby Atmos Renderer in the currently selected 
Atmos output monitoring format. There is also a parallel stereo binaural output to feed headphones.

The following Destination options are available:

	— Audio Outputs: For example, the Fairlight SX-36 audio interface, MADI, third party interfaces 
(for example, USB or Thunderbolt), or system audio. Useful when patching to playback audio to 
speakers or headphone systems.

	— Talk Back: The Talkback system for patching the General Purpose Input/General Purpose Output 
used for talkback.

	— Track Input: The inputs to the available audio tracks in the current timeline, which are the inputs 
to the Record and Thru path.

	— Dolby Atmos Send: You will need to patch this manually if you are creating original content. If you 
import a Dolby Atmos master file, the Send patching for the bed and object tracks will be created 
automatically. When an external Dolby RMU renderer is enabled, all sources patched to these 
sends will be mirrored on the physical outputs to the external renderer, as defined by the base 
audio outputs set in system preferences. 
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Legacy Fixed Bus Patching
If you choose to useing the legacy Fixed Bussing, the options are a bit different. Here is how they look 
when that is enabled.appear a bit differently.

The following Audio Source options are available:

	— Audio Inputs: The available physical audio inputs on your workstation, for example SX-36, MADI, 
or system audio. Useful when patching to record audio.

	— Track Repro: Short for Reproduction, this is the signal from the track playback, 
before any processing.

	— Track Send: Track Insert send.

	— Track Direct: Track Direct Out; can be pre or post the track fader, with an offset.

	— MT-Bus Dir: Multitrack Bus Direct Out; can be pre or post the multitrack bus master fader, 
with an offset.

	— MT-Bus Out: Multitrack Bus Out; always post the Multitrack bus master fader.

	— Aux-Bus Send: Aux bus master insert send.

	— Aux-Bus Dir: Aux Bus Direct Out; can be pre or post the Aux bus master fader, with an offset.

	— Aux-Bus Out: Aux Bus Out; always post the Aux bus master fader.

	— Sub-Bus Send: Sub bus master insert send.

	— Sub-Bus Dir: Sub Bus Direct Out; can be pre or post the Sub bus master fader, with an offset.

	— Sub-Bus Out: Sub Bus Out; always post the Sub bus master fader.

	— CR-Mon Dir: Monitor system Direct out. Post fold up/down matrix, pre the Monitor 
VolumeLevel/Dim/Mute.

	— CR-Mon Out: Monitor system output. Post fold up/down matrix and Monitor 
VolumeLevel/Dim/Mute.

	— Main Send: Main bus master insert send.

	— Main Dir: Main Bus Direct Out; can be pre or post the Main bus master fader, with an offset.

	— Main Out: Main Bus Out; always post the Main bus master fader.

	— Osc: Oscillator outputs. Sine, Pink noise, White noise.

	— Solo Out: AFL and PFL Solo Bus Out; always post the respective bus master fader.

The following Audio Destination options are available:

	— Track Input: Input to the Record and Thru path; simply put, the available audio tracks in 
the current Timeline.

	— Track Return: Track insert return.

	— Aux-Bus Return: Aux Bus master insert return.

	— Sub-Bus Return: Sub Bus master insert return.

	— Main Return: Main Bus master insert return.

	— CR-Mon In: Input to the Monitor system’s fold up/down matrices.

	— Talk Back: The Talkback system, showing Comm1 and Comm2.

	— Audio Outputs: The available physical audio outputs on your workstation, for example SX-36, 
MADI, or system audio.
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Using a Channel Strip’s Input Menu
The Input drop-down menu at the top of each track’s channel strip in the mixer provides some 
shortcuts for patching different inputs and busses to the tracks of your mix. Each option in this 
menu makes the Patch Input/Output window appear with various Source and Destination selections 
automatically set up.

Input
The Patch Input/Output window appears set up to let you patch different inputs (such as the 
system audio input) to the tracks of the timeline. This makes it fast for setting up audio inputs in 
preparation for recording.

Bus
A shortcut to open the Patch Input/Output window (discussed previously in this chapter) that lets you 
patch Bus Out or Bus Sends to Timeline track channels.

Path Settings
Choosing Path Settings opens the Path Settings window for that track. This window contains controls 
for adjusting the input level of audio signals being input via an input/output device.

The Path Settings window showing audio inputs and track inputs

These parameters are as follows:

Mic/Inst
Controls will only appear on this panel if you have connected channels 1 or 2 of a Fairlight SX36 audio 
interface to your system. If connected, you can remotely control all of the options (including level) for 
the mic/instrument inputs of the SX36 if they are assigned to the channel. If there is no connection to 
an SX36, the area is empty. 

Record Level
	— Record: Linked and identical to the Record Enable button on the channel strip; here for 

convenience. If you hit one, it will enable the other.

	— Thru: Allows the input signal to pass into the mixer without enabling a record path. This is ideal 
when you want a source signal to always be available and just want to monitor it. 

	— Record Level: Allows you to apply a digital gain adjustment to the record path to disk, post the 
output of your audio interface’s analog-to-digital converter. 

Normally, this control should be left at 0.0 (no change, unity gain), as it affects the level you are 
recording to disk. It is best practice to use the level controls on your audio interface to control the 
input level into DaVinci Resolve in order to maximize audio fidelity. However, there might be a time 
where you need a bit more level, or may not have access to an audio interface’s controls, and in 
those cases you can adjust the input.
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Trim
	— Polarity: Inverts the polarity of the signal coming into the channel strip (sometimes referred 

to as “flipping the phase”). For example, you may have an input signal, like an explosion, where 
the transient attack of the signal produces with a massively positive-going waveform (where the 
waveform mostly appears above the zero line). If you invert the polarity, the signal will now be 
mainly negative-going and the waveform will be concentrated beneath the zero line. Inverting 
polarity is sometimes used to more closely align signals from multiple microphones and can be 
used creatively to affect frequency response of such a signal.

	— Trim Level: Allows you to trim the level of the signal coming off of disk, post the Track FX (which 
process directly off of disk) and pre all other effects. Trim Level appears post the recorded signal 
to disk and doesn’t affect the recording level. Trim is a playback adjustment and allows you to 
adjust the level of the signal coming into your mix to optimize the level feeding effects and the 
busses or to slightly trim an otherwise perfect element in the mix up or down in level. 

Direct Output
Each audio channel strip can enable a direct output that can be used to feed any other input 
destination. You can patch this source using the Track Direct choice in the Patch Input/Output 
dialog via the Source drop-down. For more information see Chapter 167, “Setting Up Tracks, Busses, 
and Patching.”

	— On/Off: Enables/disables the direct output.

	— Pre: Sets the direct output tap-off point to be pre (before) the channel fader. On by default.

	— Level Control: Sets the level from full off (minus infinity) to +10 dB. Default is 0.0 (unity gain). 

Insert
Linked and identical to the Effects In button on the channel strip; here for convenience. If you hit one, 
it will enable the other. Switches all Fairlight FX, AU, or VST effects on a channel in or out of the signal 
path with a single switched control. 

Input Menu with Legacy Fixed Bussing
When using the legacy Fixed Busing, the options there are a bit different. Here is how they look when 
that is enabled.

Input
The Patch Input/Output window appears set up to let you patch different inputs (such as the system 
audio input) to the tracks of the Timeline. This makes it fast for setting up audio inputs in preparation 
for recording.

Aux Bus
A shortcut to open the Patch Input/Output window (discussed previously in this chapter), which 
appears set up to let you patch different Aux busses to specific submix and Timeline track channels.

Sub Bus
A shortcut to open the Patch Input/Output window (discussed previously in this chapter), which 
appears set up to let you patch different Sub (submix) bus channels to specific Timeline track channels.
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Main Bus

A shortcut to open the Patch Input/Output window (discussed previously in this chapter), which 
appears set up to let you patch different Main bus channels to specific Timeline track channels.

Path Settings

Choosing Path Settings opens the Path Settings window for that track. This window contains controls 
for adjusting the input level of audio signals being input via a BMD input/output device.

The Fairlight Presets Library
The Fairlight page offers a powerful and flexible preset system that allows you to store and recall 
presets for everything from the complete configuration of the audio page to individual presets for 
plugins. To access the presets library, choose Fairlight > Presets Library and the library floating 
window appears: 

Fairlight Presets Library with stored presets on the 
left panel and destination tracks on the right

A Filter By drop-down menu on the upper left allows you to choose what type 
of preset you want to work with.  

Filter By menu of preset types
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The choices are:

	— Equalizer Presets: Presets for the built-in channel EQ.

	— Dynamics Presets: Presets for the built-in Dynamics Processor.

	— Plugins Presets: Fairlight FX, AU, or VST.

	— Global Tracks Presets: All settings for a Mixer channel strip.

	— Global Bus Presets: All settings for a Mixer bus.

	— Fairlight Configuration Presets: Many parameters of the Fairlight page stored as a preset including:

	— Track height.

	— What tracks are shown or hidden in the Tracks pane of the Index.

	— Split point in the Mixer.

	— Full Track vs. Small Track views in the Mixer.

	— Track Groups enable status.

NOTE: Some items are not currently stored in Fairlight Configurations, such as which panels 
are shown (for example, Media Pool or Index), Meter Panel show/hide, Fairlight video 
window docking, and size if the video window is set to be floating. 

Using the Presets Library
Select the preset type you want to work with from the Filter By drop-down menu on the left. 

The tracks list on the right (which appears for most preset types) acts as both a list of sources that 
contain information you want to store and a list of destinations that you want to assign to when you 
have presets defined. To store and recall and assign presets:

	— If you’re storing a preset for the first time, select the source track in the tracks list on the right 
of the window that you’ll be grabbing the preset type from (unless it’s a Fairlight Configuration 
preset, which has no tracks to chose from, as it is global).

	— Click the Save New button to save your preset.

	— To load your preset onto another track, deselect any tracks currently selected in the track list on 
the right, and select the track(s) you want to assign to. Click Assign and the preset is loaded.

	— To save a new version of an existing preset or update your present version, first choose a track 
in the track list that has your preset assigned to it. Then click the Save New button, and a dialog 
appears that allows you to choose to update the current version of the preset or save a new 
preset based on the current settings.

	— To Delete a preset, select it in the list, and click the Delete button. 

Update or Create New preset dialog
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Chapter 168

Transport Controls, 
Timeline Navigation, 
and Markers
The Fairlight page has unique transport control, zooming, and 
scrolling options not found in the other pages of DaVinci Resolve 
that help you to work with audio more efficiently. 

This chapter covers how to navigate around the Fairlight version of the Timeline.
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Transport Controls and 
JKL Navigation
Because of the Fairlight page’s audio-focused workflow, the transport and playback controls differ 
from those found in the Media, Edit, Color, and Deliver pages.

Transport Controls

Fairlight page transport controls

The Fairlight transport controls are also designed to mirror their counterparts on the Fairlight control 
panels. They include the following functions:

	— Rewind and Fast Forward: Initiates accelerated playback through the Timeline in either direction. 
Pressing either of these buttons multiple times speeds up this motion, cycling through 8x, 24x, 
60x, 150x, and 360x play speeds.

	— Play: Plays forward. Identical to pressing the Spacebar or L keys while playback is stopped.

	— Stop: Stops playback. Identical to pressing the Spacebar or K keys while playback is engaged.

	— Record: Initiates recording if you have an audio source patched to a track, and if that track is 
enabled for recording. For more information about recording, see Chapter 169, “Recording.”

	— Loop: Toggles looped playback off and on. While looped playback is on, playback will loop at the 
end of the Timeline, and will also loop when you use the Play In to Out command, and will continue 
to loop automatically until you stop playback.

	— Automation controls: This button exposes the automation toolbar. For more information about 
recording automation, see Chapter 174, “Mix Automation.”

Using JKL to Control Playback
The JKL keyboard shortcuts are common to many editing applications, and experienced editors know 
these to be some of the most useful controls for playback and editing there are. Here’s a list of the 
many different ways you can use these three keyboard shortcuts to play through clips and timelines 
as you work.

J Plays 100% backward.

K Stops playback.

L Plays 100% forward.

Press J repeatedly
Increases backward play speed each time you press J,  
for a range of fast-reverse speeds.

Press L repeatedly
Increases forward play speed each time you press L,  
for a range of fast-forward speeds.
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Shift-J Plays in fast reverse.

Shift-L Plays in fast forward.

K+J Plays backward at slow motion (with slow motion audio playback).

K+L
Plays forward at slow motion  
(with pitch-corrected audio playback on OS X).

Pressing K while tapping J Moves the playhead back one frame.

Pressing K while tapping L Moves the playhead forward one frame.

If you’re using Fairlight with the keyboard, then this will probably become one of the main ways you 
move the playhead around in DaVinci Resolve.

NOTE:  All of the keyboard commands listed in this document are based on the 
DaVinci Resolve keyboard customization preset. There is great power in the remapping of 
keyboard commands to systems that may be more familiar to you like Premiere Pro or Pro 
Tools. However, if their keyboard command set does not offer the same commands as the 
DaVinci Resolve keyboard commands, they won’t work the same. For instance, the Pro Tools 
keyboard preset does not support J-K-L timeline navigation.

Dragging the Playhead to Scrub
You can also drag the playhead left and right to scrub through the visible area of the Timeline by 
clicking and dragging anywhere within the Timeline ruler at the top of the Timeline, directly below 
the toolbar. If you’re zoomed in at a reasonable level for editing, scrubbing the playhead using 
your pointer will result in smooth, tape-like slow and fast audio playback, giving you a great deal of 
precision while trimming audio.

Looping Playback
Two controls govern looping on the Fairlight page, similarly to how looping works on the Edit page.

	— Loop: Command-Forward Slash (/). Toggles looped playback off and on. While looped playback 
is on, playback initiated with any of the following commands will loop automatically until 
you stop playback.

	— Play In to Out: Option-Forward Slash (/). If you’ve marked a section of a clip or timeline with In 
and Out points, this command lets you preview how it will play.

Loop Jog Scrubbing
Currently available only on the Fairlight page, choosing Timeline > Loop Jog enables a brief sample 
preview to be heard while scrubbing the playhead through the Timeline. This can make it easier to 
recognize bits of dialog or music as you’re quickly scrubbing through tracks, in situations where you’re 
trying to locate specific lines or music cues. It also enables this brief sample preview to loop endlessly 
when you hold the playhead on a frame, so you can pause while scrubbing and hear (by default) the 
current 80 ms prior to the playhead as it loops.
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A pair of settings in the User Preferences let you customize this behavior. 

	— Loop Jog Alignment: Three options let you choose whether you loop audio Pre the position of 
the playhead, Centered on the playhead, or Post the position of the playhead.

	— Loop Jog Width: A field lets you choose how many milliseconds of audio to loop when Loop Jog is 
enabled. How many milliseconds of audio corresponds to one frame depends on the frame rate 
of the video. For example, at a frame rate of 25 fps, there are 1000/25 = 40 ms per frame, so the 
default value of 80 ms equals two frames of looping.

Moving the Playhead Using Timecode
You can use absolute or relative timecode entry to move the playhead in the Timeline. Timecode entry 
lets you move the playhead very precisely or jump to specific timecode values really quickly.

How to Enter Timecode Values
When entering timecode, type each pair of hour, minute, second, and frame values from left to 
right, with a period representing a pair of zeros for fast entry. The numbers you enter appear in the 
timecode field at the upper left-hand corner of the Viewer with focus. When you’re finished typing, 
press the Return key to execute the timecode command. The rules for timecode entry are as follows:

	— The right-most pair of timecode values (or period) you enter is always the frame number.

	— A period to the left or to the right of any number you type is considered to be a pair of zeroes. 

	— A single period between two numbers is considered to either be a single zero or ignored if it’s 
between two pairs of numbers.

	— Any untyped pairs of values to the left of what you enter are assumed to be whatever those values 
were prior to the timecode you entered; this makes it easy to type partial timecode values even 
when the Timeline starts at hour one. 

	— It’s not necessary to enter colons or semicolons. 

Absolute Timecode Entry
Absolute timecode is entered simply by typing the timecode value you want to move the playhead to, 
and when you press the Return key, the playhead will move to that timecode value.

Here are some examples of absolute timecode entry using this method:

Original TC Value User-Typed Value New TC Value

01:10:10:10 15245218 15:24:52:18

01:10:10:10 2.. 01:02:00:00

01:10:10:10 15 01:10:10:15

01:10:10:10 12 01:10:10:12

01:10:10:10 1.2 01:10:01:02

01:10:10:10 1115.. 11:15:00:00

01:10:10:10 23... 23:00:00:00
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Relative Timecode Entry
Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding a plus 
results in the value you type being added to the current timecode value for purposes of offsetting the 
playhead from its current position. Adding a minus will subtract the value you type from the current 
timecode value. Here are three examples of relative timecode entry:

User-Typed Value Result

+20. 00:00:20:00 is added to the current timecode value.

+3.. 00:03:00:00 is added to the current timecode value.

–5 00:00:00:05 is subtracted from the current timecode value.

Clip, Marker, and Track Navigation
The Up and Down Arrow keys are used to move the playhead from one edit point to the next in the 
Fairlight page Timeline, just as in the Edit page Timeline. 

However, holding Command-Option down while using the Arrow keys gives you Fairlight page-specific 
behaviors that are used to navigate among clips, markers, and tracks in the Fairlight page in a way 
that’s different than other pages of DaVinci Resolve but very useful to the way the Fairlight page 
operates. This section covers the basics.

Selecting Tracks
Which tracks are selected determine the behavior of the Arrow keys.

	— In Pointer mode: You can select tracks by clicking or Command-clicking (to select multiple tracks) 
anywhere in the background area or on the track number of the track headers. If you click and 
drag in the track header, you can use a bounding box to select multiple tracks. Pointer mode will 
not select in unused areas of the Timeline.

	— In Range or Focus mode: You can select tracks by clicking or Command-clicking anywhere either in 
the background area or on the track number of the track header, or in any unused area of the track 
itself in the Timeline. If you click and drag, you can use a bounding box to select multiple tracks.

Moving the Clip Selection
The Command-Option-Left and Command-Option-Right Arrow key shortcuts are used to move the 
playhead left and right in the Timeline, navigating from clip to clip or from marker to marker. How 
these keys function depends on whether or not one or more tracks is selected in the Timeline.

	— If no tracks are selected: The Left and Right Arrow keys will jump the playhead from Timeline 
marker to Timeline marker. Clip markers will be ignored.

	— If one or more tracks are selected: The Left/Right Arrow keys will jump the playhead among clip 
In points, clip Out points, and Timeline markers.
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Moving the Track Selection
The Command-Option-Up and Command-Option-Down Arrow key shortcuts are used to move 
the track selection up and down in the Timeline, changing which tracks are selected. By changing 
which tracks are selected, you can alter which clip’s In and Out points are used to jump the playhead 
around the Timeline.

If no tracks are selected, then nothing happens.

Zooming and Scrolling
The Fairlight page has several methods of zooming into and out of the Timeline, and scrolling when 
you’re zoomed to the point where your edited sequence of clips extends past the left and right edge 
of the visible timeline.

The Playhead
Zooming is always centered on the position of the Playhead. By default the Playhead moves along the 
Timeline as it plays. However, Fairlight offers the option of a Fixed Playhead where the Timeline moves 
while the Playhead remains centered.

The Playhead options are found  
in the Timeline Scrolling panel.
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Setting the Zoom Level of the Timeline
Depending on how you like to work, there are several methods of zooming into and out of the Timeline.

	— Using the Vertical Zoom slider: A pair of sliders at the right of the toolbar let you zoom vertically 
and horizontally. The first one lets you scroll vertically in order to see more detail in the height of 
your waveforms. If no tracks are selected, then zooming is centered on the top audio track in the 
Timeline. If one or more tracks are selected, then zooming is centered on the topmost selected 
audio track.

	— Using the Horizontal Zoom slider: A pair of sliders at the right of the toolbar let you zoom 
vertically and horizontally. The second one lets you zoom horizontally in order to see more detail 
in the width of your waveforms.

	— Pressing Command-Equal (=) and Command-Minus (–): Command-Equal (also referred to as 
Command-Plus) and Command-Minus let you zoom horizontally into the Timeline. 

	— Use Shift-Z to Zoom to Fit: Command-Z lets you zoom horizontally to fit all clips in your program 
to the available width of the Timeline.

	— Using scroll controls of your pointing device to scroll horizontally: Holding the Option key 
down and using the scroll wheel (or scroll control) of your pointing device will zoom horizontally 
into the Timeline. Holding the Command key down and using the scroll wheel will move the 
Timeline earlier or later than its current time, without moving Playhead.

	— Using scroll controls of your pointing device to scroll vertically: Holding the Shift key down 
and using the scroll wheel (or scroll control) lets you zoom vertically in the Timeline. In this case, 
if no tracks are selected, then zooming is centered on the top audio track in the Timeline. If one or 
more tracks are selected, then zooming is centered on the topmost selected audio track.

	— Using the Fairlight panel’s Jog/Edit wheel: If you have a Fairlight panel, you can hold 
the ZOOM button down while turning the Jog/Edit wheel to zoom into the Timeline at the 
position of the playhead.

Scrolling Through the Timeline
However closely you’re zoomed into the Timeline, if you’re zoomed enough so that clips extend past 
the visible area of the Timeline, scroll bars appear below. If the playhead is offscreen, a small orange 
tic mark indicates its position relative to the entire timeline, which is represented by the total width of 
the scroll bar’s background.

If you drag the playhead, or otherwise use any of the transport controls or playback key shortcuts to 
move through the Timeline, the contents of the Timeline refresh every time the playhead hits the left 
or right edge of what’s visible.
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Using Flags
Flags are meant to mark an entire clip, and they also flag every other clip in the Timeline that shares 
the same Media Pool source clip, making this a handy way of quickly identifying which clips in a given 
timeline come from the same Media Pool source. Flags are visible in every page of DaVinci Resolve, 
making them an excellent method of tracking media from page to page.

The Flag and Marker 
buttons and pop-ups.

You can apply multiple flags to clips, with a variety of colors to choose from. In addition to flagging 
specific media files, flags can be useful for sorting by column in the Media Pool, as well as a variety 
of other operations. Whenever you enter text into a flag, it displays a small dot that indicates there’s 
more information inside of it.

Methods for flagging clips in the Fairlight page:

	— To flag a clip: Select one or more clips, and either click the Flag button to flag that clip with the 
current color, or click the Flag pop-up in the toolbar to choose a different color and then click the Flag 
button. In the Edit page, flags appear in the Timeline superimposed in the name bar of each clip.

	— To remove all flags from a clip: Select one or more clips with flags you want to remove, 
then click the Flag pop-up in the toolbar, and choose the top “Clear All” option. 

	— To change the Flag color or remove individually: Double-click the Flag icon on the clip 
and a Marker dialog box appears to change the Flag color, remove the flag, or make a note 
regarding the flag.

Using Markers
Markers are used to call attention to a particular frame within a specific clip. Markers can be 
individually colored, and can have customized name and note text. Whenever you enter text into a 
marker, that marker displays a small dot that indicates there’s more information inside of it. Once 
placed, markers snap to In and Out points, edit points, the playhead, and other markers whenever 
snapping is enabled, making it easy to use markers to “measure” edits and trims that you make in the 
Timeline. Markers are visible in every page of DaVinci Resolve, making them an excellent method of 
tracking frames in clips and specific moments in the Timeline from page to page.

You can add markers to the Timeline (in the Timeline ruler) or to clips. The full procedures for placing 
and editing markers in the Fairlight page’s onscreen interface are identical to those for the Edit 
page, so for more information, see Chapter 40, “Marking and Finding Clips in the Timeline.” For now, 
here’s a summary.
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Adding Markers to Clips
The following procedures describe how to add markers to clips in the Timeline of the Media page.

To mark a clip in the Timeline, do one of the following: 

	— Select one or more clips you want to mark, then move the playhead to the frame of a selected 
clip in the Timeline, and click the Marker button in the toolbar (or press M) to place a marker 
at that frame, using the current color (if multiple overlapping clips are selected, you’ll add a 
marker to all clips). 

	— To place a marker during playback and immediately open the marker dialog to enter a name or 
note within it, select one or more clips you want to mark, play through the selection until you want 
to place a mark, then press Command-M. Playback pauses until you enter some text and close the 
marker dialog again, at which point playback continues.

	— Select one or more clips you want to mark, and then click the Marker pop-up to choose a different 
color, and click the Marker button.

Adding Markers to Timelines
You can also place markers of any color into the Timeline ruler to denote specific times for future 
reference, or add notes about issues you want to keep track of. You should note that all markers 
placed on clips or in the Timeline also appear within the Mini-Timeline of the Color page, making it 
easy to place notes to reference particular audio cues that might be valuable when editing or grading.

To mark the Timeline itself, make sure all clips are deselected, and do one of the following: 

	— Click the Marker button (or press M) to place a marker of the currently selected color 
in the Timeline ruler. 

	— To place a marker during playback and immediately open the marker dialog to enter a 
name or note within it, select one or more clips you want to mark, then press Command-M. 
Playback pauses until you enter some text and close the marker dialog again, at which point 
playback continues.

	— Click the Marker pop-up to choose a different color, and click the Marker button. 

	— Right-click in the Timeline ruler and choose a marker color from the Add Marker submenu of the 
contextual menu.
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Chapter 169

Recording
It’s possible to record to one or more tracks on the Fairlight page, 
accommodating workflows as varied as editors recording scratch 
voiceover or temp sound effects, recording engineers recording 
narration, ADR, or foley as part of the audio finishing process, 
music studios recording orchestras for the music score, or garage 
bands recording their latest magnum opus. 

While DaVinci Resolve is a comprehensive post-production environment for cinema and video, the 
Fairlight page can be used for any audio recording application you might have, from books on tape to 
live music to feature films and television.
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Setting Up to Record
Depending on how your workstation is set up, it’s possible to simultaneously record to multiple tracks 
in the Fairlight page at once. How many tracks you can record to depend entirely on what hardware 
you have available. This section describes the process of recording to tracks in the Fairlight page.

Patching Inputs
Before you can record anything, you need to use the Patch Input/Output window to patch an available 
audio input to a track. If you’re computer has nothing else, the inputs of your workstation are available 
to connect whatever audio device is set up as the default audio input on your system to the track you 
want to record to.

To open the Patch Input/Output window, do one of the following:

	— Choose Fairlight > Patch Input/Output.

	— Click the Input menu at the top of the channel strip of the track you want to record to, 
and choose Input.

The Input drop-down menu lets 
you open the Patch Input/Output 
window with that track selected

To patch an audio source to an audio destination:

1	 Make sure that the Source menu is set to Audio Inputs, and the Destination menu is set to 
Track Input.

2	 On the right, click the audio input that you want to patch so it’s highlighted.

3	 On the left, click the audio destination that you want to patch so it’s highlighted also, if it’s not 
already. In this simplified example, channel 4 of the ULN is being connected to Audio 4.

Selecting a source and a destination to patch

3600Fairlight  |  Chapter 169  Recording



4	 Click the Patch button at the bottom of the window, and your recording setup will be patched. 

5	 Continue steps 2 and 3 until you’ve patched all the inputs you want to record from to all of the 
tracks that you want to record onto. You can patch as many inputs to as many tracks as your 
system is set up to accommodate. In this example, there are twelve available audio sources, and 
the first four have been patched.

6	 When you’re finished, close the window.

Arming Tracks
To record on a track, it must be armed. You should note that it’s impossible to arm a track that hasn’t 
been patched first, so make sure you’ve patched the audio source you want to record from to the track 
you want to record to first. Then arming that track is as simple as clicking the R button in the track 
header controls, or in the channel strip for that track in the Mixer.

(Left) The arm button turned on in the track header,  
(Right) the arm button turned on in the channel strip

Once a track has been armed, you’re ready to record.

Record Name Prefix
A right-click on the designated record track header has the option to set a recording name prefix to 
the recordings for that track. This is a useful way to keep tabs of the various recordings required by 
your project. For instance, if recording ADR you can add a prefix for each character’s recordings as in 
the example below for a character named Pilot.

Right-clicking a track header reveals 
the Set Track Record Name option

Example of a recording name prefix 
for a character called Pilot
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Choosing Where to Record Audio Clips To
The process of recording in the Fairlight page creates new clips and generates additional media on 
disk. You can specify the location on disk where you want to save these recordings by opening the 
Capture and Playback panel of the Project Settings. In the Capture section use the Browse button, 
found underneath the “Save clips to” field, to choose a new location (a folder named “Capture” on your 
scratch disk is the default location).

To choose where the new clips that are created are placed in the Media Pool, simply open the 
Media Pool and select any bin in the Bin list, or create a new bin and select it if you want to put your 
recordings in their own location.

User-Selectable Input Monitoring Options
The Fairlight > Input Monitor Style submenu presents five options governing how you want to monitor 
inputs while recording.

	— Input: You only hear the live signal being input; you never hear the contents of tracks.

	— Auto: When one or more tracks are armed for recording, you hear the live input signal; on 
playback you hear the contents of each track.

	— Record: You only hear the live input signal while actively recording, meaning the Record button 
has been pressed while one or more tracks are armed for recording. You don’t hear the input 
signal while tracks are merely armed.

	— Mute: You hear nothing.

	— Repro: While recording, you only hear what’s just been recorded, played from the track. In other words, 
you’re not listening to the live input, but you’re reviewing what’s just been recorded as it’s recording.

Recording Using the 
Onscreen Controls
You can record anywhere you want on the currently armed track or tracks by placing the playhead 
where you want recording to begin. In this way, you can record to specific areas of your program 
as you record voiceover, sound effects, foley, or other timed performances that need to fit into a 
particular region of the edit.

To begin recording:

1	 Position the playhead where you want recording to begin.

2	 Click the Record button in the transport controls. Recording immediately begins, and the material 
being recorded immediately begins drawing a waveform in real time, giving you immediate 
feedback that the input you’re recording is properly connected or not, as well as where on the 
currently armed track material is being recorded.

To stop recording, do one of the following:

	— Click the Stop button in the transport controls.

	— Press the Spacebar.
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Recording and Editing Multiple 
Takes Using Layering
There are two ways you can record multiple takes. You can either record them one after the other, 
sequentially, and then edit them later. However, you also have the ability to record multiple takes to 
the same region of the timeline, one on top of another, while at the same time preserving every take 
using track layering.

In the following screenshot, multiple takes have been recorded over the same section of the timeline, 
including some partial takes to correct specific phrases in the voiceover being recorded. When you 
do this, the result looks like a series of cuts and overwritten clips, with the most recently recorded 
segments being the ones that play back over the previously recorded segments.

Overlapping recordings with Audio Track Layers turned off

However, if you choose View > Audio Track Layers, you’ll see that all your recordings have actually 
been preserved via a vertical stack of overlapping audio clips.

Overlapping recordings with Audio Track Layers turned on, showing layering within the same track

The layering of audio clips in DaVinci Resolve means that the topmost superimposed clips in a layered 
stack like this mutes the audio of overlapping clips that are lower in the stack.

Using layering, it’s easy to edit the best segments of the best takes, while preserving all other takes, 
simply by adding edits and rearranging clips in the stack so the best parts are on top.

For more information about audio layering, see Chapter 171, “Editing Basics in the Fairlight Page.”
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Recording VSTi Instruments
DaVinci Resolve supports VSTi instruments working with connected MIDI controllers to trigger 
instrument sounds that can be recorded live on audio tracks of the Timeline. Davinci Resolve Studio 
includes the Fairlight FX Foley Sampler. This can be loaded with foley sounds such as footsteps or 
human movements, so you can perform these sounds in real time and record the result to another 
track as you watch performers walking or punching in the edit, even if you lack a recording booth with 
foley pits and props.

 

The Foley Sampler ready to be filled with sounds

For more information about the Foley Sampler, see Chapter 177, “Fairlight FX.”

On the other hand, if you’re a musician, there’s nothing stopping you from loading VSTi musical 
instruments of different kinds for playback, and using the Fairlight page as a multi-track recorder. 
DaVinci Resolve doesn’t have MIDI sequencing functionality, but you can record live playback straight 
to the Timeline, using layered audio to manage multiple takes for later re-editing. Bet you never 
thought you’d be recording music in DaVinci Resolve.
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A VST Instrument (in this case Serato Sample) loaded into a track of the Timeline

To enable a MIDI controller in macOS:

1	 If DaVinci Resolve is running, quit before connecting your MIDI controller and setting it up.

2	 On macOS you’ll use the Audio Midi Setup utility to choose output hardware and select a speaker 
configuration to be made available on your system. In the Finder, use Spotlight and search for 
Audio MIDI Setup to open it.

3	 In Audio MIDI Setup, choose Window > Show MIDI Studio. A window showing icons for all 
connected MIDI controllers appears. Your controller should be showing an icon. If it’s not, you 
may need to install drivers for it.

4	 Select the icon for your controller and turn on the “Enter test MIDI setup mode” button (it 
looks like a little keyboard) to test if your keyboard is connecting with the computer. If it is, then 
turn this off.

For more information on setting up MIDI on different systems, see the DaVinci Resolve 
Configuration Guide, available on the web from the Blackmagic Design support page at  
https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion. 

To set up the Fairlight page for VSTi instrument recording using a sampler:

1	 Open DaVinci Resolve.

2	 Make sure you have at least two available audio tracks in the Timeline, one for the instrument 
you’ll be playing, and one to record into. This example will use tracks A4 and A5 for this.

3	 Open the Effects Library, find a VSTi sampler you have installed on your system, and drag it to the 
track header of the track you want to use for playing, for example track A4. 

Massively-featured sampler/synth combinations such as Native Instruments Kontakt and 
Steinberg Halion are ubiquitous and useful when you want to specifically map a collection 
of sound effects to specific keys or pads to create re-usable multi-purpose instruments. 
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However, more streamlined samplers that emphasize automatic audio clip slicing such as Serato 
Sample (Windows and macOS) or Image Line Slicex (Windows only) can make short work of the 
more specialized task of loading library sound effects recordings (or custom recordings you create) 
with multiple footsteps, punches, keyboard presses, cloth rustles, or other foley activities, and 
quickly splitting them up into individually playable samples you can trigger with pads or a keyboard.

4	 When the VSTi interface window appears, open the MIDI menu at the upper right-hand corner of 
the VSTi window and choose the correct MIDI channel from your MIDI controller’s submenu. If 
you’ve selected the correct MIDI channel, the instrument should start responding to the keys or 
pads on your controller.

 

Enabling MIDI control

5	 Next, configure the VSTi instrument you’re using to play the sound effects you want to use for 
foley. In this example, the Serato Sample VSTi plugin is being used to automatically slice up a 
recording of footsteps from one of Sound Ideas’ many sound effects libraries.

Because the VSTi you added is patched to that track’s Insert (if you look at the Mixer you should 
see that the I button is enabled on the channel strip the instrument is patched to), the Send is 
PRE the Instrument. This means you need to patch that track’s Track Direct output to the input of 
another track to record the instrument.

6	 Choose Fairlight > Patch Input/Output to open the Patch Input/Output window, then set the 
Source drop-down menu to Track Direct and the Destination drop-down menu to Track Input. 
Click Audio 4 to the left, and Audio 5 to the right, and click the Patch button; this sets you up to 
play the VSTi plugin on track A4, and record its output on track A5.

Be aware that after patching Track Direct from the track with the instrument to the track you’re 
recording onto, you also need to turn “Direct Output” on for that track in the Path Settings of that 
track’s channel strip in the Mixer. 

7	 Open the Mixer (if necessary), click the Input drop-down menu at the top of the channel strip 
that shows the VSTi instrument you’re using, and choose Path Settings. When the Path Settings 
window appears, click the ON button for Direct Output, then close the Path Settings window. 

At this point, you’re ready to begin recording.
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To play and record a VSTi instrument:

1	 Click the Record Arming button of the track you’re recording to (in this example A5), move 
the playhead to where you want to begin recording, and then click the Record button 
to begin recording.

2	 As the video of your program plays, use your MIDI controller to trigger sound effects as 
necessary. When you’re finished, click the Stop button. 

If necessary, you can record multiple takes using track layering until you get the timing right. 
When you’re finished, you can remove the instrument from the track it’s on since the recorded 
audio is all you need.
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Chapter 170

ADR  
(Automated Dialog 
Replacement)
The Fairlight page of DaVinci Resolve has a sophisticated interface 
for doing ADR, or automated dialog replacement, in a structured 
and straightforward manner. 

Simple, yet powerful, the ADR panel incorporates Cue list management, industry-standard audio 
beeps and visual cues, and sophisticated take management with star ratings and layered take 
organization to create and manage the re-recording of dialog in any program. With this sophisticated 
organization and layering, it’s easy to edit together the best parts of each take into your program.
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The ADR Interface�   3609

Setting up to Do an ADR Session�   3613
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ADR (Automated Dialog Replacement)
Clicking the ADR button on the Interface toolbar opens up the celebrated Fairlight ADR panel, which 
provides a thoroughly professional workflow for doing automated dialog replacement. Dialog 
replacement, for those who don’t know, is the process whereby audio professionals bring in actors to 
re-record unsalvageably bad dialog recordings from the comfort of their recording studios, line by line 
and with a great deal of patience.

The ADR panel on the Fairlight page

It’s an old joke that ADR isn’t really automatic, but the Fairlight page aims to give you all the help it can 
to make this a structured and straightforward process. Simple, but powerful, Cue list management 
lets you efficiently assemble a re-recording plan. Industry-standard audio beeps and visual cues via 
your BMD video output device help the actors in the booth nail their timings and their lines. Then, 
sophisticated take management with star ratings and layered take organization in the Timeline help 
you manage the resulting recordings to pick and choose the best parts of each take when you edit 
the results.

The ADR Interface
When open, the ADR interface consists of three panels to the left of the Timeline: a List panel, a Record 
panel, and a Setup panel. The controls of these panels are described in the order in which they’re used.

The Setup Panel
As its name implies, the Setup panel is where you configure your ADR session. 

The Setup panel of the ADR interface
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This panel presents the following controls:

	— Pre Roll and Post Roll: Specifies how many seconds to play before and after each cue’s specified 
In and Out points, giving actors a chance to listen to what comes before and after each cue in 
order to prepare. If you enable the Beep options below, beeps provide a countdown during the 
specified pre-roll.

	— Record Source: (Disabled until you select a Record Track) A drop-down menu lets you choose the 
input you want to record from, creating a patch to the Record Track.

	— Record Track: A drop-down menu lets you choose the track you want to record to. Selecting 
a track with this menu creates a patch from the Record Source to the Record Track, and 
automatically toggles Record Enable on.

	— Guide Track: A drop-down menu lets you choose which track the original production audio you 
need to re-record is on. This is used for sending audio playback to the talent to use as a guide for 
recording their own replacement performance.

	— Record File Name: A text entry field that lets you provide a name for the audio files being 
recorded to be saved with.

	— Character Setup: A list for adding the names of all the characters that have dialog cues you’ll 
be re-recording, to help with cue creation and management. An Add New button lets you add 
additional names to this list, while a Remove button lets you delete characters you no longer need.

	— Beep to In Point: Enables a three-beep sequence to be heard leading up to the recording. For 
beeps to be audible, the Beeps channel of the System Generator is a source that must be patched 
to your audio outputs using the Patch Input/Output window.

	— Beep at In Point: Enables one last beep at the In point. For beeps to be audible, the Beeps 
channel of the System Generator is a source that must be patched to your audio outputs using the 
Patch Input/Output window.

	— Count In: An onscreen counter that counts down to the start of the cue.

	— Video Streamer: A visual cue for the talent to watch during pre-roll to ready them for recording. 
A pair of vertical lines superimposed over the program being output to video move towards one 
another across your video output screen during the pre-roll to the cue. This gives the talent a 
visual indication of the time remaining until they should begin talking. When the beeps play, these 
lines get taller. Both lines come together at the Time In frame, at which point a cross shows that 
recording is beginning.

	— Smart Timeline: When turned on, this option automatically moves the playhead to each cue as 
it’s selected in the Cue list, and zooms in to frame the duration of that cue in the Timeline.

	— Mixing Control: Enables automated switching of audio playback, to independently control 
what the talent and the audio engineer hear at various stages of the ADR recording process. 
For example, with this enabled, the Guide track is not routed to the Control room while the 
engineer is reviewing a take.
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The List Panel
This is where you create a list of cues you need to re-record, either from within the Fairlight page, or 
imported from a .csv file that someone provides you.

The List panel of the ADR interface

This panel presents the following controls:

	— Cue editing controls: Displays the data for the currently selected cue (or a cue that was just 
created). In and Out timecode fields store the Timeline In and Out points that were set when the 
cue was created but can be manually edited for fine tuning. A Character drop-down menu lets you 
choose which character that line of dialog belongs to. A text entry field lets you enter the dialog 
cue that’s to be re-recorded, so you and the talent can both refer to it.

	— New Cue button: Clicking this button adds a new cue to the list using whatever In and Out points 
have been set in the Timeline, and whatever character was last selected.

	— Cue list: The list of all cues that have been entered or imported. The Cue list can be filtered using 
the Filter drop-down menu at the top-right of the ADR panel (next to the option menu). You can 
choose to show the cues for all characters, or for any selected combination of characters. You can 
also choose to hide all cues that are marked as done to experience the joy of this list shrinking 
more and more the closer you are to being finished.

Additionally, the ADR interface option menu has three commands pertaining to the List panel:

	— Import Cue List: Lets you import a properly formatted .csv file to create cues that have been 
prepared in a spreadsheet. Correct formatting for cue lists you want to import is no headers, one line 
per cue, with four individual columns for In timecode, Out timecode, Character Name, and Dialog.

	— Export Cue List: Lets you export the contents of the Cue list to a .csv file, for exchange or safe‑keeping.

	— Clear Cue List: Deletes all cues in the Cue list. It’s recommended you export a copy of your Cue 
list before eliminating it completely, in case you ever need to revisit a cue.
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The Record Panel
This is where you actually run the ADR recording session you’ve set up, using the dialog cues you’ve 
put into the Cue list. 

The Record panel of the ADR Interface

This panel presents the following controls:

	— Record and rehearse controls: Four transport controls and two buttons let you control 
recording during ADR sessions. These controls are only clickable when you’ve selected a cue from 
the Cue list to record.

	— Rehearse: Runs the section of the Timeline specified by a cue without actually recording 
anything, giving the talent an opportunity to run through their dialog and practice their 
timing and delivery. Beeps and on-screen streamers are not played during a rehearsal.

	— Play: Plays the currently selected take from the Take list (described below). If no take is 
selected, the most recently recorded one on top is played.

	— Stop: Immediately stops rehearsal, playback, or recording.

	— Record: Initiates recording of the cue to the specified audio track, with cue beeps and video 
streamer cues.

	— Keep Playing: At the end of a take you may wish to keep playing, so the talent can hear the 
next section of the track. Pressing the Keep Playing button at any time, even while recording, 
results in post roll being ignored and normal playback resuming after the cue’s Out time.

	— Keep Recording: At the end of a take you may wish to keep recording until you manually stop. 
Pressing the Keep Recording button at any time, even while recording, results in the Out point 
of the current cue being ignored and recording continuing until you stop it.

	— Take list: The Take list shows every take you’ve recorded for the current cue, with take number, 
name, and a five-star rating that you can set to keep track of which takes worked and which didn’t. 
Earlier takes are at the bottom of this list, while recent takes are at the top (the same order in which 
the corresponding layered audio clips appear in the Timeline track they’ve been recorded to).
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	— Cue list: The list of all cues that have been entered or imported. The Cue list can be filtered using 
the Filter drop-down menu at the top-right of the ADR panel (next to the Option menu). You can 
choose to show the cues for all characters, or for any selected combination of characters. You can 
also choose to hide all cues that are marked as done to experience the joy of this list shrinking 
more and more the closer you are to being finished.

	— Cue list Done column: A sixth column appears in the Record panel only, labeled Done. 
It contains check boxes for each cue that you can turn on to keep track of which cues you’ve 
successfully finished.

Additionally, the ADR interface Option menu has one command pertaining to the Record panel:

	— Record Early In: Enables recording during pre-roll, in the event you’re working with talent that 
likes to start early.

Setting up to Do an ADR Session
Setting up to record ADR is straightforward but requires a few steps.

Creating tracks in preparation to record ADR:

1	 In the Timeline, create a new audio track to which you’ll be doing ADR recording. Make sure it has 
the correct channel configuration for your recording (mono is typical for dialog).

2	 If you’re recording ADR to your main timeline, you may want to Solo both the Guide track and the 
Record track, so you and the talent can focus on the audio being re-recorded without hearing all 
the other tracks of the current mix.

Now you’re ready to configure the Setup panel.

Configuring the Setup panel:

1	 Open the ADR interface, and then open the Setup panel.

2	 Choose the Pre Roll and Post Roll you want to use, in seconds. A pre roll of at least 3 seconds is 
recommended to give the talent time to get ready.

3	 From the Record Source drop-down menu, choose the microphone you patched earlier.

4	 From the Record Track drop-down menu, choose the Record track you created.

5	 From the Guide Track drop-down menu, choose the track with the original production audio that 
you’re replacing.

6	 At the bottom of this panel, turn on which Preroll Cue options you and the talent want to use as 
you record each cue. Options include:

a)	 Beep to In Point and Beep at In Point provide an audible count down to when 
to start performing.

b)	 An animated Video Streamer gives a countdown to the start time, shows the duration of the 
cue being recorded, and also displays the text of the dialog for that cue on screen for the 
actor to refer to, so they can keep their eyes on the screen and not a script.

Next, if you’ve enabled Beep to In Point and Beep at In Point, you need to patch the Fairlight oscillator 
to your output channels so the talent can hear the preview beeps.
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Patching the Oscillator to play beeps over your audio output:

1	 Choose Fairlight > Patch Input/Output to open the Patch Input/Output window.

2	 Choose System Generator from the Source drop-down menu, and click to select Beeps.

3	 Choose Audio Outputs from the Destination drop-down, and choose the left/right outputs you 
want these preview beeps to play out of. You can drag a bounding box to select multiple outputs, 
thereby connecting the mono Beeps input to stereo output for comfortable listening.

4	 Click Patch to make the connection, then close the Patch Input/Output window.

Creating and Importing 
ADR Cue Lists
You must have a list of cues to be able to use the ADR interface properly. There are two ways you can 
create a Cue list to record with, make one from scratch on the Fairlight page, or import one. The ADR 
panel accommodates both workflows.

Manually Creating an ADR Cue List
If you’ve been doing all of your dialog editing inside of DaVinci Resolve, you can go ahead and create 
a list by marking the sections of the Timeline you need to re-record and creating cues from those 
timings. To create cues properly, you should start by adding the names of each character you’ll be 
creating a cue for in the Setup panel. These names make it easier to enter cues and will help you to 
filter and sort the list as necessary later on.

To add character names before entering cues:

1	 Open the Setup panel of the ADR interface.

2	 Click Add New.

3	 When a selected entry appears in the Character Setup list, type a name.

4	 Press Return when you’re done.

To edit the Character Setup list, do one of the following:

	— If you mis-spell a name, you can double-click any name in this list to edit it. 

	— To delete a name, you can select it and click Remove to eliminate it.

Once you’ve created a complete set of character names, you can begin creating your Cue list.

To manually add cues to the Cue list:

1	 Open the List panel of the ADR interface. This is where all the controls for creating and 
editing cues are.

2	 In the Timeline, set In and Out points to mark the section of dialog you want to turn into a cue. 
Those timecode values appear in the Cue Editing section of the List panel.

3	 Click New Cue to add a blank cue to the Cue list.
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4	 In the Cue Editing section, choose the character who’s speaking that cue from the Character drop-
down (only names that have been entered in the Setup tab appear in this list). 

5	 If necessary, select the text field below, and type the dialog that needs to be re-recorded.

6	 Repeat steps 2 through 5 until you’re finished creating all the cues you intend to re-record. If you 
need to edit any cue, simply click to select that cue, and edit it in the Cue Editing section above.

Importing Cues
If you or an assistant has already created a Cue list using a spreadsheet with separate columns for 
character names, dialog, and In/Out timecode values, then you can also create a Cue list by importing 
this data from an exported .csv file.

To import a .csv file to the Cue list:

1	 Choose Import Cue List from the ADR option menu, then use the dialog to choose the .csv file 
containing the Cue list you were given, and click Open. 

2	 An ADR Setup dialog appears, showing the data from the .csv file previewed as a series of 
columns. This lets you see if each column of incoming data is being assigned correctly. If it’s not, 
you can reassign each column of the incoming data to the correct column of the ADR panel.

Correct formatting for Cue lists you want to import is to have no header text, and to enter 
information using one row per cue, with four individual columns for In timecode, Out timecode, 
Character Name, and Dialog. If any of these columns are transposed, you can correct this by 
choosing the correct data type for each column from the drop-down menus at top.

Dialog for rearranging columns of cue data, if necessary

3	 Click Import CSV. The cues should appear in the Cue list.

To export a .csv file from the Cue list:

	— Choose Export Cue List from the ADR option menu, choose a location to save the file, and click Save.
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Recording ADR to the Timeline
Once you’ve configured your workstation for recording, and you’ve set up a Cue list to work with, it’s 
time to start recording each cue.

To record a cue from the Cue list:

1	 Open the Record panel of the ADR interface.

2	 If you want to record a particular character’s cues, you can select each unnecessary character in 
the ADR Option menu to uncheck that character, hiding their dialog in the Cue list.

3	 With the list showing the character cues you need, select the cue you want to start recording. That 
cue contains the timecode necessary to determine which part of the Timeline to record to, and the 
playhead automatically moves to that part of the Timeline.

4	 Click the Rehearse button a few times to run through the cue with the talent. When you click 
Rehearse, both audio and video corresponding to that cue will play, including pre roll and post roll, 
along with all beep and onscreen cues.

5	 When the talent is ready to try a take, click the Record button, and let the Fairlight page do the 
work of playing through pre roll with beep notifications and visual streamer cues, initiating 
recording, and then stopping recording automatically once the cue is done. To record another 
take, simply click the Record button again.

Every time you complete a recording, a take appears in the Take list. Making multiple recordings 
results in multiple takes in the list. In the Timeline, all new takes appear as layered audio, so you 
can record as many takes as you like into the same area of the Timeline. Once you’ve finished 
recording takes, you’ll have a neatly organized stack of alternate takes to draw upon as you edit 
together the best parts of each recording.

6	 If you or the talent want to hear a particular take again, select it in the Take list and click Play. 
You can use the 5-star ratings control to keep track of how you liked each take.

7	 When you’re finished recording a cue, click the Done checkbox for that cue, and select the next 
cue you want to record. When you’re finished re-recording dialog, simply close the ADR interface. 
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Chapter 171

Editing Basics in 
the Fairlight Page
You can use the Fairlight page to refine the editing of audio 
that was initially assembled in the Edit page, or you can use the 
Fairlight page to both record and edit audio programs from scratch. 

Because audio clips have properties that video clips do not, audio editing encompasses additional 
procedures that are not available in the Edit page. This chapter takes you through the fundamental 
steps of editing audio the Fairlight way.
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Compatible Audio Formats
DaVinci Resolve is compatible with WAVE, Broadcast WAVE, AIFF, MP3, AAC (M4A), CAF (macOS only), 
both MTS and QuickTime containers that use the AC3 audio format, and Enhanced AC-3 (macOS 
and Windows only). DaVinci Resolve is compatible with audio at sample rates including 32, 44.1, 48, 
88.2, 96, and 192 kHz. Linux users have the added ability to encode and decode MP3 files in Fairlight.

DaVinci Resolve 17 adds Dolby Atmos ADM file creation and manipulation as well as the ability to 
export Atmos masters as IMF deliverables. IMF (Interoperable Master Format) is a SMPTE standard 
for a single master file format that incorporates all the media and metadata necessary to deliver 
what’s necessary.

ADM Import
Importing an ADM file into a project will open the Bed mix or mixes and any associated Object tracks 
into a timeline. They will be imported onto corresponding track types of the audio files embedded into 
the ADM. For instance, if a Bed file is 7.1.2, then on import that file will open in a 7.1.2 track in Fairlight. 
Object files will be created as separate tracks in Fairlight containing all of their panning data.

NOTE:  If bringing in a Dolby Atmos file from the Media Pool, it will render the file 
dynamically to the chosen output format directly on the Timeline using the Dolby Renderer. 
However, Fairlight can import the full Atmos file with beds and objects if imported from 
the Fairlight menu instead - Fairlight > Immersive > Audio > Import Master File. By bringing 
a file in this way, it will create a timeline with all of that file’s Atmos program and dynamic 
metadata properly mapped and routed.
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Editing Audio Clips Into the Timeline
The Fairlight page offers a complete audio editing environment that lets you either record and 
assemble clips from scratch, or refine tracks full of audio clips that have been edited together in 
different ways. There are four ways of adding media to the Timeline in the Fairlight page, depending 
on the type of work you do:

	— Recording new audio into one or more tracks, for more information, see Chapter 169, “Recording.”

	— By dragging and dropping new audio clips from the Media Pool into the Fairlight timeline

	— By editing audio clips into audio tracks on the Edit page

	— By importing a project with audio clips

	— By auditioning and confirming sound effects from the Sound Library

However audio clips come to be in your timeline, the rest of this chapter covers the myriad methods 
available to edit and sweeten the contents.

Overwriting Vs. Layering Clips That Overlap
When you add clips to the Timeline, what happens when you add a clip that overlaps another clip 
that’s already in the track you’re editing to depends on the Timeline > Layered Audio Editing setting. 
By default, with Layered Audio Editing turned off, overwriting one audio clip with another results in 
the overlapping part of the overwritten clip being non-destructively deleted from the Timeline by the 
incoming clip.

However, if you turn Layered Audio Editing on, then incoming clips do not overwrite overlapping 
clips in the Timeline; instead, they’re layered within that track, such that the incoming audio clip takes 
precedence over what was previously there, but overlapping audio segments that were previously in 
the Timeline are preserved, which can be seen when you choose View > Show Audio Track Layers.

In this way, you can choose whether you want to overwrite previously edited clips, or layer newly 
edited clips, as your needs require, regardless of whether or not Audio Track Layers are visible. Audio 
layering can be enabled in both the Edit and Fairlight pages.

For more information about audio layering, see the section later in this chapter.

Choosing Parts of Clips to Edit in the Media Pool
The Media Pool has a preview player at the top that provides a place to open selected source clips in 
the Media Pool, play them, add marks to log them, and set In and Out points in preparation for editing 
them into the Timeline via drag and drop. The Media Pool Preview Player effectively acts as a Source 
monitor for editing in the Fairlight page.
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The preview player in the Media Pool

	— Various viewing controls populate the title bar at the top. A drop-down menu at the upper left lets 
you choose a zoom level for the audio waveform that’s displayed. To the right of that, a Timecode 
window shows you the duration of the clip or the duration that’s marked with In and Out points. 
Next to the right, a real-time performance indicator shows you playback performance. In the 
center the title of the currently selected clip is shown, with a drop-down menu to the right that 
shows you the most recent 10 clips you’ve browsed. To the far left, a Timecode field shows you 
the current position of the playhead (right-clicking this opens a contextual menu with options to 
change the timecode that’s displayed, and to copy and paste timecode).

	— The center of the Media Pool Preview Player shows you the waveforms in all channels of the 
currently selected clip, at whatever zoom level is currently selected.

	— Transport controls at the bottom consist of a jog bar for scrubbing, Stop, Play, and Loop buttons, 
and In and Out buttons.

Dragging Audio Clips Into the Timeline
You can show the Media Pool in the Fairlight page, and edit audio clips into the Timeline in their 
entirety by dragging and dropping individual clips onto whichever audio track you want them to 
appear. You can drag any clip onto any track, regardless of whether or not the channels of the clip 
match the channel mapping of the track. However, if you edit a clip with more channels than a track 
has (for example, editing a stereo clip onto a mono track), only the channels supported by that track 
will be output, with all other channels in that clip being muted. If this happens, you can always remap 
the audio track by right-clicking the track header and choosing a new mapping from the Change Track 
Type To submenu.

TIP:  Dragging one or more clips to the empty area underneath the existing audio tracks of 
the Timeline results in the creation of new tracks, each of which is automatically mapped to 
however many channels are required by each audio clip being edited.

If you want to edit several clips into the Timeline at once by dragging them from the Media Pool, you’ll 
probably want to do a bit of preparation to make sure they’re edited in the right order.
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Dragging several clips into the Timeline as one contiguous series of edited clips:

1	 Change the sort order of the Media Pool’s 
browser area to put the clips into the order in 
which you want them to appear. In Thumbnail 
view you can use the Sort Order menu, but 
in List view you can click the header of any 
metadata column to sort by that column’s data.

2	 Use the Media Pool thumbnails, the Media Pool 
List view Filmstrip, or the Source Viewer to set 
In and Out points to define the part of each 
clip that you want to edit into the Timeline.

3	 Select the Media Pool clips you want to edit 
into the Timeline by dragging a bounding box, 
Command-dragging multiple bounding boxes 
over different sets of clips, by Shift-clicking 
a range of clips, or by Command-clicking 
individual non-contiguous clips.

4	 Drag any of the selected clips to the desired 
position in the Timeline to perform an 
overwrite edit.

The clip(s) you drag overwrite whatever other 
clips they overlap in the Timeline. Multiple clips 
dragged from the Media Pool will be edited in 
the order in which they’re sorted in the Media 
Pool, using each clip’s In and Out points.  

Using the 
Sort Order 
menu to 
change the 
sort order of 
clips in the 
Media Pool

It’s possible to edit audio clips into the Timeline so that each clip’s timecode lines up with 
the Timeline Ruler. This can be useful if you’re organizing multiple source audio recordings 
that you want to synchronize together on multiple tracks.

Dragging multiple clips to edit them into a track at their timecode positions:

1	 Select the Media Pool clips you want to edit into the Timeline by dragging a bounding box, 
Command-dragging multiple bounding boxes over different sets of clips, by Shift-clicking a range 
of clips, or by Command-clicking individual non-contiguous clips.

2	 Hold Command-Shift down, and drag the selected clips into the track you want them to appear, to 
perform an overwrite edit.

A series of audio clips edited into the Timeline by timecode position
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Each clip edited into that track appears at the same timecode position as its embedded timecode. 
This means that if you were recording time-of-day timecode, each clip will appear on the Timeline at 
the time it was recorded. A series of clips recorded during hour 10 through 13 will appear distributed 
throughout hours 10-13 on your timeline.

You can also edit two or more audio clips into the Timeline as a stack, in preparation for layering 
multiple sound effects for doing sound design work.

Dragging multiple clips to edit them into a track as a parallel stack:

1	 Select the Media Pool clips you want to edit into the Timeline by dragging a bounding box, 
Command-dragging multiple bounding boxes over different sets of clips, by Shift-clicking a range 
of clips, or by Command-clicking individual non-contiguous clips.

2	 Command-drag the selected clips into a track of the Timeline. The first of the selected clips 
appears in the track you’re dragging to, the other clips appear either in audio tracks underneath 
the first one, or if there are no audio tracks available, in new audio tracks that will be created to 
hold those clips.

All clips you’ve edited appear as a parallel stack, in separate tracks, one on top of another.

Moving Audio Clips to Embedded Timecode Position
All clips have a timecode embedded into their metadata. There are options to place clips onto the 
Timeline from either the Media Pool or in the Timeline itself with this metadata.

Right-clicking a clip in the Timeline has the choice to Move to Embedded Start Timecode. When this is 
clicked the clip will spot onto the Timeline on a selected track with the timecode.

It’s important to be aware of the embedded audio timecode and the Timeline timecode. The two must 
have overlapping timecode, or this function will not work. For example, a clip that has an embedded 
timecode of 00:00:00:00 may be difficult to find on a Timeline that starts at 00:59:58:00. If you have 
spotted a clip using these tools and still don’t see the clip in question, then check the embedded 
timecode in the Metadata panel of the Inspector as well as the timecode of the Timeline itself.

Right-clicking a clip in a Timeline reveals the 
Move to Embedded Start Timecode option.

Right-clicking a clip in the Media Pool reveals 
the Insert Selected Clips to Timeline option.
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Right-clicking a clip in the Media Pool has the choice to Insert Selected Clips to Timeline Using 
Timecode. When this is clicked the clip will spot onto the Timeline on a selected track with the 
embedded timecode.

NOTE:  You can find the embedded timecode for a clip in the Inspector in the File tab 
under timecode.

Timecode metadata is in the 
Inspector window under the File tab.

Clip Attributes now lets you assign channels among 
different tracks with different channel assignments

Support for Mixed Audio Track 
Formats from Source Clips
DaVinci Resolve supports media with multiple audio tracks that have differently formatted channels 
embedded within them. For example, a clip with one stereo track, one 5.1 surround track, and 
six mono tracks can all be appropriately set up in the Audio panel of Clip Attributes after that clip has 
been imported.

The Audio panel of Clip Attributes has controls over what format (Mono, Stereo, 5.1, 7.1, Adaptive) 
the channels embedded within a particular audio track should be configured as. This means you 
can set up clips with multiple tracks, each one using different formats of audio employing different 
combinations of channels, which is useful for setting up imported audio mix files that you want to 
output when mastering a program.
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Making Audio Clip Selections 
in the Timeline
Nearly every editing operation described in this chapter and others requires you to make a selection to 
define which clips will be affected. Three editing modes in the toolbar give you different ways of selecting 
clips, depending on what you’re trying to do, and how you like to work. These are (from left to right) the 
Pointer mode, the Range mode, and the Focus mode. Which mode you choose determines how clips and 
clip segments are selected in the Timeline in preparation for all manner of editorial operations.

The Pointer, Range, and Focus 
modes seen in the toolbar

Fairlight Edit Mode Remains 
Between Application Restarts
Fairlight retains the Edit Mode the project was saved with between restarts. Whatever edit mode you 
were working in prior to closing the application will be active when reopened.

Why Are There Three Edit Modes?
While the Pointer and Range modes can also be used with the pointer, they’re really 
designed to enable automatic selections based on the position of the playhead. This is 
accomplished when using the Fairlight Editing console, the Fairlight Desktop Console, or 
keyboard shortcuts to control Timeline transport, while specific tracks are selected to 
enable selection and editing on those tracks.

The Focus mode is designed for efficient selections made using the pointer via a mouse, 
trackpad, or pen and tablet, made in conjunction with a variety of commands for extending 
and editing selections triggered via keyboard shortcuts. If you’re editing with a keyboard 
and mouse, this mode is designed to let you work quickly by enabling a variety of different 
selection functions based on clicking different parts of clips.

Selecting Tracks
In order to understand clip selection, you must first understand track selection. The Timeline on the 
Fairlight page lets you select entire tracks to facilitate the automatic selection of clips that intersect 
the playhead on those tracks using keyboard shortcuts, the Fairlight Desktop Console, or the Fairlight 
Editing panel, in Pointer and Range modes (described in upcoming sections).

For example, were you to select tracks A2, A3, and A4, then moving the playhead to intersect two clips 
on those tracks in Pointer mode automatically selects them, so they’re ready for any operation you 
want to perform on both clips. To give a few examples, you could now split both clips at the playhead, 
Cut Head or Tail to the playhead, Delete both clips, or Copy them in preparation for pasting elsewhere.
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Command-clicking multiple track headers selects those tracks

Additionally, there are times when clicking or dragging on one or more clips with the pointer 
results in both those clips being selected, along with the tracks on which they sit. For example, 
selecting clips using the Focus mode will also select the tracks those clips are on.

If you’re manually selecting tracks using the pointer, there are different ways to do so.

Methods of selecting and deselecting tracks in the Fairlight page Timeline:

	— To select a single track: Click anywhere in the background or on the track number of that track’s 
header (not on a button). In Range mode you can also click in any unused area of the track itself.

	— To deselect a single track: Click anywhere in the background or on the track number of a 
previously selected track’s header (not on a button). In Range mode you can also click in any 
unused area of the track itself. If multiple tracks are selected, Command-clicking one will remove 
just that track from the selection.

	— To select multiple tracks: Command-click in the track header background of every track you 
want to select. In Range mode you can also Command-click in any unused area of the tracks 
themselves. Command-clicking an already selected track will deselect it.

	— To select multiple continuous tracks: Click anywhere in the background or on the track number 
of a track header, and then drag a bounding box up or down over all other tracks you want to 
select. In Range mode you can also drag a bounding box over any part of the tracks themselves, 
while also defining a range in which you want to work.

	— To move the selection to higher or lower tracks: Press Control-Option-Up Arrow or Down 
Arrow to move the selection state to the next track higher (Control-Option-Up Arrow) or lower 
(Control-Option-Down Arrow). If multiple tracks are selected, then the multi-selection will be 
moved as a block; for example, selecting tracks A2 and A3 and then pressing Control-Option-
Down Arrow will result in tracks A3 and A4 being selected.
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Using Pointer Mode
Pointer mode uses the position of the playhead to make automatic selections when using the Fairlight 
Editing console or keyboard shortcuts to make clip selections on selected tracks. However, you can 
also use this mode in conjunction with the pointer and keyboard shortcuts to make selections in a 
different style. Pointer mode is primarily intended to allow efficient editing of whole clips.

	— If no tracks have been selected: Clips that intersect the playhead are not selected. You can use 
the pointer to select one or more clips by clicking, Command-clicking, or dragging a bounding 
box. Clips you select in this way are highlighted in orange. Making selections in this way is similar 
to making clip selections in the Timeline of the Edit page.

	— If tracks have been selected: All clips that intersect the playhead on selected tracks will be 
automatically highlight selected, but no In and Out points will be set. Clips on de-selected tracks 
will be ignored. Selecting one or more clips with the pointer (by Command-clicking or dragging a 
bounding box) creates an orange-highlighted selection.

	— If you set In and Out points: Some functions will affect ranges of clips between In and Out 
points on selected tracks. Clips on unselected tracks are ignored.

To choose Pointer mode:

	— Click the Selection tool (the arrow) in the toolbar.

	— Choose Trim > Pointer mode.

	— Press A.

To automatically select clips using the playhead position in Pointer mode:

1	 Press A to enter Pointer mode.

2	 Select one or more tracks with clips you want to select.

3	 Move the playhead to intersect those clips.

All clips that intersect the playhead on selected tracks of the Timeline are automatically selected in 
their entirety. Automatic selections are illuminated brighter to indicate their selection. Intersecting 
clips on unselected tracks are not selected.

 

Clips intersecting the playhead in Pointer mode are automatically selected with orange highlights
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Methods of selecting clips using the pointer:

	— Click any clip to select it.

Click a clip to select it

	— Command-click multiple clips to select them all at once.

Command-clicking multiple clips selects those clips, even if they’re separated by other clips

	— Click anywhere in the background of the Timeline and drag a bounding box over multiple clips.

Dragging a bounding box over multiple clips selects all of them

Using Range Mode
Range mode also uses the position of the playhead to make selections of a partial range of clips in the 
Timeline when using the Fairlight Editing console or keyboard shortcuts. You can also use this mode in 
conjunction with the pointer and keyboard shortcuts to make partial selections of clips.

	— If no tracks have been selected: Clips that intersect the playhead are not selected. You can 
use the pointer to click a clip and select it in its entirety along with the track it’s on. You can also 
use the pointer to drag on one or more clips to select a partial range in preparation for different 
editing operations. Whenever you make a selection with the pointer, Timeline In and Out points 
are set to the boundaries of the selection.
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	— If tracks have been selected: Selected tracks are brightened in the Timeline, and any clip on a 
selected track that intersects the playhead will be automatically highlighted brighter. Clips on de-
selected tracks will be ignored. Dragging a crosshairs over one one or more clips with the pointer 
overrides all automatic selections and selects the regions of the clips you drag over, and the tracks 
they’re on.

	— If you set In and Out points: Partial regions of all clips on all selected tracks between the In and 
Out points will be highlighted brighter. Clips on unselected tracks are ignored. While In and Out 
points are set, the playhead no longer makes automatic selections; you must set new In and Out 
points to modify the selection in this mode.

To choose Range mode:

	— Click the Range Selection tool (the crosshairs) in the toolbar.

	— Choose Trim > Range mode. 

	— Press R.

To automatically select clips in Range mode using the playhead position:

1	 Press R to enter Range mode.

2	 Select whichever tracks have clips you want to select.

3	 Move the playhead to intersect those clips.

All clips that intersect the playhead, on the tracks you selected, define a selected range from the 
beginning of the first selected clip to the end of the last selected clip.

Clips intersecting the playhead on a selected track in Range mode are automatically selected
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To create custom clip ranges using In and Out points in the Timeline:

1	 Press R to enter Range mode.

2	 Select whichever tracks have clips you want to select.

3	 Move the playhead and press the I (Mark In) and O (Mark Out) keys to define a range in the Timeline.

All clip segments that fall within the range of your In and Out points on selected tracks will be selected.

Using the Range mode to select clip segments 
on selected tracks using In and Out points

Methods of selecting clips in Range mode via clicking and dragging:

	— To select a single clip: Click any clip to select both it and the track it’s on, and define a range in 
the Timeline that matches the duration of that clip.

Click to select a single clip as well as the track it’s on
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	— To select multiple clips: Command-clicking multiple clips to select them all at once defines a 
range in the Timeline that matches the total overlapping duration of all clips in the selection, from 
the beginning of the first selected clip to the end of the last selected clip.

Range selection by Command-clicking multiple clips

	— To drag to select a range within a single clip: With the Range Selection tool selected, drag 
anywhere on top of a clip to drag a bounding box over whatever segment of that clip (or of one 
or more clips) to select both that clip segment and the track it appears on. This is a good way of 
selecting part of a recording you want to move or delete.

 

Ranged selection within a clip using a bounding box
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	— To drag to select a range within multiple clips: Click and drag a bounding box over whatever 
segment of one or more clips you want to select to select both those clip segments and the tracks 
they appear on. Or, Command-click and drag anywhere on top of any clip to drag a bounding box 
over whatever region of clips and tracks you like.

Ranged selection across multiple clips using a bounding box

In Range mode, whenever you make a selection, the In and Out point fields update with the range 
that you’ve created. 

The range fields showing you 
the In and Out point values that 
define the current range

These ranges can be cleared if necessary.

Methods of clearing In and Out points to clear the current range:

	— Press Option-I to clear the current In point.

	— Press Option-O to clear the current Out point.

	— Press Option-X to clear both the In and Out points.
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Using Focus Mode
Focus mode works as a Multi Tool that is designed for making efficient pointer-based selections and 
edits, in conjunction with an assortment of commands for extending and editing selections that can 
be triggered via customizable keyboard shortcuts. If you’re editing with a mouse and keyboard, this 
mode is designed to let you work quickly by enabling a variety of different functions based on clicking 
different parts of each clip in the Timeline.

Additionally, an important aspect of working in Focus mode is that this is the only mode that lets you 
edit the Timeline during playback, which you can’t do in Pointer and Range modes.

	— If no tracks have been selected: Whenever you make a selection with the hand, Timeline In and 
Out points are set to the boundaries of the selection. Whenever you make a selection with the 
crosshairs, Timeline In and Out points are set to the boundaries of the region you dragged. In all 
cases, the tracks that contain selected clips and regions of clips are also selected.

	— If tracks have been selected: Any clip on a selected track that intersects the playhead will 
be automatically highlighted brightly. Clips on de-selected tracks will be ignored. Dragging a 
crosshairs over one one or more clips with the pointer overrides all automatic selections and 
selects the regions of the clips you drag over, and the tracks they’re on.

	— If In and Out points have been set: Clicking the bottom half of clips in the Timeline will select 
that clip and track, and the In and Out points will change to encompass that clip.

To choose Range mode:

	— Click the Range Selection tool (the crosshairs at the bottom of a track) in the toolbar.

	— Choose Trim > Range mode. 

	— The keyboard shortcut is pressing - R.

To select an entire clip using the Hand tool of the Focus mode:

	— Move the pointer to the bottom half of a clip until a hand cursor appears, and click once to select 
that clip in its entirety.

Clicking the bottom half of a clip to select that clip in Focus mode
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	— Use the Hand to Command-click multiple clips to make either contiguous or 
noncontiguous selections.

	— Use the Hand to Shift-click multiple clips to make contiguous selections.

To select a range using the I-beam cursor of the Focus mode:

	— Move the pointer to the top half of a clip until an I-beam cursor appears, and drag to select a 
region of one or more clips. As you drag, the playhead follows the Out point.

Dragging within the top half of a clip to select a region in Focus mode

	— Using the crosshairs, you can also Shift-click to expand or contract the selected region across 
one or more clips.

	— Using the crosshairs, you can also double-click to select an entire clip.

	— Partial edit selections that contain a fade will copy with the fade intact.

To select a single frame using the I-beam cursor of the Focus mode:

	— Move the pointer to the top half of a clip until the I-beam cursor appears, and click once to place a 
point selection at the frame you clicked. The playhead also moves to this frame. 

 

Clicking within the top half of a clip to make a single frame selection
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	— Using the I-beam cursor, you can also Command-click clips on higher and lower tracks to add 
them to the single frame selection, aligned at the same frame. For example, you could do this to 
split multiple clips at once. One frame selections can be on discontiguous tracks.

Command-clicking within the top half of multiple clips on multiple 
tracks to add single frame selections at the same frame

To move a selection using the Hand tool of the Focus mode:

	— Once you’ve made a selection of one or more clips or regions using the Hand or I-beam cursor 
of the Focus mode, you can move the pointer to the bottom half of any selected clip and drag the 
selection to another position on the Timeline.

Commands For Editing and Extending the Selection
Once you’ve made one or more selections in the Timeline, there are a series of commands you can 
use to modify or expand the selection. These commands were designed to be used alongside the 
Focus mode, but they can be used in any mode.

Editing the Selection
There are six commands for changing the current selection, moving it from one clip or group of clips 
in the Timeline to another. These commands only move the range of clips/frames that are selected; 
they do not move the clips themselves. These commands are found within the Timeline contextual 
menu when you right-click on a clip.

	— Move To Previous/Next Edit: Moves the current selection to the next clip/edit point to the left or 
right in the Timeline.

	— Move To Previous/Next Track: Moves the current selection to the next track up or 
down in the Timeline.

	— Move to Previous/Next Frame: Nudges the current selection to the left or right in the Timeline.
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Extend Edit Selection
There are four commands for expanding the range of what’s selected in the Timeline, one clip or 
track at a time. These commands are found within the Timeline contextual menu when you right-click 
on a clip.

	— To Previous Edit: Expands the selection to include the previous clip to the left in the Timeline.

	— To Next Edit: Expands the selection to include the next clip to the right in the Timeline.

	— To Previous Track: Expands the selection to include the clip in the next track up in the Timeline.

	— To Next Track: Expands the selection to include the clip in the next track down in the Timeline.

Locking Audio Tracks
Another step you can take to prepare before performing any kind of editorial operation is to lock 
tracks with media that you don’t want to be affected by whatever it is you’re about to do. For example, 
if you have a complex set of music edits on track A3 that you don’t want to be affected by operations 
that will delete media that overlaps it, you can lock track A3 so those clips remain unaffected.

Locking an audio track

Clips on locked tracks cannot be moved, deleted, cut, or otherwise affected by editorial 
operations. Furthermore, parameters of clips on locked tracks cannot be edited in the Inspector. 
However, clips on locked tracks can be played back and mixed like any other audio clips.

To toggle the lock or unlock state of audio tracks in the Fairlight page, 
do one of the following:

	— Click any track’s lock control to toggle lock on and off.

	— Click any track’s lock control and drag over the lock controls of other tracks in the Timeline to 
quickly lock or unlock several adjacent clips.

	— Open the Index and click/drag one or more track lock controls to toggle lock on and off.

Splitting Clips
In many situations you may find yourself splitting audio clips in order to separate multiple 
rolling takes.

To split one or more clips in either Pointer or Range mode:

1	 Select each track that has a clip you want to split.

2	 Move the playhead to intersect the clips you want to split at the frame where you want the split 
to happen.
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3	 Do one of the following:

a)	 Choose Timeline > Split Clip or press Command-\ (backslash).

b)	 Choose Timeline > Razor or press Command-B.

When you split a clip in the Edit page, a through edit appears to show that you currently have an edit 
with continuous timecode running from the outgoing to the incoming half. This is called a through edit 
and is displayed in the Edit page with a dotted line running along its edge so you know that it’s special. 
The Fairlight page doesn’t display through edits as of the time of this writing.

Linked Clips in the Fairlight Page
Clips can be linked together in the Fairlight page. When multiple clips are linked, Fairlight editing 
commands treat all linked clips as if they were a single clip. Anything you would do to a single clip is 
done to all linked clips at once. Selecting one item of a linked clip selects all items. Editing the In point 
of one item of a linked clip edits them all.

To link two or more clips together:

1	 Select all clips you want to link together.

2	 Right-click one of the selected clips, and choose Link Clips from the contextual menu.

A link indicator at the bottom left of every clip you’ve just linked shows their new linked status.

Trimming Clips Without 
Rippling the Timeline
Most basic adjustments in the Fairlight page only affect the selected clip or region of the Timeline. 
Clips to the right of the adjusted area of the Timeline are generally left alone so as not to inadvertently 
change sync when you don’t expect it. This section covers the most basic parts of the Fairlight page’s 
“seven-point editing” paradigm.

Multi-Point Editing Overview
Each clip in the Timeline has several draggable handles and click targets that let you perform different 
editing tasks using the pointer.

	— In point: The left edge of the clip can be dragged to resize the beginning of the clip.

	— Out point: The right edge of the clip can be dragged to resize the end of the clip.

	— Fade In handle: A handle at the upper left-hand corner of the clip that only appears when the 
mouse is positioned over that clip, used to fade the audio in by dragging it to the right, or as 
part of a crossfade between two audio clips. Fades can be reset (eliminated) by double-clicking 
the fade handle.

	— Fade In curve:  A handle at the center of the Fade In curve that only appears when the curve is 
exposed, used to adjust the power of the fade in. This handle can be dragged vertically to change 
the X-Level of the fade, and horizontally to change the X-Point of the fade. Fade curves can be 
reset by double-clicking the curve handle.

3636Fairlight  |  Chapter 171  Editing Basics in the Fairlight Page



	— Fade Out handle: A handle at the upper right-hand corner of the clip that only appears when 
the mouse is positioned over that clip, used to fade the audio out by dragging it to the left, or as 
part of a crossfade between two audio clips. Fades can be reset (eliminated) by double-clicking 
the fade handle.

	— Fade Out curve: A handle at the center of the Fade Out curve that only appears when the curve 
is exposed, used to adjust the power of the fade out. This handle can be dragged vertically to 
change the X-Level of the fade, and horizontally to change the X-Point of the fade. Fade curves can 
be reset by double-clicking the curve handle.

	— Level: Considered an editorial characteristic, the level of any given audio clip can be adjusted via 
a level overlay running across each clip. The level of any clip can be reset to the default 0.0 dB by 
double-clicking the level overlay.

	— Position: Clicking anywhere within the middle of a clip in Pointer or Range mode, or on 
the bottom of Focus mode, lets you drag that clip either forward or backward in time, or to 
another track.

Resizing the In and Out Points of a Clip
Trimming the head or tail of a clip in the Fairlight page means to resize the In or Out point of that clip, 
making it shorter or longer accordingly.

To resize the beginning or end of a clip:

	— To shorten or lengthen clips: Move the pointer over the beginning or end of a clip, and when 
it turns into the Resize cursor, drag the In or Out point to the left or right to change the clip’s 
length. As you drag the In or Out point of an audio clip in the Fairlight page, an overlay appears 
showing the waveform of all available media at the head (if you’re dragging the In point) or tail 
(if you’re dragging the Out point) of the clip you are resizing.

The overlay seen when resizing the In point of an audio clip in the Fairlight page

To quickly resize the beginning or end of a clip to the very beginning or 
end of available media:

	— Double-click the In point of the clip to move the In point to the very beginning of that clip’s media.

	— Double-click the Out point of the clip to move the Out point to the very end of that clip’s media.

If you resize a clip’s In or Out point to overlap one or more neighboring clips in the Timeline, the 
overlapping parts of the neighboring clips will be overwritten by the clip you’ve resized.
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Trim Start and Trim End
The Trim > Trim Start (Shift-[) and Trim End (Shift-]) commands let you move the In or Out point of 
all clips that intersect the playhead as either a ripple operation (in Trim mode) or a resize operation 
(in Selection mode). You do not need to make a selection to use Trim Start and Trim End, making 
these commands fast to use in the right situation. A classic use of Trim End is when you have several 
superimposed clips of different lengths that you want to either start or end at the same time.

	— Trim Start resizes or ripples (depending on what mode you’re in) all clips that intersect the 
playhead, so that each clip’s In point is moved to the current playhead position. 

	— Trim End resizes or ripples intersecting clips so that each intersecting clip’s Out point is moved to 
the current playhead position.

Clips that don’t intersect the playhead are not affected. Furthermore, you can exclude clips on specific 
tracks from this operation by locking those tracks.

Trim to Selection
The Trim > Trim to Selection (Shift-Command-T) command simultaneously trims the heads and tails 
outside of a selection of one or more clips so that the selection is all that remains. This command is 
found within the Timeline contextual menu when you right-click on a clip.

(Left) A selection that includes parts of two clips, (Right) The result of using Trim 
to Selection to eliminate the heads and tails outside of this selection.

Moving and Overwriting Clips
There are a number of ways to move clips in the Timeline. Clips can be nudged and moved within 
a track, changing the timing of that clip’s position in the edit or they can be moved up or down to 
other tracks.
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To move clips in the Timeline, do one of the following:

	— To move one or more selected clips in the Timeline: Drag any clip in the Timeline to any other 
position. If you’re in Focus mode, you must drag using the bottom half of the selection. If you drag 
a clip to overlap another clip, the clip you’re dragging overwrites the clip you’re moving it over.  

	— To nudge one or more selected clips in the Timeline by frame using the keyboard: Make a 
selection, then press the Comma key (nudge 1 frame left) or Period key (nudge 1 frame right) to 
roll the selected edit to the left or right. Shift-Comma and Shift-Period nudges by 5 frames.

	— To move one or more selected clips up or down to other tracks at the same time: Make a 
selection, then hold the Shift key down while dragging one of the selected clips up or down in 
the Timeline to lock their position in time while moving them to other tracks. Or, you can hold the 
Option key down and press Up or Down Arrow.

Sync Offset Indicator
Audio clips in the Fairlight page display an “out-of-sync” or sync offset indicators when they’re moved 
out of sync with the video items they’re linked to.

Subframe Nudging
In the Preferences/User/Editing panel under General Settings you can change the nudge amount by 
either subframes or by milliseconds for the Fairlight page. These are completely user definable so that 
you can type your desired nudge amount into the corresponding box.

Be sure to fully investigate this settings panel, which includes pre-roll and post-roll settings and other 
useful Fairlight adjustments.

Slipping
Formerly called resyncing, slipping an audio clip keeps that clip in the same place in the Timeline 
while changing the range of media that appears in that spot. Slip edits do not change the duration of 
the overall Timeline, and they don’t move the clip’s position relative to the other clips in the Timeline. 
Slipping simply changes the range of media that clip represents.

NOTE:  While available in previous versions of Fairlight, slipping is not available at the time 
of this writing.

Duplicating Clips
The Duplicate Selection command duplicates one or more selected clips, placing the duplicates 
immediately after the Out point of the selection. If you’re duplicating a region of a clip with tails, or a 
clip that’s in between other clips, the duplicated selection will overwrite whatever is to the right of the 
current selection, for the duration of the duplicate. 
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Using the Duplicate Selection command to duplicate a selected region

If you hold the Option key down while dragging a clip in the Timeline, you’ll place a duplicate clip 
wherever you drop it.

Option-dragging to duplicate a clip in the Timeline

Disabling and Re-Enabling 
Clips in the Timeline
Sometimes there’s one or more audio clips in the Timeline that you don’t want to play along with 
the rest of the edited sequence, but you don’t want to remove from the Timeline either, in case you 
change your mind later. For this reason, it’s possible to disable clips, effectively turning them off 
without removing them. Previous versions of Fairlight referred to this operation as Mute clip.
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Disabled clips appear dimmed in the Timeline. They don’t play back, they’re not rendered, and they’re 
not output to video. However, their position is preserved in the Timeline, so you can always re-enable 
them at a later time if you change your mind and decide you want to use them.

Disabled clips appear in the Timeline in gray.

To disable or re-enable one or more selected clips:

	— Right-click part of the selection and choose Enable Clip from the contextual menu.

	— Choose Clip > Enable Clip.

	— Press D.

Deleting Audio Clips and Regions
You can delete any clips or clip regions that are selected, in either Pointer or Range modes, 
by pressing the Delete key, or by right-clicking a clip and choosing Delete Selected from the contextual 
menu. By default in the Fairlight page, deleting anything leaves a gap. Under the Edit Menu > 
Ripple Delete you can ripple delete selected clips changing the placement of all of the clips that follow.

Cut, Copy, and Paste
The Fairlight page has a unique copy and paste methodology that takes advantage of the “ghost” 
overlays that are used for the waveforms of selected audio clips. This method makes it easy to copy 
and paste clips using keyboard shortcuts and the JKL keys.

Conventional Cut, Copy, and Paste
The typical cut, copy, and paste commands expected of every software application are available in 
the Fairlight page, but with a unique twist that’s particularly advantageous for users of the Fairlight 
control surface, or for anyone who uses the JKL transport key shortcuts to move around the Timeline 
for keyboard-driven editing. 

To cut or copy and paste either all or part of a clip:

1	 If you’re cutting or copying a whole clip, then choose either the Selection (press A) or Range 
Selection (press R) mode. If you’re cutting or copying part of a clip, then make sure you’re in 
Range mode (press R).

2	 To use the playhead to make a clip selection, select the track that contains the clip you want to 
copy or cut. If one or more tracks are already selected, you can use the Control-Option-Up or 
Down Arrow key shortcuts to move the track selection state up or down to the tracks with the clip 
you want to cut or copy.
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Selecting the track with a clip you need to cut

3	 Do one of the following:

a)	 To cut or copy a whole clip, move the playhead so that it intersects the clip you want to cut or 
copy. If the playhead intersects a clip on a selected track, that clip should become selected. 
You should note that even if you use the mouse to select a clip without selecting a track first, 
you should still move the playhead to intersect the clip you’re copying or pasting, as this sets 
up an important reference point for the operation.

b)	 To cut or copy a segment of a clip, move the playhead so that it intersects the clip you want 
to cut or copy. If the playhead intersects a clip on a selected track, that clip should become 
selected. Then, using JKL and the I (In) and O (Out) keys, mark a range in the Timeline that 
includes the segment of the clip you want. That segment should appear highlighted as a result.

Cutting or copying a segment of a clip using In and Out points

4	 Making sure the playhead is over the section of the waveform that you want to use as the frame to 
move the clip by, press Command-X to cut or Command-C to copy that clip (you can also right-click 
a clip and choose Copy or Cut). That clip will immediately become highlighted.
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Cutting or copying a clip at the position of the playhead

5	 At this point, there are two things you can do to position the cut or copied clip to the position in 
the Timeline at which you want to paste it:

a)	 Moving the playhead will now also move the clip you cut or copied, shown as a ghost clip with 
waveform that’s “attached” to the playhead at the frame you chose. Whether you drag the 
playhead with your mouse or use JKL to move the playhead through the Timeline, the cut or 
copied clip will move along with it, so that moving the playhead repositions the cut or copied 
clip on that track.

b)	 If you want to move the cut or copied clip to another track, use the Control-Option-Up or 
Down Arrow key shortcuts to change the selected track; the ghost clip will move along with 
change in track selection.

Positioning the cut or copied clip before you paste it

This way, you can use the playhead to align the ghost waveform with other audio clips 
surrounding it in preparation for pasting it.
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6	 When the clip is positioned where you want it, press Command-V to paste the clip at the position 
you’ve chosen (you can also right-click a track and choose Paste from the contextual menu). The 
clip becomes solid, and you’re finished.

The pasted clip

Using this method of cutting and pasting makes it quick to cut or copy clips using only keyboard 
commands, with the clip’s ghost overlay making it easy to precisely align the clip you’re pasting to 
fit exactly where you need it to, perfectly in sync.

Using the Cut/Copy Head and Tail Commands
Four additional commands make it easy to cut or copy portions of one or more clips that intersect 
the playhead, either from the In point to the current position of the playhead (the Head), or from the 
current position of the playhead to the Out point (the Tail).

To cut or copy the head or tail of a clip, and paste the result:

1	 Using these commands, there’s no need to make a partial selection, so you can use either the 
Selection (press A) or Range Selection (press T) modes.

2	 Select the track that contains the clip you want to copy or cut. If one or more tracks are already 
selected, you can use the Control-Option-Up or Down Arrow key shortcuts to move the track 
selection state up or down to the tracks with the clip you want to cut or copy.

3	 Move the playhead so that it intersects the clip you want to cut or copy at the frame you want to 
define, either the end of the head or the beginning of the tail. If the playhead intersects a clip on 
a selected track, that clip should automatically become selected. You should note that even if you 
use the mouse to select a clip without selecting a track first, you should still move the playhead 
to intersect the clip you’re copying or pasting, as this sets up an important reference point for 
the operation.

4	 Choose Edit > Cut/Copy Head/Tail to cut or copy the portion of the selected clip you want to paste. 
That portion of the clip will immediately become highlighted.

5	 At this point, there are two things you can do to position the cut or copied head or tail of the clip 
to the position in the Timeline at which you want to paste it:
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a)	 Moving the playhead will now also move the clip you cut or copied, shown as a ghost clip with 
waveform that’s “attached” to the playhead at the frame you chose. Whether you drag the 
playhead with your mouse or use JKL to move the playhead through the Timeline, the cut or 
copied clip will move along with it so that moving the playhead repositions the cut or copied 
clip on that track.

b)	 If you want to move the cut or copied clip to another track, use the Control-Option-Up or 
Down Arrow key shortcuts to change the selected track; the ghost clip will move along with 
change in track selection.

This way, you can use the playhead to align the ghost waveform with other audio clips 
surrounding it in preparation for pasting it.

6	 When the clip is positioned where you want it, press Command-V to paste the clip at the position 
you’ve chosen (you can also right-click a track and choose Paste from the contextual menu). The 
clip becomes solid, and you’re finished.

Paste and Remove Attributes
The Fairlight page has Paste Attributes and Remove Attributes commands that allow for the copying 
and resetting of audio parameters and effects, similar to the same commands on the Edit page.

Clip Attributes Naming
By double-clicking any clip in the Timeline, you can access the Clip Attributes window to rename the 
clip. You can still access this window with a right-click, revealing the drop-down menu of options.

Copying and Pasting Clip Attributes
For clips, this works as simply as copying a clip, then selecting one or more audio clips and right-
clicking another clip and choosing Paste Attributes from the contextual menu. A dialog appears letting 
you choose which audio attributes you want to paste before clicking Apply.

The Paste Attributes dialog in the Fairlight page
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Copying and Pasting Track Attributes
For tracks, it works a little differently. Right-click on a track header and choose Copy Attributes to copy 
all track settings and effects. Then, select one or more other track headers, right-click the selection, 
and choose Paste Attributes. A dialog appears letting you choose which track attributes you want to 
paste before clicking Apply.

The Paste Attributes dialog in the Fairlight page, 
used to copy attributes from one track to another

Removing Attributes
For either clips or tracks, you can right-click and choose Remove Attributes to open a dialog with 
which to choose which attributes you want to reset to their default settings.

NOTE:  By choosing the Volume check box in Remove Attributes you will delete all of the 
Clip Gain keyframes that have been added to a clip.

Audio Clip Layering
Audio layering is a special audio editing mode that lets you superimpose multiple audio clips in the 
same track, with audio clips edited into the top layers muting overlapping sections of audio clips 
appearing on lower layers. With audio layering enabled, superimposed audio clips are treated similarly 
to superimposed video clips that have opacity set to 100%, with clips on top obscuring (or muting) 
clips underneath. 

An example of multiple audio performance editing using layers, where the 
top layer mutes overlapping sections of audio clips in lower layers
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Audio layering is incredibly useful for any situation where you’re combining segments of multiple 
takes together to create a single voiceover, audio vocal track, or dramatic performance, as you can 
choose which segments to use via their superimposed position in the stack of clips appearing in that 
track, while at the same time you’re preserving the other takes underneath in case you might want 
them later.

TIP:  Track layering can be used on the Edit page as well.

To enable audio layering:

	— Choose Timeline > Layered Audio Editing so that a check mark appears by the command. All 
overlapping audio will be layered instead of overwritten from that point forward.

To view audio layering:

1	 Choose View > Show Audio Track Layers to reveal track layers for each audio track (and each lane 
within a given audio track) in the Timeline. When layering is on, space appears at the top of each 
track in the Timeline which provides a region into which you can edit layered audio clips.

2	 To edit an audio clip or segment as a layer within a particular audio track, drag it from elsewhere 
in the Timeline or from the Media Pool, and drop it into the empty area above whatever audio is 
already in that track.

Dragging an audio clip to become layered above another clip

3	 Edit the different superimposed layers of audio such that the segments of each take that you 
like are on top. Only the topmost clip segments will be audible. Audio segments that overlap 
underneath are silent. To put another layer on top, drag it from its current position to the empty 
area at the top of the track.

Dragging a bottom audio layer to appear on top

4	 When you’re finished editing clips in track layers, choose View > Show Audio Track Layers again 
to hide the individual layers, so that only the topmost clips appear as a flat sequence in each 
track and lane.
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Hiding layers makes all audio layers appear on a single track, as if the top clips are 
overwriting what’s underneath, except the muted material underneath is preserved

Audio Compound Clips
DaVinci Resolve supports audio compound clips, which are created just like any other compound 
clip, by selecting multiple audio clips, right-clicking one of them, and choosing New Compound Clip. 
Alternately, compound clips with video clips may now contain multiple audio items as well. 

When compound clips containing audio are opened in the Edit or Fairlight pages by right-clicking 
an audio compound clip and choosing Open in Timeline, breadcrumb controls appear beneath the 
Timeline that let you exit the compound clip and get back to the master Timeline.

Opening an audio compound clip; note the path 
control at the bottom left of the Timeline

Audio Crossfades
You can add Cross Fade transitions to any edit point between two audio clips that have enough 
handles similarly to how you add video transitions, by dragging and dropping from the Effects Library, 
by right-clicking an edit and choosing an option from the contextual menu, or by selecting an audio 
edit point and choosing Timeline > Add Audio Only Transition (Shift-T). 

Cross Fade transitions are a quick and easy way to fade the volume of the outgoing clip down while 
simultaneously fading the volume of the incoming clip up, letting you create a smooth aural transition 
between two audio clips.

An audio Cross Fade transition applied between two clips
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You can double-click a Cross Fade transition to open it into the Inspector, revealing the 
following parameters:

	— Duration: The duration of the transition, shown in both seconds and frames.

	— Alignment: A drop-down that lets you choose the transition’s position relative to the edit point it’s 
applied to. Your choices are “End on Edit,” “Center on Edit,” and “Begin on Edit.”

	— Transition style: You can choose –3dB, 0dB, or +3dB to set both the Fade In and Fade Out levels 
to the same value. For more information on what these levels mean, see the following parameter.

	— Fade In/Fade Out levels: There are three options that affect the incoming and outgoing halves 
of the Cross Fade effect independently. 0dB applies a linear fade (this is the default). +3dB applies 
a boosted curve; when applied to both Fade In and Fade Out, this can compensate for diminished 
levels in the middle of a Cross Fade. –3dB applies an attenuating curve, which deliberately lowers 
the level of the Cross Fade.

Crossfades can be created and edited on both the Edit and Fairlight pages.

Fades and Crossfades
Part of audio editing in the Fairlight page is the use of fades and crossfades. This section shows you 
how to create these effects for smoothly segueing from one audio clip to another.

Using Fades
Like the Edit page, each audio clip has fader handles that appear at the upper right and left corners of 
a clip you’re hovering the pointer over.

Fader handles appear when you 
hover the pointer over a clip

Pulling these handles out creates a fade effect with a duration equal to the length you extended 
the handle.

Creating a fade effect by pulling 
out one of the fader handles
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Once you’ve created a fade effect, you can adjust the curve of the fade by dragging the handle that 
appears right on top of the fader curve. Dragging the handle up and down affects the angle of the 
curve, and dragging the handle left and right affects the shape of the curve. In this way, you can 
create all manner of fade effects.

Adjusting the curve of the fade

Batch Fade and Crossfade Editor 
in the Fairlight Page
Multiple fades are available to multiple clips with multiple tracks selected, significantly increasing 
fade functionality. The Batch Fades window has fade shapes for Fade In, Cross Fade, and Fade Out. 
The Fade Length is user definable by frame for each of these fade types, and there is an option to 
overwrite existing fades on the highlighted clips.

All of the settings in the Batch Fades window

There are six options per Fade type for precise usage. When adding Fades between sources, it’s 
important to determine the shape so that only the desired media is included in the fade. The curves 
indicate the ramping slopes of the fade. 
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Each box has similar controls for affecting the individual Fade type.

1	 Next to the Fade type name is the on/off toggle

2	 There are six Fade curves to create the precise fade needed.

3	 A Length box determines how many frames the fade will extend,

4	 A click box to overwrite any previous fades, if needed.

The Crossfade box has three additional controls.

1	 Equal Power maintains the signal level through the fade.

2	 Equal Gain is used when crossfading media that could phase when combined. For instance, 
if a music cue is crossfaded at the mid-point of the fade, there could be a jump in level or added 
phasing issues. Using this option maintains the gain across the fade for that type of media.

3	 Unlinked allows for a different curve type on either side of the crossfade.

This window will retain the settings that were last made so once a series of Fade types have been 
chosen, then Batch Fades can be made without opening this window and can be accessed via the 
Fairlight menu with a single click across highlighted regions. The Apply Batch Fades in the Fairlight 
menu are applied with the settings made in the Batch Fades window.

Batch Fade options in 
the Fairlight menu
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This graphic shows highlighted clips and tracks ready to have Batch Fades applied.

Tracks and clips highlighted for Batch Fades

The graphic below shows how the Batch Fades are applied. Clips that are not connected have 
Fade In and Fade Out applied. Clips that are connected have Crossfades applied. The Batch Fades 
window determines each of the Fade parameters and then applies them to all of the selected clips. 
In this example, the Overwrite box was unchecked. Compare the fades that were already there 
and see that they retain their original Fade length and shape.

All of the highlighted clips have been faded according to the Batch Fades window.

NOTE:  If the media is too short, a dialog box will alert you that there are insufficient handles 
and that the fade could not be created. You can then choose to trim clips, skip clips, or 
cancel the Batch Fade. If you cancel, you can then alter the settings to better suit the media.
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Fade In and Out to Playhead
A pair of commands in the Trim menu let you move the playhead over a clip, and use the playhead 
position to “Fade In to Playhead” or “Fade Out to Playhead.” These commands work in both the Edit 
and Fairlight pages.

(Left) Placing the playhead where you want a fade in to end, (Right) Using Fade In to Playhead

Creating Crossfades With Overlapping Fades
While a fade gradually fades a single track of audio up or down, a crossfade fades two overlapping 
clips at the same time, fading one clip up and another clip down, for the aural equivalent of a cross 
dissolve. There are currently two ways of creating a crossfade in the Fairlight page. Both depend on 
clip layering to allow you to have overlapping fades over overlapping clips.

To create a crossfade by overlapping two clips together:

1	 Add a fade out to the end of one clip, and a fade in to the beginning of another clip. By default, all 
fades you add in this way are linear, although you can adjust them to whatever gain you want.

Adding fades to adjacent clips

2	 Drag the first clip to overlap the second clip by the length of the fade you’ve created.

Dragging the clips to overlap, the overlapping 
parts will be preserved via clip layering
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3	 Drop the clip. The overlapping fades will both be preserved thanks to clip layering, and a 
crossfade will appear in the Timeline.

The resulting crossfade

To create a crossfade over two clips that are already layered:

	— Drag a fader handle at the beginning or end of a clip that’s layered, and a crossfade will 
automatically appear.

Creating a crossfade by adjusting the fader handle of a layered clip

Using Crossfades From the Edit Page
You can also add crossfades in the Edit page, but they appear in the Fairlight page as transitions in the 
Edit page style.

The resulting crossfade
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Finding Clips in the Media Pool
You can right-click any clip in the Timeline and choose Find in Media Pool to automatically select that 
clip in the Media Pool, for instances where you might want to edit another copy of that clip somewhere 
else in the Timeline, or re-edit another segment from that clip into the same area.

NOTE:  Automation Follows Edit when clips with embedded automation are moved or 
pasted from the Timeline. When clips with automation are instead pulled from the Media 
Pool, they are in their default state with no automation attached.

Changing Clip Color in the Timeline
You can right-click one or more selected clips in the Timeline to change the clip color, to be more 
organized. For example, you might set production audio clips containing dialog from different actors 
to different colors, or you could set clips with dialog, music, and effects to different colors in order to 
easily differentiate each clip’s purpose.

Editing Audio Clips in External Editors
While working in the Fairlight page, you have the ability to process an audio file using a third-party 
application if necessary, in the event you need to use another application’s capabilities to create an 
effect or solve an issue that can’t be accomplished in the Fairlight page itself. To do this, you must 
first add one or more applications to the External Audio Process list in the Audio Plugins panel of the 
System Preferences.

The External Audio Process list configured to send audio to Adobe Audition
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To add an external audio process:

1	 Open the System tab of the DaVinci Preferences, and select the Audio Plugins panel.

2	 Click the Add button in the “Setup External Audio Processes” section.

3	 To give the audio process a different name, double click in the Name column and type 
a new name.

4	 Double-click in the empty Path column for the new process, and choose an application to assign 
to that process from the dialog.

5	 Choose the type of process you want it to be from the drop-down menu in the Type column.

Once you have one or more external audio applications configured in Preferences, you can use 
them to process any audio clip in the Fairlight page by right-clicking an audio clip and choosing the 
application you want to use from the External Audio Process submenu of the contextual menu.

When you do this, a duplicate of the audio clip media is copied (bounced) to the directory location 
specified by the “Save clips to” field of the Capture and Playback panel of the Project Settings. At that 
point, the external application is either opened or launched as a command from the command line 
(depending on how the external application has been configured in Preferences). 

Once the bounced audio is opened in the external application, you can process it however you need 
to and bake in any changes made by saving/rendering/outputting and overwriting the original copied 
audio media file. DaVinci Resolve detects when changes have been made, and the altered result is 
automatically reimported as an additional audio layer on top of the original clip in the Timeline.

The way an audio application is configured in the DaVinci System Preferences dictates how the 
bounced audio file is passed to the external program. There are three choices: 

	— Command Line: As a command line parameter, if your audio application is able to be 
run from the Terminal.

	— Clipboard: By placing the path to the bounced file in the clipboard, so you can paste it into the 
application which has been automatically launched, or import it via a File > Open dialog.

	— Reveal: By revealing the bounced copy in the file manager of your workstation, so you can drag 
and drop it onto the application which has been automatically launched.

Exporting Audio Clips to External Files
For any workflow where you need to write clips from the Timeline to external files with extensive file 
altering capabilities, you can use the Export Audio Files command. 

To export clips to external files:

1	 Select one or more clips in the Timeline.

2	 Right-click the desired selected files and choose Export Audio Files from the contextual menu.

3	 When the Export Audio Files dialog appears, choose the following:

a)	 Click Browse to choose a location to save the exported audio files.

b)	 (Optional) Enter a tag and one of the various Name options.

c)	 Choose a File Format, Sample Rate, and Bit Depth for the exported files.

d)	 Choose a Channel Format of Multi-Mono or Interleaved for the exported files.
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e)	 Choose a Source of Individual Clips or Consolidated Clips; a drop-down menu further defines 
the ranges of the complete timeline, a selected range, or just the selected clips.

f)	 Checkboxes can further define using only the selected tracks, including hidden tracks and 
padding to frame boundaries.

g)	 When exporting you can choose to include the Clip Level, the Clip Fades, the Clip EQ and FX, 
and the Clip iXML.

h)	 The exported files can be normalized to predetermined target levels and target loudness 
values with all of the standards offered throughout the Fairlight page. 

The dialog that lets you choose 
options for exporting clips to files

4	 Click Export.

The selected audio files are written to the location you chose.
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Sample Editing
You can zoom quite far into audio clips on the Fairlight page timeline, until you see the individual 
samples that comprise the audio waveform of each clip. Samples are represented by control points 
once you’ve zoomed in far enough. 

When you zoom in far enough, you can see the individual samples of an audio clip as control points

You can non-destructively edit these control points to eliminate clicks and pops, and to effect other 
fixes to problem audio clips. 

Methods of editing audio samples:

	— To see the editable audio samples: Zoom all the way into an audio clip until you see the sample 
control points, using either Command-Plus or Command-Minus, the scroll wheel of your pointing 
device, or by holding down the ZOOM button of your Fairlight editing panel and turning the 
JOG/EDITING wheel.

	— To edit a single audio sample: Click and drag that audio sample up or down to change its height.

	— To edit a section of samples: Click and drag horizontally left or right across the samples you 
want to edit to “redraw” the waveform any way you’d like.

	— To reset all edited samples to their original state: Right-click an audio clip with edited samples, 
and choose Reset Edited Samples from the contextual menu.

Black points show the previous levels when samples have been edited in a clip

Sample editing can be undone, just like any other editing procedure, as the edited sample points are 
stored non-destructively within the DaVinci Resolve project.
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Waveform Zero Crossing Indicator
Waveforms have a zero crossing indicator line. Since a waveform is an image representation of sound 
continually moving positive to negative, the zero crossing point is the level at which that fluctuation 
occurs. When zooming into a waveform at the sample level, the waveform will display the zero crossing 
line to enable precise editing. 

The zero crossing is a useful feature when editing audio, since clean edits are made at the zero 
crossing to avoid inducing clicks or pops. A crossfade between two audio clips automatically brings 
both sides of the fade to the zero crossing.

The center line in the waveform indicator is the zero crossing.
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Chapter 172

Audio Clip 
Specific Inspector 
Adjustments
Each audio clip in a track has individual settings that are specific 
to that clip, which can be adjusted and animated in the Inspector. 
This makes it easy to adjust the levels and EQ of several clips to match 
one another, while reserving the track level for your overall mix. 

These clip-based effects are different from real time track-based effects in that they apply only to 
individual clips on the timeline rather than all clips on a track. For more information about real time 
track-based effects, see Chapter 176, “Audio Effects.” and Chapter 177, “Fairlight FX.” 

An additional set of clip-specific pitch controls make it easy to make small pitch adjustments, either 
static or keyframed, where necessary. This chapter describes how to use these clip-specific controls.
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Making Adjustments in the Inspector
Clip-specific audio parameters like Volume, Pan, Pitch, and Equalization can be adjusted and animated 
in the Inspector. This section walks you through how this works.

Using the Inspector
Audio clips in the Fairlight page expose similar controls to those found in the Audio Inspector Panel of 
the Edit page. Additionally, the Inspector will display controls for audio plugins that you apply to clips 
as well. All parameters are organized into groups, with a title bar providing the name of that group, 
along with other controls that let you control all parameters within that group at the same time.

Closed and open Inspector group controls in the Fairlight page

These controls include:

	— Enable button: A toggle control to the left of the parameter group’s name lets you disable 
and re-enable every parameter within that group at once. Orange means that track’s enabled. 
Gray is disabled.

	— Parameter group title bar: Double-clicking the title bar of any group of parameters collapses or 
opens them. Even more exciting than that, Option-double-clicking the title bar of one parameter 
group collapses or opens all parameter groups at once.

	— Keyframe and Next/Previous Keyframe buttons: This button lets you add or remove 
keyframes at the position of the playhead to or from every single parameter within the group. 
When the button is highlighted orange, a keyframe is at the current position of the playhead. 
When it’s dark gray, there is no keyframe. Left and right arrow buttons let you jump the playhead 
from keyframe to keyframe for further adjustment.

	— Reset button: Lets you reset all parameters within that group to their default settings.
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Audio Settings in the Inspector
Each selected clip and each selected Main or Bus channel strip in the Mixer exposes some audio-
specific parameters in the Inspector Panel tabs.

The Audio Tab in the Inspector
These are the options in the Audio tab:

	— Volume: Each clip has a single volume control, which corresponds to the volume overlay 
over each audio clip.

	— Pan: (Only exposed for clips) A simple Pan slider that controls stereo panning.

	— Pitch: (Only exposed for clips) Each clip has two pitch controls for altering clip pitch without 
altering clip speed. You can control pitch in Semi Tones and Cents.

	— Speed Change: Any adjustments made using Elastic Wave to the clip is found here. 

	— Equalizer: (Only exposed for clips) Each clip also has a four-band EQ, complete with low-pass, high-
pass, and parametric settings for fine tuning and problem-solving audio issues at the clip level.

The Audio tab of the Inspector

The Effects Tab in the Inspector
If you’ve applied any Fairlight FX, VST plugins, or Audio Unit plugins, those controls will appear in the 
Effects tab the Inspector. For more information, see Chapter 176, “Audio Effects.”

Additionally, when you apply other audio plugins from the Audio FX panel of the Effects Library, 
additional parameters and controls are exposed.

De-Hummer controls in the 
Effects tab of the Inspector
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The Transition Tab in the Inspector
If you’ve applied any Transitions between clips, you can make adjustments in the Transition tab.

Crossfade controls in the Transition 
tab of the Inspector

Adjusting Multiple Clips at the Same Time
There’s an easy way to make adjustments to the Inspector parameters of multiple clips at the same 
time, without needing to use Paste Attributes (described later in this chapter). All you need to do is 
simultaneously select every clip you want to alter, and then modify the parameter in the Inspector that 
you want to change. As a result, every selected clip will be adjusted by the same amount. This works 
for compositing effects, transforms, text parameters, filters, and audio settings, just about anything 
that can be simultaneously exposed in the Inspector for multiple selected clips.

When you select multiple clips, the Inspector will display “Multiple Clips” as the title. If each of the 
selected clips have different values in the parameter you’re adjusting, that parameter will have two 
dashes in the value field. There are two ways you can make adjustments to multiple clips:

	— If you want to make a relative adjustment to all selected clips while keeping their original offsets 
from one another, then drag the virtual slider in the parameter field which will display a + or – 
before however many units your adjustment is.

	— However, if you want to set all selected clips to the same value, you can double-click in the number 
field, type the value, and press Return.

Making a relative adjustment of plus 4.00 in 
the Volume level of all selected clips
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Animated Inspector Adjustments
Keyframing in the Edit page works slightly differently than when using the Keyframe Editor in the 
Color page. Most simple keyframing tasks can be performed in the Inspector using three buttons 
that appear to the right of any parameter that’s capable of being keyframed. It takes two keyframes at 
minimum to create an animated effect.

The three keyframe controls 
that appear in the Inspector, 
from left to right: Previous 
keyframe, Create/Delete 
keyframe, Next keyframe

Methods of keyframing parameters in the Inspector:

	— To add a keyframe: Select a clip, open the Inspector, then move the Timeline playhead to 
the frame where you want to place a keyframe, and click the Keyframe button next to the 
parameter of the Inspector you want to animate. Once you’ve added at least one keyframe to a 
parameter, all other adjustments you make to parameters in the Inspector, or using the onscreen 
Transform/Crop controls in the Timeline Viewer, add new keyframes automatically if the playhead 
is at another frame.

	— To move the playhead to the next or previous keyframe: Click the small left- or right-
hand arrow to either side of a parameter’s keyframe control to jump the playhead to the next 
or previous keyframe. You can also press Right-Bracket ( [ ) and Left-Bracket ( ] ) to go from 
keyframe to keyframe.

	— To edit an existing keyframe of a parameter: Move the playhead to be on top of the keyframe 
you want to edit, and then change that parameter, either in the Inspector, or using the onscreen 
controls of the Timeline Viewer.

Methods of changing keyframe interpolation in the Inspector:

	— To change a keyframe to Ease In or Ease Out: Eased keyframes create animated changes that 
begin slowly and accelerate to full speed, or slow down gradually to decelerate to a stop. This only 
works when you have two or more keyframes creating an animated effect. Move the playhead to 
a frame with a keyframe using the next/previous keyframe controls, then right-click the orange 
keyframe button and choose Ease In, Ease Out, or Ease In and Out, depending on which keyframe 
you’re editing and the effect you want to create.

	— To change a keyframe to Linear: Move the playhead to a frame with a keyframe using the next/
previous keyframe controls, then right-click the orange keyframe button and choose Linear.

Methods of deleting keyframes and disabling keyframed effects:

	— To delete a single keyframe: Open the Inspector, move the Timeline playhead to a frame with a 
keyframe, and click the orange Keyframe button in the Inspector to delete it.

	— To delete all keyframes for one parameter: Click the reset button to the right of a parameter’s 
keyframe control in the Inspector.
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	— To delete all keyframes in a group of parameters in the Inspector: Click the reset button to 
the right of a parameter group’s title bar in the Inspector.

	— To disable or enable a single parameter’s keyframed effect: In the Timeline, click the 
toggle control at the left of a parameter’s keyframe track. Orange means that track’s enabled. 
Gray is disabled.

	— To disable or enable a group of parameters in the Inspector: Click the toggle control at 
the left of a parameter group’s title bar in the Inspector. Orange means that group is enabled. 
Gray is disabled.

Paste and Remove Attributes
The Fairlight page has Paste Attributes and Remove Attributes commands that allow for the copying 
and resetting of audio Inspector parameters and effects, similar to the same commands on the Edit 
page. For more information on how to do this, see Chapter 171, “Editing Basics in the Fairlight Page.”

Setting Clip Volume
Each audio clip, or audio item in the case of audio clips with linked audio on multiple tracks, has its 
own Volume level. This means that audio clips with multiple channels share a common Volume setting. 
There are several ways you can adjust these levels simply.

Adjusting Volume in the Inspector
Each clip has individual Volume parameters that are accessible in the Audio panel of the Inspector 
when one or more audio clips are selected.

The Volume parameters available for 
audio clips in the Inspector

Selecting an audio clip in the Timeline and adjusting its Volume only alters the volume levels of that 
clip, which lets you adjust basic levels for individual clips in your program. The Volume control affects 
every channel within that clip simultaneously. 

If you select multiple clips in the Timeline, then adjusting the Volume or Pan sliders or virtual sliders 
for all of them simultaneously will make a relative adjustment to all of the clips, preserving their offsets 
from one another. If you want to set all clips to the same level, then making a numeric adjustment will 
set all selected clips to the same absolute level.
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Adjusting Volume in the Timeline
Each clip (or item) of audio in the Timeline has a Volume overlay that lets you set that clip’s gain level 
by simply dragging it up or down with the pointer. This overlay corresponds to the Volume parameter 
in the Inspector.

Dragging a Volume overlay to adjust the clip level

Additionally, you can click any clip’s Audio Curve Editor button, at the bottom right-hand corner of 
each audio clip, to open an audio-specific Curve Editor with which you can keyframe not just volume, 
but pan, and the parameters of any audio filters you might have applied to that clip.

NOTE: Under the Fairlight menu > Show Clip Gain Line, you can show each clip’s gain in the 
Timeline. This is a handy way to quickly see all of the relative gains of clips in the Timeline.

Clip information for all clips in 
the Timeline can be enabled 
in the Clip Info display.
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Adding and Adjusting Volume 
Keyframes in the Timeline
Mixing audio by adding and adjusting individual keyframes can be a fast and effective way of 
balancing clip levels with one another and of fixing clip-specific dynamic level problems. When 
manually editing any audio parameter curve, you can use the following procedures.

Methods of adjusting the Volume curve using the pointer:

	— To adjust any curve segment: Position the pointer over the overall segment for clips with no 
keyframes, or position it between any two keyframes, directly on top of the curve segment you 
want to raise or lower. When the move cursor is displayed, click and drag up to raise the Volume, 
or down to reduce the Volume.

	— To adjust a section of level in a clip: Use the Edit Selection tool to highlight the portion to adjust. 
Then with the Clip Gain line showing, increase or decrease to the desired level and keyframes will 
automatically be created at the boundary of the gain adjustment.

	— To add keyframes to the level curve: Hold the Option key down and click the curve to place a 
keyframe at that frame. You must add at least two keyframes to create an automated change in 
Volume. By using the Option and Command key you can remove any keyframe.

	— To adjust a keyframe in any direction: Move the pointer over a keyframe so that the four-way 
cursor appears, and then click and drag up or down to change the Volume, or side to side to 
change its timing.

	— To adjust a keyframe in only one direction: Move the pointer over a keyframe so that the 
four-way cursor appears, and then click and drag in the intended direction of adjustment, either 
vertically to change the volume of the clip at that frame, or horizontally to move the keyframe to 
a different point in time. Once you start dragging a keyframe into a particular direction, keyframe 
movement is constrained in that direction until you release that keyframe.

	— To select one or more keyframes: Click any keyframe to select it. 

	— To select multiple discontiguous keyframes: Command-click all keyframes you want to select, 
whether they’re next to one another or not.

	— To select multiple contiguous keyframes: Click the first keyframe you want to select, and then 
shift-click the last keyframe you want to select, and all keyframes between will also be selected.

NOTE:  When adjusting the gain on clips, the tooltips will show the current gain level 
and reflect whatever changes you make indicating the amount of change as the 
keyframe moves.

Normalize Audio Levels Command
The Normalize Audio Levels command automatically adjusts the level of clips to a specific target 
level, and you can choose the method used to analyze each audio clip’s levels to determine how to 
normalize each clip’s volume. Options include a variety of loudness normalization algorithms specific 
to various international standards, which are useful for balancing the perceived overall loudness of 
several clips to one another, regardless of transient levels throughout each clip. You can also do Peak 
normalization, with options for both Sample Peak and True Peak.
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The various loudness options are designed to analyze an audio signal based on its perceived loudness 
to the listener, which results in a more accurate automatic balancing of different clips’ audio levels to 
one another, regardless of transient peaks occurring throughout different clips.

The target peak meter now uses the BS.1774 standard for measuring maximum “true peak,” which 
means that this meter is capable of measuring “inter-sample peaks,” rather than only the peaks at 
each sample of a waveform. However, you still have the option to measure Sample Peak, which is the 
previous method of measuring the actual peak of the samples in a media file.

The change made by the Normalize Audio Volume command is only a volume adjustment; no 
dynamics are applied, so the result of using this command is that the loudest parts of each selected 
clip are going to match one another at the target level. This command is also available in the 
Fairlight page.

To normalize one or more selected audio clips:

1	 Right-click one of the selected clips and choose Normalize Audio Levels. The Normalize Audio 
Level dialog appears.

The Normalize Dialog in the Fairlight page

2	 Choose the Normalization Mode you want to use. You can choose among a variety of standardized 
loudness measurement algorithms, or Sample Peak, or True Peak.

3	 Choose the reference level that you want to set the peak volume of the selected clips to 
match, in dBFS.

4	 Choose how you want to set the level of multiple selected clips:

	— When Set Level is set to Relative, all selected clips are treated as if they’re one clip, so that 
the highest peak level of all selected clips is used to define the adjustment, and the volume 
of all selected clips is adjusted by the same amount. This is good if you have a series of clips, 
such as a dialog recording, where the levels are consistent with one another, and you want to 
normalize all of them together.

	— When Set Level is set to Independent, the peak level of each clip is used to define the 
adjustment to that clip, so that the volume of every selected clip is adjusted by an amount 
specific to that clip. The end result may be a set of very different volume adjustments 
intended to make the peak levels of each audio clip match one another. This is good if, for 
example, you’re trying to balance a series of different sound effects with one another that 
have very different starting levels.

For more information about loudness normalization, see Chapter 178, “Audio Meters and 
Audio Monitoring.”
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Volume
Each audio clip in the Timeline has a simple Volume control that lets you adjust the gain of that clip.

Volume Control in the Inspector

Pan
Each audio clip in the Timeline has a simple stereo Pan control that lets you pan that clip. While most 
professional mixes will restrict panning to the more robust panner found in the Fairlight page Mixer, 
this simple clip-based Pan control is useful for editors of visuals working in the Edit page to quickly 
create simple panning effects to aid in a craft edit. Dragging the slider lets you pan audio left to right. 
This control is centered at 0 by default.

Pan Control in the Inspector

Voice Isolation
Each audio clip in the Timeline has a simple control for applying Voice Isolation. For more information 
about Voice Isolation, see Chapter 177, “Fairlight FX.”

Voice Isolation control in the Inspector

Dialogue Leveler
Each audio clip in the Timeline has Dialogue Leveler controls that let you apply the effect to the clip. 
For more information about Dialogue Leveler, see Chapter 177, “Fairlight FX.” 

Dialogue Leveler controls in the Inspector
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Dialogue Leveler Controls in the Inspector

Pitch Controls
Each audio clip in the Timeline has Pitch controls that Lets you alter the pitch of a clip without 
changing the speed. Two sliders let you adjust clip pitch in semi tones (large adjustments, a twelfth of 
an octave) and cents (fine adjustments, 100th of a semi tone).

Pitch control in the Inspector

Speed Change Controls
Each audio clip in the Timeline has Speed Change controls that lets you alter the speed of the clip. 
It has the option to have the clip’s pitch follow the adjusted speed change or maintain the original 
speed’s pitch.

Speed Change control in the Inspector

The Speed Change window has the following overall controls:

	— Enable button: Turns the overall Speed Change effect off and on, without resetting the controls.

	— Reset button: Resets all controls of the Speed Change window to their defaults.

	— Direction: The Right Arrow maintains the forward direction of the waveform, the Left Arrow 
reverses the direction of the waveform, and the Snowflake icon creates a freeze frame.

	— Speed %: A flywheel control to adjust the speed by a percentage plus or minus 100%.
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	— Frames Per Second: A flywheel control that syncs with the Speed % control showing the 
FPS relative to the speed change.

	— Duration: Indicates the new timing of the clip.

	— Ripple Sequence: When checked this moves all the media after the action to ripple edit to 
the new duration.

	— Pitch Correction: When checked this maintains the original pitch of the clips when speed 
changed. When unchecked the audio will speed up or slow down with the speed adjustment. The 
slower the speed change, the lower the pitch; the higher the speed change, the higher the pitch.

NOTE:  When in the Speed Change controls, do not use the freeze frame option. This will 
negatively affect the selected audio file.

Equalizer Controls
Each audio clip in the timeline has a four-band equalizer that has both graphical and numeric controls 
for boosting or attenuating different ranges of frequencies within that clip, before it even gets to 
the EQ built into the mixer. Each band has controls for the filter type (Bell, Lo-Shelf, Hi-Shelf, Notch), 
Frequency, Gain, and Q-factor (sharpness of the band), with the available controls for each band of 
EQ changing depending on the filter type.

When a channel strip’s EQ is enabled, the equalization curve that’s being applied is displayed in the 
Mixer. A channel strip’s EQ settings affect all the clips on that track, so you must open the EQ window 
to make those modifications.

The channel strip’s EQ indicator
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Master EQ Controls
The Equalizer window has the following overall controls:

	— Enable button: Turns the overall EQ effect off and on, without resetting the controls.

	— Reset button: Resets all controls of the EQ window to their defaults.

Graphical EQ Controls
A graph at the top shows a curve with handles that correspond to each of the enabled EQ bands listed 
below. You can drag any numbered handle to boost or attenuate the range of frequencies governed 
by that band, using whatever type of equalization that band has been set to.

The EQ graph with user-draggable handles

Dragging the numbered handles on this graph in turn modifies the parameters of the 
corresponding band, and changing each band’s parameters will also alter the EQ graph, which 
serves the additional purpose of providing a graphical representation of the equalization being 
applied to that track.

Bands 1 and 4
The outer two sets of band controls let you make high-pass and low-pass adjustments, if necessary.

	— Band enable button: Turns each band of EQ on and off.

	— Band filter type: Bands 1 and 4 can be switched among six specific filtering options for 
processing the lowest or highest frequencies in the signal. These include (from top to bottom) Hi-
Shelf, Hi-Pass, Bell, Notch, Lo-Pass, and Lo-Shelf. Bands 2 and 3 can be switched among Lo-Shelf, 
Bell, Notch, and Hi-Shelf.

	— Freq: Adjusts the center frequency of the EQ adjustment.

	— Gain: Adjusts the amount by which the affected frequencies are affected. Negative values 
attenuate those frequencies, while positive values boost those frequencies.

Bands 2 and 3
The middle two sets of band controls let you make a wide variety of equalization adjustments.

	— Band enable button: Turns each band of EQ on and off.

	— Band filter type: Bands 2–5 can be switched among four different filtering options 
(from top to bottom): Lo-Shelf, Bell, Notch, and Hi-Shelf.
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	— Frequency: Adjusts the center frequency of the EQ adjustment.

	— Gain: Adjusts the amount by which the affected frequencies are affected. Negative values 
attenuate those frequencies, while positive values boost those frequencies.

	— Q Factor: Adjusts the width of affected frequencies. Lower values include a wider range of 
frequencies; higher values include a narrower range of frequencies.

NOTE:  This may seem obvious, but not all parameters are available for every curve type. 
For instance, a Bell curve filter has Frequency, Gain, and Q adjustments, but a Lo-Pass or 
Hi-Pass filter will only have Frequency available to adjust.

Paste and Remove Attributes 
for Clips and Tracks
The Fairlight page has Paste Attributes and Remove Attributes commands that allow for the copying 
and resetting of audio parameters and effects, similar to the same commands on the Edit page.

The Paste Attributes dialog in the Fairlight page

The Paste Attributes dialog box gives you three types of attributes to choose from. Volume will paste 
the copied attributes to the clip. Plugins will paste any plugin attributes to the clip. Equalizer will past 
EQ data copied from another clip. One or all of these can be copied at one time.

The Remove Attributes dialog box gives you the same three types of attributes to choose from 
for removal of a clip. When the Volume box is enabled, all Clip Gain keyframes will be removed 
from the clip.
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Chapter 173

Mixing in the 
Fairlight Page
The Mixer is “control central” of the Fairlight page, providing all of 
the functionality you need to mix the various audio tracks of your 
program into a harmonious whole. 

By using EQ, dynamics, panning, level control, and Fairlight FX, VST and Audio Units audio plugin 
effects of all kinds, all with full automation, you can hone your sound and balance each track’s 
elements with one another. 

This chapter focuses on explaining the various functions of the Mixer so you can harness its 
power for yourself.
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Introduction to Mixing
This chapter describes the use of the Mixer to adjust the levels and fine-tune the audio of each track in 
the timeline. It’s focused on the function of the channel strip controls, with the following exceptions:

	— For more information about bussing, see Chapter 167, “Setting Up Tracks, Busses, and Patching.”

	— For more information about recording audio, see Chapter 169, “Recording.”

	— For more information about mix automation, see Chapter 174, “Mix Automation.”

The Mixer
The Audio Mixer provides a set of graphical controls you can use to assign track channels to output 
channels, adjust EQ and dynamics, set levels and record automation, pan stereo and surround audio, 
mute and solo tracks, and add Fairlight FX, or VST, or AU effects plugins. At its most basic, each audio 
track in your timeline corresponds to an individual channel strip in the Mixer, and by default there’s a 
single main stereo mix bus labeled “Bus 1” that combines all these tracks into an overall mix.

The Audio Mixer with channel strips corresponding to the tracks in the Timeline

Tracks and Busses
Once you start creating busses, the Audio Mixer exposes two sets of channel strips. The leftmost set 
of channel strips correspond to the audio tracks in the Timeline, while the right-most set of channel 
strips expose sets of controls for each bus that you’ve created. 
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By default, the Audio Mixer is divided into two sections, 
one for tracks (at left) and one for busses (at right).

If you have more tracks and busses than can be displayed all at once given the width of your computer 
display, then each half of the Mixer has independent scroll bars so you can choose which tracks and 
which busses you want to see next to one another. You can also remove the split between sections 
and have a single, continuously scrollable view with all tracks, or change the order or split point for 
the channels.

FlexBus Routing and Mixing
The Fairlight audio engine bussing system is called FlexBus. As its name suggests, FlexBus offers a 
hight level of flexibility for bus types and signal routing. DaVinci Resolve Fairlight’s older Fixed Bus 
configuration (prior to DaVinci Resolve v17) offered a more limited fixed bus topology, and can still be 
used, but FlexBus makes it possible to patch outputs and/or sends in any way required, as dictated by 
your project. 

With FlexBus, each track can output to up to ten busses and sends with additional level and pan 
controls to a further ten busses. Busses can be sent to other busses up to six layers deep, facilitating 
complex stem building, processing, and allowing discrete deliverables, for mor information  
see Chapter 167, “Setting Up Tracks, Busses, and Patching.”

What is a Bus?
A bus is simply a common signal connection point in an audio mixer. Busses can be mono, stereo, or 
any larger format, like 5.1 or Dolby Atmos 9.1.6 (where 16 audio signals are used). Bussed connections 
are mix points for the audio, allowing each audio track feeding their signals to the bus to be summed 
together to create a master output for that bus.

Bus-to-Bus Routing
A mix may use a single bus (for example, the default stereo Main 1 bus may be all that you need if 
you’re doing basic stereo mixing). Or you can create “submixes” where multiple busses feed into other 
busses to create a master mix. For example, you might have a dialogue bus, an effects bus, and a 
music bus so you have control over those elements separately via the bus “masters” for each, then 
feed the 3 masters into a main output bus for final mix rendering.

You may want to route the output of a bus to an audio track to record the resulting signal, or route to 
monitor speakers to listen to the real time output. Finally, the Deliver page can render the output of 
your designated master bus to create a final bounced file.
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The FlexBus structure allows for many different 
bus track types to be created or changed.

User-definable busses allow for bus-to-bus, bus-to-track, or track-to-bus routing, with each bus 
having the ability to sum together signals from mono to fully immersive formats (such as Dolby 
Atmos) at your discretion. As with any and all of the audio track types in Fairlight, you can change 
bus types at any time if needed.

The power of the FlexBus system is that it allows you to direct signals to many different places at 
one time to achieve complex mixing scenarios. Perhaps you need to generate two mixes that are 
identical in content but need to be of different output levels. You can designate two mix busses, 
one with a target output level of -14 LUFS and one with a target output level of -24 LUFS. The final 
mix signal is sent to one bus that is then broken into two more busses, one with a limiter set to 
accommodate the -14 LUFS mix and one set to the correct level for the -24 LUFS mix, allowing you 
to create these two different mixes at one time. 

FlexBus supports expanded Dolby Atmos capabilities; for more information see Chapter 180, 
“Immersive Audio Workflows.”

FlexBus bus routing buttons.
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Legacy Fixed Bussing
Prior to DaVinci Resolve 17, the Mixer had a fixed topology with specific, fixed numbers of sends, 
submix busses, and main outputs. DaVinci Resolve still supports this older “legacy” bussing topology 
to maintain compatibility with earlier projects. 

With the current FlexBus bussing, the Mixer looks slightly different. The Aux panel on the legacy Mixer 
has been renamed Bus Send, and the the Main/Submix panel has been changed to Bus Outputs.

In the legacy Fixed Bus view:

	— Each audio track’s channel strip has a set of Main and Submix bus buttons that let you assign the 
audio output by that channel strip to a Sub (typically used to combine different subsets of tracks 
into submixes) or to a Main (typically used to output or render overall mixes). 

	— Each Sub and Aux’s channel strip has a set of Main buttons so that different combinations of Subs 
can be assigned to each Main. Main channel strips have no buttons because, from a bussing 
perspective, they’re the final output.

	— Main and Submix buttons let you assign tracks to busses, and busses to other busses.

Main and Submix bus buttons

Using Legacy Fixed Busing
If you want to work using the previous method of Fixed Bus mapping, you can do so for new 
projects by accessing the Project Settings > Fairlight panel, and turning on the “Use fixed 
bus mapping” checkbox. If you’re starting work in FlexBus, this checkbox can only be 
enabled in new projects in which no timelines have yet been created. Older projects that 
were created with Fixed Bus mapping have this setting enabled by default to preserve the 
previous mix.

Converting Older Fixed Bus Projects to FlexBus
Older Fixed Bus projects can be converted to FlexBus by doing the following:

	— Open Project Settings > Fairlight. 

	— Under the Bussing heading, uncheck “Use fixed bus mapping.”

	— A dialog will appear, allowing you to convert the project to FlexBus.
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Customizing the Onscreen 
Mixer Controls
The 3 dot Option menu at the upper right-hand corner of the Mixer provides several different options 
for customizing the appearance of the Mixer, as well as which controls are shown or hidden:

	— Full Track Mixer or Small Track Mixer option: While the Full Track Mixer provides more room for 
buttons and controls that are large enough you don’t have to squint to see them, the Small Track 
Mixer allows many more channel strips to be seen at one time.

The Small Track Mixer view

	— Show Labels option: These are the sectional names for functional areas of the Mixer that appear 
at the far left of the Mixer channel strip area. If you’re first getting started, these labels are useful, 
but once you’ve gotten used to the Mixer’s layout, hiding the labels can give you a bit more room 
to work with for another channel strip or two.

	— Channel Strip Control Visibility options: Allows controls to be shown or hidden in the Mixer. 
You can hide controls you know you’re not going to be using, no longer need to adjust, or wish to 
not disturb. 
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Managing Channel Strips Using the Index
The Index is a consolidated list view of all the tracks in the current Timeline, designed to make it easier 
to manage timelines with lots of tracks. Columns let you see each track’s visibility, track number, name, 
controls, channel format, monitor assignment (if any), ADC controls, and VCA assignment. The controls 
in these columns let you manage the tracks in the current Timeline by showing or hiding them, 
toggling track controls, or rearranging them. You can also right-click on one or more selected tracks to 
color code them, or change the track type.

The Tracks panel of the Index shows all 
tracks on both the Timeline and the Mixer.

Showing and Hiding Tracks
You can use the Tracks panel of the Index to hide tracks you don’t need to work on in order to create 
more room for tracks you need to see. 

TIP: To quickly show or hide a number of tracks, click and drag up or down over the eyeball 
button of each track where you want to toggle the visibility.

Color Coding Tracks
Select one or more tracks, then right click one of the selected tracks and choose a color from the 
Change Track Color submenu of the contextual menu.

Toggling Lock, Record, Solo, and Mute
As with visibility, you can use the Lock, Record, Solo, and Mute controls to quickly enable or disable 
multiple tracks by clicking and dragging up or down over the Lock, R, S, or M buttons you want to toggle.

Rearranging Tracks
You can rearrange tracks in the Tracks tab in the Index by clicking any track strip area between other 
controls, and then dragging that track up or down in the Index. As you drag, a white line shows you 
where that track will be inserted when you release it. You can even select a contiguous series of tracks 
and drag them all to a new position in the Timeline at once. 

Managing the Dividing Line

By default, there are two areas of tracks in the Index; one area is for audio tracks, and one area for 
busses and VCAs with a dividing line separating them. Busses and VCAs can be dragged up out of the 
divider and into any position for any order. This can be quite useful when having a series of dialogue 
tracks, for instance, and pulling the dialogue bus up next to them.
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The dividing line’s position can be moved to any location by dragging it, so you can keep the split 
organization of tracks into two different areas but re-order what is shown.

Once the order has been changed in the Index, this is reflected in both the Mixer panel as well as in 
the Meter panel. By reordering busses and tracks, you can adjust your workflow for whatever set of 
tasks you are working on.

Single Mixer View

Clicking the three dot Option menu at the top of the Mixer panel offers an option for Single Mixer view. 
The Single Mixer view removes the divider line from the Tracks tab in the Index entirely, providing a 
continuous scroll of the tracks, both in the Mixer panel horizontal scroll and the Index vertical scroll. 
You can restore the divider at any time.

NOTE: You can reset the bus order to its original layout by choosing “Reset Bus Order” from 
the three dot Options menu on the upper right of the Mixer.

Changing Track Type
Track type refers to the channel width of the audio track and what format it is. The track type can be 
changed at any time. For example, you could have a mono track, and change it stereo, or to a 5.1 track, 
or to a 12 channel Adaptive. 

To change the track type, select one or more tracks, then right-click one of the selected tracks and 
choose a different track type from the Change Track Type submenu of the contextual menu. 

NOTE: Keep in mind that if you change from a larger track type to a smaller one, you may 
need to also set which of the channels in the larger source audio file are now audible on the 
smaller track type. This can be handled via the contextual menu choice Clip Attributes for a 
clip, using the Audio tab. 

Selecting Channel Strips and Tracks
When you select a track in the Timeline, you also select that track’s accompanying Mixer channel strip, 
and vice versa:

	— To select single tracks, just click.

	— To select multiple contiguous tracks, select a starting track or channel strip, hold down Shift, and 
click on last item you want in your selection.

	— You can also select multiple channel strips in the Mixer by clicking and dragging to create a 
bounding box around the tracks you want to select.

	— To select non-adjacent (discontiguous) tracks or channel strips, command-click on each item you 
want to add to your selection. 
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Selecting multiple channel strips selects the same tracks in the Timeline

Track Organization
Each channel strip has three organizational properties that let you keep track of which channel strip is 
responsible for which part of the mix.

	— Track color: Each track can be differently color coded to help you keep organized. These colors 
appear in the Timeline track header, the Mixer, and the meters to help you keep track of which 
track corresponds to which channel strip and meter.

The track color and track number appear 
at the top of each channel strip.

	— Track number: The number of the timeline audio track corresponding to each channel strip 
appears here.

	— Track name: This mirrors the track name found in the track header of a track on the Timeline. 
If you customize an audio track’s name in the Timeline or in the Mixer, that name appears here.

Each track’s name appears between 
the assignment buttons and the 
arm/solo/mute buttons
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Fairlight Mixer Signal Path
The signal path or layout (“topology”) of a mixer describes how the audio signals are routed from one 
place to another.

The default signal flow on the Fairlight channel strip is as follows:

1	 Audio source: Input menu allows choice of source, including file playback, bus, live input, etc.

2	 Path Settings: Accessible from the Input menu. Allows adjustments to the input signal.

3	 Track FX: Built-in effects, Voice Isolation (Studio only), and Dialogue Leveler. Disabled by default.

4	 Effect: Fairlight FX, AU, or VST effects.

5	 Dynamics: Dedicated channel dynamics processor with expander/gate, compressor, and limiter.

6	 EQ: Dedicated 6 band EQ with variable gain, frequency, and Q.

7	 Output Routing: Panning and bussing.

The main fader for the channel strip then controls the level to any assigned main output busses. 
Bus Send faders control the level to any destination set for a mixer channel send and can be set 
pre‑or post-fader.

What Is An Effects Insert?
Each time you add an effect to a channel, a signal processing “insert” (insertion point) is enabled. 
The source signal flows from the input of the effect to its output, and then onwards to any additional 
insert(s) to the next stop in the Mixer’s signal flow. 

DaVinci Resolve supports a total of 6 inserts per channel in addition to the built in Dynamics 
and EQ processing.

Click on the Input area to access the Input drop-down menu, letting you patch inputs, patch 
busses, and configure the input settings of audio signals routed through Blackmagic or other 
hardware audio interfaces.

“Pre” vs. “Post”
The term pre refers to a signal that is routed for use before another connection point. 
For example, you may prefer to work with pre-fader metering as you can always see the 
original signal level coming off of disk reflected in the meter level. 

A signal that is post occurs after a connection point. For example, you generally want effect 
sends that go to a reverb effect to follow the level of a track’s main fader so that the reverb 
level follows the overall level. As a result, Bus Sends are set to have post fader routing 
by default.
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Input
For more information on using the options of the Input menu, see Chapter 167, “Setting Up Tracks, 
Busses, and Patching.”

 The Input drop-down menu 
allows you to initiate patching 
any available sources using the 
Patch Input/Output window.

Path Settings
Choose Input at the top of the Mixer channel strip to access the Path Settings control window. 
These controls allow you to modify various aspects of the Mixer channel strip that may need 
adjustment prior to, or post, recording to control the mic/line inputs on Fairlight audio interface 
hardware, and more.

Path Settings window

Mic/Inst
Controls will only appear on this panel if you have connected channels 1 or 2 of a Fairlight SX36 audio 
interface to your system. If connected, you can remotely control all of the options (including level) for 
the mic/instrument inputs of the SX36 if they are assigned to the channel. If there is no connection to 
an SX36, the area is empty. 

Record Level
	— Record: Linked and identical to the Record Enable button on the channel strip; here for 

convenience. If you hit one, it will enable the other.

	— Thru: Allows the input signal to pass into the Mixer without enabling a record path. This is ideal 
when you want a source signal to always be available and just want to monitor it. 

	— Record Level: Allows you to apply a digital gain adjustment to the record path to disk, post the 
output of your audio interface’s analog-to-digital converter. 
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Normally, this control should be left at 0.0 (no change, unity gain), as it affects the level you are 
recording to disk. It is best practice to use the level controls on your audio interface to control the 
input level into DaVinci Resolve in order to maximize audio fidelity. However, there might be a time 
where you need a bit more level, or may not have access to an audio interface’s controls, and in 
those cases you can adjust the input.

Trim
	— Polarity: Inverts the polarity of the signal coming into the channel strip (sometimes referred to 

as “flipping the phase”). For example, you may have an input signal like an explosion where the 
transient attack of the signal produces with a massively positive-going waveform (where the 
waveform mostly appears above the zero line). If you invert the polarity, the signal will now be 
mainly negative-going and the waveform will be concentrated beneath the zero line. Inverting 
polarity is sometimes used to more closely align signals from multiple microphones and can be 
used creatively to affect frequency response of such a signal.

	— Trim Level: Allows you to trim the level of the signal coming off of disk, post the Track FX (which 
process directly off of disk) and pre all other effects. Trim Level appears post the recorded signal 
to disk and doesn’t affect the recording level. Trim is a playback adjustment and allows you to 
adjust the level of the signal coming into your mix to optimize the level feeding effects and the 
busses, or to slightly trim an otherwise perfect element in the mix up or down in level. 

Direct Output
Each audio channel strip can enable a direct output that can be used to feed any other input 
destination. You can patch this source using the Track Direct choice in the Patch Input/Output 
dialog via the Source dropdown for more information see Chapter 167, “Setting Up Tracks, Busses, 
and Patching.”

	— On/Off: Enables/disables the direct output.

	— Pre: Sets the direct output tap-off point to be pre (before) the channel fader. On by default.

	— Level Control: Sets the level from full off (minus infinity) to +10 dB. Default is 0.0 (unity gain). 

Insert
Linked and identical to the Effects In button on the channel strip; here for convenience. If you hit one, 
it will enable the other. Switches all Fairlight FX, AU, or VST effects on a channel in or out of the signal 
path with a single switched control.

Effects
Fairlight FX, VST, or Audio Unit effects can be applied on the Mixer’s channel strips. Effects are applied 
on the entire track, not just on one or more clips in the Timeline for that track. 

Clicking the plus (“+”) button opens a drop-down menu, allowing you to apply any Fairlight FX, VST, or 
AU effects installed on your machine to that track. The menu is organized by processing type. Within 
each type, there is a hierarchical choice for Fairlight FX, AU, and VST (if you’re on a Mac) or Fairlight FX 
and VST (if you’re on Windows).
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NOTE: Depending on what you have 
installed on your machine, the collection 
of audio effects available for the Mixer 
channel strip inserts is often close to (or 
identical to) those that you can access for 
clip-based audio processing found in the 
Effects panel on the left side of Cut, Edit, 
and Fairlight pages.

TIP: You can store favorite effects for 
quick access at the top of the list by 
marking them as favorites in the Effects 
panel. Mark a favorite by clicking on the 
star next to the name.

Clicking on the plus sign 
shows the Effects drop-
down list for assignment

Moving the pointer 
over an effect 
reveals controls 
for that effect

Hovering the mouse over any listed effect reveals 
controls for enabling/disabling, replacing or 
deleting the effect, or opening an effect’s custom 
controls (the user interface for that effect).

Changing the Order of Effects on a Channel
The order of effects on any Mixer channel strip can be changed by clicking on the Effects Order 
button.  A drop-down menu appears allowing you to change the order between various routing 
combinations of all insert effects (Fairlight FX, or AU, or VST plugins) and the built-in Dynamics and EQ 
modules. The default routing is Effects (“FX”), Dynamics, EQ.  

Effects  
Order drop-
down menu

Different effects orders can produce very different creative results. 
For example, it is usually best practice to apply noise reduction 
first in a signal chain, so you’re not affecting the volume or quality 
of the noise floor you’re trying to remove, so the plugin can do its 
job most effectively. Or you may wish to apply dynamics processing 
prior to EQ, as changing the spectral content of your source may 
affect the response of the compressor. 
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Moving Inserts by Dragging
You can move inserts from one location to another simply by clicking and dragging to a new location. 
Using this technique, you can move an effect from one channel to another, or swap or move the 
location of an effect on a channel to another insert position on that channel (displacing the plugin 
already present). Note that, at this time, you can’t use this technique to copy tracks to busses or 
vice versa.

Copying and Pasting Effects
You can copy entire effect chains with their specific effect parameters intact, track by track. Let’s say 
that you’ve created a plugin chain on a dialogue track that has Noise Reduction, a De-Hummer, and a 
Dynamics plugin that you have tweaked to the exact settings needed for those dialogue recordings to 
sound great. 

You also have another track that has similar recordings that could benefit from the exact same chain 
of plugins and those particular settings. Rather than install each plugin to the track and redo the 
settings, you can simply right-click the track header (A1 for example) and click Copy. Then go to the 
track header of the new track you want effected, right-click, and click Paste. You will now have the 
identical plugin chain copied over to the new track, all with each of the settings exactly as you had 
created on the source plugin dialogue track

Copying and Pasting Effect Settings
If you have a setting for one effect that you spent a lot of time getting right and see that it could also 
work just as well on another track’s effect, you can copy and paste just those settings.

For example, you have a Reverb on a dialogue track that you have tweaked to perfection. You see that 
those exact settings will work well for another dialogue track that is on your timeline. Rather than try 
to recreate those settings, you can duplicate them. 

	— Hold down the option key and drag the Reverb plugin you want to copy to a new location. This 
creates a copy at the new location and leaves the original intact.

	— Alternatively, you can use Copy and Paste in the plugin three dot Options menu. To apply those 
settings to the other track, just click Copy from the Options menu of the source Reverb effect, 
then open the Reverb plugin window of the destination Reverb effect, and click the Options menu 
to paste. Now all of the parameters are the identical between the two plugins. 

For more information on using audio effects, see Chapter 176, “Audio Effects.”

TIP: You can create and load presets for entire channel strips and use them in any project 
or timeline using the Fairlight > Presets Library.  
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Effects In
The Effects In button allows you to bypass all Fairlight FX, AU, or VST effects plugins for the channel 
with a single control. When it is lit (orange), all effects are enabled; when it is unlit, all effects 
are bypassed.

NOTE: Track FX (Voice Isolation with Resolve Studio and Dialogue Leveler) and the built-in 
Dynamics and EQ processors are not affected by Effects In.

Dynamics
Each Mixer channel strip has a built-in Dynamics processor, with a mini Dynamics Indicator graph that 
appears on the channel strip and acts as the access button. Double-clicking the Dynamics Indicator 
brings up the Dynamics processor window, with three modules: an Expander/Gate, a Compressor, 
and a Limiter. Each can be used separately or in concert to manage the dynamics of the audio on the 
target track.

The Dynamics control window

The Dynamics Graph
When you enable any combination of the Dynamics window modules you may need for a track, the 
Dynamics graph updates with curves that show you how the signal is being affected by the Expander/
Gate, Compressor, and/or Limiter settings that are being applied. The Dynamics graph also provides 
a real time animated display that meters the true response of the input/output signals compared 
against the graphic that shows the basic response curve.
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	— The X axis (horizontal scale) represents the input signal level.

	— The Y axis (vertical scale) represents the output level.

	— The blue line represents the threshold.

	— The light green line represents the dynamics curve (dependent on the process type and setting; 
this will change).

	— The light green balls that animate in the upper area of the graph follow how the Dynamics control 
settings affect the signal as it moves above or below the threshold. The balls are affected by the attack 
and release settings, allowing you to visualize the way the compressor is affecting the input signal.

	— The smaller lines that appear on the on the input and outline X-Y lines allow you to see exactly 
where the input/output levels are. 

The Dynamics graph shows the response 
curve and how the signal is being affected 
by the current settings in real time

The Dynamics Indicator on the channel strip displays the same curve, so you can see at a glance 
what is happening on that channel (but without the real time display). This indicator cannot be 
adjusted; you must open the Dynamics window to make modifications.

The channel 
strip Dynamics 
Indicator

Master Dynamics Controls
The Dynamics window contains the following overall controls at the top of the window:

	— Enable button: Turns the overall dynamics effect off and on, without resetting the controls. 

NOTE: You can also turn dynamics on/off by single clicking on the Dynamics button (the 
mini graph) in the channel strip. 

	— Reset button: The circular reset icon on upper right next to the three dot Options menu resets all 
controls of the Dynamics window to their defaults.

3690Fairlight  |  Chapter 173  Mixing in the Fairlight Page



	— Preset Menu: Dynamics presets appear here. You can create, change, and save presets, and use 
the default presets as good starting points for your track’s specific needs.

	— Make Up Gain control: A post-dynamics level control that lets you boost the signal to 
compensate for dynamics settings that may have lowered the overall level.

Expander/Gate
The first of three sets of dynamics modules, the Expander/Gate controls can be switched between 
expansion and gating. Expansion emphasizes differences in volume by lowering the level of soft parts 
of the signal relative to the level of louder parts and can be used to minimize noise while increasing 
the dynamic range of a signal. Gating reduces the level or even silences parts of a signal that fall below 
the set threshold level in order to reduce or eliminate noise in quiet parts of a recording.

	— Expander: This button enables the Expander.

	— Threshold: Sets the signal level below which expansion occurs. Defaults to –35 dB. 
The range is from –50 to 0 dB.

	— Range: Amount of decrease in signal level in dB, affected by both threshold and ratio. As ratio 
increases, range can have more of an effect. At lower ratios, as threshold increases, the effect 
of range increases.

	— Ratio: Sets the attenuation ratio (input to output) applied to signals which fall below the 
threshold level. It controls the rate at which signals will drop, while range controls how much 
the signal will drop. Defaults to 1:1.1. The range is 1.0:1 to 10:1. A 1:5 ratio means that for every 
1 dB of input level decrease below the threshold, the expander output will decrease 5 dB.

	— Attack: Adjusts how quickly the expansion occurs when a signal exceeds the threshold. 
Defaults to 1.4 ms (milliseconds). The range is 0 to 100 ms.

	— Hold: Controls how long the Expander is kept open after the input has fallen below the 
threshold, in ms. Defaults to 0 ms. The range is from 0 to 4000 ms (4 seconds).

	— Release: Adjusts how quickly or gradually the Expander attenuates when the input signal 
goes back below the threshold. Defaults to 93 ms. The range is 50 to 4000 ms (4 seconds).

	— Gate: This button enables the Gate.

	— Threshold: Sets the signal level below which gain reduction occurs. The range is from –50 to 0 dB.

	— Hold: Controls how long time the Gate is kept open after the input has fallen below the 
threshold, in ms. Defaults to 0 ms. The range is from 0 to 4000 ms (4 seconds).

	— Range: Sets the maximum amount of gain reduction that will be applied when the signal falls 
below the gate threshold. Once the signal has fallen below the level determined by the gate 
threshold minus the gate range, no gain reduction is applied. The default is 18 dB. The range 
is from 0 to 60.2 dB.

	— Ratio: Unused for gate.

	— Attack: Adjusts how quickly the gating occurs when a signal exceeds the threshold. Defaults 
to 1.4 ms. The range is 0 to 100 ms.

	— Hold: Keeps dynamics from being triggered again until a certain amount of time has passed, 
in ms (milliseconds). Defaults to 0 ms. The range is from 0 to 4000 ms (4 seconds).

	— Release: Adjusts how quickly or gradually the sidechain detector stops attenuating when the 
input signal goes back below the threshold. Defaults to 93 ms. The range is 50 to 4000 ms 
(4 seconds).
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Compressor
The second set of dynamics parameters let you apply compression, which detects the envelope of an 
audio signal in order to automatically change its level. A compressor is used to compress a signal’s 
dynamic range by reducing differences in level between the loudest and quietest parts of the input signal. 

Compression can be used to raise the signal’s overall level to be boosted without clipping, increasing 
perceived loudness. Compression is often used to allow voices to have more presence within a mix, 
and to smooth out changes in the levels of tracks with too much dynamic range for the task at hand.

However, “overcompressing” can remove natural dynamics of a sound, or remove too many of 
the natural transients (energy bursts or “attacks”) that give the original sound its character. But 
more extreme compression can also be used creatively to change a sound’s character to give it 
more perceived attack, change its release characteristic, or change the balance and blend of the 
environment a sound is recorded in (for example, compressing a source signal with a higher ratio and 
fast release to raise up the presence of a room sound that the source is recorded in).

	— Compressor: Enables the Compressor.

	— Threshold: Sets the signal level above which compression is applied. The default is –15 dB. The 
range is –50 to 0 dB.

	— Ratio: Adjusts the compression ratio. This sets the gain reduction ratio (input to output) applied 
to signals which rise above the threshold level. The default is 2.0:1. The range is 1.0:1 to 10:1. 
Commonly used ratios for dialogue processing are 2.5:1 to 3:1. With a 3:1 ratio, for every 3 dB of 
increase in signal above the threshold, 1 dB is output.

	— Knee: Affects behavior with signals that are very near the threshold. The knee can smooth out the 
transition between where you don’t hear any compression and when the “hard compression” (the 
set ratio) starts. 

	— The Knee: Control allows a smoothing of the slope of the threshold point. You can see Knee’s 
effect on the graph when using a ratio like 4:1 and adjusting Knee; the graph will show the line 
where compression “kicks in” being rounded off by higher values of the Knee control. 

	— Normally, compression begins directly above the threshold. This is known as a “hard knee.” 
For a smoother and less audible handling of compression, you can set a softer knee, so the 
compression turns on gradually as signals approach the threshold and rise above. 

Hard and Soft Knee graphs
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	— Mix: Adjusts the mix between the compressed (0) and non-compressed input signal (100), 
allowing you to balance the compressed signal against the original, unaffected sound. For 
example, if you’re creating a large explosion impact sound effect, it might sometimes be 
useful to mix in just a bit of the original, uncompressed signal with a more compressed 
version to preserve more of the original character along with compressed version. The default 
is 0 (all compression, no original signal).

	— Attack: Adjusts how quickly the compression will occur when a signal exceeds the threshold. 
The default is 1.4 ms. The range is 0 to 100 ms.

	— Hold: After the attack phase has been completed, the Hold parameter controls how long this 
initial attenuation is maintained, before entering the release phase. Defaults to 0 ms. The 
range is from 0 to 4000 ms.

	— Release: Adjusts how quickly or gradually the sidechain detector stops applying compression 
when a signal falls back below the threshold. The default is 93 ms. The range is 50 to 4000 ms 
(4 seconds).

	— Send: Enable Send when you want to use the audio levels of the currently selected track to 
attenuate those of another track using sidechain compression. For example, you can turn on the 
compressor and enable Send for all tracks with dialogue, in order to use those levels to attenuate 
the levels of another track containing music. 

	— Listen: Enable Listen when you want to use the audio levels of tracks that you set to Send to 
attenuate the levels of your currently selected track. If there are no tracks with Send enabled, then 
the current track is compressed as usual, using itself as the sidechain.

Sidechaining and “Ducking” with Dynamics
The built-in Dynamics module allows you to set up “sidechaining” compression. A “sidechain” refers 
to a control signal path that allows a source signal to be used to control the response of another 
processor, in most cases, dynamics processing. This is done by feeding the control signal into a special 
“side chain input” on the processor you want to affect.

NOTE: DaVinci Resolve presently supports sidechaining exclusively on the built-in 
dynamics processor.

To use sidechain compression to automatically “duck” music in the presence of dialogue on other tracks:

1	 Edit dialogue into one track of the Timeline, and edit overlapping music into another 
track of the Timeline. 

Choosing the track header in the Fairlight timeline to add dynamics
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2	 Click the track header or channel strip of a track with dialogue to select that track, and 
then double-click the Dynamics Indicator on the channel strip in the Mixer to open the 
Dynamics window.

3	 Turn on the Send button to automatically send all levels from that track to the sidechain of a 
Compressor on another track (it’s not necessary to turn on the Compressor for this). If you hover 
the pointer over the Send button, a tooltip will show you which tracks of the current timeline are 
set to Send. This enables your sidechain “feed.”

4	 If you have multiple tracks with dialogue, you can repeat steps 2-3 for each so that the output 
levels of all dialogue are sent to the sidechain.

Enabling sidechain Send in the 
Compressor of a track with dialogue

5	 Next, click the track header or channel strip of a track with music to select that track. If you haven’t 
closed the Dynamics window, the header will show you that the Dynamics controls are now those 
of the newly selected track.

6	 Turn on Compressor, and then turn on the Listen button to connect the “Send” signals from any 
of the tracks you were feeding to the sidechain of the Compressor on this track. If you hover the 
pointer over the Listen button, a tooltip will show you which tracks of the current timeline are 
being received by Listen.

7	 At this point, you need to lower the Threshold and raise the Ratio controls to the appropriate 
levels so that as dialogue is heard, the music is compressed in the way you’d like to hear it. You 
may also want to raise Hold a bit so this gain reduction doesn’t fluctuate too wildly, and raise 
Release slightly so the volume adjustment doesn’t end too abruptly. 

Enabling side chain Listen on the 
Compressor assigned to a music track
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If you’ve set up everything correctly, then during playback the Sidechain meter (upper right of the 
meter area) should show the levels of the dialogue tracks that have Send enabled, and the Gain 
Reduction meter should show you how much the level of the music track is being reduced when 
triggered by the dialogue being fed to the sidechain. 

As a result, you should hear that whenever speech plays, the music volume is automatically lowered. 
Adjust Threshold and Ratio to set the amount of this gain reduction, and adjust Attack, Hold, and 
Release to adjust how quickly gain reduction responds to changes in the Sidechain level (as defined by 
the Send levels).

Limiter
The third set of dynamics parameters let you apply limiting, which imposes a targeted maximum level 
allowed for a signal. Limiting is similar to compression but essentially has a very high ratio.

	— Limiter: Enables the Limiter.

	— Threshold: Sets the threshold above which limiting will occur. As the Limiter is designed to hard 
limit the output, this also essentially sets maximum allowable output level. The default is –21 dB. 
The range is from –50 to 0 dB. It’s best to set the amount of limiting by listening, and looking 
at the amount of gain reduction in the meter. Too much limiting can “squash the life out of the 
sound” as all of the internal dynamics of a mix can be lost. Used properly, you can smooth out 
the final mix and achieve higher average level. You can also watch the the yellow animated 
balls in the display to see how the real time limiting response is affected by the controls.

	— Attack: Adjusts the attack rate time constant of the sidechain detector. The default is 0.71 ms. 
The range is 0 to 100 ms.

	— Hold: Once the input level falls below the threshold, Hold keeps limiting active until the hold 
time has elapsed, when release time will start. Default is 0 ms. The range is from 0 to 4000 ms.

	— Release: Adjusts how quickly the sidechain detector stops applying limiting when the signal 
falls below the threshold. The default is 90 ms. The range is 50 to 4000 ms.

NOTE: When limiting is applied to the final output of your channel (or to an entire mix), you 
often will need to use the Makeup Gain slider to maximize the output level (if a master) or to 
match the original level of an individual track (unity). You can audition the difference in level 
by bypassing the Dynamics module overall, or the Limiter only.

EQ
Each Mixer channel strip has a EQ (equalizer) processor, with a mini EQ Indicator graph that appears 
on the channel strip and acts as the access button. Double-clicking the EQ Indicator brings up the EQ 
user interface.

The EQ is a 6-band equalizer with choice of high and low shelving, parametric or notch response 
curves, and high- and low-pass filters. It has both graphical and numeric controls for boosting or 
attenuating different ranges of frequencies of audio on each track. 
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The EQ also offers four different tailored response curves, from the native Fairlight response to 
emulations of the response characteristics of classic mixing with options for Earth (the default), Air, 
Ice, and Fire.

Each band has controls for the filter type (Bell, Lo-Shelf, Hi-Shelf, Notch), Frequency, Gain, and 
Q-factor (sharpness of the band), with the available controls for each band of EQ changing depending 
on the filter type.

The channel strip EQ window

When a channel strip’s EQ is enabled, the EQ Indicator button displays the equalization curve 
that’s being applied. This indicator cannot be adjusted; you must open the EQ window to make 
modifications. As with Dynamics, single-clicking on the EQ Indicator will bypass the EQ.

The channel strip’s EQ Indicator,  
(Left) EQ is adjusted, (Right) EQ is default (no EQ)

Master EQ Controls
The Equalizer window has the following overall controls:

	— Enable button: Turns the overall EQ effect off and on, without resetting the controls.

	— Reset button: The circular reset icon on the upper right, next to the three dots Options menu, 
resets all controls of the EQ window to their defaults.

	— Equalizer Type: Drop-down menu choices that allow you choose a response curve that can 
emulate EQ characteristics from several “classic” mixing consoles.
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There are four options:

	— Earth: (Default) Native Fairlight response

	— Air: Emulates the SSL 4K

	— Ice: Emulates the Neve V

	— Fire: Emulates the Focusrite

	— Preset Menu: A drop-down menu that has several useful EQ presets available. You can create, 
change, and save presets, and use the default presets as starting points for your tracks’s 
specific needs.

	— Gain fader: A post-EQ level control that lets you boost or attenuate the signal to compensate 
for the EQ adjustment you’re making raising or lowering the level. Keep in mind that this control 
presently affects the EQ graph.

The EQ Graph
A graph at the top are of the EQ shows a curve with handles that correspond to each of the enabled 
EQ bands listed below. You can drag any numbered handle to boost or attenuate the range of 
frequencies governed by that band, using whatever type of equalization response that band has 
been set to. 

The EQ graph with user-draggable handles

Dragging the numbered handles on this graph in turn modifies the parameters of the corresponding 
band, and conversely, changing each band’s parameters will also alter the EQ graph, which serves the 
additional purpose of providing a graphical representation of the equalization curve being applied to 
that track. If you have a mouse wheel, it can be used to control Q.

Bands 1 and 6
The outer two sets of band controls allow access to high-pass and low-pass adjustments but can be 
switched to other response curves. They’re off by default.
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Band 1  
controls

	— Band filter type: Bands 1 and 6 can be switched among four specific filtering options for 
processing the lowest or highest frequencies in the signal. These include (from top to bottom): 
Low Shelf, Low Peak, High Shelf, High Pass for Band 1, and Low Pass, Low Shelf, High Peak, High 
Shelf for Band 6.

	— Frequency: Adjusts the center frequency of the EQ adjustment

	— Gain: Adjusts gain in dB, with a range of ±20 dB. Only available when bands are set to a peaking or 
shelving response curve.

Bands 2–5
The middle four sets of band controls let you make a wide variety of equalization adjustments. 
They’re on by default, to make it easy to begin making adjustments.

Band 3  
controls

	— Band enable button: Clicking the band name turns each EQ band on and off.

	— Band filter type: Bands 2–5 can be switched among four different filtering options (from top to 
bottom), Low Shelf, Peaking, Notch, and High Shelf.

	— Frequency: Adjusts the center frequency of the EQ adjustment.

	— L, ML, MH, H Buttons: Sets the EQ frequency to predetermined frequency ranges per band with 
Low, Medium Low, Medium High, and High settings.

	— Gain: Adjusts gain in dB, with a range of ±20 dB. Only available when bands are set to a peaking or 
shelving response curve.

	— Q Factor: Adjusts Q (bandwidth). Range of .3 to 10.3. Smaller numbers reflect wider bandwidth 
and higher numbers are narrower bandwidth. Q is only available when a band is set to a peaking 
response, or on the Fire Type for shelving, and will control the overall shape of the boost or cut. The 
Equalizer Types choices in the drop-down menu alter the Q to emulate the chosen console type.
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Bus Sends
Bus Sends let you route a channel strip’s source signals to a bus destination, with control over level, 
pan, mute, and pre/post fader routing. You can create bus sends on channels that go to any bus 
destination you’ve created. 

Some common mixing tasks that sends can be useful for:

	— Submixing: For example, to render separate mixed outputs that are different formats, such as 
stereo, 5.1 surround, or Atmos, all at the same time.

	— Feeding signals to a shared effect: For example, route to a reverb plugin, where post fader 
sends on various mixer channels feed a reverb placed on a bus channel strip by varying amounts.

	— Headphone cue mixes: Create separate, pre fader mixes for the talent so you don’t disturb what 
you’re listening to on your main monitor speakers. 

Creating Sends
To create a Bus Send and access its controls:

	— Click on the assign button with the plus sign (+) in the Bus Sends area of the Mixer.

	— A drop-down menu appears with a list of busses; select one to assign.

	— Your send is now created. 

You can hover over the rectangular name button and access a disable/bypass button, an access 
icon to show the Bus Send window for the channel, and an “x” to delete the send. A tooltip appears 
showing the send bus name. 

Hovering over 
the rectangular 
name button 
will show send 
controls.

Accessing the Bus Sends Window
You can access the Bus Sends window to control a channel’s sends by clicking in the center of the 
name button.

Bus Send window controls
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Each Bus Send you create exposes the following controls in the Bus Send window:

	— On: Turns the send on or off.

	— Pre: Switches the send to use pre- or post-fader routing. Enabling this button allows that track to 
send levels to the destination bus before level adjustments on that track are applied. 

	— Send Level: Adjusts the amount of signal sent from the selected feed to the send bus. 
The range is OFF to +10dB.

	— Pan: Provides panning across Bus Send destinations.

Uses for Pre- fader Routing
One common use of pre-fader sends is for cue mixes to ADR or voice over talent, where the 
artist wants to hear a completely different mix than the control room mix. Using pre-fader 
sends and setting up a complete mix to a bus that feeds the headphone system allows a 
mix that is completely independent.

Pre-fader sends can also be used for special creative effects that might involve a dialogue 
channel being sent to a reverb plugin via a send. If the send is routed pre-fader, when 
the main channel fader is lowered to close to zero, the dialogue is still being fed to the 
reverb, so the dialogue will sound extremely reverberant (almost all of the signal is “wet”). 
Gradually raising the channel fader will make it sound like the voice is moving closer to the 
listener, changing the reverb balance and sounding more present.

Bus send levels are shown in the rectangles for each send and have the color codes assigned to 
the destination busses. 

Bus Send 
levels shown 
on the Mixer 
channel strip

Legacy Bus Sends – “Auxiliaries”
Prior to DaVinci Resolve 17, the Bus Send panel was called Auxiliaries. Any projects created prior to 
DaVinci Resolve 17 will use the legacy Fixed Busing. The only difference between the two is the use of 
“Aux” to refer to sends in the windows and titles.
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Pan
The Mixer provides access to two kinds of pan controls, depending on whether you’re doing stereo 
and surround or 3D positioning in your mix.

The Stereo and Surround Pan Controls
When working with stereo or surround, a mini Pan Indicator appears on the channel strip that 
includes visualization and control of both left/right and front/back panning: 

	— Click and drag within the Pan Indicator to adjust the basic panning position.

	— Single click to bypass panning.

	— Command-drag to adjust width.

	— Double-click to expose a large, floating Pan window with additional controls. 

	— With surround, Boom level is displayed as a horizontal blue line at the bottom of the Pan Indicator. 

The channel 
strip’s Pan 
Indicator on a 
stereo track 

The Pan Window
The Pan window’s control set depends on the mapping of the source audio track; both stereo and 
surround panning controls are available with corresponding numeric controls. You can either adjust 
panning directly within the Pan window’s control graphic, or adjust specific panner characteristics 
using the controls to the left.

The Pan control window
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The Audio Pan window contains the following controls:

	— Left/Right: Changes the balance of signal between the left and right side speakers you’re 
outputting to, depending on the speaker format you’re mixing to. Accommodates stereo output 
and larger front formats.

	— Front/Back: Changes the balance of signal between the front and back sets of speakers you’re 
outputting to, depending on what surround format you’re mixing to.

	— Rotate: Simultaneously adjusts the left/right and front/back pan controls in order to rotate a 
surround mix about the centre of the room.

	— Spread: Adjusts the left/right spread between the speakers, with a numeric scale of 1-99, where 
99 is labeled FULL and 1 is labeled PNT (“Point”). Reducing spread gradually moves the overall 
left/right positions more towards the center, until the signal is only center and has no left/right 
component (PNT). 

	— Divergence: Spreads or bleeds the signal for an individual feed across more of the adjacent 
loudspeakers, allowing the sound to be more broadly present in the sound field, with less focus 
toward a single speaker position.

	— Boom: The send level to the LFE part of the mix (the Low Frequency Extension subwoofer system).

	— On: Enables the Boom output.

	— Pre: Routes the LFE signal pre fader.

	— Only: A special hidden LFE routing mode that allows the panner to output an LFE signal only 
from the channel. To enable, option-click the Pre button.  

Boom with Only 
mode enabled

TIP: To constrain left/right position as you adjust panning, hold down the Shift key. Within 
the large Panner window, you can reset any rotary control to its default value by double-
clicking on it..

The 3D Audio Pan Controls
The regular Pan window is for stereo and conventional 5.1 and 7.1 surround panning, but 
DaVinci Resolve also supports a 3D Audio Pan window lets you do the kind of spatial audio positioning 
enabled by advanced surround formats such as Atmos, Auro 3D, and NHK 22.2. 

Option-double-clicking on the Pan control of the Mixer opens the 3D Audio Pan window.
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The 3D Pan window

The 3D Audio Pan window has a few more controls than the ordinary Pan window:

	— Pan enable: Toggles the entire panning effect on and off.

	— Panner viewer: A large 3D representation of the listener’s perceived sound stage, with a blue 
sphere that represents the position of the track’s audio being positioned within that space, which 
casts a shadow straight down on the floor and projects a blue box on the four walls of this space 
to indicate its position more concretely.

	— Front panner: A 2D panning control that represents the horizontal left/right axis and the vertical 
up/down axis, letting you make these specific spatial adjustments.

	— Side panner: A 2D panning control that represents the horizontal front/back axis and the vertical 
up/down axis, letting you make these specific spatial adjustments.

	— Top panner: A 2D panning control that represents the horizontal left/right axis and the vertical 
front/back axis, letting you make these specific spatial adjustments.

	— Left/Right: A 1D knob that changes the balance of signal between the left- and right-side 
speakers you’re outputting to, depending on what speaker format you’re mixing to.

	— Front/Back: A 1D knob that changes the balance of signal between the front and back sets of 
speakers you’re outputting to, depending on what speaker format you’re mixing to.

	— Rotate: A 1D knob that simultaneously adjusts the left/right and front/back pan controls in order 
to horizontally rotate a surround mix about the center of the room.

	— Tilt: A 1D knob that simultaneously adjusts the left/right and up/down pan controls in order to 
vertically rotate a surround mix about the center of the room.

	— Spread: Adjusts the left/right spread between the speakers, with a numeric scale of 1-99, where 
99 is labeled FULL and 1 is labeled PNT (“Point”). Reducing spread gradually moves the overall 
left/right positions more towards the center, until the signal is only center and has no left/right 
component (PNT).
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	— Divergence: Spreads or bleeds the signal for an individual feed across more of the adjacent 
loudspeakers, allowing the sound to be more broadly present in the sound field, with less focus 
towards a single speaker position. A 2D button lets you set how this is done. With the 2D button 
turned off, divergence creates a one-dimensional bleed between the left/right planes only. With 
the 2D button turned on, divergence creates a two-dimensional bleed between both the left/right 
and front/back planes of sound.

	— Boom: The send level to the LFE part of the mix (the Low Frequency Extension subwoofer system).

	— On: Enables the Boom output.

	— Pre: Routes the LFE signal pre fader.

	— Only: Allows the panner to output an LFE signal only from the channel.

Bus Assignment Buttons
To route a bus created in the Bus Assignment dialog directly on the Mixer, click the + sign to see a 
drop-down menu of all available busses.

The Bus Outputs panel is where you can route bus signals.

Legacy Mixer Bus Assignment
In the Legacy Mixer the bus assignments have two sets of buttons let you route audio from one 
channel strip’s output to Sub and Main buses that you’ve set up for your mix.

The channel strip’s Bus Assignment buttons

	— Main: These buttons let you assign a track or sub’s channels to one or more of the main busses.

	— Submix: These buttons let you assign that track’s channels to one or more submix busses.

Nested Audio Timelines
Edited timelines can be combined with other timelines by dragging the desired nested timeline onto 
an empty track in the destination timeline. This is a very powerful and useful feature. For general 
information about nested timelines, see Chapter 42, “Take Selectors, Compound Clips, and Nested 
Timelines.”
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For example, you might have created a master timeline that will contain your master mix, and you’d 
like to bring the work done on a separate timeline that is focused on dialogue editing. The dialogue 
timeline could now appear as a single nested timeline, represented as single track in the master 
mixing timeline.

Track A1, Dialogue, is a stereo representation of an edited timeline

If you want to work with the individual tracks and clips again, you can use a process called 
decompose to change that single nested timeline track back to the edited sequence. There are a 
number of options to decompose to the original set of tracks, with several bussing options available.

This image shows what was a separate, edited timeline of tracks of dialogue and is now a single track, 
A1 Dialogue, brought into the destination master mix timeline. By right-clicking the clip, a contextual 
menu allows you to decompose the track in place, back into its original tracks and clip edits. 

There are two decompose options for this. On the Fairlight page, you can Preserve Audio Data, and 
when on the Edit page, you can Preserve Audio Data as well as decompose by Using Clips Only.

Decompose in Place contextual menu

Once you’ve chosen to decompose the track into its prior Timeline elements, then the Decompose 
Preserving Audio Data dialog box appears, making several more options are available.
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Options for signal routing when decomposing a clip

There are three options when choosing to decompose a nested timeline in the Fairlight page. 
All three options preserve mix and plugin automation on the source tracks; they only differ in in 
terms of routing. The choices are:

	— New Matching Busses: All of the busses from the nested source timeline are brought into the 
current timeline as separate, new busses. These busses will have all of the processing, routings, 
settings, and automation carried over from the nested source timeline. Any preexisting bus 
routing in the destination timeline is left unaltered. 

This option is best when you want combine different mix layouts and to preserve all preexisting 
bus routing in the destination timeline, while adding the bus topology from the nested source 
timeline to the destination to create a single, larger entity. 

	— Preserve Existing Paths: This option preserves all of the master bus information in the current 
timeline and routes matching busses from the decomposed nested timeline to preexisting, 
identical busses in the destination timeline.  

This option is best when the nested source timeline and the destination timeline share the same 
bus routing structure, as might be the case of a common layout template. In this case, you just 
want to add the tracks to the destination timeline and route them to the same designations in the 
master. You still get all of your mix automation and plugins carried across as well. 

	— Leave Unassigned: This option leaves the new tracks unassigned when created, ready to be 
routed in whatever way you need.

Decomposed version of the  nested dialogue timeline 
showing the original dialogue tracks and edits
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Nested audio timelines can be very useful when managing large projects with many tracks and 
sophisticated routing. Multiple editors can be working on various aspects at one time. For instance, 
a dialogue editor could be doing the dialogue and ADR in one timeline, an effects editor can be 
designing and spotting effects in another timeline, a music editor can be cutting and spotting music 
in another timeline, all separately. Then these interim timelines can be imported later to a master 
timeline for a final main mix. 

This is also useful for picture editors who don’t want to have to deal with many tracks of audio when 
cutting picture. When working in the Edit page, when a track sequence is decomposed, it can also 
revert back to the original track layout with all of the audio clips ready to be further edited.

VCA Faders
A VCA fader is used to to control the level of multiple tracks with a single control. You can assign 
multiple faders to a dedicated VCA, and a VCA channel strip then appears at the right of the Mixer. 
VCAs let you simultaneously adjust the underlying level of multiple faders using one VCA master fader 
and can be helpful in managing the levels of complex collections of audio tracks. 

The controls for doing this are found in the VCA and 
Group label area of each mixer channel strip, which shows 
which VCA or Track Group each fader has been assigned to.

Group Labels in each 
control strip, above 
the control strip label

Making Fader VCA Assignments
You can assign any channel strip to one of 64 VCAs by right-clicking the VCA label area and choosing 
a VCA from the drop-down that appears. If a fader is already assigned to a VCA, you can choose 
“No VCA” to remove it. 

NOTE: To reduce unneeded clutter, the VCA Assignment drop-down menu will only display 
10 VCAs initially; others are added as needed. If the first 10 have all been assigned, the 
menu display will add VCAs from the available pool, one a a time.
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TIP: You can use the “Do To All Selected” keyboard 
shortcut to save time in assigning a VCA to a group 
of channels with a single click. Select the channel 
strips that you want to assign your VCA to, hold 
down the option key, then choose the target VCA 
number from the list.  Done!

Right-clicking a VCA Label 
reveals a drop-down menu that 
lets you assign faders to or 
remove faders from that VCA.

Using VCA Faders
Once you’ve assigned multiple faders to a VCA, a dedicated channel strip for that VCA appears at 
the right side of the Mixer. Making adjustments to the VCA channel strip simultaneously controls all 
the faders, solo buttons, and mute buttons of all channel strips that are members of that group, as 
seen below.

Adjusting the VCA 1 fader also adjusts the SYNC,  
VO, and Drum Hit faders that are assigned to that VCA.

When controlling faders belonging to a VCA, you can still move each individual channel strip fader 
independently to make relative adjustments. 

	— Channel strip faders only move together when you adjust the VCA fader. 

	— While the VCA fader is being moved, each individual fader’s relative offset from other faders 
controlled by the VCA is maintained. 
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For example, as seen in the screenshot above, the VCA 1 fader is moving the faders in tracks 
SYNC, VO, and Drum Hit, while each individual channel strip fader in this group maintains its offset 
from the others.

Recording Fader Automation for VCAs
You can record automation data to a VCA fader, and all faders in that VCA group will follow even 
though they’re not actually automated themselves. This makes it easy to record complex automation 
involving multiple faders when you still might want the freedom to finely adjust each individual 
fader later on.

Nesting VCAs
VCAs can also be “nested,” where one or more VCAs can be controlled by yet another VCA. 
To nest a VCA, simply assign the VCAs you want have controlled to yet another “master” VCA.

Arm, Solo, and Mute Buttons
These controls are identical to the controls found on the track header of each timeline audio track.

	— Record Arm: Enables a track for recording when the Record button on the transport is engaged 
(highlights red when enabled). 

	— Solo: Lets you mute all other tracks in order to play a track you need to focus on in isolation 
(highlights green when enabled). 

	— If Solo is enabled for multiple tracks, all soloed tracks will play, and all non-soloed tracks 
will be muted. 

	— Solo status affects rendering, so if one or more tracks are soloed, the muted tracks won’t be 
output or rendered.

	— Solo Safe: Command-Shift-click a Solo button to put it into Solo Safe mode 
(highlights blue when enabled). 

	— Channel strips set to Solo Safe always play even if Solo is enabled for other tracks. 

	— Solo Safe can be useful for effect returns busses with effects like reverb where you may want 
to hear the reverb when tracks feeding it are soloed.

	— Mute: Turning on Mute disables audio playback from that track (highlights orange when enabled). 
This affects rendering, so if one or more tracks are muted, they won’t be output or rendered.

The channel strip’s Arm, Solo, and Mute buttons

TIP: You can click a button and drag across multiple channel strips to turn that button on or 
off for multiple tracks easily.
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Fader Controls
Each track’s vertical fader lets you control the level that’s output by that track, either by using your 
mouse, or using a physical fader of your Fairlight console or third party control surface. If you’re 
working with a console, then the onscreen faders serve as a visual reference of what levels are set.

	— dB Indicator: Numerical at the top of the track indicates the volume, in decibels, 
that track is currently set to.

	— Fader: Each track’s vertical fader can be dragged with your mouse or other pointing 
device to adjust the volume of that track and perform automation recording. 
Dragging up increases volume, dragging down decreases volume. Fader handles 
turn red while you record level automation, and they turn green when automation 
has been recorded for that track.

Methods of adjusting channel faders:

	— To change level: Click and drag any fader up or down.

	— To reset the level to default level of 0 dB: Double-click a fader’s handle. This does 
not work after you’ve recorded automation for a track, unless you erase the 
automation first.

The fader area

Metering Options
DaVinci Resolve has a variety of metering options that allow you to tailor metering to your workflow. 
The settings appear in Project Preferences > Fairlight on the Audio Metering pane, but they affect 
mixer, Fairlight effects, or master metering on the Cut and Edit pages.

Level Metering Options
You can chose the response characteristic of the level meters for channel strips and Fairlight FX.

The Meter Type drop-down allows you to choose between IEC 60268-18, Digital VU, and Custom 
response characteristics. Both meter types have separate “hold and fall” metering, allowing you to see 
the highest peak that is reached.

	— IEC 60268-18: A digital PPM-type meter with reference standard of -18 dBFS, a fast response to 
peaks, and a slower release characteristic. This is the default in DaVinci Resolve and is used in all 
Blackmagic Design software and hardware products.

	— Digital VU: A dual-value meter, showing the peak level as a single segment with fast ballistics, and 
the RMS (volume unit) as a bar graph. It has a far faster quasi linear decay characteristic, making it 
easy to monitor average levels while allowing sounds with quick transients and decays to be more 
easily tracked. This option can be best for audio editing and mixing. 

	— Custom: Allows each aspect of the meter response to be chosen, including level detector, scale, 
peak, deck, and peak indication.
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Pre-fader Metering
By default, “Pre fader metering on tracks” is unchecked (disabled), setting the metering on channel 
strips to be post (after) the fader level and mute button. For example, if the source audio file has peaks 
that are hitting -2 dBFS, and the channel fader is lowered from 0 to -10, then the peaks that show on 
the meter will now be at -12. 

When pre-fader metering is on, the metering point is set to be before the fader, and is not affected by 
the fader’s position. However, the meter is affected by clip gain settings or key framing as these level 
changes occur before the clip’s signal enters the mixer’s signal path. 

With pre-fader metering, you could lower the fader to be fully off (minus infinity) and the meter will still 
read the level of the source signal. This allows you to always be aware of the source signal and what it 
is doing before being altered by mixer’s controls or processing.

Many video editors prefer to work with post-fader metering, but most audio mixers prefer to work 
with pre-fader in order to be aware of what the actual source level is at any time.

Solo and Pre-fader Metering
When pre-fader metering is enabled, soloing one or more tracks will show a lighter “ghost” version of 
meter activity on non-soloed tracks, allowing you to always see audio levels on tracks that are muted 
by the soloing process. This makes it easy to focus on tracks that are actually audible while still seeing 
activity on those that are not. 

If pre-fader metering is off (the default), when one or more tracks are soloed, no metering occurs on 
tracks unsoloed tracks. 

Pre-fader metering with light shaded meters on non-soloed tracks
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Target Loudness Level
Allows the target loudness level in LUFS for the master Loudness meters to be set to your desired 
output target level. For example, DaVinci Resolve’s default loudness standard target is -23 LUFS, 
but the YouTube target LUFS specification is -14 LUFS. If -14 LUFS is set, the “0” mark on the 
loudness meter scale moves to this level, allowing you to focus your master mix levels towards that 
loudness standard. 

Bouncing Audio
Bouncing audio refers to mixing and rendering audio from one or more Timeline tracks onto 
another track of the Timeline, in the process “baking in” processor intensive effects and complicated 
or intricate audio edits to create a new continuous piece of audio media. The bounced file is 
written to the directory location specified by the Project Settings > Capture and Playback panel > 
“Save clips to” field.

There are two commands available for bouncing audio on the Fairlight page:

	— Timeline > Bounce Selected Tracks to New Layer

	— Timeline > Bounce Mix to Track

To use Bounce Selected Tracks to New Layer:

1	 Set In and Out points to define the range of the Timeline you want to bounce. If you don’t do this, 
nothing will happen.

2	 Command-click the track headers or mixer channel strips of all tracks you want to bounce in order 
to select them.

3	 Choose Timeline > Bounce Selected Tracks to New Layer.

The audio on each track is processed and rendered and appears as the top layer of audio on that 
track. While View > Show Audio Track Layers is turned off, it will appear as if the new bounced 
audio is the only clip on that track. However, the original audio (with any unrendered clip-based 
effects) is still available as the bottom of the stack of layered audio on that track; turning on View > 
Show Audio Track Layers will reveal this. 

The bounced audio is a new audio media file that’s written to the directory location specified by 
the Project Settings > Capture and Playback panel > “Save clips to” field.

To use Bounce Mix to Track:

1	 Choose Timeline > Bounce Mix to Track. The Bounce Mix to Track window appears, showing all 
busses that are currently available.

2	 In the Destination Track column, set which mixes you want to bounce by choosing either 
New Track, or choosing a specific existing track from the drop-down menus.

3	 Click OK.

The specified mix is processed, mixed, and bounced to the specified track as a new piece of 
audio. This creates new audio media that’s written to the directory location specified by the 
Project Settings > Capture and Playback panel > “Save clips to” field.
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TIP: There’s also a Bounce Audio Effects command in the contextual menu of audio clips in 
the Timeline that have clip-based audio effects applied to them. For more information,  
see Chapter 176, “Audio Effects.”

For more information on exporting clips, ranges, and files, see Chapter 171, “Editing Basics in the 
Fairlight Page.”

Third-Party Control Panel 
Support for Mixing
DaVinci Resolve supports HUI- and MCU-compatible third-party mixing control panels with up to 
eight faders, such as the Mackie MCU Pro Control Surface, connected via USB MIDI, and selectable 
in the Control Panels panel of the Resolve System Preferences. Supported basic panel controls that 
correspond to Fairlight features at the time of this writing include the following.

Transport controls including:

	— Rewind (REW)

	— Fast Forward (FF)

	— Stop (double-press the Stop button for Home in the Timeline)

	— Play (double-press the Play button to “play again”)

	— Record (press Record+Play to begin recording if one or more tracks is record-enabled)

	— Jog control (Press SCRUB and rotate the jog wheel)

Channel Strip controls including:

	— Rotary controls for panning, with Rotary Value display and Rotary touch

	— Alphanumeric Track Name display

	— Record button to record-enable tracks (only works if an input is patched to a track input)

	— Solo, with a double-press selecting or de-selecting that track

	— Mute

	— Select to select the track corresponding to that channel strip

	— Fader control and optional Level display

	— Channel and Fader Bank buttons to move left and right among banks of channel strips

	— Double-press the Fader Bank Left button to move the playhead Home in the mixer (track 1)

	— Double-press the Fader Bank Right to move to the Master channel strips

Marker buttons:

	— Marker to add a marker

	— Pressing the Marker+Stop buttons sets Home

	— Pressing the Marker+FF/REW buttons jumps the playhead forward or backward
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Additional supported controls for control panels that have them include: 

	— Master Solo clear/restore

	— Undo (pressing the Undo+Option buttons does Redo)

	— Arrows to move the selection

	— Zoom horizontal and vertical controls

	— Audio Tracks, to turn Automation On/Off 

	— Write/Trim/Touch/Latch switches

	— Nudge controls

	— Cut, Copy, and Paste

Monitoring controls include: 

	— Level control

	— Dim

	— Mute

	— Alt Speaker

For more information on third-party mixing control panel support, see the Blackmagic Support site at 
https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion.
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Chapter 174

Mix Automation
The Fairlight page provides straightforward, flexible, and powerful 
automation capabilities for audio mixing. Automation data can 
be created graphically by drawing automation changes, or by 
recording the movement of on screen mixer or effects controls, 
using the mouse or a Fairlight control surface with physical 
controls. Once recorded, mix parameter automation for any control 
type—faders or sends, panning, or effects—can be played back in 
perfect sync with the audio on the timeline.

The Fairlight page is designed to allow the operator to automate every static and dynamic parameter 
change you make in the process of balancing the mix of tracks in the timeline. Mixer automation 
can be drawn graphically or recorded for one or multiple parameters or channels at a time. More 
adjustments may be added with each automation recording pass, letting you build complex and 
detailed mixes that can be frame-accurately replayed at will.

This chapter covers automation mixing using the combined controls of the onscreen mixer and timeline. 
For more information on basic mixing operations, see Chapter 173, “Mixing in the Fairlight Page.”

Contents

Creating Mix Automation�   3716

Drawing Automation�   3716

Recording Automation�   3716

What Can Be Automated�   3717

Why Use Track Automation?�   3717

Drawing Mix Automation�   3717

Enabling and Viewing Automation�   3717

Editing Mix Automation Curves�   3720

Using Edit Operations�   3720

Adjusting the Automation Line�   3721

Recording Mix Automation�   3723

Automation Controls�   3723

3715Fairlight  |  Chapter 174  Mix Automation



Creating Mix Automation
The Fairlight page has a comprehensive toolset for creating and editing mix automation data. You can 
either draw automation data or record mix changes, “performing” those changes by moving on-screen 
controls. Either method can produce the same seamless results. The underlying data is the same 
whether you draw in automation or record movements of controls; you can choose which method 
best suits your workflow or the task at hand.

Drawing Automation
If you’re a video editor or audio creative, in many contexts, drawing mix automation data may be 
simpler and more straightforward when you’re making static level changes or ramped level or 
switched changes to controls (like mutes), especially if don’t have the benefits of working with a 
Fairlight hardware control surface and are using a mouse. 

For example, you could select over a timeline range and mute several tracks at once, “carve out” 
fixed level boosts or drops on tracks exactly where you want them to take place to picture, or slowly 
increase the strength of a reverb effect applied to foley footsteps as a character walks into a long, dark 
cavern, all without having to play through the material to finesse a real time “performance” of your 
changes as you would if you were recording automation.

When drawing, you don’t need to pay attention to the various Fairlight automation recording modes 
or control enable/disables for whatever automation parameter type you want to create or edit; you 
can just draw or adjust automaton data in the appropriate “lane” right on the Timeline.

Recording Automation
You can also record mix automation by recording changes you make to onscreen controls and/
or Fairlight console controls in real time as the Timeline plays. Afterwards, your “performance” can 
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be accurately played back with extreme accuracy. Recording automation has real advantages over 
drawing as you’re able to perform the changes you want to hear against picture as actions occur, 
which can make the process intuitive and fast.

In this way, you can create a dynamic mix where different audio level, pan, and EQ, dynamics, and 
other audio processing settings change over time to fade music up or down against effects or 
dialogue, pan the sound effect of a car driving by from one speaker position to another, or gradually 
increase the strength of that reverb effect as your character walks into that long, dark cavern.

While the recording of keyframe automation is most commonly associated with either the onscreen 
mixer or the Fairlight console, you can also record automation using controls found in the Inspector, 
or using the controls of the Pan, EQ, and Dynamics plugin effects, thereby enabling you to record 
automation for the various audio effects that you’ve applied to a track. 

What Can Be Automated
Automation can be recorded for nearly every control in the Mixer for channel strips corresponding to 
individual tracks, track groups, or busses, including fader, sends, mute, and panning. Additionally, you 
can record automation for controls found in audio plugins that you use in your mix.

Why Use Track Automation?
If you’re a video editor, you may be more familiar with using clip-based automation to make changes to your 
audio mix, but this approach has limitations. Sometimes there are global changes you may want to make 
to a track over the Timeline, or want to adjust groups of tracks at once (see Chapter 175, “Track Groups.” ). 

And when working with time-based effects like reverb or a repeating delay, you may want to adjust 
the level of “trails” on these effects dynamically as the track evolves. For example, you may have a 
situation where a scene changes perspective from a larger space to a smaller one, and the room 
ambience or tonal quality of the dialogue needs to change immediately or over time characters move 
through the scene. 

This is where track automation techniques (whether drawing or recording the movement of controls) 
can be powerful and creatively inspiring.

Drawing Mix Automation
Automaton can be drawn in the Timeline for any parameter by globally enabling automation recording 
and playback, viewing a parameter to be automated, then drawing the automation in the Timeline.

Enabling and Viewing Automation
The Toggle Automation button, to the right of the transport controls, turns automation recording and 
playback on and off. It must be enabled to draw or record track-based automation and to see busses 
on the Timeline. 

The Automation  
Enable button
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Automation View
Audio tracks normally display an arrangement of clips on the Timeline (“Clips View”). In Clips View, 
clips can be placed or edited, and clip gain for individual clips can be adjusted (See Chapter 172, 
“Audio Clip Specific Inspector Adjustments.” ). Effects can also be added to clips, which can be managed 
in the Inspector.

Tracks can also show an Automation View, which appears when the automation button is enabled. 
When active, a drop-down menu appears under the track controls in the track header. By default, the 
menu will display “None,” indicating you are working with clips only; no automation data will appear.  

Fairlight Automation View showing “None”

Clicking on the drop-down menu allows you to choose an automation parameter to view or edit. 
Choices are included for all parameters that can be controlled on a track, including fader, sends, 
pan, mute, and built-in dynamics and EQ as well as AU or VST plugin effects. 

Fairlight Automation View menu choices

Once a parameter is chosen, the automation view changes so that the focus is on editing track 
automation data rather than manipulating clips. The clips darken and the automation data line is 
shown in light gray. When automation is drawn or recorded for the parameter, the line will change 
to bright green. 

NOTE:  When in Automation View you can still move and trim clips, but cut/copy/paste and 
delete operate on automation keyframe data only. When in Automation View, timeline-
based clip gain keyframe adjustment is not available, but overall clip gain can still be 
adjusted using Volume slider in the Audio tab of the Inspector.
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Vector-based Automation
Audio keyframe automation is vector-based, so levels will smoothly ramp between any 2 points on the 
Timeline based on the direction of the change in control value and the time between the points. 

For example, if you have a single keyframe setting fader level to 0 dB that occurs at 01:00:20:00 on the 
timeline, and then add a point at at 01:00:28:00 at -10.5 dB, the level will change smoothly between 
0 dB and -10 dB over the 8 seconds between the 2 points. 

This allows you to draw individual keyframes to quickly construct different transition shapes, such 
as fade ins or outs, with just a few points, or adjust them up or down by specific amounts quickly 
and easily. 

Creating Curves
Keep in mind that audio automation keyframes are not Bezier keyframes, so they only let 
you create a single level adjustment at that point in time. If you make a large adjustment 
with only a single new keyframe, you can end up with an abrupt level change, or level 
changes that don’t have a curve you may want (exponential changes can be particularly 
useful on fade ins or outs to get a natural result). You can create convex or concave shapes 
when drawing by adding just a few keyframes to create your curve, or you can perform the 
change exactly as you want by recording the automation (see “Recording Mix Automation” 
later in this chapter).

A fade out transition with 5 keyframes  
for an exponential shape

Track Automation Line
Audio automation on a track is represented by a line that extends over length of the Timeline, called 
the automation line, or “curve.” The level of the line can be changed by dragging, entering keyframes 
one at a time, or using the Pencil tool to draw a series of keyframes. 

Automation line for fader level showing multiple keyframes
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Sample Accuracy: Audio keyframes allow creation of precisely placed parameter changes 
on timeline tracks. On the Fairlight page, audio keyframes are sample accurate, meaning 
they can be placed at any sample location with sub-millisecond precision, allowing more 
precision than keyframe handling on the Cut and Edit pages. However, sample-accurate 
audio automation data created on the Fairlight page can be accurately played back on the 
other pages. 

Sample accuracy is important when working to picture as the location of audio events often 
does not fall on exact frame or sub-frame boundaries.

Working with Audio Keyframes on the Timeline
To draw automated changes to any audio control:

	— Enable the Automation button to see Automation View on all audio tracks.

	— On the track(s) where you want to create automation, choose the parameter you wish to automate 
in the Automation type drop-down menu in the track header.

	— Using Focus Mode’s Multi tool allows you to draw automation using the up/down arrow cursor (to 
adjust an overall curve), enter or delete keyframes one a time using modifier keys, create different 
curves depending on individual keyframe position, select and delete a range of keyframes, and more.

Adding and Deleting Individual Keyframes

Managing keyframes on the automation line is nearly identical to working with clip gain, for more 
information see Chapter 172, “Audio Clip Specific Inspector Adjustments.”

To add a keyframe:

	— Hold down the option key and a plus sign appears. Click to place a keyframe on the automation line. 

To remove a keyframe:

	— Hold down Command-option and a minus sign appears. Click on keyframe to delete it.

TIP:  You can quickly flip between Clips View and Automation View using the keyboard 
shortcut F4. This can be changed by using the DaVinci Resolve > Customization dialog.

Editing Mix Automation Curves
Using Edit Operations
Normal editing operations such as cut, copy, paste, delete, and nudge can all be used on automation 
keyframe data. When automation data is cut or deleted, the value at either end of the selection 
is preserved. 
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Nudging can be very useful when fine-tuning the location of automation events.  

Before and after cut or deletion

Adjusting the Automation Line
Once one or more keyframes are on the automation line, the resulting curve for the entire track 
can be adjusted. Individual keyframes can be edited up or down using the same techniques as with 
adjusting clip gain; the whole line can be adjusted, or a selection can be affected.

If you adjust the last keyframe on a line with multiple keyframe points, the line will change from that 
point onwards to the newly set level. 

Adjusting an individual keyframe changes the line from that point onwards

Adjusting the Entire Line
To adjust the entire line:

	— With automation view enabled, click anywhere within the track, and select all automation data on 
the curve by choosing Command-A. 

	— Position the cursor close to the line and and the dual arrow cursor appears, allowing the level of 
the entire line to be adjusted.  

Select all automation to adjust the entire line 

Adjusting a Selected Range
You can perform adjustments to only a specific range of the automation curve. This can be useful 
when you want to make “snapshot” changes for a specific scene.
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To adjust only a selected range: 

	— Use the Focus Mode Select tool (I-beam cursor) to select the range you want to affect.

	— Position the mouse close to any area of the line, and the up/down arrow cursor appears. 

	— Trim the line up or down. A tooltip will appear showing the current value and a delta to the original 
value, so any difference in a control’s value can be seen.

	— At the bounds of the selection, “bounding keyframes” are automatically created, so the level at the 
edge of the selection is preserved. 

Trimming a selected range of the automation curve

TIP:  Hold the Shift key when adjusting levels to maintain precision. When adjusting fader 
levels this allows .1 dB accuracy, even when working with small track heights.

Drawing Automation with the Pencil Tool
The Pencil tool allows automation keyframes to be drawn freely:

	— Choose the Pencil tool in the Automation toolbar, or when in Focus mode, hold down Option-Shift 
to temporarily switch to the Pencil tool.

	— Click the mouse and drag to draw keyframes in either direction. 

Automating Switched Controls 
Some automation parameters are switched (i.e., they have only fixed states). Examples of this type 
of control are mutes (on or off). When adjusting switched automation, keyframes can only be at the 
bottom end of the Automation view or the top.  

Mute automation showing on and off states
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Recording Mix Automation
Recording mix automation uses many of the same techniques as drawing but allows you to capture 
a performance where you are moving the controls you want to automate. This can be flexible and 
creative as you “perform to picture” to get the results you want.

To get started, you’ll need to ensure that Automation recording is enabled (see “Enabling and Viewing 
Automation” above) and that one or more parameters are enabled for automation recording. 

Clicking the Automation 
Controls button displays 
the Automation toolbar

Automation Controls
The Automation Controls button, to the right of the transport controls, lets you show and hide the 
Automation toolbar.

The Automation toolbar has buttons for each option that’s available for preparing to record 
automation in your mix.

Automation toolbar options

The Automation toolbar displays the following options:

	— Automation Modes: Controls how automation data is recorded.

	— Write: Records absolute changes to a control’s position, replacing any data that was there 
previously.

	— Trim: Records relative changes to a control’s position, maintaining relative existing levels 
created over time, but increasing or reducing those levels overall. This can be very useful 
when incrementally refining a mix.

	— Touch Modes: Defines what happens when an automatable control is moved during a mix.

	— Off: No automation is recorded.

	— Latch: Automation is recorded once a control is moved and continues recording after the 
control is released until the transport is stopped.

	— Snap: Automation is recorded once a control is moved and then smoothly glides back to the 
pre-existing level at the point it was released, to create a seamless transition. 

	— At the point where the glide transition ends, automation is no longer recorded unless the 
control is moved once again while the transport is playing. You can continue to capture 
additional automation with Snap until the transport is stopped.  

	— The time for the glide transition can be set in milliseconds in Preferences > User > 
Fairlight > Automation. The default is 250 ms.
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	— Snap Latch: A combination of Snap and Latch modes, where faders operate in Snap and 
all other controls operate in Latch. This can be useful when dynamically changing fader 
levels through a mix pass are desired, while other controls “stick” when they’re moved. It is 
particularly useful when working with Fairlight mix control surfaces where faders and rotary 
controls can be changed simultaneously during a mix pass. 

	— On Stop: Defines what happens when entering Stop at the end of an automation pass.

	— Event: The last recorded automation value overwrites previous levels to the start of the next 
available recorded automation data (or event) in that track.

	— Hold: Deletes all previously recorded mixing data after what you’ve just recorded, to hold the 
last recorded level for the rest of that track.

	— Return: The last recorded automation value is interpolated to ramp back to the previously 
recorded automation values on that track.

	— Enables: The following buttons let you enable or disable different controls for recording automation.

	— Fader: Automates track and bus volume.

	— Mute: Automates the mute button.

	— Pan: Automates all pan controls.

	— EQ: Automates all EQ controls.

	— Comp: Automates just the Compressor controls in the Dynamics window.

	— Gate: Automates just the Gate controls in the Dynamics window.

	— Lim: Automates just the Limiter controls in the Dynamics window.

	— Sends: Automates the Send controls in the Sends window.

	— Plugins: Automates all Fairlight, VST or Audio Unit (AU) plugins.

	— Misc: Automates Buss on/off, Insert, and Direct Out controls. If a project is using the Fairlight 
legacy Fixed Bus configuration, it allows automation of fixed bus Main and Sub bus enables.

How to Record Automation 
There are two different ways you can set up the recording of automation for levels, panning, EQ, 
Dynamics, and other audio controls in the mixer.

Recording Automation for Multiple Tracks
You can use the following steps to record automated changes to any audio control in any control strip:

1	 Open the Automation toolbar, and do the following three preparatory steps:

a)	 Choose whether you’re going to write new automation, or trim automation that’s already 
recorded. Write mode is appropriate when you’re recording automation for the first time, 
or when you’re overwriting previous automation with brand new values. Trim mode is 
appropriate when you’re making incremental changes to previously recorded automation. 
Note that Trim mode works as a delta trim system only with fader positions at zero (unity) on 
Fairlight control surfaces at this time.

b)	 Next, choose Touch and On Stop behaviors that are appropriate for the kind of automation 
recording you need to do.
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2	 Move the playhead to the beginning of the section of the timeline you want to record 
automation for. 

3	 Next, initiate playback using any method (Spacebar, L, Play button, Fairlight or third-party audio 
control surface), and make whatever adjustments you want to the controls you’ve enabled 
automation recording for. As you make adjustments, the affected fader control turns red to let you 
know you’re recording automation.

4	 When you’re finished, stop playback using any method (Spacebar, K, Stop button, third-party or 
Fairlight audio control panel). Automation recording stops as well.

Recording Automation for Specific Individual Tracks
You can use the following steps to record automated changes to controls in specifically armed 
control strips:

1	 Open the Automation toolbar, and do the following three preparatory steps:

a)	 Choose whether you’re going to write new automation, or trim automation that’s already 
recorded. Write mode is appropriate when you’re recording automation for the first time, 
or when you’re overwriting previous automation with brand new values. Trim mode is 
appropriate when you’re making incremental changes to previously recorded automation.

b)	 Next, set Touch to Off, which disables across-the-board automation recording and requires 
you to arm specific tracks that you want to automate.

2	 Click the automation arm button above the fader of any Mixer track or any track header to which 
you want to record automation. Even though the Touch control is set to off, moving a control on 
an armed channel strip will record automation in Latch mode.

The automation 
arming button above 
a fader in the Mixer

The automation arming  
button in the track header

3	 Move the playhead to the beginning of the section of the timeline you want to record 
automation for. 

4	 Next, initiate playback using any method (Spacebar, L, Play button, Fairlight or third-party audio 
control panel), and make whatever adjustments you want to the controls for which you’ve enabled 
automation recording. While you make adjustments, the affected fader control turns red to let you 
know you’re recording automation. If you’re displaying the same automation data in the Timeline 
that you’re recording, you can see the new automation being drawn in real time, in red.
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New automation line in red while being recorded

5	 When you’re finished, stop playback using any method (Spacebar, K, Stop button, Fairlight or third-
party audio control panel). Automation recording stops as well. Displayed automation turns green 
once recording has stopped.

If you don’t like what you’ve done, you can undo and start over, or you can edit the automation 
using methods described later in this chapter. Or, you can back the playhead up and overwrite 
automation at any time with new automation.

Automation Preview Mode
Preview is an additional mix automation workflow, specifically for working across scene-based 
material. When enabled, mix items that are in preview are not controlled by pre-recorded automation, 
so they respond manually to their controls. These can subsequently be placed into write (or trim) to 
write actual automation. 

Typically, Preview mode is used to audition new mix settings for one particular section of a timeline, 
while other sections already have recorded automation data. Preview mode prevents pre-recorded 
automation from moving the controls you are trying to adjust in a targeted section. As soon as you’re 
happy with the new adjustments, they can be written to the targeted section. 

Preview mode frees the faders (and other controls) from automation control, and lets you move them 
freely while you experiment with different levels and settings. Ordinarily, moving one or more controls 
implies writing automation data for those controls, but entering Preview mode lets you play with the 
controls as much as you like without committing to anything, only writing automation data when 
you’re ready. 

To engage the Preview state on enabled mix items,  
first enter Preview mode by doing one of the following: 

	— Toggle Preview in the Automation toolbar.

	— Press the Preview key on the Mix page of the Fairlight controller.

Once Preview is engaged:

	— Individual parameters can be switched into Preview Touch Latch.

	— You can use the AUTO key next to a fader to preview all enabled parameters on a channel.

	— You can use the Auto button on the screen mixer strips.

	— When you’re in Preview mode, all parameters in Preview are indicated by a 
BLUE automation indicator. 
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Once in Preview mode, mix items can be placed into write (or trim) by:

	— Dropping in manually via the Fairlight > Automation > Punch In menu choice. 

	— Dropping in manually with the In key on the Fairlight controller. 

	— Automatically using the Active In and Out points on the Fairlight controller.

Once enabled for Preview, parameters remain in that state regardless of transport starts and 
stops. This is different from putting mix items into WRITE, which must be done again after each 
transport stop. 

Other Preview-related operations include: 

	— Filling a range defined by In and Out points with all parameters currently in Preview. 

	— Gliding all parameters from their existing values at the Range In point to the Preview values at the 
Range Out point.

Automation Active Range
The Automation Active Range allows you to set only a specific range on the timeline to record 
automation to, so that everything outside of that range is “write protected” and will not be disturbed. 

	— To enable the Active Range, choose Fairlight > Automation > Active Range, where you can mark 
the Active Range In/Out points, or enable or disable the Active Range. 

	— Once a range is defined, automation writing will only take place within the range. 

	— You can set the automation mode you wish to work in (e.g., Snap). 

	— Once playback begins, all automation data produced prior to the range automatically occurs in 
Preview mode (without having to enable the Preview switch), up and until you reach the Active 
Range in point. Once inside the Active range, automation recording will start. 

	— At the end of the range, automation recording is automatically punched out. 

	— The Active Range can be disabled by unchecking Fairlight > Automation > Active Range > Enable.

NOTE:  Any controls in Read mode will playback their automation regardless of the status of 
the Active Range.

Active Range shown in the ruler with red bar; Automation data being written within the range..
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Viewing Automation in the Timeline
Once you’ve recorded automation keyframes for a particular parameter, they can be made visible in 
Automation view on a track. When automation is enabled via the Toggle Automation button, you can 
use the Automaton drop-down menu on the track header to choose which automation curve to view, 
with options for Fader, Mute, Pan, EQ, Compressor, Limiter, Aux, Plugins, and Misc controls.

Mixing automation for the Fader shown in the Timeline

Overwriting Automation
Once you’ve recorded automation for a particular clip, you can overwrite that automation in 
subsequent passes. Using either of the previously described methods of recording automation, 
adjusting the levels of a track control with previously recorded automation displays a red line that 
shows the new level relative to the previously recorded level.

Setting new levels to overwrite previously recorded automation displays a red line

Pressing play to actually record this new automation will overwrite the previous levels at this 
new value.

New automation overwrites the previous levels

Automation data can be copied, pasted, and erased under the Fairlight Menu > Automation > Copy/
Paste/Erase. 
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Automation Follows Edit
When editing your timeline, you can choose whether automation will follow the movement of clips or 
stay locked to its position. This is enabled by default but can be changed by unchecking Fairlight > 
Automation > Follows Edit. 

When enabled, anytime you move or edit a clip on the Timeline, the automation you’d written over its 
range will follow with it, ensuring that as you make changes to the edit, the automation for a given clip 
range will remain the same.

This is also extremely useful when doing an initial edit of audio clips that contain automation data. For 
instance, if you have a recurring sound effect that pans left to right, first automate that panning to the 
audio clip. When this clip is copied through the Timeline it will retain the same panning automation for 
each new instance. This can be very useful for a variety of edits that require the same automation data 
for audio clips in a timeline. 

Be aware, however, that Automation Follows Edit will need to be turned off when copying and pasting 
clips or sequences where the automation that has been applied is not relevant to the new edits.

When Automation Follows Edit is enabled, automation data “lives with” the time range it came from. 
Any of that data, like volume or panning, will travel with clips. So if a complete section has been 
removed, all of the automation inside of the clips contained in that section are also removed. If a 
section of clips changes its location in the Timeline, all of the automation embedded in those clips 
move to the new location on Timeline with the clips.

When the Automation is enabled in the Fairlight toolbar, the Automation Follows Edit button 
will appear.

The Automation Follows Edit button to the 
left of the Flag button on the toolbar

Editing Automation
When automation is enabled (Toggle Automation button is on), the Pencil tool appears. Combined with 
the Focus mode, these tools let you edit automation in different ways.

Focus mode provides the main tools 
used for editing automation. The Pencil 
appears when automation is enabled 
(Toggle Automation is on).
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Adjusting and Deleting Automation Keyframes
The Focus tools let you adjust automation in two different ways. 

Adjusting Individual Keyframes
Using the Focus tools, you can click and drag any automation keyframe up or down and left or right 
(bounded by its neighboring keyframes) to adjust it directly. When zoomed in, this can be an effective 
way of making precise adjustments. The segment of automation affected by the keyframe being 
dragged continues to show green to indicate the new curve being created, and a tooltip with the 
currently adjust value appears, while the previously created data is shown in gray. When you release 
the mouse button, the curve is adjusted

Single keyframe being adjusted showing prior level in gray

Adjusting and Deleting Multiple Keyframes
You can also use the Focus Mode Selector I-beam tool to create a selection of select multiple 
keyframes, or to move or delete them.

Use the Focus mode I-beam selector to select a range of keyframes

If you delete the keyframes in the range, the remaining section of the curve flattens out to fit the 
first and last keyframe of the selection..
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Automation curve after deleting the selected keyframes

Adding and Editing New Keyframes
See “Working with Audio Keyframes on the Timeline” earlier in this chapter for more information about 
working with drawing and editing keyframes..

Fairlight > Automation Controls
A series of commands in the Fairlight > Automation submenu let you initiate various automation tasks. 
These commands are:

	— All Read: Switches all parameters that are in Trim or in Write mode back to Read mode.

	— Punch In: When Preview mode is on, switches all parameters currently in Preview (blue) into 
Write or Trim. When Preview mode is off, this switches all Automation-enabled parameters on all 
selected channels into Write or Trim.

	— Punch Out: When Preview mode is on, switches all parameters currently in Write, Trim or Preview 
into Read. When Preview mode is off, this switches all Automation-enabled parameters on all 
selected channels into Read.

	— Fill Range: When there is an active In and Out range in the Timeline, the current value of all 
parameters in Preview will be written over that range. 

	— Glide Range: In Preview mode, “glides” all parameters from their existing values at the In point to 
the preview values at the Out point of the Timeline.

	— Join Mix: Lets you manually resume writing automation in Latch mode from the current level and 
moving to any other.

Automation – Copy/Paste/Erase
The Fairlight > Automation submenu also has special local choices for Copy, Paste, and Erase of 
automation data. Copy/Paste allows you to do powerful range-based manipulation of automation, or 
to create a “snapshot” change where all automation data is pasted for a single point in time, allowing 
all enabled parameters to switch at once to new levels. 
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Using these commands requires that you choose which automation parameters are affected explicitly 
by using the Automation Enables controls (the same ones used to choose what automation data is 
recorded). For example, if you want to affect fader, mute, and pan automation, you must activate the 
enables for those parameters first. Only the parameters enabled are affected.

NOTE:  Clip view or Automation view (any parameter) can be used with these commands; 
the choice of what is affected is governed by the Automaton Enables, not by the view.

Enables set for copy, paste, or erase of Fader, Mute, and Pan data only

	— Copy: If there is an active In and Out range in the Timeline, Fairlight > Automation > Copy will copy 
the automation data of all selected channels and enabled parameters within this range to the 
clipboard. If there is no active In and Out range, this command copies the data of all automated 
parameters on all selected and enabled data at the playhead (Snapshot mode). 

	— Paste: Pastes the active range or in point for all automation data copied to the clipboard for 
Automation-enabled parameters. 

	— If there is an active In to Out range defined, then the range will be filled with any automation 
data copied to the automation clipboard using Automation > Copy. If there is no active In to 
Out range defined, then the automation clipboard is simply pasted in its entirety. 

	— The contents of the clipboard can potentially target a different channel set and/or with a 
different target time, just by using a new in point or track selection. 

	— If there is an active In to Out range defined in the Timeline, and the clipboard was in Snapshot 
mode when the data was copied, then this range will be filled with static values of the 
snapshot data. 

	— Erase: If there is an active In and Out range in the Timeline, Erase will delete the automation data 
of all selected channels within the range, obeying all Automation Enable buttons. If there is no 
range selected, nothing is affected. 

TIP:  To clear all automation from a timeline or group of tracks, select the entire timeline 
range, enable the Automation Enable buttons for the types of automation you wish to clear, 
and choose Fairlight > Automation > Erase. Alternatively, Fairlight > Automation > Mix List 
can be used to clear all automation from the Timeline.

Automation – Mix List
The Mix List allows you to create and manage multiple mix “passes” and complete routing and effects 
setups for a single Timeline. Each stored mix can have totally different mix automation data that is 
changing over time, routing, plugin setup, track grouping, etc. 
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This capability is incredibly powerful and allows a lot of creative freedom for creating different 
versions of mixes (for example moving between stereo, 5.1, and Dolby Atmos as formats), or between 
using totally different plugin effects or different creative approaches to the mix itself using all of the 
automated parameters. 

So the Mix List’s utility is not limited to storing mix automation data; it can be used to store a dynamic 
preset of literally anything about the setup of the Mixer.

Keep in mind that the Mix List is particular to a single Timeline and also cannot be shared between 
projects. However, using the Mix List can be more convenient than saving multiple different versions 
of timelines or projects.

The Mix List can act as a floating window where you can see the various mixes, or it can be hidden 
until you need to load or save a new version. 

The Mix List Window

Using the Mix List Window
	— Set up your mix, including all routing and automation as you like.

	— When you’re ready to save a mix version, choose Fairlight > Automation > Mix List, then choose 
“Save Mix” and give it a name, along with any notes you make want to add.

	— You can then change your mix automation, any routing, etc. you wish and save a new version, load 
a different version, or delete an existing mix.

The “System” preset is an internal system preset that can’t be altered; it can be ignored.

The “New Mix” Dialog

For “New Mix” in the Mix List window, a dialog appears with the following options:

	— Cancel: Lets you cancel the operation.

	— Write All: Writes present levels of all controls to their automation curves establishing a baseline 
“snapshot” of all parameters.
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	— Empty Mix: Clears all automation data from the mix, leaving only the assignments, routing, track 
group enables, etc. This option offers a simple way to start “fresh” with a mixer setup on a new mix.

New Mix dialog

Playing Automation
After you’ve automated a mix, playing it back is as simple as moving the playhead to an area of the 
timeline prior to the recorded automation, and initiating playback. As the timeline plays, the onscreen 
controls for each automated parameter are shown in green, and move and update to show the 
recorded levels for those controls.

Controls that have recorded 
automation during playback 
are shown in green.
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Chapter 175

Track Groups
Track Groups are a way to organize and structure your project to 
make it easier to affect multiple tracks at the same time with the 
same operation.

Contents
Track Groups�   3736

Editing with Track Groups�   3736

Mixing with Track Groups�   3736

Creating and Editing Track Groups�   3738

The Mixer and Track Groups�   3739

3735Fairlight  |  Chapter 175  Track Groups



Track Groups
You can group audio tracks for editing and/or mixing tasks. When editing with a track group, any edit 
you make to one track applies to all tracks in the group (such as nudging or trimming an audio clip). 
When mixing, any changes you make to one track apply to all tracks in the group while maintaining 
relative mixer settings (such as adjusting track fader positions).

Editing with Track Groups
When editing, track groups let you switch focus from individual tracks, to smaller groups of tracks 
(2 or 3), to larger groups (for example, all tracks of a certain type, a larger multitrack sub-mix, or all 
timeline tracks).

When a group is enabled, any editing operation applies to all of the tracks in the group together. 
However, some operations that involve moving clip boundaries or trimming obey rules having to do 
with individual tracks. For example, pressing up/down arrows to navigate to the next/previous clip 
boundary obey the boundaries of the individual tracks within the group, regardless of their vertical 
position in the Timeline.

Groups can be disabled, allowing you to change focus. Smaller groups can be “nested” within a larger 
one, so if you disable a larger group(s) that contains a smaller group of tracks, any smaller group will 
continue to work.

NOTE:  In some cases, the clips in an edit group may be of differing lengths. However, 
group behavior still applies, and any trim, cut, paste operation, and the like, follows the 
group at its present boundaries.

Mixing with Track Groups
When mixing, track groups let you make changes to all group members at once, such as faders or 
send levels, mute, solo, or track arming state, and/or related automation. 

Fader and sends maintain their relative levels, preserving their absolute levels when they may “top 
out” or “bottom out” (top or bottom of their range). For example, if you have 2 faders that are part 
of a group, with one starting at +6 and the other at –7.5 (a delta of 13.5 dB), and you move the lower 
fader to +2, the first fader will show +10 and won’t change as the lower level fader is increased. As you 
decrease the group level, the offset of 13.5 dB is maintained so that the higher level fader eventually 
falls below +10 and keeps the correct offset as the group level lowers. 

NOTE:  Plugin controls cannot be added to Mix groups.

Showing the Groups List
The Groups list appears beneath the Tracks list in the Index. Closing the Index, or choosing another 
heading in the Index, will hide the Groups list.
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Groups list

Groups List Controls

Group Name: The group name or “ID” appears in this column.

Groups Switch: Toggles all groups on or off, allowing you to switch easily from working 
with groups to working with individual tracks. 

Selected Checkbox: When checked, all tracks that are members of the group are 
selected. If some members are selected, a hyphen is shown.

Action Icons on Hover: These icons only appear when hovering over the group row. 
The Tools icon accesses the Modify Groups dialog, and the Trash icon deletes the group.

The All Group
The All Group contains contains all tracks in the Timeline and mixer channels in the Mixer, making it 
easy to perform edit or mix tasks on all tracks at once. It is always present in topmost in the Groups list. 

The Selected Checkbox
When the Selected checkbox is checked on, all members of a group are selected. This makes it easy 
to add to a current group (shift-clicking to add more members and using Create Group), or to control 
routing of all selected tracks at once by holding option (Alt Windows) while assigning/de-assigning. 
For example, let’s say we have Group 1 with six tracks and Group 2 with 10. Just click on the Selected 
checkbox for Group 1 and all tracks Group 1 are selected.  Hold down Shift and click on the checkbox 
next to Group 2. Now all members for both groups are selected, and you can created a new Group 3 
that contains all members.

If only some members or a group are selected, the checkbox shows a hyphen (“-“). 

If you click on the checkbox when in the selected or partially selected state, it will turn off (no tracks in 
the group will be selected).

NOTE: The Selected checkbox operates independently of whether a group is enabled or 
disabled; it’s a separate control that is not directly tied to grouping.
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Group Key Commands

	— Enable/Disable Groups using Command + num keypad 0 key (Control on Windows).

	— You can use Command (Control on Windows) + num keypad number 1-9 to enable/disable the first 
nine groups.

	— Use Command (Control Win) + num keypad * key to toggle the special All Group.

Creating and Editing Track Groups
To create a track group, do one of the following:

	— Select one or more tracks via their track headers in the Timeline. Right-click on any track you want 
to include in the group and select Create Group. This also works in the Mixer on a channel strip.

	— Select one or more tracks via their track headers in the Timeline. Then click the Create Group icon 
in the upper-right corner of the Groups list.

Create Groups icon

In the resulting dialog, do the following:

Create Group dialog

1	 Type a name for the group. Click on the 
right of the name field to set a color for 
the group.

2	 Select which controls you want to include 
for the group (Editing, Fader, Solo, Mute, 
Arm, Sends, and Automation). Click Set As 
Default to retain your settings for creating 
groups in the future.

3	 Select tracks in the Add Channels column 
on the left, and then click the >> icon to 
add selected tracks to the group. You can 
also select tracks in the Channels Added 
column on the left and click the << icon to 
remove those tracks from the group.

4	 Click Save to save the group.

5	 The new group appears in the Groups list.

To enable (or disable) a group:

	— Select (or deselect) the group in the Groups list. Selecting a group will highlight it, 
indicating it is active. 
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To rename a group:

	— Double-click the group name in the Groups list.

	— Type the new name you want for the group.

To edit a group:

	— Hover over the group you want to edit and click on the Tools icon to bring up the Modify Groups dialog.

	— Make any changes you wish, then choose Save.

Tools icon to launch Modify Groups dialog

To delete a track group:

	— View the Tracks list/Group list.

	— Hover over the group you want to remove and click the Trash Can icon to delete.

The Mixer and Track Groups

Groups menu on Mixer channel strip

Temporary Override (“Clutch”)

When working on the Mixer, holding down Command-
Shift (Mac) or Control-Shift (Win) and moving a fader or 
faders within a group allows them to be manipulated 
independently of other group members. I.e., this is like 
suspending the group for just the faders that are “clutched.”

Group Management on Mixer Channel Strips

You can manage aspects of group operation directly on a 
mixer channel strip. Clicking on the group name area on a 
channel shows a menu that allows you to:

	— See which groups are active and which groups the 
channel belongs to. Active groups are represented by a 
check mark. 

	— Select any group in the list to make it active or inactive. 

	— Create a new group from selected channels.

3739Fairlight  |  Chapter 175  Track Groups



Chapter 176

Audio Effects
Audio plugins let you apply effects to the audio clips in your mix, 
such as echo or reverb, noise reduction, aural enhancement, 
click and pop removal, and so on. DaVinci Resolve is compatible 
with a wide variety of third-party VST and Audio Unit effects 
for audio processing, and these can then be used either in the 
Edit or Fairlight pages. 

This chapter goes through the different methods available for applying and customizing effects for 
clips and for tracks.

Contents
Elastic Wave Audio Retiming�   3741

Elastic Wave Options�   3743

Elastic View�   3743

Clearing Timing Points�   3744
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Elastic Wave Audio Retiming
Elastic Wave retiming is a fast and easy keyframe-based way of dynamically retiming audio, squishing 
and stretching different parts of a waveform to subtly retime audio playback for a variety of reasons, 
all while maintaining constant pitch. For example, if you’re using the audio from another take to 
replace that of the current take, but the performer’s timing is just a little bit different, you can use 
Elastic Audio to make small adjustments to retime the second performance to match the first.

To use Elastic Wave retiming on an audio clip:

1	 In this example, two tracks of foley effects have been recorded, and the bottom one needs to be 
retimed to match the top one.

2	 Right-click an audio clip and choose Elastic Wave retiming from the contextual menu to reveal the 
Elastic Wave retiming controls.

Enabling Elastic Wave

3	 Command-click anywhere on the clip to add speed keyframes to parts of the waveform you 
want to retime by stretching or squishing. You can also place speed keyframes to lock parts of a 
waveform you don’t want to retime.

Adding a speed keyframe with 
Elastic Wave retiming enabled
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4	 Dragging the speed keyframe to the left or right speeds up the audio on one side of the 
keyframe and slows down the audio on the other side of the keyframe, from that keyframe to the 
neighboring keyframes applied to that clip. Using an audio clip’s waveform as your guide, you 
can use multiple speed keyframes to match the waveform of one performance to the waveform 
of another, in order to make the timing match. Or, you can adjust speed keyframes freeform to 
manipulate performances or sounds for creative effect.

Adjusting a series of speed keyframes to 
retime one performance to match another

You can also drag the beginning or end of an audio clip to retime that portion of the clip going 
forwards or back to the next speed keyframe that’s been added.

5	 If you’ve made some speed keyframe adjustments, but you find yourself wishing a speed 
keyframe you created had been placed at a different position relative to the audio waveform being 
adjusted, you can hold the Command key down and drag any speed keyframe to move it closer 
to or farther away from a part of the waveform you want it to retime. This fine-tunes the audio 
retiming adjustment occurring at that point in the clip.

(Left) Before Command-dragging a speed keyframe to be closer to the 
original beginning of the sound being retimed, (Right) After
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6	 When you’re done, you can click the close button at the upper-left-hand corner to hide the Elastic 
Wave retiming controls.

To remove Elastic Wave retiming keyframes, do one of the following:

	— To remove a single speed keyframes: Right-click on a speed keyframe and choose Remove 
Speed Keyframe from the contextual menu.

	— To remove all speed keyframes and eliminate the Elastic Wave retiming effect: Right-click a 
clip and choose Reset Speed Curve.

NOTE:  All Elastic Wave retiming adjustments you make in the Fairlight page appear in the 
Edit page as variable speed effects, accessible using the Retime controls. Be aware that 
while all Elastic Wave retiming effects can appear as Edit page retime effects, not all Edit 
page retime effects can appear as Elastic Wave retiming effects on the Fairlight page.

Elastic Wave Options
The Elastic Wave context menu has three options for processing:

	— Off: Elastic Wave is not enabled for the clip (Default).

	— Voice: Focused on human speech or singing. Note that this is not a good option for other 
material.

	— General Purpose: Ideal for music and effects.

Elastic View
Elastic view shows Elastic Wave “Time Points,” which are similar, but the not the same as, Resolve 
keyframes. Keyframes represent a point in time plus a value, and Elastic Wave time points represent 
only a point in time.

When Elastic View is enabled, time points are visible on the selected clip.

Elastic Wave Time Points
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When disabled, the time points are not visible, but the info lane still shows that Elastic Wave is 
enabled with the Elastic Wave icon:

Elastic Wave disabled

Clearing Timing Points
“Timing points” are the moveable Elastic Wave control points that stretch or compress a given area of 
a clip. If you choose “Clear Timing Points,” all selected points within a clip are cleared (deleted).

Elastic Wave can operate in the Edit window where video editors may want to re-time spoken word 
performances so that when the audio is re-timed, the video follows the retiming to match. However, 
when working in the Fairlight page, re-timing of video is disabled so that you can have separate 
control of the audio file.

About Audio Plugins
There is no limit to the number of single or multiple plugins when in Flexbus mode that can be applied 
to clips and to tracks. However there is a limit of 480 when using Fixed Bus Legacy. Plugins are accessed 
via each track’s control strip, or via the Inspector which provides access to both clip and track plugins.

Fairlight FX
Fairlight FX are a DaVinci Resolve-specific audio plugin format that runs natively on macOS, Windows, 
and Linux, providing high quality audio effects with professional features to all DaVinci Resolve users 
on all platforms.

VST and VSTi 
VST (Virtual Studio Technology) is an audio plugin standard created by Steinberg. The VST standard 
allows third-party developers to create VST plugins for use within VST host applications, or to 
create VST host applications themselves. The VST plugin standard is the most widespread audio 
plugin standard in use today, with thousands of available plugins spanning the gamut from EQ and 
compression to reverb, denoising, de-essing, aural exciting, and much more.
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The Fairlight page supports VST effects from Mono to 7.1 - and beyond. These effects can be inserted 
on mono channels or Link Groups. If a stereo VST effect is inserted on a LCR, LCRS, or 5.1 Link Group, 
the left and right channels will be allocated to left and right Link Group channels automatically.

DaVinci Resolve supports VST3. VST effects are available on macOS and Windows workstations, 
but not on Linux.

VST Effects versus VST Instruments (VSTi)
A VST effect is a type of VST plugin that is used to process audio. A VST effect might be a Reverb, 
Compressor, or EQ. VST Instruments are typically used to synthesize sound or play back sampled 
audio. VSTs have rapidly replaced hardware synthesizers and dedicated samplers due to their 
flexibility, repeatability, and low cost.

Audio Units
Audio Units are an audio plugin API created by Apple. Similarly to VST, Audio Units (AU) can either 
process audio, or work as instruments. Audio Units are only available on macOS workstations.

Using Audio Plugins
Fairlight FX are pre-installed on all DaVinci Resolve installations. If you install additional VST or Audio 
Unit effects on your workstation, they appear in the Audio FX panel of the Effects Library, organized in 
separate categories.

Audio plugins in the Effects Library

You can click on the far right of any effect to flag it with a star as a favorite effect. When you do so, the 
favorited effects appear in a separate Favorites area at the bottom of the Effects Library Bin list, and it 
also appears at the top of the Effects button’s menu on the Mixer when you click the “plus” button.
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Stars indicate a flagged favorite effect; all favorites are currently filtered

Audio plugins let you apply effects to individual audio clips or entire tracks worth of audio, to add 
creative qualities such as echo or reverb, or to take care of mastering issues using noise reduction, 
compression, or EQ.

Methods of applying audio plugins to clips on the Fairlight page:

	— To apply an audio filter to a clip: Drag any filter from the Audio FX panel of the Effects Library 
onto the clip in the Timeline you want to apply it to.

	— To apply an audio filter to multiple clips: Select all of the clips you want to apply an audio 
filter to, then drag any filter from the Audio FX panel of the Effects Library onto any of the 
selected clips.

When you apply an audio plugin to a clip, a badge appears to the left of that clip’s name bar in the 
Timeline to let you know there’s an effect applied to it.

Timeline clips with audio plugins applied appear with a badge.

Methods of applying audio plugins to tracks on the Fairlight page:

	— To apply an audio filter to an entire track in the Timeline: Drag any filter from the Effects 
Library onto the track header.

Applying an audio filter to a 
whole track via the Timeline

	— To apply an audio filter to a track or bus in the Mixer: Drag any filter from the Audio FX panel 
of the Effects Library onto the clip in the Timeline you want to apply it to.

Applying an audio filter 
to a whole track via drag 
and drop to the Mixer
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	— To apply an audio filter to a track or bus using the Mixer controls: Click the plus button in the 
channel strip of the track you want to apply an effect to, and then choose a filter from the drop-
down menu that appears. All filters appear within categories to make them easier to find. If you’ve 
clicked the star button of any filters in the Effects Library to favorite them, these favorite filters 
appear at the top of the plus button’s drop-down list.

	— To copy audio filters from one mixer channel to another: Hold the Option key and click and 
drag the effect to the desired channel and slot to copy.

	— To reorder audio filters in the mixer: Click and drag the audio filter to move to the 
desired slot position.

Applying an audio filter to a whole track 
via the Mixer’s own controls

TIP:  The categories that audio filters are organized into in the Mixer can be edited in the 
audio plugins panel of the DaVinci Resolve System Preferences window. All plugins on a 
workstation are shown in the  Available Plugins list, and clicking within the Category column 
lets you use a drop-down menu with which to change categories.

To edit a clip’s audio plugins:

	— Select that clip and open the Inspector. All audio plugins applied to that clip appear in the Effects 
tab, with that filter’s controls appearing directly in the inspector.

To edit a track’s audio plugins, do one of the following:

	— Click in the background of the Timeline header to select that track, and then open the Inspector. 
Click the custom UI button for that filter to open its controls.

The custom UI button for 
audio plugins in the Inspector
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	— Move the pointer over the plugin’s name in the Effects area of the Mixer, and click on the custom 
UI button to open its controls.

The custom UI button for audio 
plugins in the Mixer

Nearly all Fairlight FX, VST, and Audio Unit audio plugins have a custom user interface that 
makes it much easier to manipulate that filter’s controls. These can be opened from within 
DaVinci Resolve.

The custom audio filter interface for iZotope RX Voice De-noise

Methods of working with audio plugins in the Inspector:

	— To rearrange the order of multiple video filters applied to a clip: Click the move up or move 
down buttons in any filter’s title bar, to the left of each filter’s Trash Can button.

	— To disable or re-enable a filter: Click the toggle button at the far left of each filter’s title bar.

	— To remove a filter: Click the Trash Can button.

	— To reset any filter parameter: Click the Reset button at the far right of the parameter 
you want to reset.

	— To open or collapse a filter’s parameters: Double-click the title bar.

	— To open or collapse the parameters of all filters: Hold the Option key down and double-click 
any filter’s title bar.

Once applied to a clip or track, audio plugins can also be keyframed or automated just like volume and 
pan settings, to create dynamic audio effects that change over time.
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Applying Audio Plugins to Buses
You can apply audio plugins to Main and Sub buses just like any other track, with which to apply any 
audio mastering effects operations you require to individual submixes, or even to an entire main.

Dealing With Processor 
Intensive Plugins
As you apply more and more plugins directly to clips in complicated mixes, you may discover you lack 
the processing power to play all audio tracks and effects in real time. When this happens, there are 
two ways you can ease the burden that audio clip effects are placing on your workstation.

Caching Audio Clips With Plugins
One quick fix is to manually enable the caching of one or more selected audio clips with audio effects 
applied to them to improve your project’s performance. Once an audio clip is cached, all plugin effects 
are “baked in” and that clip’s audio waveform updates to reflect the altered audio. Cached clips appear 
with a small badge to the right of the FX badge in the name bar of the clip.

A cache badge lets you know this 
audio clip has cached effects

This is a non-destructive operation that has no lasting effect on the source media of cached clips. 
You can still alter a cached clip’s plugin parameters whenever you want. Opening the graphical 
controls of a cached clip temporarily suspends audio caching, and when you’re finished, the clip is 
automatically re-cached and its waveform is updated to reflect the change so long as Cache Audio 
Effects remains enabled.

To cache audio effects for one or more selected clips:

	— Right-click an audio clip with a plugin applied and choose Cache Audio Effects to enable audio 
effect caching for that clip. If you right-click one of multiple selected clips, you’ll enable Cache Audio 
Effects for all selected clips at once. Once enabled, that clip will be continue to be cached (and 
re‑cached if you change the plugin’s parameters) until you manually disable audio caching.
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To disable audio caching for one or more selected clips:

	— Right-click an audio clip that’s been cached and choose Cache Audio Effects to disable audio effect 
caching for that clip.

Exporting Audio Clips With Plugins
Another way of easing the burden of audio clip effects on your system is to export the effected clip 
to another layer. This creates a new piece of audio media with the effect “baked in,” which is written 
to the directory location specified by the “Save clips to” field of the Capture and Playback panel of the 
Project Settings.

To bounce one or more selected audio clips with effects to another layer:

	— Right-click an audio clip with a plugin applied and choose Export Audio Files. If you right-click one 
of multiple selected clips, you’ll have options for what you would like exported for each selected 
clip all at once.

Exported clips no longer have editable effects, but you can always choose View > Show Audio 
Track Layers to see the original underlying clip that still has the original plugin effect applied, and 
you can unmute it, move it back up to the top, edit the effect, and export another version of the 
clip, which appears as the topmost layer.

For more information on exporting clips to files, see Chapter 171, “Editing Basics in the Fairlight Page.”
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Chapter 177

Fairlight FX
Fairlight FX are a DaVinci Resolve-specific audio plugin format that 
runs natively on macOS, Windows, and Linux, providing high-quality 
audio effects with professional features to all DaVinci Resolve users 
on all platforms. 

These audio plugins that can be used both in the Edit and the Fairlight page include a wide variety of 
plugins for repairing faulty audio, creating effects, and simulating spaces. This chapter explains what 
they do and how to use them.
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Common Controls For All Fairlight FX
Before going into the specific controls of each Fairlight FX plugin, there are some common controls 
that all plugins share, found at the top of the custom GUI window for each plugin.

Common controls for all Fairlight FX

	— Presets: A cluster of controls that let you recall and save presets specific to each plugin.

	— Add Preset button: Click this button to save the current settings of the Fairlight FX you’re 
using. A dialog box lets you enter a Preset name and click OK.

	— Preset drop-down menu: All presets for the currently open plugin appear in this menu.

	— Previous/Next preset buttons: These buttons let you browse presets one by one, going up 
and down the list as you evaluate their effects.

	— A/B Comparison: A set of buttons that lets you compare two differently adjusted versions of 
the same plugin. The A and B buttons let you create two sets of adjustments for that plugin, 
and toggle back and forth to hear which one you like better. The arrow button lets you copy 
the adjustments from one of these buttons to the other, to save the version you like best while 
experimenting further.

	— Reset: A single reset control brings all parameters in the current plugin to their default settings.

When the Automation is turned on, an automation button appears at the top right of each of the 
plugins. Automatable parameters for that effect are available in the Plugin drop-down menu for 
that track.

Automation activated and available to the Fairlight FX

NOTE:  Although Default is the preset when initially opened, many of the plugins, have 
presets already created. Reverb, for instance, has Cathedral, Concert Hall, and Studio 
presets built in. These can be excellent starting points to change, rename, and save for your 
specific needs. These new presets will also be available in the Preset drop-down menu.
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Chorus
An effects plugin. A classic Chorus effect, used to layer voices or sounds against modulated versions 
of themselves to add harmonic interest in different ways.

An animated graph shows the results of adjusting the Modulation parameters of this plugin, 
giving you a visualization of the kind of warble or tremolo that will be added to the signal as you 
make adjustments.

The Chorus Fairlight FX 

Chorus has the following controls:

	— Bypass: Toggles this plugin on and off.

	— Input Format: (Only visible when Chorus is inserted on a multi-channel track.) Lets you choose 
how multiple channels are input to the Chorus. Stereo sets separate Left and Right channels. 
Mono sums Left and Right to both channels. Left inputs the Left channel only, and Right inputs 
the Right channel only.

	— Delay: The amount of delay between the original sound and the Chorus effect.

	— Delay Time: Length of the Chorus delay lines.

	— Separation: Time separation of the delay voices.

	— Expansion: Sets L/R length differences, phase offset of modulators.
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	— Modulation: These controls adjust the low frequency oscillator (LFO) that drives the tremolo of 
the chorus effect in different ways.

	— Waveform: Specifies the shape of the LFO that modulates the rate of the Chorus, affecting 
the timing of the oscillations. There are six options for the oscillator for you to choose from:

Sine (smooth oscillations)

Triangle (sudden oscillations)

Saw1 (jerky oscillations)

Saw2 (jerky oscillations)

Square (hard stops between oscillations)

Random (randomly variable oscillations)

	— Frequency: Rate of LFO controlling the Chorus. Lower values generate a warble, higher 
values create a tremolo.

	— Pitch: Amount of frequency modulation, which affects the pitch of the Chorus.

	— Level: Depth of level modulation. Affects the “length” of the segment of Chorus that’s added 
to the sound. Low values add only the very beginning of the Chorus effect, high values add 
more fully developed Chorus warble or tremolo.

	— Feedback:

	— Amount (%): The percentage of signal fed back to the Chorus Delay Line. Values can be 
positive or negative, the default is 0 (no effect). Increasing this parameter adds more of the 
Chorus effect to the signal, lowering this parameter adds more of the inverted Chorus effect 
to the signal. At values closer to 0, only a faint bit of Chorus can be heard in the audio, but 
at values farther away from 0 (maxing at +/- 99), a gradually pronounced Chorus becomes 
audible.

	— Blend (%): Amount of feedback which bleeds into the opposite channel (Stereo mode only).

	— Output: Controls for adjusting the final output from this plugin.

	— Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to “wet” or 
processed signal. 0 is completely dry, 100% is completely wet.

	— Output Level (dB): Adjusts the overall output level of the affected sound.

3754Fairlight  |  Chapter 177  Fairlight FX



De-Esser
A repair plugin specific to dialog. The De-Esser is a specialized filter that’s designed to reduce 
excessive sibilance, such as hissing “s” sounds or sharp “ts” sounds, in dialogue or vocals. 

A graph shows you which part of the signal the controls are set up to adjust, while reduction and 
output meters let you see which part of the signal is affected and what level is being output.

The De-Esser Fairlight FX

The De-Esser has the following controls:

	— Bypass: Toggles this plugin on and off.

	— Listen to Ess Only: This checkbox at the top right lets you listen only to the ess that is being 
removed. This is very useful to determine if too much signal is being removed or if more ess 
attenuation can be applied. 

	— Frequency Range: Two controls let you target the frequency of the “s” sound for a 
particular speaker.

	— Target Frequency: A knob that lets you target the frequency of the offending sibilance. 
Sibilant sounds are usually found in the range of 5 - 8kHz. 

	— Range: switches the operational mode of the De-Esser. Three choices (from top to bottom) let 
you switch among Narrow Band, Wide Band, and All High Frequency which processes all audio 
above the source frequency.

	— Amount: Adjusts the amount de-essing that’s applied.

	— Reaction Time: Adjusts how suddenly de-essing is applied. There are three choices.

	— Slow: Equivalent to a slow attack.

	— Medium: Equivalent to a medium attack.

	— Fast: Equivalent to a fast attack.

3755Fairlight  |  Chapter 177  Fairlight FX



De-Hummer
A repair plugin with general applications to any recording. Eliminates hum noise that often stems 
from electrical interference with audio equipment due to improper cabling or grounding. Typically 
50 or 60 cycle hum is a harmonic noise, consisting of a fundamental frequency and subsequent partial 
harmonics starting at twice this fundamental frequency. 

A graph lets you see the frequency and harmonics being targeted as you adjust this plugin’s controls.

The De-Hummer Fairlight FX

De-Hummer has the following controls:

	— Bypass: Toggles this plugin on and off.

	— Listen to Hum only: This checkbox at the top right lets you listen only to the hum that is being 
removed. This is very useful to determine if too much signal is being removed or if more hum 
attenuation can be applied.

	— Frequency: Target source fundamental frequency. A knob lets you make a variable frequency 
selection, while radio buttons let you select common frequencies that correspond to 50Hz/60Hz 
electrical mains that are the typical culprits for causing hum.

	— Amount: Adjusts how much De-Hum extraction you want to apply.

	— Slope: Adjusts the ratio of fundamental frequency to partial harmonics, the adjustment of which 
lets makes it possible for various kinds of hum to be targeted. For example, a value of 0 biases 
hum extraction towards the fundamental frequency, while a value of 0.5 gives equal extraction of 
all harmonics (up to 4), and finally a value of 1.0 targets the higher frequency partials.
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Delay
An effects plugin. A general purpose stereo delay effect, suitable for tasks varying from track 
doubling, to early reflection generation, through simple harmonic enhancement. Processes in stereo 
or mono, depending on the track it’s applied to.

A graph shows the timing and intensity of the echoes generated by this plugin on each channel, and 
an Output meter displays the output level of the resulting signal.

The Delay Fairlight FX

Delay has the following controls:

	— Bypass: Toggles this plugin on and off.

	— Input Format: (Only visible when Delay is inserted on a multi-channel track.) Lets you choose 
how multiple channels are input to the delay. Stereo sets separate Left and Right channels. 
Mono sums Left and Right to both channels. Left inputs the Left channel only, and Right inputs 
the Right channel only.

	— Filters: Alters the proportion of frequencies that are included in the delay effect. When the 
Delay plugin is inserted on a Mono Channel, the Left and Right sections are replaced with a 
single “Delay” section.

	— Low Cut (Hz): A global High Pass filter.

	— High Cut (Hz): A global Low Pass filter.

	— Delay: Adjusts the timing of the delay.

	— Left/Right Delay (ms): Delay time of each channel.

	— Left/Right Feedback (%): Feedback % of the Left or Right channel back to itself. 
A negative value equates to % of feedback with a phase reverse from the original signal.

	— Feedback: Controls for adjusting the amount of bleed between channels.

	— High Ratio: Adjusts the frequency of a damping filter for the feedback signal.

	— Stereo Blend: Adjusts the proportion of signal from Left and Right channel feedback which 
feeds into the opposite channel. When the Delay plugin is inserted on a Mono channel, 
Stereo Blend control does not appear.
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	— Output: Controls for adjusting the final output from this plugin.

	— Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to “wet” or 
processed signal. 0 is completely dry, 100% is completely wet.

	— Output Level (dB): Adjusts the overall output level of the affected sound.

Dialogue Processor
The Dialogue Processor chains together six different common audio processing operations inside 
of a single plugin, each tuned to the specific needs of adjustments to improve recorded dialog. The 
specialized De-Rumble, De-Pop, De-Ess, Comp(ressor), Expander, and Excite controls each have a 
streamlined set of controls tailored to the specific types of common adjustments that may be required 
for a great sounding dialogue track.

The Dialogue Processor plugin

	— De-Rumble: Controls the frequency cut-off for the filter which can reduce or eliminate rumble.

	— Frequency: Sets the high-pass filter to frequencies between 40Hz to 235Hz.

	— De-Pop: These controls adjust the low frequency oscillator (LFO) that drives the tremolo of the 
chorus effect in different ways.

	— Frequency: Sets the filter to frequencies between 50Hz to 200Hz.

	— Amount: Sets the amount of the filter effect on the signal with lower values effecting less and higher 
values effecting more. A meter next to the amount knob shows how the signal is being effected.

	— De-Ess: These controls adjust the low frequency oscillator (LFO) that drives the tremolo of the 
chorus effect in different ways.

	— Frequency: Sets the filter to frequencies between 700Hz to 9000Hz.

	— Amount: Sets the amount of the filter effect on the signal with lower values effecting 
less and higher values effecting more. A meter next to the amount knob shows how the 
signal is being effected.

	— Compressor: These controls adjust the low frequency oscillator (LFO) that drives the tremolo of 
the chorus effect in different ways.

	— Threshold (dB): Sets the level at which the signal will start to be effects from -40dB to -8dB.
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	— Amount: Sets the amount of the compression on the signal with lower values effecting 
less and higher values effecting more. A meter next to the amount knob shows how the 
signal is being effected.

	— Fast/Slow: Determines the speed at which the effect is applied, fast or slow.

	— Expander: These controls adjust the low frequency oscillator (LFO) that drives the tremolo of the 
chorus effect in different ways.

	— Frequency: Rate of LFO controlling the Chorus. Lower values generate a warble, higher 
values create a tremolo.

	— Amount: Sets the amount of the expansion on the signal with lower values effecting 
less and higher values effecting more. A meter next to the amount knob shows how the 
signal is being effected.

	— Fast/Slow: Determines the speed at which the effect is applied, fast or slow.

	— Excite: These controls adjust the low frequency oscillator (LFO) that drives the tremolo of the 
chorus effect in different ways.

	— Amount: Sets the amount of the exciter on the signal with lower values effecting less and 
higher values effecting more. A meter next to the amount knob shows how the signal is 
being effected.

	— Female/Male: Allows for precise use on either male or female voices.

Dialogue Leveler
The Dialogue Leveler analyzes source material to detect dialogue, and then “ride down” louder areas, 
“lift up” softer areas, and lower background sounds that are not dialogue. It works without typical 
dynamics processor “pumping” (compression/limiting) or other obvious side effects, and produces 
results similar to detailed manual clip gain adjustments or by carefully “riding” the track with fader 
automation. Dialogue Leveler can often “fix and mix” a recording with a single boom mic where one 
character is closer than another or turns away from the mic at times, and level it out so that the original 
relative dynamics are preserved  while increasing intelligibility and average level.

The Dialogue Leveler plugin
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Dialogue Leveler can be used on track audio in real time but not on live audio input. Dialogue Leveler 
can be used on any mono or stereo (or multi-mono) audio track, but it is not supported on greater-
than-stereo tracks.

Dialogue Leveler has the following controls:

	— Dialogue Leveler: Enables or disables Dialogue Leveler processing.

	— Waveform Processing display: Shows a scrolling waveform display and indicates Dialogue 
Leveler processing with a gray line. However, note that the display does not appear in the version 
of Dialogue Leveler for clip-based processing.

	— Preset Menu: The preset menu provides the following options:

	— Allow wider dynamics: This is the default, and is best for sources with wider ranging dynamic 
levels from loud-to-soft, and where the clip levels are medium to high.

	— More lift for low levels: Select this option if the source has more low level dialogue that you 
want to boost.

	— Lift soft whispery sources: Select this option if the source has whispered dialogue and 
background noise.

	— Optimize moderate levels:  Select this option if the source has wider ranging dynamic levels 
from loud-to-soft.Select this option if the source is at medium levels throughout.

	— Reduce Loud Dialogue: When enabled, louder dialogue is ridden downward on peaks and acts 
somewhat like a “perfect limiter” where you don’t have to adjust threshold or time constants. Due 
to the “near real time” aspect, analysis occurs prior to audible playback for optimal results.

	— Lift Soft Dialogue: When enabled, finds low level dialogue and lifts and evens out material that is 
more variable in level and softer, but because the process is dialogue focused, it doesn’t tend to 
raise background sounds (unless they are happening at the same time as the dialogue itself). More 
often than not, the Lift Soft Dialogue option is the most useful of the three options, as it makes less 
audible lines of dialogue more audible and naturally smooth, while not boosting background noise.

	— Background Reduction: When enabled, reduces background sounds by focusing on dialogue 
and gently removing them based on the internal presets (Preset menu).

	— Output Gain: Adjust the Output Gain by clicking and dragging on the Output Gain control or by entering 
a value in the numeric field (Output Gain control in dB with 0 to +6 dB range with .1dB resolution).

Distortion
An effects plugin. Creates audio distortion that’s useful for sound design and effects, ranging from 
simple harmonic distortion simulating an audio signal going through primitive or faulty electronics 
(such as bad speakers, old telephones, or obsolete recording technologies), all the way to mimicking 
an overdriven signal experiencing different intensities of hard clipping (think someone yelling 
through a cheap bullhorn, megaphone, or PA system). This plugin includes soft tube emulation in the 
output stage.

An animated graph shows the results of adjusting the Distortion parameters of this plugin, giving you 
a visualization of the kind of harmonic distortion, waveshaping, and clipping that will be modifying 
the signal as you make adjustments. Input and Output meters let you see how the levels are 
being affected.
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The Distortion Fairlight FX

Distortion has the following controls:

	— Bypass: Toggles this plugin on and off.

	— Filters: Two filters let you simulate devices reproducing limited frequency ranges.

	— LF Cut: Low frequency distortion shaping.

	— HF Cut: High frequency distortion shaping.

	— Distortion: Three sets of controls let you create the type and intensity of distortion you want.

	— Mode buttons: Switch the operational mode of distortion. The one to the left, Distortion, 
creates harmonic distortion. The button to the right, Destroy, is a more extreme 
polynomial waveshaper.

	— Distortion: Adjusts the amount of distortion that’s applied to the signal. Higher values 
distort more.

	— Ceiling: Adjusts the level of input signal that triggers clipping.

	— Output: Controls for adjusting the final output from this plugin.

	— Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to “wet” or 
processed signal. 0 is completely dry, 100% is completely wet.

	— Output Level (dB): Adjusts the overall output level of the affected sound.

	— Auto Level button: Applies automatic compensation for gain added to the signal due to the 
distortion being applied. Having this button turned on prevents the signal from becoming 
dramatically and unexpectedly increased, while turning it off frees you to do what you want, 
if what you want is to hear a lot of distortion.
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Echo
An effects plugin. A classic Echo effect, simulating the reflection of sounds that occur with a delay 
after the direct sound is heard. Processes in stereo or mono, depending on the track it’s applied to.

A graph shows the timing and intensity of the echoes generated by this plugin on each channel, and 
an Output meter displays the output level of the resulting signal.

The stereo Echo Fairlight FX

Echo has the following controls:

	— Bypass: Toggles this plugin on and off.

	— Input Format: (Only visible when Echo is inserted on a multi-channel track.) Lets you choose how 
multiple channels are input to the echo. Stereo sets separate Left and Right channels. Mono sums 
Left and Right to both channels. Left inputs the Left channel only, and Right inputs the Right 
channel only.

	— Filter: Alters the proportion of frequencies that are included in the delay effect. When the 
Delay plugin is inserted on a Mono Channel, the Left and Right sections are replaced with a single 
“Delay” section.

	— Low Cut (Hz): A global High Pass filter.

	— High Cut (Hz): A global Low Pass filter.

	— Feedback: Adjusts the frequency of a damping filter for the feedback signal.
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	— Left Channel: Parameters that independently affect delay on the Left Channel. When the Echo 
plugin is inserted on a Mono Channel, the Left Channel and Right Channel sections are replaced 
with a single “Echo” section with only the Delay Time, Feedback Delay, and Feedback controls.

	— Delay Time: Global Delay time for the Left Channel.

	— Feedback Delay: Echo Delay time for the Left Channel.

	— Feedback: Feedback percentage of the Left channel back to itself.

	— L > R Feedback: Percentage of Left feedback signal which feeds back to Right Channel.

	— Right Channel: Parameters that independently affect delay on the Right Channel.

	— Delay Time: Global Delay time for the Right Channel.

	— Feedback Delay: Echo Delay time for the Right Channel.

	— Feedback: Feedback percentage of the Right channel back to itself.

	— R > L Feedback: Percentage of Right feedback signal which feeds back to Left Channel.

	— Output: Controls for adjusting the final output from this plugin.

	— Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to “wet” or 
processed signal. 0 is completely dry, 100% is completely wet.

	— Output Level (dB): Adjusts the overall output level of the affected sound.

Flanger
An effect plugin, giving that unmistakable Flanger sound dating from the days of dual tape machines 
with a slight delay added to one in periodic intervals causing flanging as they got back in sync 
with one another. Typically used to add a sort of warbling harmonic interest to a signal, in a wide 
variety of ways.

An animated graph shows the results of adjusting the Modulation parameters of this plugin, giving 
you a visualization of the kind of warble that will be added to the signal as you make adjustments.

The Flanger Fairlight FX
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The Flanger has the following controls:

	— Bypass: Toggles this plugin on and off.

	— Input mode: (Only visible when the Flanger is inserted on a multi-channel track.) Lets you choose 
how multiple channels are input to the Flanger. Stereo sets separate Left and Right channels. 
Mono sums Left and Right to both channels. Left inputs the Left channel only, and Right inputs 
the Right channel only.

	— Modulation: A low frequency oscillator (LFO) used to drive the Flanger effect.

	— Waveform (Hz): Specifies the shape of the LFO that modulates the rate of the Flanger. The 
three choices are Sine (a smooth change in rate), Triangle (a jerky change in rate), and Sawtooth 
(an abrupt change in rage). Affects the timing of the warble that is added to the sound.

	— Rate: Speed of the LFO, affects the speed of the warble that is added to the sound. Low rate 
values create a slow warble, while high rate values create more of a buzz.

	— Depth: Affects the “length” of the warble that is added to the sound. Low values add only the 
very beginning of a warble, high values add more fully developed warble.

	— Width: Consists of a single parameter, Expansion, which sets Left/Right channel length 
differences, along with the phase offset of modulators.

	— Feedback: These controls determine, in large part, how extreme the Flanging effect will be.

	— Amount (%): The percentage of signal fed back to the Delay Line. Values can be positive or 
negative, the default is 0 (no effect). Increasing this parameter adds more of the Flange effect 
to the signal, lowering this parameter adds more of the inverted Flange effect to the signal. 
At values closer to 0, only a faint phase shift can be heard in the audio, but at values farther 
away from 0 (maxing at +/- 99), a gradually increasing warble becomes audible. The type of 
warble depends on the Modulation controls.

	— High Ratio: Determines the attenuation of the echo over time.

	— Output: Controls for adjusting the final output from this plugin.

	— Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to “wet” or 
processed signal. 0 is completely dry, 100% is completely wet.

	— Output Level (dB): Adjusts the overall output level of the affected sound.

Foley Sampler
The Foley Sampler is a built-in sampler that makes it easy to add sound effects that you want to play 
using a keyboard, pad, or other MIDI performance device connected to your computer, to add timed 
sound effects to sync with onscreen visuals. This plugin has been designed to simplify the process of 
recording performed audio cues on the current track to which the sampler has been added.

Setting Up the Foley Sampler
Using the Foley Sampler to record samples played with a MIDI controller is easy.

1	 Create an audio track for your sound effects or instrument recording.

2	 Drag the Foley Sampler onto the track header to assign it to that track. The Foley Sampler window 
automatically appears. The Fairlight page knows this is an instrument with no inputs to the plugin, 
so this effect is automatically patched to that track’s input, ready for recording.
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3	 If you have a MIDI controller of some kind connected to your computer and properly configured, 
it will appear in the MIDI drop-down menu at the upper-right corner of the Foley Sampler window 
(next to the Keyboard button). Choose your device from this menu, and the Keyboard button will 
highlight to show it’s enabled.

At this point, the Foley Sampler is ready to be used, but by default it has no samples loaded to play. 
The next step is to add sound effects.

Adding Sound Effects
You can add prerecorded sound effects or instruments to the Foley Sampler in the following ways:

	— Drag and drop an audio file in a supported format from the file system onto the 
Foley Sampler window

	— Drag and drop a sound effect from the Sound Library onto the Foley Sampler window

	— Click the Foley Sampler window’s Option menu and input sounds from your attached drives. 

Once you’ve loaded a sound effect of some kind, it’s automatically mapped to the top four keys of your 
instrument, starting at C2. Pressing a key or pad of your controller will play that sound.

To see the sound’s waveform, click the Sample button at the top of the Sound panel. In this example, 
there are a series of continuous footsteps recorded in a row that we can use.

A footsteps recording loaded into the Foley Sampler
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Splitting Sound Effects
It’s common to use pre-recorded library sound effects that consist of a series of recorded footsteps, 
cloth rustles, punches, or other “foleyed” sound recordings, in order to play variations of a specific 
kind of repetitive sound effect in sync to action that’s happening on screen. The Foley Sampler lets 
you do this easily.

1	 After you’ve loaded a sound effect, click the Foley Sampler window’s Option menu and choose 
Split Sample to automatically split the current sample into slices based on an analysis of its noise 
floor, and assign each slice to a set of keys or pads on your selected MIDI device. Continuing with 
the previous example, each footstep has been split and assigned to a different key.

2	 To adjust the timing of each slice of the sound effect that’s been split apart, you can click on 
the assignment text above the keyboard at the bottom of the window to see that slice in the 
Sample view.

3	 You can adjust the Range Start and Range End parameters to encompass as much or as little of 
that slice as you want to play back. 

4	 If you want a sample to loop if a note is held down, you can enable the Loop button, and then 
adjust the Loop Start and Loop End parameters to choose how much of each slice will loop.

5	 To delete slices that aren’t useful, you can select a slice you don’t like and press Shift-Delete to 
clear that slice from the virtual keyboard.

A single slice of the footsteps recording after being split in 
the Foley Sampler, with the range of the effect adjusted
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Assigning Sound Effects Manually
When you first load sound effects into the Foley Sampler, they’re automatically assigned to a series of 
notes. Each additional sound effect that you load is automatically assigned to the next series of notes 
to the right. Once all notes are occupied, additional sound effects will shuffle all previous assignments 
to the left.

You also have the option of manually assigning sound effects that you load. This is useful when you 
want to manually load a variety of different sound effects all at once (such as a combination of punch 
sounds, human grunts, and cloth rustles to use in a fight scene), and assign them to particular notes 
of your choosing.

1	 Load a sound effect you want to map.

2	 Click the Mapping button to remap the range of notes it corresponds to.

3	 Use the Low and High parameters to select a range of notes for the selected sound.

4	 You also have the option of tuning the pitch of specific sound effects, if necessary.

The Mapping controls used to assign a 
sound to a particular set of notes

Adjusting Sound Effects
If you want to customize a sample or slice further, you can select it above the virtual keyboard and use 
the controls on the Level panel to control the dynamics of audio playback, or you can use the controls 
on the Filter panel to EQ the sound.

TIP:  If a sample or slice is set to loop, you can press the Control key and click a key on 
the virtual keyboard to initiate looping, so you can hear these adjustments as you’re 
making them.

Playing and Recording Sound Effects
Once you’ve set up the Foley Sampler with sound effects you can play from a MIDI controller, 
recording those sound effects is simple. 

1	 Make sure that the “Save clips to” field in the Capture and Playback panel of the Project Settings is 
correctly set up to record to the desired storage volume, using the Browse button, if necessary.

2	 Click the R button in the track header of the audio track to which you applied the Foley Sampler, to 
put that track into Record Enable mode.
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3	 Click the Record button in the Fairlight toolbar.

4	 While Fairlight records, use the keys or buttons of your MIDI controller to play sounds in sync to 
the picture on your display. When you’re done, click the Stop button.

You should now have a recorded clip containing the sound effects you played, in sync to the picture. 
If they’re a bit out of sync, you can always use the Elastic Wave audio retiming controls to tighten the 
sync without re-recording everything.

A new clip of audio created by recording sounds played via the Foley Sampler

Frequency Analyzer
This lets you see a visualization of the levels across all frequencies of a clip or track. A Mode drop-
down lets you choose to see the full audible spectrum, or to restrict the visualization to low, medium, 
or high frequencies.

This utility tool can analyze a clip or a track’s frequencies. With this added information you can then 
use the EQ to further sculpt the audio to reduce the unwanted frequency and boost the desired ones.

The Frequency Analyzer plugin
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LFE Filter
A low-pass filter that you can apply to a FlexBus or Main that’s in a surround sound format, to feed low-
frequency sound to an LFE channel as part of a surround sound mix. The filter will exclude any sounds 
above your chosen frequency setting to the audio that is sent to a sub-woofer in the LFE channel. It helps 
keep unwanted and unnecessary audio from being sent to the sub-woofer and increases playback clarity.

A Frequency control lets you choose which low frequency range you want to include, and a Trim 
control lets you set the level of the resulting LFE channel. If it is multi-channel but has no LFE channel 
available, such as a 5.0 format, then this plugin does nothing.

The LFE plugin

Limiter
A true peak limiter that is capable of looking 64 samples ahead of the input, in order to limit the 
audio in a very smooth fashion. An Input control lets you adjust the level of the incoming signal, while 
Threshold and Release controls let you adjust the limiting that’s being done. A graph shows you an 
analysis of the audio as it’s processed, with a visual indication of what parts of the signal are being 
affected by this plugin.

It is used to detect and reduce the peaks of an audio signal so that the overall level can then be 
boosted without clipping, thus reducing the dynamic range of a given signal, similar to compression.

The Limiter plugin
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The Limiter has the following controls:

	— Bypass: Toggles this plugin on and off.

	— Input Meter: Shows the input level into the Limiter.

	— Input Level: Allows you to adjust the level incoming to the Limiter, allowing for reducing down 
to -18dB or boosting up to an additional 18dB. A Soft button, when activated, makes a more gentle 
attack to the limit amount.

	— Limit Threshold: Determines at what level the Limiter will activate and reduce the input signal. 
When set to -24dB any signal above that is limited, when set to 0 then no limiting will take place.

	— Release: Determines the speed of the Limiter’s release from the signal’s reduction, from very fast 
at the lowest setting of 0.01 milliseconds to its slowest release of 1000 milliseconds.

	— Reduction Meter: Shows the level reduction applied to the input signal.

	— Output Meter: Shows the output level after the limit.

Meter
A sample peak processing meter that’s useful for for temporarily adding a meter to a specific track 
or FlexBus. These meters are useful for instances where you want a large meter that focuses on a 
specific bus or track while you’re working. 

These meters are presented very simply, with a gray bar indicating 
level and a red peak line that holds for two seconds, which indicates 
the highest peak. A numeric reading at the top of the meter gives 
the exact level, in dB. This number continues to hold, indicating the 
loudest level measured for any given stretch of playback.

Meter can be resized by pulling from the bottom right and has the 
following controls located in the option menu:

	— Reset Peak on Play: When enabled, the numeric peak level 
is reset every time playback stops and starts again. When 
disabled, the numeric peak level persists until changed by a 
higher peak.

	— Reset: Resets the numeric peak level.

The Meter  
Fairlight FX
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Modulation
An effect plugin. General purpose modulation plugin for sound fx/design. Four effects combine 
an LFO, FM adjustment, AM adjustment, Sweep and Gain filters to allow simultaneous frequency, 
amplitude and space modulation. In conjunction with the Rotation controls, simple Tremelo and 
Vibrato effects can be combined with auto-filter and auto-Pan tools in order to provide texture and 
movement to a sound.

An animated graph shows the results of adjusting the Modulator, Frequency, and Amplitude 
parameters of this plugin, giving you a visualization of the kind of modulations that will be applied to 
the signal as you make adjustments. Output meters let you see what level is being output.

The Modulation Fairlight FX

Modulation has the following controls:

	— Bypass: Toggles this plugin on and off.

	— Modulator: A low frequency oscillator (LFO), shown in blue in the animated graph.

	— Shape: Specifies the shape of the LFO waveform that modulates the audio. Six options include 
Sine, Triangle, Saw1, Saw2, Square, Random.

	— Rate (Hz): Adjust the speed of the modulating LFO. Lower settings result in warbling audio, 
while extremely high settings result in buzzing audio the timbre of which is dictated by the 
shape you’ve selected. 

	— Frequency: Frequency modulation (FM) of a secondary oscillator, shown as 
green in the animated graph.

	— Level (%): Acts as a Dry/Wet knob controlling the amount of Frequency Modulation that’s 
applied, intensifying or easing off the effect.
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	— Phase: Since each of the four primary effects within this plugin can be applied together, along 
with the fact that modulation with level components (Tremelo/Rotation/Filter) have the ability 
to combine or cancel out one another, phase controls are available. Altering the phase of an 
individual effect allows control of such interaction (e.g., cancel out a high level change, or 
offset a cancellation).

	— Filter: Sweep and gain filters.

	— Filter (%): Acts as a Dry/Wet knob controlling the amount of filter sweep and gain to 
additionally use to modify the signal. The amount you’ve selected is previewed in a 1D graph 
to the side.

	— Tone: Adjusts the center frequency of sweep.

	— Phase: Since each of the four primary effects within this plugin can be applied together, along 
with the fact that modulation with level components (Tremelo/Rotation/Filter) have the ability 
to combine or cancel out one another, phase controls are available. Altering the phase of an 
individual effect allows control of such interaction (e.g., cancel out a high level change, or 
offset a cancellation).

	— Amplitude: Amplitude modulation (AM) of a secondary oscillator, shown as 
green in the animated graph.

	— Level (%): Acts as a Dry/Wet knob controlling the amount of Amplitude modulation applied. 
(Disabled in Ring Modulation Mode.)

	— Phase: Since each of the four primary effects within this plugin can be applied together, along 
with the fact that modulation with level components (Tremelo/Rotation/Filter) have the ability 
to combine or cancel out one another, phase controls are available. Altering the phase of an 
individual effect allows control of such interaction (e.g., cancel out a high level change, or 
offset a cancellation).

	— Ring Modulation Mode: Enables a Ring Modulation effect (where the signal is multiplied by 
the modulator, rather than modulated by it).

	— Rotation: These controls are only available when applied to a multi-channel track.

	— Rotate: Amount of Rotation applied.

	— Offset: Start offset of rotation in order to further place the signal in space.

	— Phase: Since each of the four primary effects within this plugin can be applied together, along 
with the fact that modulation with level components (Tremelo/Rotation/Filter) have the ability 
to combine or cancel out one another, phase controls are available. Altering the phase of an 
individual effect allows control of such interaction (e.g., cancel out a high level change, or 
offset a cancellation).

	— Output: Controls for adjusting the final output from this plugin.

	— Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to “wet” or 
processed signal. 0 is completely dry, 100% is completely wet.

	— Output Level (dB): Adjusts the overall output level of the affected sound.
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Multiband Compressor
A dynamics processor that compresses in highly definable frequency bands. The graph displays 
frequencies in Hertz horizontally and gain in decibels vertically. This allows for precise compression 
specific to defined frequency bands and is useful for taming only one or several parts of a signal. 

The default setting of the Multiband Compressor

Each band has dynamics control in the determined frequency ranges of Low, Med, and High and are 
adjustable by pushing the intersection mark on the graph per band or by typing in a frequency.

Bands 1 – 4: Controls for each band.

	— Threshold: Sets the maximum allowable output level. The default is –25dB. The range is from 
–50 to 0dB.

	— Gain: Can add or attenuate up to 12 dB of gain.

	— Ratio: Adjusts the compression ratio. This sets the gain reduction ratio (input to output) applied 
to signals that rise above the threshold level. The default is 1.5.0:1. The range is 1.0:1 to 7:1.

	— Limit: Limits the output amount by up to 15 dB. The default is 4.5 dB.

	— Attack: Adjusts the attack rate time constant of the sidechain detector. The default is 1.4 mS. 
The range is 0.1 to 100 mS.

	— Hold: Keeps dynamics from being triggered again until a certain amount of time has passed, 
in mS (milliseconds). Defaults to 0mS. The range is from 0 to 4000 mS.

	— Release: Adjusts how quickly the sidechain detector stops applying dynamics when a signal 
goes back below the threshold. The default is 150 mS. The range is 50 mS to 4.0 S.
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	— Master: Controls for adjusting the final output from this plugin.

	— Gain (dB): Adjusts the overall output level of the affected sound by adding or reducing 
18 dB of gain.

	— Q: Adjusts the width of affected frequencies. Lower values include a wider range of 
frequencies, higher values include a narrower range of frequencies.

Noise Reduction
A repair plugin designed to reduce a wide variety of noise in all kinds of recordings. A graph shows 
a spectral analysis of the audio being targeted, along with a purple overlay that shows what noise is 
being targeted. Two audio meters let you evaluate the input level (to the left) versus the output level 
(to the right), to compare how much signal is being lost to noise reduction. There are three default 
presets: De-Hiss, De-Rumble, and De-Rumble and Hiss.

The Noise Reduction Fairlight FX in action

Noise Reduction has the following controls:

	— Bypass: Toggles this plugin on and off.

	— Listen to Noise Only: This checkbox at the top right lets you listen only to the noise that is being 
removed. This is very useful to determine if too much signal is being removed or if more noise 
attenuation can be applied.

	— Threshold (in dB): Relates to the signal-to-noise ratio (SNR) in the source recording. Recordings 
with a poor signal-to-noise ratio will require a higher threshold value, resulting in more noise 
reduction being applied.

	— Attack (in ms): Primarily useful in Auto Speech mode, this controls the duration over which the noise 
profile is detected. Ideally, the attack time should match the variability of the unwanted noise. A low 
value corresponds to a faster update rate of the noise profile and is useful for quickly varying noise; a 
high value corresponds to a slower update rate and can be used for noise that’s more consistent.

	— Sensitivity: Higher sensitivity values exaggerate the detected noise profile; the result is that more 
noise will be removed, but more of the dialogue you want to keep may be affected. 
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	— Ratio: Controls the attack time of the signal profile relative to the attack time of the noise profile. 
A faster ratio detects and preserves transients in speech more easily, but the resulting speech 
profile is less accurate. 

	— Frequency Smoothing: Smooths the resulting signal in the frequency domain to compensate for 
harmonic ringing in the signal after the noise has been extracted.

	— Time Smoothing: A toggle button enables smoothing of the resulting signal in the time domain as well.

	— Dry/Wet: A percentage control of the output mix of “dry” or original signal to “wet” or processed 
signal. 0 is completely dry, 100% is completely wet.

	— Level: To let you compensate for level that may be lost due to the noise reduction operation 
you’re applying, this applies a pre-gain in, from -6dB to +18dB, just before the dry/processed mix. 

Phase Meter
Phase cancellation is a phenomena where the waveforms of a stereo recording (for example a stereo 
recording of a music performance) go slightly out of sync with one another for whatever reason, 
and begin to cancel one another out in unpredictable ways, resulting in the audio sounding strange. 
This results in poor quality audio and can cause problems when you’re trying to compress a mix to a 
distribution format such as AAF or MP3. 

The Phase Meter plugin is a visual meter that lets you evaluate whether or not a signal is in phase 
and is meant to be applied to a bus so you may evaluate the phase of a mix and correct whatever 
problems may be occurring. The position of a green dot within a horizontal meter indicates the phase 
of the signal. When there’s no signal or a signal on only one half of a stereo bus, the dot appears in the 
center (0). When the signal is out of phase, the dot appears all the way to the left (–). When the signal is 
in phase, the dot appears all the way to the right (+).

The Phase Meter plugin

Pitch
An effects plugin that shifts audio pitch without altering clip speed.

The Pitch Fairlight FX
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Pitch has the following controls:

	— Bypass: Toggles this plugin on and off.

	— Semitones: A “coarse” adjustment that can shift audio pitch up to +/- 12 semitones.

	— Cents: A “fine” adjustment that can tune audio pitch in +/- 100ths of a semitone.

	— Dry/Wet: A percentage control of the output mix of “dry” or original signal to “wet” or processed 
signal. 0 is completely dry, 100% is completely wet.

Reverb
A spatial simulation plugin, capable of recreating multichannel reverberation corresponding to 
rooms of different sizes, adjustable via a graphical 3D cube control. This plugin lets you take a “dry” 
recording and make it sound as if it’s within a grand cathedral, an empty room, a tiled bathroom, or 
other spaces.

To understand this plugin’s controls, it helps to know that the signal follows three paths which are 
combined to create the final effect:

	— A direct path.

	— An early reflection path (ER) simulating early reflection rays obtained from the first multiple 
reflections on the walls, traveling from the virtual source to the virtual listener.

	— A late reverberation path (Reverb) simulating the behavior of an acoustic model of the room.

A graph shows an approximate visualization of the reverb’s effect on the frequencies of the 
audio signal.

The Reverb Fairlight FX
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Reverb has the following controls:

	— Bypass: Toggles this plugin on and off.

	— Room Dimensions: By controlling the size of the virtual room a sound is to inhabit, these 
parameters simultaneously control the configuration of Early Reflection and Late Reverberation 
processing. The acoustic modes from this simulated room are computed and fed to Late 
Reverberation processing. The shape, gain, and delay of the first reflections are computed and 
then fed to Early Reflection processing.

	— Height, Length, Width: Defines the dimensions of the reverberant space, in meters.

	— Room Size: The calculated Room Width x Length, in meters.

	— Reverb: Additional controls that further customize the configuration of Early Reflection and Late 
Reverberation processing.

	— Pre Delay: Increase or negate the propagation time from the virtual source to the virtual 
listener. As a result, it modifies the initial delay time between the source signal and the 
first reflection.

	— Reverb Time: Decay time of the Reverb tail. It controls the overall decay time of the acoustic 
modes from late reverberation processing. 

	— Distance: Modifies the distance between the virtual source and the virtual listener. It modifies 
only the configuration of early reflections processing.

	— Brightness: Modulate the shape of the decay time over frequency. At maximum brightness, 
decay time is identical at any frequency. At minimum brightness, higher frequencies result in 
shorter decay time and therefore duller sound. 

	— Modulation: Adds random low-frequency phase modulation from the tapping point of 
ER processing. At 0%, modulation is not used.

	— Early Reflection Tone: Four post equalization controls modify the tone of early reflections to suit 
a particular room’s characteristics.

	— Low Gain: Amount of gain added to the low frequency.

	— Low Frequency: Frequency range of 150 Hz to 500 Hz.

	— High Gain: Amount of gain added to the high frequency.

	— High Frequency: Frequency range of 1k Hz to 16k Hz.

	— Reverb Tone: Four post equalization controls modify the tone of the reverb tail to suit a particular 
room’s characteristics.

	— Reverb Tail Low Gain: Amount of gain added to the low frequency.

	— Reverb Tail Low Frequency: Frequency range of 150 Hz to 500 Hz.

	— Reverb Tail High Gain: Amount of gain added to the high frequency.

	— Reverb Tail High Frequency: Frequency range of 1k Hz to 16k Hz.

	— Output: These controls recombine the three audio processing paths into a single output signal.

	— Dry/Wet: A percentage control of the output mix of “dry” or original signal to “wet” or 
processed signal. 0 is completely dry, 100% is completely wet.

	— Direct Level: The amount of the direct level to mix into the final signal.

	— Early Reflection Level: The amount of early reflection to mix into the final signal.

	— Reverb Level: The amount of reverb to mix into the final signal.
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Soft Clipper
The Soft Clipper is a limiting processor that reduces the output level above a defined threshold in 
a rounded manner so that peaks are more cleanly attenuated. The Soft Clipper plugin will impart 
saturation effects when pushed hard above the threshold, allowing for the introduction of warmth 
and subtle distortion to the sound. A graph shows the shape of the curve adjustment this plugin 
makes to the audio.

A soft clipper is often combined with a standard limiter in order to increase perceptual loudness of 
material without imparting harshness.

The Soft Clipper Fairlight FX

	— Threshold: Introduces input gain to the signal prior to hitting the clipper, forcing audio peaks 
over the threshold by that amount. As such, it will drive the saturation and distortion.

	— Shape: The shape of the clipper can be varied to change the character of the soft clipper from full 
soft-clipping (all the way right, where the peaks are rounded) to full hard-clipping (all the way left, 
where the peaks are squared off). 

	— Output Level: Lets you adjust the output gain to compensate for signal lost during soft clipping, 
if necessary.

Stereo Fixer
A simple plugin designed to fix stereo source material in cases where only one side of a stereo signal 
was recorded, where one side of a stereo recording is a different level to the other, or where the 
stereo channels have been incorrectly Left/Right swapped.

This plugin can also be used as a “Mid/Side” decoder, for recordings that were made using this 
microphone technique. 

This plugin is for stereo clips only.
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The Stereo Fixer Fairlight FX

	— Format: The input processing mode you want to use to fix the stereo output.

	— Stereo: (Default) No format conversion is performed.

	— Reverse Stereo: Swaps the Left and Right side.

	— Mono: The output from the plugin is a mono mix of the two inputs.

	— Left Only: The left input is sent to both left and right outputs.

	— Right Only: The right input is sent to both left and right outputs.

	— M/S: The left output is the left (Mid) input minus the right input (Side). The right output is the 
left (Mid) input plus right input (Side).

	— Left/Right Gain: Lets you apply independent gain on the left or right outputs. This gain is applied 
after (post) the input processing mode.

TIP:  For a comprehensive M/S decoder solution, simply chain two Stereo Fixer plugins 
together. Use the first unit to control the Side signal level, thus controlling the width of the 
second unit (set to M/S).

Stereo Width
An enhancement plugin that increases or reduces the spread of a stereo signal in order to widen or 
reduce the separation between channels. If this plugin is added to a Mono channel, it will be disabled, 
as there is no stereo width to either distribute or control.

A graph shows the currently selected width of stereo distribution as a purple arc, while inside of that 
graph a stereo meter shows the Left and Right distribution of the audio signal. Two audio meters 
measure levels, an Input meter to the left, and an Output meter to the right.
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The Stereo Width Fairlight FX in action

Stereo Width has the following controls:

	— Width: Lets you control the spread of the stereo output. Settings range from 0 (Mono) to 1 
(Stereo) to 2 (extra wide stereo).

	— Diffusion: Adds more complexity to the output.

	— Sparkle: Adds more high frequencies to the spread.

Surround Analyzer
The Surround Analyzer is a graphical meter that shows a spatial image of the audio being measured, 
rather than a typical bar graph meter. Due to its changing shape because of the signal being played, 
sometimes it is referred to as the “jellyfish meter.”

This type of metering is very useful; rather than relying on bars to indicate the directions in which 
audio is radiating, you can clearly see the relationship of all of the channels to one another.

The signal here is radiating more to the 
right, indicating the panning of the audio.
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Vocal Channel
An enhancement plugin for general purpose vocal processing consisting of High Pass filtering, 
EQ, and Compressor controls.

Side by side EQ and Dynamics graphs are presented above the controls. An output audio meter lets 
you monitor the final signal being produced by this plugin.

Vocal Channel has the following controls:

	— High Pass: Enabled by a toggle, off by default. Has a single frequency knob that sets the threshold 
below which frequencies are attenuated to reduce boominess or rumble.

	— EQ: A three-band EQ for fine tuning the various frequencies of speech, enabled by a toggle, 
including Low, Mid, and High Mode, Frequency, and Gain controls 

	— Low/Mid/Hi Mode: Lets you choose from different filtering options to use for isolating a 
range of frequencies to adjust. Different bands present different options.

	— Low/Mid/Hi Freq (Hz): Lets you choose the center frequency to adjust.

	— Low/Mid/Hi Gain (dB): Lets you boost or attenuate the selected frequencies.

The Vocal Channel Fairlight FX

	— Compressor:

	— Threshold (dB): Sets the signal level below which compression occurs. Defaults to -25dB. 
The range is from -40 to 0dB. 

	— Reaction: Adjusts how quickly compression is applied when a signal exceeds the threshold. 
The default is 0.10.

	— Ratio: Adjusts the compression ratio. This sets the gain reduction ratio (input to output) applied 
to signals which rise above the threshold level. The default is 1.5:1. The range is 1.1 to 7.0.

	— Gain (dB): Lets you adjust the output gain to compensate for signal lost during compression, 
if necessary.
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Voice Isolation
Voice Isolation is a plugin that can remove loud, undesirable sounds from existing voice recordings. 
This effect utilizes AI to provide models that let you completely remove undesired sounds. The AI 
model is trained for any type of human voice, male or female, young or old, so you can get incredible 
results that isolate dialogue from background sounds in a recording—including everything from air 
conditioning or fans to extremely loud sounds like a jackhammer, restaurant background noise, or 
music playing at the same time that the subject is speaking, and so on).

Voice Isolation can be used on track audio in real time but not on live audio input. Voice Isolation can 
be used on any mono or stereo (or multi-mono) audio track, but it is not supported on greater-than-
stereo tracks.  

The Voice Isolation plugin

Voice Isolation has the following controls:

	— Amount: Lets you adjust the amount of voice isolation processing.
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Chapter 178

Audio Meters and 
Audio Monitoring
The Meters panel, which appears at the top of the Fairlight page 
when it’s enabled, provides a visual reference of the levels of each 
track in your mix, along with specialized meters showing the busses, 
monitoring mix, loudness, and a Viewer for seeing the video of the 
current project as you work. 

This chapter describes the use of these meters, and provides information about the different options 
that are available.

Contents
The Monitoring Panel�   3784

Track Meters and Monitoring Controls�   3784

Bus Meters�   3785

Meter Plugin�   3786

Surround Analyzer�   3786
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The Monitoring Panel
Turning on the meters in the UI toolbar displays the Monitoring panel that runs along the top of the 
Fairlight page, which shows all of the audio meters that correspond to the tracks in the Timeline, as 
well as the Bus meters that correspond to the Mains, Subs, and Aux busses of your mix, the Control 
Room meters, and a video viewer.

The Monitoring panel

Double-clicking anywhere on the Tracks panel of the meters hides or reveals a double-height Track 
display. With the increased track counts necessary for immersive audio, the extra metering allows you 
to see more tracks display in real time.

Hovering a mouse below the Tracks panel shows a cross-hairs that allows you to resize the Monitoring 
panel to fit a particular need for viewing. 

The Compound meters and the Bus Output meters can also be resized by hovering on the right side of 
the Loudness meter and dragging to the desired dimensions.

The double-height Monitoring panel

Track Meters and 
Monitoring Controls
At left, a row of audio meters corresponds to the channel strips of the Mixer, one meter for every 
audio track in the timeline. Each track displays the number of meters that corresponds to that track’s 
audio mapping, with mono tracks having a single audio meter, stereo tracks having two, 5.1 tracks 
having six, and so on.
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Each track and bus meter (with the exception of the Loudness meters) display RMS (root mean square) 
levels against a dB scale. A single line indicating the maximum value at any given moment in time is 
held briefly just above the current RMS levels, which appear as a solid bar extending from the bottom 
of the meter. RMS meters display a weighted “average” representation of the audio level that’s closer 
to the way audio is actually perceived, although not as accurate in measuring perceived loudness as 
the loudness meters discussed later in this section.

Track audio meters with different 
numbers of meters depending 
on that track’s audio mapping

The peak  
meter  
at top 

Each meter bar is color coded to indicate three different sound level “zones,” from low to medium 
(green) to moderately high (yellow) to very high (red).

Each meter is identified by the track number it represents (track names are not shown over track 
meters) as well as the color of that track.

Bus Meters
To the right of the track meters are the bus meters, in which all user-created mains and busses 
appear, separated by type, and each displaying the number of meters that corresponds to that track’s 
audio mapping. These meters allow you to monitor the sum of all tracks that have been routed to a 
particular bus, as you can on bus channel strips.

Bus meters for 
the Mains, Subs, 
and Aux busses
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Meter Plugin
There is a Meter plugin available for temporarily adding a meter to a specific track, FlexBus, or when 
using fixed busing to Sub, Aux, or Main. These are sample peak processing meters that are useful for 
instances where you want a large meter that focuses on a specific bus while you’re working. 

These meters are presented very simply, with a gray bar indicating level and a red peak line that holds 
for two seconds, which indicates the highest peak. A numeric reading at the top of the meter gives the 
exact level, in dB. This number continues to hold, indicating the loudest level measured for any given 
stretch of playback. The option menu in this meter’s floating window presents different settings you 
can choose. For more information, see Chapter 177, “Fairlight FX.”

The Meter Fairlight FX The signal here is radiating more to the 
right, indicating the panning of the audio.

Surround Analyzer
The Surround Analyzer is a graphical meter that shows a spatial image of the audio being measured, 
rather than a typical bar graph meter. Due to its changing shape because of the signal being played, 
sometimes it is referred to as the “jellyfish meter.”

This type of metering is very useful; rather than relying on bars to indicate the directions in which 
audio is radiating, you can clearly see the relationship of all of the channels to one another.
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Compound Meters and 
Output Bus Selection Menu
The compound meters, to the right of the bus meters, consist of Control Room meters and Loudness 
meters, shown side-by-side to provide a comprehensive analysis of your overall audio mix. Below, 
drop-down menus let you choose which bus you want to monitor, as well as which set of speakers you 
want to use to do the monitoring.

The Control Room 
meters (at left) 
and Loudness 
meters (at right)

Monitoring Menus
Bus Monitoring Menu
The bus monitoring drop-down menu determines which bus is monitored by your audio output 
(speakers or headphones), and thus which gets analyzed by the compound meters, letting you choose 
which bus you want to monitor as you work. You can choose one of your mains or any other bus (or 
track) you’ve set up that you want to focus on for more detailed work.

The monitoring menu 
lets you choose which 
bus you want to monitor 
while working

Speaker Set Monitoring Menu
To the right of the Monitoring menu, the output is set to “Auto” by default (if you have Automatic 
speaker configuration checked on in Preferences > Video and Audio I/O > Audio I/O). This means 
that your basic speaker set up is routed to the stereo or surround output your hardware supports 
automatically and can’t be altered. 

Monitoring with Multiple Speaker Sets

If you want to manually configure multiple speaker sets, unchecking the automatic speaker 
configuration preference will display a drop-down to the right and lets you choose one of the available 
sets of speakers once they have been configured in the Video and Audio I/O panel of the System 
Preferences. This gives you the flexibility to quickly compare your mix on a variety of speakers and 
configurations to see how it holds up in different situations. 
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For more information on configuring different speaker setups, see Chapter 4, “System and User 
Preferences.”

The monitoring menu 
lets you choose which 
bus you want to monitor 
while working

Control Room Meters
The mustard-colored Control Room audio meters show the sum of all audio channels that are routed 
to the currently selected bus being monitored (as selected in the drop-down menu below). These are 
peak meters measured in dBFS.

A true peak audio measurement is displayed at the top of the Control Room meter.

Loudness Meters
The set of meters all the way to the right are the Loudness meters, which consist of a set of two 
graphical meters and a numerical readout. This lets you keep track of the “integrated loudness” of the 
overall mix, which is the standard that all contemporary mixing specifications refer to when specifying 
client deliverables. Unlike the RMS audio meters found in the Timeline or Mixer, which measure audio 
in dB, Loudness meters do a different kind of analysis, measured in LUFS (loudness units relative to 
full scale).

What Is LUFS?
LUFS measurements evaluate sound levels that are averaged over time referenced to full 
scale. Full scale is the loudest level a digital audio system can handle before overloading 
(“clipping”). LUFS allows totally different types of program material to be matched in 
perceived level by human ears and has become the standard way that mixes are measured 
for final delivery of your program material. LUFS are shown as negative numbers, such as 
-23, -14, etc., because the level is referenced to full scale (digital 0). 

Loudness Meter Options
Two options in the General Options of the Project Settings let you customize the Loudness meters. 

	— Target Loudness level: Lets you set the LUFS value that’s used as a reference level for loudness 
metering. Defaults to –23 LUFS, which conveniently makes the display of these meters scale 
similarly to traditional audio meters that you’re already used to.

	— Loudness Scale: Lets you choose which scale you want to use with which to measure the meters. 
Options currently include the default of EBU +9 Scale (–18 to +9), and EBU +18 Scale (–36 to +18).
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Support for Multiple Loudness Standards
The Loudness Meter can be switched among a variety of international industry-standard loudness 
monitoring standards. The standard you choose uses the integrated loudness value (along with a 
specified tolerance defined by each selected standard) to indicate whether or not the current mix level 
is of acceptable loudness via color coding of the Integrated Loudness value, and in the Integrated 
Loudness graph described below. Blue values indicate loudness levels that are below tolerance, 
yellow indicates loudness values that are within tolerance, and red indicates loudness values that 
are above tolerance.

The built-in standards you can switch among include the following:

	— BS.1770-1: An older loudness standard used by DaVinci Resolve version 15 and before.

	— BS.1770-4: The most up-to-date loudness standard as of DaVinci Resolve 16; the algorithms 
specified by this standard govern the other standards that are listed below in this drop-down menu.

	— ATSC A/85: The American standard for acceptable loudness in broadcast.

	— EBU R128: The European standard for acceptable loudness in broadcast.

	— OP-59: The New Zealand and Australian standard for acceptable loudness in broadcast.

	— TR-B32: The Japanese standard for acceptable loudness in broadcast.

	— AGCOM 219: The Italian standard for acceptable loudness in broadcast.

	— NETFLIX: The Netflix standard for acceptable loudness in broadcast.

All of these loudness standards are available for off-line readings as well, using the Loudness Analyzer 
described in the next section.

NOTE:  The target peak meter now uses the BS.1770-4 standard for measuring maximum 
“true peak,” which means that this meter is capable of measuring “inter-sample peaks,” 
rather than only the peaks at each sample of a waveform.

Graphical Loudness Meters
Two separate meters give you a dynamic graphical measurement of the loudness of the selected 
bus being monitored according to the loudness standard you’ve selected, which determines how 
to analyze the subjective loudness of a given audio mix for purposes of compliance with required 
broadcast quality control (QC) standards.

	— A steel-blue meter labeled M (for momentary) has as many channels as the selected bus you’re 
monitoring, excluding the LFE channel(s) of surround formats, which aren’t factored into loudness 
metering. This meter measures LEQ (equivalent sound level), within a 400ms window following the 
playhead as measured every 100ms. This lets you evaluate the LUFS (Loudness Units Full Scale) 
level of the mix at the current frame as you play. This discrete-channel analysis is used to calculate 
all other values of the loudness metering system.

	— A second steel-blue mono meter to the right displays the sum of all channels in the M meter, 
displayed in LU (loudness units). The number value displayed at the top of this meter is the 
maximum LU value that’s been analyzed during any stretch of timeline playback. This value is held 
until it’s reset, either by stopping and initiating playback a second time while Link to Playhead is 
enabled, or when you click the Reset button at the bottom of the loudness meter area.
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Numeric Loudness Meters
A set of values to the right of the meters give running reports on the audio level of your mix. While 
the graphical meters are useful for analyzing your mix as you work, these numeric readouts are 
particularly valuable for providing the strict information you need to adhere to written QC standards. 
Their meaning is as follows:

	— Short: Measures the average LU level over a 30-second window following the playhead.

	— Short Max: Shows the maximum level over the same 30-second window. This analysis is required 
by EBU R128.

	— Range: Measures the dynamic range of the Loudness of your mix (in LU, or loudness units), 
which is the difference between the average soft and average loud parts of your mix. Analyzes 
the overall loudness over a played range of the mix, discounts the lowest 10% and highest 5%, 
and then gives a standardized expression of the difference between the remaining soft and loud 
levels that were analyzed. The window of analysis is as long as you’ve been playing. This analysis is 
required by most QC specifications.

	— Integrated: Measures the LUFS value of the portion of the range of the mix you’ve played through. 
As you play, this integrated value accumulates. This analysis is required by most QC specifications.

Absolute Scales and Dialog
While some users prefer to measure their levels to correspond to a relative scale of “0,” similar to a VU 
meter where the needle rides above the “0,” others want to see the absolute measure of the amplitude 
in LUFS and true peak. By default, the Loudness meter is set to relative scale, but you now have the 
option to choose between relative scale and absolute scale in the Loudness meter. 

Relative scale in the Loudness menu is relative to the selected scale, so a loudness unit of 0 
corresponds to the target of the chosen measure type. For instance, if EBU R128 is selected, whose 
target measure is -23dB LUFS, the “0” LU (Loudness Unit) is -23dB. If ATSC A/85 is chosen, whose 
target is -24dB, then that becomes the corresponding equivalent of the relative LU of 0.

When using the absolute scale, the Loudness meter displays the increments to reflect the the chosen 
measure type. In absolute scale the EBU R128 meter will display -23 instead of the relative scale’s 0.

The option in the Loudness panel reveals the various measure 
types as well as the option for absolute scale.
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Using the Loudness Meters
When using the Loudness meters to do a structured analysis of your mix to determine QC adherence, 
a group of controls let you determine when analysis begins and ends.

	— Lock Metering to Transport: This setting is found in the compound meter option menu. When 
enabled, all loudness metering analysis is automatically reset whenever you move the playhead 
to another location in the Timeline. This is useful when you’re spot-checking different parts of 
your mix, or working on a particular scene. Uncheck this option if you want the measurement of 
playback to that point in the Timeline to remain.

	— Absolute Scale: An absolute measure of the selected scale type.

	— Pause and Reset buttons: When you’re doing a formal analysis of your mix, the Reset button 
lets you reset all currently accumulated analyses, and the Start button initiates loudness value 
accumulation. If you need to stop playback briefly to do something else, you can click Pause, and 
then click Resume when you’re ready to continue the analysis.

Offline Loudness Analyzer
Users also have the ability to analyze an audio file’s loudness offline. This is a fast way to measure 
loudness in imported audio files or bounced mixes. 

To initiate offline loudness analysis:

	— Right-click the file in the Timeline, and choose Analyze Audio Level from the contextual menu. 
A dialog box displays the available options for measurement. 

All of the measurements available in the real-time loudness meter are accessible in the drop-down menu 
inside the Analyze Audio Level panel. When the analyzer mode is chosen, the target measurements for 
that mode will display next to the reading in parenthesis. Once you have clicked the analyze button, the 
results will display in the panel next to the chosen mode’s target measurement values.

Select the audio file, 
choose the desired 
analyzer mode, in 
this case EBU R128, 
and click analyze.

Visualizing Loudness Monitoring
When you show the track of a Main bus in the Timeline, as long as the track is high enough (ahem, tall 
enough), you can show or hide a series of “Loudness History” curves to visualize the loudness analysis 
of the mix on that bus over the duration of the mix. 

The available curves are:

	— Integrated: A thick curve shows the averaged “integrated” loudness analysis of the current mix, 
which is a measurement that’s taken from the beginning to the end of playback. This graph is the 
primary gauge of whether or not measured loudness is acceptable. The color of each segment 
of this curve indicates whether that part of the mix is “to spec.” Blue indicate loudness levels that 
are below tolerance, yellow indicates loudness values that are within tolerance, and red indicates 
loudness values that are above tolerance. By evaluating the colors of the curve, you can easily spot 
which parts of your mix might need adjustment to meet the necessary specification.
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	— Momentary: A measurement of the loudness measured in the past 400ms, shown by a thin 
green-blue curve, which provides an analysis of transient level changes.

	— Short Term: A measurement of the loudness of the past 3 seconds, shown by a thin blue line, 
which provides a more averaged analysis than the Momentary curve, yet still indicates the 
dynamics of the mix.

To show the loudness history for Main 1:

1	 Open the Automation controls by clicking the automation button on the Fairlight toolbar.

2	 Open the Index, and click the eye button for the Main you want to see in the Timeline. Loudness 
History appears as an option in the track header controls as long as the track is tall enough to 
show the controls. These controls will be hidden on short tracks.

3	 Turn on the Loudness History toggle, and check the curves you want to see. The Integrated, 
Momentary, and Short Term loudness analyses can be individually displayed or hidden, to expose 
overlapping graphs in that track in which you can see your program’s loudness over time.

Viewing the loudness graph of the mix going out of a Main

NOTE:  Currently, loudness history is only supported for Main 1.

Metering Options
DaVinci Resolve has a variety of metering options that allow you to tailor metering to your workflow. 
The settings appear in Project Preferences > Fairlight on the Audio Metering pane, but they affect 
mixer, Fairlight effects, or master metering on the Cut and Edit pages.

Level Metering Options
You can chose the response characteristic of the level meters for channel strips and Fairlight FX.

The Meter Type drop-down allows you to choose between IEC 60268-18, Digital VU, and Custom 
response characteristics. Both meter types have separate “hold and fall” metering, allowing you to see 
the highest peak that is reached.

	— IEC 60268-18: A digital PPM-type meter with reference standard of -18 dBFS, a fast response to 
peaks, and a slower release characteristic. This is the default in DaVinci Resolve and is used in all 
Blackmagic Design software and hardware products.
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	— Digital VU: A dual-value meter, showing the peak level as a single segment with fast ballistics, and 
the RMS (volume unit) as a bar graph. It has a far faster quasi linear decay characteristic, making it 
easy to monitor average levels while allowing sounds with quick transients and decays to be more 
easily tracked. This option can be best for audio editing and mixing. 

	— Custom: Allows each aspect of the meter response to be chosen, including level detector, scale, 
peak, deck and peak indication.

Pre-fader Metering
By default, “Pre fader metering on tracks” is unchecked (disabled), setting the metering on channel 
strips to be post (after) the fader level and mute button. For example, if the source audio file has peaks 
that are hitting -2 dBFS, and the channel fader is lowered from 0 to -10, then the peaks that show on 
the meter will now be at -12. 

When pre-fader metering is on, the metering point is set to be before the fader, and is not affected by 
the fader’s position. However, the meter is affected by clip gain settings or key framing as these level 
changes occur before the clip’s signal enters the mixer’s signal path. 

With pre-fader metering, you could lower the fader to be fully off (minus infinity) and the meter will still 
read the level of the source signal. This allows you to always be aware of the source signal and what it 
is doing before being altered by mixer’s controls or processing.

Many video editors prefer to work with post-fader metering, but most audio mixers prefer to work 
with pre fader in order to be aware of what the actual source level is at any time.

Solo and Pre-fader Metering
When pre-fader metering is enabled, soloing one or more tracks will show a lighter “ghost” version of 
meter activity on non-soloed tracks, allowing you to always see audio levels on tracks that are muted 
by the soloing process. This makes it easy to focus on tracks that are actually audible while still seeing 
activity on those that are not. 

If pre-fader metering is off (the default), when one or more tracks are soloed, no metering occurs on 
tracks unsoloed tracks. 

Pre-fader metering with 
light shaded meters 
on non-soloed tracks
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Target Loudness Level
Allows the target loudness level in LUFS for the master Loudness meters to be set to your desired 
output target level. For example, DaVinci Resolve’s default loudness standard target is -23 LUFS, but 
the YouTube target LUFS specification is -14 LUFS. If -14 LUFS is set, the “0” mark on the loudness meter 
scale moves to this level, allowing you to focus your master mix levels towards that loudness standard.

Viewer
A small viewer to the right of the Monitoring panel shows the frame of video at the position of the 
playhead. This is the same image that’s output to the external broadcast display of your workstation if 
you have one connected.

The Viewer lets you see the picture you’re mixing to.

Clicking the Expand Viewer button at the bottom right-hand corner lets you open the Viewer into 
a floating window, which you can then position anywhere you want.

To close the floating Viewer, click the Dock Viewer button at the upper right-hand corner of the 
floating viewer window.

Click the button at the upper right-hand corner to dock the Viewer again.
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Cinema Viewer on Fairlight Page
Sometimes when you need to verify lip sync, sound effects sync, or simply review a new section of 
a mix you’ve been working on, it helps to watch the visuals of the program full screen as you listen to 
your mix. You can now set the Fairlight page Viewer to Cinema Mode by choosing Workspace > Viewer 
Mode > Cinema Mode (Command-F).
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Chapter 179

Signal Flow 
Diagrams
The diagrams in this chapter describe the audio signal flow 
that takes place within the Fairlight audio processing used 
by DaVinci Resolve. They’re intended for people who want an 
in-depth understanding of how audio is processed.

Contents
Signal Flow Overview�   3797

Audio Processing Path�   3797
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Signal Flow Overview
The following simplified flow diagram describes Fairlight audio processing overall.
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Chapter 180

Immersive 
Audio Workflows
DaVinci Resolve offers substantial support for object and 
channel‑based surround or immersive audio formats. 

This chapter describes how to set up and mix with these formats when mixing in the Fairlight page.
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About Immersive Audio Formats
Immersive audio formats use multiple channels of audio to position audio around an audience, to 
add a specially creative dimension to sound design. At their simplest, formats such as 5.1 and 7.1 
surround allow the mixer to send varying amounts of any given track to the combination of speakers 
that makes audio sound centered in front, ambient from the rear, or weighted towards the left or right 
of an auditorium or living room. More sophisticated “object-based” formats such as Dolby Atmos™ 
define a virtual soundstage on which you can actually position tracks in 3D space, and the resulting 
positional audio is rendered by specialized encoder/decoders to however many speakers in whichever 
configuration a venue happens to have.

Dolby Atmos(tm)

The traditional surround sound experience outputs a specific set of monitoring channels that requires 
a specific number of monitor speakers placed in particular areas of a room, which can position sound 
approximately within a ring around the listener. Dolby Atmos improves upon this by being an object-
based sound system operating within a 3D immersive space that can accommodate a wider variety of 
different speaker configurations using more speakers positioned around the listener. This increases 
dimensionality with more precise sound placement, adding height channels to produce sound 
that comes specifically from above. DaVinci Resolve supports Dolby Atmos output render formats 
5.1.4 to 9.1.6.

A practical example of this difference can be heard when panning in a 7.1 mix; since you’re sending 
signals to specific points in a speaker array, those points are fixed. Although the physical size of rooms 
can be larger or smaller, the mix is always sent to those assigned point speakers, so the experience 
from room to room may be inconsistent. By comparison, Dolby Atmos gives re-recording mixers a way 
to mix to an idealized space instead of fixed speaker positions. This means a Dolby Atmos mix, when 
played in a Dolby Atmos room, takes into account the actual dimensions of the space, as well as the 
number of speakers that are used, to recalculate audio playback to suit that exact space and playback 
equipment, giving a more faithful recreation of the mix with much more specific sound placement, 
when necessary.

To give a clear example of the benefits of Dolby Atmos, think of a small theatre that has standard 
left, center, and right front-screen speakers. It then has four left surround and four right surround, 
four overhead left, and four overhead right. For this example, let’s say you have sent a sound to the 
surround left in Atmos, positioned at about one-half of the distance from the screen. 

Now move the Atmos mix to a much larger room with twice as many monitor speakers. The new 
theatre has eight left surrounds, eight right surrounds, eight overhead left, and eight overhead right. 
Playing in this new configuration, Atmos automatically calculates the ratio of the room and the new 
speaker array. In this example, when that sound is reproduced at one-half of the distance from the 
screen, Dolby Atmos calculates the ratio of the sound in relation to the new playback setup, so the 
listener hears exactly what the re-recording mixer intends.
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For this example, let’s say to have that audio playing back at one-half of the distance from the screen 
in the small room, the audio is played on the second surround speaker on the left. When this same 
audio is played in the larger room, Atmos determines that the fourth surround speaker is one-half the 
distance from the screen. The importance is not what speaker the sounds are assigned to but rather 
where in space the sound should be heard. Atmos calculates the ratio of the playback spaces and 
monitor speakers to faithfully reproduce a mix, rather than assign sounds to a fixed speaker position. 

Dolby Atmos Speaker Configurations
It is important to understand that the term Dolby Atmos isn’t restricted to describing any particular 
speaker layout. Dolby Atmos is a complex metadata-driven system that interprets the audio from a 
configured Atmos mix, determines the playback system of the end user, and calculates the mix to fit 
each particular space and system. Assuming the possession of a Dolby Atmos compatible system, if a 
7.1.4 Atmos mix is played by someone with only a two channel playback system, then it will intelligently 
down mix the 7.1.4 Atmos to stereo. If a user has a standard 5.1 monitor system, then the 7.1.4 Atmos 
soundtrack will down mix to five channel surround with a subwoofer.

The naming of the channel configurations in the Dolby Atmos format includes the height channels 
in the nomenclature. Channel configurations are presented as three digits separated by periods, 
such as 7.1.4, which is a typical speaker configuration. The first digit describes the number of main, 
or ear-height monitoring channels that surround the listener. The second digit describes the number 
of subwoofer channels. The third digit describes the number of height channels, which are speakers 
positioned on, or in the case of a soundbar pointed to, the ceiling.

An example of a 7.1.4 Atmos monitor speaker configuration:

	— Seven surround channels

	— Left

	— Center

	— Right

	— Left Surround

	— Right Surround

	— Left Back Surround

	— Left Right Surround

	— One Subwoofer

	— Four height channels
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Enabling Dolby Atmos
Atmos must be enabled by going into Preferences > Video and Audio I/O > Immersive Audio panel and 
turning on Enable Dolby Atmos. When enabled, the Change Track Type contextual menu when right-
clicking on a track will then include the additional Atmos track types.

The Components of a Dolby Atmos Mix
Mixes created in Atmos have several specifically identified components. These work together to create 
an immersive mix, but each element allows the Dolby Atmos system to fit the sound specifically to the 
space and speaker configuration during playback. 

These consist of:

	— The Bed track: Contains the bulk of mixed audio, including dialog, ambient sound effects, and 
music. These sorts of sounds will contain panning information, but the panning will be general. 
Wind, traffic in the distance, room tones, and sync dialog would all most likely fall within the 
bounds of a standard bed track of 7.1.2 or 5.1. 

	— Object tracks: Pinpoint the placement of sounds moving specifically across the immersive space. 
Users can use these specific tracks to create panning anywhere in the room. Sounds can fly 
through space, around a room from height channels, to side and back back channels, mimicking 
the motion of objects on the screen. Object tracks use the Atmos metadata to do the calculations 
discussed in the last example. ADM files are Atmos exports used with the IMF file type as master 
deliverables, which are in the broadcast wave file format.

It’s up to users to define which tracks are Bed tracks, and which are Object tracks; these track 
designations, are descriptions of what the tracks you create are going to be used for. Ultimately, it’s 
up to the mixer which audio is organized on Bed tracks, and which is organized on Object tracks. 
Theoretically, users can create a mix consisting entirely of Object tracks if desired, but typically the 
mix would be split into beds consisting of generally panned sounds, and Object tracks for sounds 
requiring specific room placement.

Object tracks and height channels open up possibilities that were never possible prior to Atmos. 
Imagine a scene where a man is hiding from Police while a helicopter circles overhead, or a scene 
where kids are in a basement and are startled to hear loud footsteps above them. With Atmos, the 
audience can now experience these immersive sounds along with the characters.

These are real-world examples, but sound in animation, science fiction, and fantasy can explore space 
in ways that are only limited by the creator’s imagination. Flying fairies or creatures can move about 
the space front to back, high and low. Perhaps there’s a scene with a ship moving full speed ahead 
underwater, breaking up and out into the sky, flying and dodging weapons coming from all sides. 
Object tracks are ideal to pinpoint sound effects requiring spatial specificity, but more importantly, 
Atmos assures the re-recording mixer that the final choices made in the mix will be faithfully recreated 
from theatre to theatre, and from room to room.

NOTE:  Buses feeding the Atmos master become beds, and Tracks feeding the Atmos 
master become objects.
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Predetermined Dolby Atmos Master Rules
The first ten tracks in every Dolby Atmos Master are assigned as a bed by default. From there the 
default bed is a 7.1.2 bed, however, it can be designated to a 2.0 up to the 7.1.2 bed. There is no option 
to add objects to these first ten tracks. Starting at track eleven, the tracks that follow can then be 
made into various beds or objects as needed.

A simple way to think of this is that buses routed to the Atmos Master are treated as beds, carrying 
predefined multiple sources. An Atmos bed is a fixed surround format that can contain height 
channels. Objects, are generally mono but can send any format track that DaVinci Resolve supports 
and follow the metadata as a single object element. Objects routed to the Atmos Master are treated 
as tracks, carrying dynamic audio content and positional metadata. LFE will need to be sent to a bed, 
since objects are positional metadata. If the object is 5.1 for example, the LFE channel will need to be 
routed to a Bed bus in order to be rendered in the Atmos master. 

The Dolby Renderer will render the file if it is dragged from the Media Pool into a track in the Timeline. 
In this case it will render the media with the embedded metadata to the master’s output format. This 
is a simple way to monitor pre-mastered content and to perform simple actions, such as trimming or 
syncing for new packaging and deliverables. 

When importing a Dolby Master file from the Fairlight menu, Fairlight > Immersive Audio > Import 
Master File, the resulting import will extract all of the audio and metadata for further content creation. 
This type of importing into Fairlight maps all of the metadata, tracks, beds, and objects from the 
master file into the Timeline, allowing you to adjust, process, and manipulate further, to rewrite 
panning, punch-in and add new media, and create a new Atmos Master.

Dolby Atmos files are a package of items. Simply linking files will not create an Atmos Master file. It is 
not possible, for instance, to take a rendered set of twelve tracks, link them, and then configure their 
outputs to a 7.1.4 Atmos bed. Note that 7.1.4 is not a Atmos bed type. Although this is the way typical 
PCM audio is linked and routed, it is not the case for Atmos content, which is far more than just a 
collection of tracks. 

The renderer takes the 128 channels consisting of the beds and objects and renders it. Those 
channels are either internal sources or contained within the master file. A simple linked file will not 
play back through the Renderer. It must be played back as all linked files in Fairlight do, through the 
native monitor. The Dolby Atmos Renderer plays, renders, and extracts Atmos Master files. Fairlight 
allows for .atmos, ADM, and IMF file types to be imported and played through the Renderer.

NOTE:  As mentioned above, the LFE can only be rendered in an Atmos master when routed 
as part of a bed due to the Dolby Atmos specification.

Dolby Atmos Integration
There is native Mac M1 and Linux support for the internal Dolby Atmos workflow including:

	— Input

	— Content creation

	— Internal renderer

	— Export of Dolby Atmos Master Files
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There is a dedicated Dolby Atmos Master bus format which provides a master fader in the Mixer for 
the Dolby Atmos Renderer and is indicated by the Dolby logo in its header. It also provides a loudness 
history graph in its Timeline view with integrated, momentary, and short term loudness measures. 
In the Bus Format window you will see that there are no outputs from this track; it is a control for the 
Dolby Atmos Renderer.

Only a single master bus can be created, and it will always mirror the format and metering of the 
internal renderer. When there are no patches to the Dolby Atmos Sends, all sources routed to a Dolby 
Atmos Master bus will target the master, as with a traditional bus workflow. In this send workflow, 
buses become beds and tracks become objects. 

For Mac and Windows machines, the integration of the external Dolby Atmos Renderer has been 
updated, providing a much closer integration when running an external workflow. This has unified the 
tools available within the internal renderer workflows with the external renderer. This includes:

	— External Renderer discovery within the preferences.

	— UI enable to switch between the internal and external workflow.

	— Tally of the master connection state and master file status. 

	— Storage and recall of the program metadata within the DaVinci Resolve Timeline, including all 
input configuration, trims, down-mix, and binaural settings. 

	— Direct control of the metadata from the renderer and binaural controls within DaVinci Resolve and 
bi-directional control of that program metadata from the server. 

	— Tally of the input configuration within the Patch page.

	— Multi-client workflow support, allowing multiple instances of DaVinci Resolve to run attached to 
the same server for larger workflows. 

	— Tally of the active bed and object assignments on the Dolby Atmos Sends within the Patch page. 
When assigning a bed or track to the Atmos Master on the Patch page, beds are indicated with a 
purple marking and objects are indicated with a green marking. 

Binaural Audio Monitoring
You can monitor your Dolby Atmos Master in Binaural by choosing Binaural in the monitor section.

The Binaural monitoring option

Depending on your monitoring system, you can also create a parallel speaker monitoring set 
up with Binaural. For instance, you can create a 5.1. external monitor mix along with a binaural 
headphone mix. 
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In Preferences > Video and Audio I/O, you can set Binaural to the headphone outs in the Audio I/O 
panel, and a 5.1 monitor in the Monitor Speaker configuration. Then, in the Patch Input/Output panel, 
you can route to the appropriate positional channels specific to your system and settings and also 
assign available channels for the headphones.

Using the Patch Input/Output to assign parallel binaural monitoring

Binaural Render Options
Binaural rendering is a simulation of the distance between the sound source and the listener. In the 
Index there are options on how you can choose to render the binaural objects. The default option is 
Mid, but you can also choose Off, Near, or Far, depending on the desired rendering for binaural. These 
choices will all be stored in the Dolby Atmos file.

Binaural choices in the Tracks Index for assigning perceived distance 
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You can use Clip Attributes to render a Dolby Atmos Master in Binaural. Simply right click the file 
to open Clip Attributes, select Binaural, and then right-click to create a new Timeline with the file. 
In the example below, a 7.1.4 file will be rendered to a Binaural audio file.

Using Clip Attributes to render to a Binaural file

Immersive Format Configuration
In Preferences > Video and Audio I/O > Immersive Audio, you can enable the various Immersive 
options that are available. These are Auro 3D, Dolby Atmos, MPEG-H Audio, SMPTE ST 2098, and 
22.2 Surround.

In Preferences > Video and Audio I/O > Dolby Atmos, you can configure the use of an external Dolby 
Atmos Renderer for Dolby Atmos monitoring and mastering. You can manually enter the IP address of 
the server, or select a discovered server using the drop-down menu. You should also choose the base 
audio output of the audio outputs, which will used to send the audio to the external renderer. 
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Controls for enabling various surround sound formats in the 
Preferences panel of the Video and Audio I/O

Exporting ADM BWF
You can export a Dolby Atmos master file as an audio-only ADM BWF, right from the Fairlight timeline. 
These same options are also available in the Deliver page. Exporting a Dolby Atmos master file from 
the Fairlight timeline uses the Timeline name as the filename. Be sure to change the Timeline name to 
the desired filename. 

	— In the Media Pool, locate the current Timeline. 

	— Change the Timeline name to your desired export filename. 

	— As with all other bouncing and delivery methods, you will need to mark a range in the 
Timeline to export. 

	— Press R for the Range Selection tool. Double-click any of the Timeline clips to set a range 
for the entire clip.

	— Choose Fairlight > Immersive Audio > Export Master File. 
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Export Immersive Master options

	— In the Export Immersive Master dialog, set the File Name to Timeline Name and the Format to 
Dolby Atmos ADM BWF. You can select either 48000 (delivery) or 96000 (delivery) for the Sample 
Rate of the exported file. The Source is automatically set to the Atmos Send Patching. This 
patching passes the signal through the sends to the internal Dolby Atmos Renderer for processing 
and to generate a new Dolby Atmos master file. 

	— Click Export. 

	— In the Export Immersive Master finder window, navigate to the folder you want to file to save to. 
Click Save. 

The Export Immersive Master dialog shows the 
source and format for the new ADM export.

The Export allows for several types of file types: Dolby Atmos ADM BWF, Dolby Atmos IMF IAB, 
Fraunhofer MPEG-H Production, and Fraunhofer MPEG-H Production XML.
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Parallel Loudness Measurement
A parallel 5.1 down-mix can be performed during the render as a source for a 5.1 loudness 
measurement. Certain delivery specifications (such as for Netflix) require that the loudness 
measurement of Atmos Masters be performed at 5.1. You can enable this parallel 5.1 (or stereo) render 
for the loudness measurement and monitor in the room’s native format.

Selecting a Downmix option

Low-latency Rendering
Previous versions of the Dolby Atmos Renderer were able to run at a specific latency of 10.67 ms. 
This restriction has been removed, allowing selection of lower latency engine processing block sizes, 
and thus lower monitoring latency through the Dolby Atmos renderer. However, the larger block size 
is enforced by the renderer during certain operations, such as Binaural renderer, or when a parallel 
loudness down-mix is enabled.

New Surround Buses in Fairlight  
(Studio Version Only)
The new Flexbus structure in Fairlight enables user-definable buses. Atmos mixes call for several bus 
formats that are now available in DaVinci Resolve 17. 

	— 9.1.6

	— 22.2

Object-Based Format Support  
(Studio Version Only)

	— Dolby Atmos with support for 7.1.2 and 7.1.4

	— MPEG-H with support for 5.1.4, 7.1.4, and 7.2.3

	— SMPTE ST.2098 with support for 9.1 OH, 9.1 HT, 11.1 HT, 13.1 HT, and 15.1 HT
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Auro-3D Support  
(Studio Version Only)
Auro-3D with support for 9.1, 10.1, 11.1 (7+4), 13.1

Dolby Atmos Configuration Controls
The Video and Audio I/O panel of the Resolve System Preferences lets you enable and configure the 
use of a Dolby RMU for doing Dolby Atmos mixing. You can enter the IP address of the RMU, and 
choose the base audio output.

Configuring Dolby Atmos in the Resolve System Preferences

Atmos Re-Renders
In order to provide parity with the external renderer, you can create presets that let you define a PCM 
output format and a set of sources using the bed, object, and group definitions (such as 5.1).

Bounce Mix to Track accommodate these re-render presets in Dolby Atmos timelines, allowing you to 
generate multiple deliverables in a single pass. These render presets are stored and recalled as part 
of the timeline.

Bounce Mix to Track Dolby Atmos re-render options

In addition to render format, you can select the source from a combination of Beds, Objects, or 
defined VCA Groups.
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Dolby Atmos Render Preset options

MPEG-H Authoring
DaVinci Resolve enables MPEG-H authoring. This includes Native MPEG-H track and bus formats and 
monitoring, including the ability to define basic track-level meta-data for export into an MPEG- H 
scene, and export of a MPEG-H Master file. Once enabled, the formats become available for selection 
as a bus, track, or monitoring format, in the Bus Format window.

The MPEG-H format options in the Bus Format window
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These formats also become available for multi-channel track assignment.

The MPEG-H format options in the Track Format submenu The 
MPEG-H format options in the Bus Format window

Tracks are mixed natively in a similar manner to most immersive content, with the creation of a bed 
mix consisting of a set of immersive object tracks that use dynamic panning. These are combined onto 
the main bus to form the immersive mix. 

Track Configuration
In addition to this process, once the format is enabled, a set of MPEG-H meta-data columns become 
enabled in the DaVinci Resolve Track index, including Track Type, Kind, Language, SW Group, and 
Preset. For more information about these columns and how to configure them, see Chapter 166, 
“Using the Fairlight Page.”

When MPEG-H is enabled in the Project Settings, the Tracks panel shows additional 
columns of information for defining each track in the Timeline
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Export
Once everything is configured, and your project is mixed, you export a master file. In order to do this, 
you must select a range In and Out point on the Timeline to define an export range. Additionally, you 
must define whichever busses are designated for rendering by defining their Kind, and you can select 
tracks you want to export additionally. 

Selecting tracks and busses to export

NOTE:  An MPEG-H master file can only contain a maximum of fifteen channels total. 
If the selected track and bus stems exceeds this, then the export will fail, issuing a warning. 
The same will occur if a range is not selected. 

To export an MPEG-H mix:

1	 Choose Fairlight > Immersive > Generate MPEG-H Audio File. 

2	 Choose a save location and name, and click Save.

At this point, all defined buses are rendered. Then, track loudness is measured for compliance. Lastly, 
the source audio is exported and the metadata embedded into the deliverable MPEG-H wav file. 

There are several error conditions, which are deleted during the export process, that will all cause the 
export to fail. For example, all tracks must contain audio. Audio within switch groups must be within a 
specific loudness tolerance of one another. If any of these conditions occur, a dialog will appear. 

Warning dialog during MPEG-H export
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Quality Control
You can do a quality control check of the final audio export using a Fraunhofer MHAPI tool which 
can open up the exported content. This includes compliancy tests, and visualization of the contained 
metadata. It can also render and monitor the content, but this aspect of the tool is basic, and only 
works with external audio that’s linked to the metadata. In other words, you must manually link the 
components back to the source audio files. 

Quality control using the Fraunhofer MHAPI tool

B-Chain Support for  
Audio Monitoring  
(Studio Version Only)
Choosing Fairlight > Immersive > B-Chain Control opens the B-Chain Control window. Using traditional 
cinema audio postproduction terminology, the “A-Chain” is all of the busing and signal processing 
that happens within the mix (in our case using the Fairlight page) and the “B-Chain” is the signal 
processing, amplification and speaker system that takes the sound from your workstation’s output 
and gets it “into your ears.” This typically includes all necessary signal decoding or pre-processing 
hardware, amplification systems, and speaker setups for most professional and commercial listening 
environments, especially for immersive audio or surround sound formats. These options are complex 
and have many variables in terms of speaker configuration, selection, and placement, output channel 
timing, attenuation, and phase, and a host of other considerations. 
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In DaVinci Resolve, these B-Chain controls affect how the channels of audio being output by the Main 
you’re mixing is mapped to the actual audio signals being output from your workstation into the 
amplification and speaker system of the current viewing environment. The extensive level of control 
the B-Chain presets offer is most useful in situations such as surround-sound configured grading 
and mixing theaters, to define how the immersive audio standard you’re mixing is mapped to the 
speaker setup of your particular application, and to fine-tune the channels being output to each 
speaker specifically for your environment. In simpler monitoring situations, the B-Chain controls can 
be useful for configuring the standard you’re mixing with to play out of a non-standard speaker setup 
in your room. 

Ultimately, the B-Chain controls are designed and intended for users who need to create custom, fine-
tuned settings for their specific monitoring situation. For this reason, pretty much every real-world 
use of these B-Chain controls will require custom configuration for your unique environment.

Overview of Setting Up a B-Chain Configuration
Setting up a B-Chain configuration takes some doing, but once set up, you have a preset that’s easy 
to reopen at any time. In the following example, a B-Chain preset will be configured to convert a 5.1 
surround output to a 3-channel left-center-right room speaker setup.

To set up a B-Chain:

1	 Choose Fairlight > Immersive > B-Chain Control to open the B-Chain Control dialog. This exposes 
the monitoring controls but not the configuration controls.

2	 Click the Option menu in this window and choose Setup B-Chain Presets. The B-Chain Setup 
window appears.

3	 Click the New button to create a new B-Chain preset, then enter a name in the dialog and click OK. 
In this example we’ll use the name “5.1 to LCR.” The Name you enter here is the name of the saved 
setting data.

Additional buttons let you Delete, Rename, or Duplicate presets that you’ve already created once 
you choose them from the Setting pop-up.

4	 Enter a label in the Name field (this is the name that appears in the preset menu). The name you 
enter here is the name that appears in whatever pop-up menus you select these options from.

5	 Choose Input Mode > Fixed Format, and Input > 5.1 from the pop-up menus. These define the signal 
coming out of your mix. (Input Mode > Monitor Feed sets the B-Chain to listen to the selected monitor 
source, while Input Mode > Custom Format lets you choose an arbitrary number of channels.)

6	 Choose an Output Mode > Fixed Format, and Output > LCR from the next set of pop-up menus. 
These define the speaker setup you’ll be playing the mix out of. In this example, we’ve chosen LCR, 
which stands for Left, Center, Right. 

At this point, you can see that once you’ve defined the Input and Output channels, the “Inputs/
Outputs” table of cells becomes populated:

	— At the left of this table, each channel of your selected Input occupies a vertical column. In this 
example, the Input columns are labeled L, R, C, LFE, Ls, Rs, corresponding to the 5.1 channels 
you’ve selected to be output. It’s possible to specify setups with many more channels, in which 
case the left half of the table becomes scrollable.

	— At the right of this table, each channel of your selected Output occupies a horizontal row that 
intersects the Input columns. In this example, the rows are labeled Left, Center, Right.
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In this way, every Input column intersects with each Output row, making it possible for you to 
assign how much of each Input is fed to each Output by entering values into each intersecting cell.

The Inputs/Outputs table of the B-Chain preset window

7	 To assign Input channels to Output channels, double-click the field where the desired Input 
intersects the desired Output, and type a value to set how much level from the Input to assign to 
the Output. Typing 0 assigns Input to Output at “unity” gain (0dB). Numbers you type here specify 
tenths of a dB. Typing -3 assigns half of the level from Input to Output. Typing -100 mutes that 
Input to that Output completely. Blank cells with no value make no assignment. In this example, 
we’re typing:

a)	 0 into cell L-1 to assign all of the Left source to the Left output

b)	 0 into R-3 to assign all of the Right source to the Right output

c)	 0 into C-2 to assign all of the Center source to the Center output

d)	 -6 into Ls-1 to assign a fraction of Left surround to the Left output

e)	 -6 into Rs-3 to assign a fraction of Right surround to the Right output

f)	 -8 into LFE-1 to assign a smaller fraction of LFE to the Left output (LFE is not directional)

g)	 8 into LFE-3 to assign a smaller fraction of LFE to the Right output as well (LFE is not directional)

At this point, we’ve fully defined how much of which Input channels go to which Output channels. 
In the process, you can see that this table interface makes it possible to assign the full levels of 
Input channels to Output channels, to assign partial levels of Input channels to Output channels, 
and to assign fractions of Input channels to multiple Output channels.

The Inputs/Outputs table of the B-Chain preset window fully populated to assign inputs to outputs

8	 At this point, you should notice there are additional columns to the right of the Output channels 
that provide various options that let you fine-tune each channel’s output in order to optimize the 
acoustics and layout of your room:

	— Trim each channel (in tenths of a dB)

	— Add a Delay (in milliseconds)

	— Add specific EQ (None, LFE Only, Surr Mode)

	— Mute or Solo groups. 
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9	 The last thing you need to do is to right-click each Output channel row’s right-most Output 
column, and choose the hardware output of your audio or video+audio interface that you want 
that channel to go to. See one of the following I/O Setup procedure for how to rename these 
options to make this easier. 

Assigning I/O channels to output to

10	 Once you’ve finished setting up your B-Chain preset, click OK, and that preset will be saved and 
available for use.

To choose a B-Chain preset to use and enable B-Chain:

1	 Choose Fairlight > Immersive > B-Chain Control to open the B-Chain Control dialog.

2	 Turn on the toggle at the upper left-hand corner of the window to enable B-Chain, and choose a 
preset from the pop-up menu.

3	 Choose the Input you want to assign that B-Chain preset to.

4	 A set of Solo and Mute buttons lets you selectively choose sets of channels you want to listen to in 
isolation, or mute from the whole, in order to better evaluate selected portions of your mix.

5	 A Fixed Level button lets you fix the output level in the DaVinci Resolve UI to a single value. With 
this enabled, you cannot drag the level slider to change the monitoring volume.

6	 When you’re finished using B-Chain for monitoring, turn off the toggle at the upper 
left‑hand corner.

NOTE:  While the B-Chain is enabled, the Speaker Setup controls in the Video and Audio 
I/O panel of the Resolve System Preferences is disabled.

The B-Chain Control Window where you can choose 
and enable a B-Chain preset to affect the output
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To name the various outputs of your system’s channels for easy assignment:

1	 Choose Fairlight > Immersive > B-Chain Control to open the B-Chain Control dialog.

2	 Click the Option menu in this window and choose Setup I/O Names. The I/O setup window 
appears, showing every single audio input and output on every audio interface that’s connected 
to and recognized by your system.

The I/O Setup window lets you rename the Inputs and Outputs associated with your workstation 
setup, to make it easier to configure Fairlight when you’re managing hundreds of channels. 
The names you choose here are shown everywhere in DaVinci Resolve where channels are 
selectable and/or exposed.

3	 To rename a channel, double-click that channel’s field in the Name column, type a new name, and 
press Return.

4	 To protect a channel, click the checkbox in the Protect column. Protected channels are prevented 
from being patched to. This is intended for potentially high-volume speaker outputs, to which it 
would be hazardous to accidentally connect the wrong input. Protected channels can be seen 
everywhere patches can be made, but they’re grayed out. Protected channels can only be used in 
the Speaker Setup controls in the Video and Audio I/O panel of the Resolve System Preferences, 
and in the B-Chain Setup window.

5	 When you’re finished, close the window. The names and protected status of channels are a 
system-wide setup.

The I/O Setup window where you can rename your system’s audio 
outputs and protect channels going to amplified speakers
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Space View Channel Monitoring
Once you’ve configured your DaVinci Resolve workstation to mix audio via an Immersive format, you 
can use the Space View to facilitate surround sound mixing. Choose Fairlight > Immersive > Space 
View Scope to open the Space View window, which is a virtual representation of your control room 
with all defined source channels positioned in space according to the speaker that channel is intended 
to play out of. This view makes it easy to see which audio channels on which timeline tracks are playing 
out each speaker.

The Space View window gives you a spatial representation of what levels are 
playing where; this example show the various stems of a 5.1 mix.

Each channel shows a label and a meter that lets you see, at any given part of the mix, what audio 
levels are playing where, spatially. However, you only see channels that are unmuted and with a fader 
level of more than -70dB. A checkbox lets you choose whether to see labels for all track channels 
in your mix, or to only show labels for track channels with active levels that are currently playing. 
The Space View is also aware of the state of all Solo controls, allowing you to quickly focus on just 
what you hear.

3818Fairlight  |  Chapter 180  Immersive Audio Workflows



Chapter 181

Using the Fairlight 
Desktop Console
The Fairlight Desktop console is the newest member of the Fairlight 
console family and offers professional mixing controls for editors 
and audio professionals alike. This compact desktop console has 
enhanced mixing controls for both the Edit and Fairlight pages in 
DaVinci Resolve. 

This chapter provides details and functional descriptions of each section of the Desktop Console and 
should be read in conjunction with the Fairlight chapters in the DaVinci Resolve Reference Manual to 
get the best from your console.

NOTE:  To set up a Fairlight Desktop Console and connect it to your DaVinci Resolve system, 
open the Control Panels settings in System Preferences, and change the Audio Console 
Select this console for Fairlight drop-down menu to Fairlight Desktop Console. 

Additionally, firmware updates for the Desktop Console are installed via the DaVinci Control 
Panels Setup utility. You’ll find details for downloading and installing firmware updates at 
the end of this chapter. 
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About the Fairlight Desktop Console 
Fairlight Desktop Consoles offer traditional and enhanced mixing controls for both the Edit page and 
Fairlight page in DaVinci Resolve. All that you need to connect a Fairlight Desktop Console to your 
DaVinci Resolve computer is a standard USB-3 or Ethernet cable. Once connected to your workstation, 
you can use the transport controls and search dial on the Desktop Console for timeline navigation, 
recording, playback, and more. 

Fairlight Desktop Console Sections in Clockwise Order
On the upper-left of the Desktop Console there is a set of 10 control buttons that are used to map 
the 12 adjacent encoder knobs and select buttons to focus mode mixing parameters. Moving to the 
upper-right of the Desktop Console, you’ll find the Automation section with six buttons used to control 
the automation system. Below the Automation section are the channel and monitoring controls. 
The channel controls include three buttons that work in conjunction with the channel select buttons 
above the faders and two bank buttons for banking faders in groups of 12 in the relative direction. 
To the right of the Channel section are the monitoring controls complete with an encoder knob and 
four buttons to target the Control Room monitoring. Additional TALK and CANS buttons add studio 
controls and can be pressed and held for talkback and re-targeting the monitoring controls for studio 
monitoring. The lower-right of the Desktop Console includes an electronic search dial for full shuttle 
and scroll transport control, along with a set of transport keys. A handy Zoom Icon button below 
the dial lets you use the dial for quick timeline zoom functions including: horizontal, vertical, and 
waveform zoom. 

The center of the Desktop Console includes 12 fader channel strips, each with a belt-driven 
touch‑sensitive fader, Mute, Solo, and Select (SEL) buttons, as well as an encoder knob for panning in 
default mode and controlling additional parameters in Focus modes. At the top of each channel strip 
you’ll find an LCD screen that displays information for that channel in default mode or alternative 
parameter information in Focus modes. 

Arrow and Modifier keys are located in the lower-left of the Desktop Console and can be used in 
conjunction with the Transport, Channel, and Automation buttons for expanded functionality. Directly 
above the Arrow keys is the User section, containing six sequentially numbered buttons that can be 
used in combination with other keys to change the current operation depending on the mode and 
task at hand. 
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Channel buttons

12 Fader Channel Strip with  
control knob and buttons

Automation buttons

Search dial

Zoom key

Listening level  
control knob

12 LCD displays

Monitoring buttons

Transport keys
User buttons

Arrow keys

Modifier and 
undo keys

Control buttons

Connecting to a Monitor via HDMI
For additional visual feedback, you can add an HDMI display to the Fairlight Desktop Console. There’s 
no configuration needed, simply plug in an HDMI monitor and start working! This allows you to see an 
extensive graphical display of everything happening on the console. The screen automatically switches 
between Strip, Channel, and Master layouts depending on the current control mode. Along the top 
of the HDMI screen you’ll always see a fixed display that includes: timecode, monitoring controls, 
automation toolset, and the Bus, Control Room, and Loudness meters. While at the bottom of the screen 
you’ll see 12 sets of Channel Extension Buttons for quickly identifying channel status while you work. 

Optional HDMI monitor displaying Strip mode layout with an identical set of parameters in-
line with each of the 12 channel strips, including from the top down: Track color, Name. 
Level, Status, EQ, Dynamics, Panning controls, and Channel Extension buttons. 
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Optional HDMI monitor displaying the Channel Control mode layout, which includes 
192 different parameters for the active channel. Parameter controls currently mapped 
to the LCD displays, knobs, and SEL buttons are highlighted with blue text.

Optional HDMI monitor displaying the Master Control mode layout with 
bus meters, level, and mute for each of the master buses.

HDMI Fixed Monitoring section with timecode, monitoring controls, 
Automation toolset, Bus, Control Room, and Loudness meters.
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Channel extension buttons along the bottom of each HDMI layout showing six 
highly‑visual status switches for each of the 12 channels, including in clockwise order 
from the top: Insert, Solo Safe, Select, Record (Arm), EQ and Dynamics. 

Desktop Console 
Functional Overview
This section offers a rundown of the various types of controls, operational modes, transport, and 
modifier keys, as well as pointing out the multi-purpose track selection buttons, encoder knobs, and 
LCD display screens within the console. 

Types of Controls
The Fairlight Desktop Console comes loaded with an assortment of 111 physical controls that you can 
use to record, monitor, mix, and sweeten your soundtracks. Some buttons serve a single purpose, 
while others serve multiple functions, therefore it’s a good idea to understand the different types of 
controls before moving on to the specific button, knob, and fader details. 

Search dial

Knob

Toggle buttons

Faders

Fixed buttons

	— Search Dial: To quickly navigate, scroll, and zoom, this fully integrated, highly-responsive 
electronic dial offers smooth free rotation control.

	— Knobs: When you want to make fast changes to specific parameters, these versatile knobs give 
you precision rotary control, as well as touch-sensitive input for enabling automation or resetting 
levels. Holding the Shift modifier key changes the gearing for finer precision control, while 
holding the Control modifier key while touching one of these knobs will reset the knob’s current 
parameter to its default value. 
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	— Fixed Buttons: Fixed buttons serve a specific function and produce the same results every time 
they are used, regardless of the operational mode or current workflow. 

	— Soft Menu Toggle Buttons: The twelve Select (SEL) buttons near the top of the fader 
channel strips are multi-functional toggle switches that change based on the console mode and 
active control button. 

	— Faders: The 12 touch-sensitive electronic faders give you precision volume control for your tracks 
and buses, and correspond with faders on the onscreen Mixer in DaVinci Resolve.

Desktop Console Modes
The upper section of the 12 Channel Strips, including the Select (SEL) buttons, knobs, and LCD 
screens, can operate individually per channel in Strip mode or combined for a comprehensive set 
of parameter controls in Focus mode. In both cases, the different tasks are engaged via the button 
selection in the Control section to the left of the knobs and LCD display area. 

Strip Mode
This is the default console mode, when none of the control buttons are active. 

Strip mode functionality includes: 

	— 12 identical sets of fader channel controls, one for each fader channel strip.

	— Each LCD display, knob, and SEL button is associated with the Fader, Mute and Solo button that is 
in line with that channel strip. 

	— The Select buttons are used for track selection and illuminate accordingly when 
they are switched on.

Focus Mode
In contrast, Focus mode, focuses all of the knobs, Select buttons, and LCD displays on a single mixing 
task or parameter control set determined by the active Control button. These focused control sets 
mirror signal processing available in the Fairlight page Mixer, such as Pan and EQ, as well as dynamics 
like the Compressor and Limiter. 

Focus mode functionality includes: 

	— The LCD display at the top of each channel strip provides visual feedback for the active parameter 
set assigned to the adjacent knob and SEL button. 

	— SEL buttons become toggle switches for the active parameter control set.

	— Knobs are mapped as precision encoders for the active parameter control set.

	— Focus mode controls collectively mirror the corresponding parameter controls in 
the Fairlight page UI. 

	— Focus mode parameter sets control the signal processing for the active track or bus 
determined by the selection buttons prior to entering Focus mode. The active track is the most 
recently selected track.

	— When the Master (MSTR) control button is active, the focus mode LCD, SEL buttons, 
and knobs are mapped to each bus as Mute and Level controls, respectively. 

	— When the Channel (CHNL) control button is active, the focus mode LCD, SEL buttons, and knobs 
are mapped to the most commonly used signal processing parameters for the active track.
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Undo, Modifier and Arrow Keys
While working with the Fairlight Desktop Console, you will always have access to the Undo, Modifier, 
and Arrow keys, conveniently located on the lower left side of the console. The Arrow keys function 
like the Arrow keys on a standard keyboard and are used in conjunction with the transport buttons to 
move the playhead (CTI), selected clip, range, or selected tracks incrementally up, down, right, or left. 
The Undo key offers the failsafe option to go back a step at any time, just as you would expect during 
normal keyboard and mouse workflows. Additionally, the SHIFT, ALT and CTL modifier keys are used 
with other console controls to expand functionality and speed up your workflow. For example, while 
you hold the Control key, the Rewind and Fast Forward transport buttons act as Project Start and 
Project End buttons to quickly jump to the beginning or end of the Timeline. The Shift modifier key can 
be used with the knobs for fine incremental parameter control, while the ALT modifier key used with 
Undo results in Redo functionality to go forward a step.

NOTE:  If your Desktop Console is connected to a Fairlight Audio Editor, the Control (CTL), 
Shift, and ALT keys on the Desktop Console work in tandem with the modifier keys on the 
Fairlight Audio Editor.

Track Select Buttons
The Fairlight Desktop Console includes a dedicated row of multi-function Select (SEL) buttons at the 
top of the channel strips for selecting either tracks or master buses. From left to right, the 12 Select 
buttons follow the order of the tracks in the Mixer, and in the Timeline from top to bottom. Use the 
bank buttons to move to the next or previous set of 12 tracks. 

Track Select 
Buttons

12 Track Select (SEL) buttons 

	— In Focus mode, track Select buttons become toggle switches for switched parameters assigned 
to the focused channel strip. Focus mode parameter sets are determined by the control buttons 
in the upper left of the Desktop Console.
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	— In Strip mode, the Select buttons can be used to select the track or bus assigned to that specific 
channel strip. Pressing a Select button is the same as clicking a track header or channel strip in 
the Fairlight page Mixer with your mouse. Select buttons illuminate when latched and the top of 
the corresponding LCD brightens so you can always see at a glance which tracks are selected in 
Strip and Focus modes. Likewise, if you are using an optional HDMI monitor with your Desktop 
Console, you’ll see illuminated Select buttons for each selected track in the Channel Extension 
buttons along the bottom of the screen.

	— The Active track reflects whichever track is actively being controlled or touched with any of 
the channel strip controls. You can select and control multiple tracks at once, however only the 
most recently touched track is considered the active track. For easy identification, the active 
track’s name turns red in both the LCD display and the Fairlight page Timeline. It is important to 
recognize the active track because that will be the track that receives focused parameter controls 
in Focus mode. 

Track Select Button Press Options
The default Strip mode Select buttons include some unique selection nuances to improve your 
efficiency without the need for a mouse. 

	— Press once to select or deselect a track. 

	— Select as many tracks as needed, one track at a time, by simply pressing the corresponding 
SEL button. 

	— Double-press any SEL button to deselect all other tracks and exclusively select the current track. 

	— To select a range of tracks, hold a SEL button, then double-press another SEL button to select 
both tracks as well as all contiguous tracks between them. In this case, the button that was 
double-pressed will become the active track.

TIP:  To select all tracks or an extensive range of tracks, open the Tracks Index panel in the 
Fairlight page. Select a track in the Index, then hold Shift while turning the dial to extend 
selection. Additionally, you can select a track in the Tracks Index and choose Edit > Select 
All, or press Cmd-A on your keyboard to select all tracks. 

Strip mode Select buttons latched on tracks 
A1, A3, and A5, and the red track name on the 
A3 track indicating it is the active track

3826Fairlight  |  Chapter 181  Using the Fairlight Desktop Console



The Fairlight Timeline and Mixer showing the same track selection, 
A1, A3, and A5, with A3 as the active track. 

Channel extension buttons on the optional HDMI monitor showing 
illuminated Select Buttons for tracks A1 and A5.

Fairlight Desktop Console
Now that you are familiar with the general layout, types of controls, modes, and other options in 
the Fairlight Desktop Console, you are ready to take a more detailed look at the different areas 
of operation and how everything works together. One primary concept to keep in mind is that 
the Fairlight Desktop Console is designed specifically to control the DaVinci Resolve Fairlight 
page. Therefore, the better you understand the Fairlight page, the more proficient you’ll be with 
your console. 

Please refer to previous Fairlight chapters for detailed information on the software interface, tools, 
functions, and audio workflows. Meanwhile, this section will give an overview of the entire Fairlight 
Desktop Console and focus in-depth on unique features and functions that go beyond the standard 
keyboard and mouse options in the Fairlight page. 

Control Buttons
The twelve control buttons in the upper-left corner of the Desktop Console offer fast access to all of 
the mixing parameters available in the Fairlight Mixer, without the need to grab your mouse. Each 
control button maps a different set of mixing parameters to the upper section of the channel strips. 
These parameter control sets are identical to the parameter controls in the corresponding UI windows 
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accessible in the Fairlight Mixer. Additionally, if you are using an HDMI monitor with your Desktop 
Console, the active control set parameters on the monitor screen are highlighted in blue text. 

The control sets include the LCD screens, knobs, and SEL buttons and work collectively for Focus 
mode operations. The control area defaults to the standard operational strip mode whenever there 
are no control buttons active. 

Control buttons  
that assign control 
sets to the adjacent 
Select buttons, 
knobs, and LCDs

 

Default mode where SEL is Select button, knob controls Pan, and LCD 
shows channel info for each of the 12 channel strips. 

NOTE:  In each of the following control set examples, track A3 DIA - Kate is the active track. 
You can easily identify the active track because the track-based Focus mode control sets 
always display the active track’s name, number, and color in the first channel strip’s LCD. 
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Control Buttons from left to right, starting with the top row, include: 

MSTR: The Master control button dedicates the adjacent LCDs, knobs, and SEL buttons 
to the Master buses. The default Master control set gives you direct channel control for 
up to 11 master buses. The knob controls the corresponding Master bus level, while the 
SEL button allows the bus to be muted. 

Master control set mapping shows MAIN 1, MAIN 2, SUB 1, SUB 2, AUX 1, and AUX 2

CHNL: The Channel control set assigns up to 11 of the most commonly used channel 
controls to the knobs and also to the SEL buttons, if populated or active, primarily used as 
In/Out or On/Off switches. 

Knob controls update in realtime as they are adjusted. SEL switches illuminate when 
enabled and the label on the corresponding user interface switch in the LCD turns red. 
The Channel controls from left to right are; Active Track DIA - Kate A3, Path Trim, High 
Pass Filter Frequency, Low EQ Gain, Low Mid Gain, High Mid Gain, High Gain, Low Pass 
Filt Frequency, Compressor Threshold, Lmiter Threshold, Pan Left/Right and Front/Back. 
These controls are also available in the associated Focus mode control sets.

Page 1 of the Channel control set mapping

PAN: The Pan control set maps all of the pan parameters available in the Pan window to 
the control area knobs with graphical feedback in the LCD. Pan controls are applied to the 
selected track. Pan controls assigned to each knob from left to right are: Pan, Left/Right, 
Front/Back, Rotate, Spread, Diverge, and Boom. Pan, Divergence, and Boom have On/Off 
switches assigned to the adjacent SEL switches. 
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Pan control set mapping includes all parameters in the Fairlight Pan window.

Pan window 
available in 
the Fairlight 
page Mixer

Pan control 
set visual 
feedback in 
optional HDMI 
monitor
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PLUG: The Plugin control sets differ from plugin to plugin. However, for each plugin slot 
there are up to two pages (12+12) of user-mappable parameters on the encoder knobs 
as well as On/Off on SEL1, plus up to 11 user-mappable switch functions. In this example, 
the Fairlight FX Echo plugin automatically maps parameters to the first nine knobs and 
first two switches: Echo On/Off, Filter LowCut and Stereo Switch, Feedback High Ratio, 
Left Channel Delay Time, Right Channel Delay Time, Feedback Delay, Output Dry/Wet, 
and Level.

Hold Plug and press User 1 to User 6 to choose a different plugin slot for focus. This also 
opens the corresponding Plugin window in the Fairlight page interface.

Echo control set mapping

Echo Plugin window 
that mirrors the Plugin 
control set on the 
Fairlight Desktop Console

EQ: The EQ control set includes two pages of controls. Press the EQ button to load the 
Page 1 control set, mapped left to right across the encoders and SEL switches. Master 
Gain trim appears at knob position 2, and knobs 3-12 control Bands 2-5, alternating gain 
and frequency. The SEL switch at position 1 switches the EQ on/off, and the remaining 
SEL switches toggle either the Frequency band ON/OFF or the shape per band. 
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Hold CTL and press EQ to switch to Page 2. 

This EQ control set focuses on the High Pass and Low Pass filters on Bands 1 and 6, and 
the corresponding SEL switches toggle the filters ON/OFF or shape. Press EQ again to 
return to Page 1 and repeat as needed to toggle between Page 1 and Page 2. The EQ 
control set mirrors all of the parameter controls available in the Fairlight EQ window. 

EQ control set Page 1 with controls for Bands 2-5

EQ control set Page 2 with controls for the filters on Bands 1 and 6 

Fairlight EQ controls available via the Fairlight Mixer
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EQ control set 
visual feedback 
in optional 
HDMI monitor

EXP: The EXP control set includes all of the Expander and Gate parameter controls 
available in the Fairlight Dynamics window. The first channel strip shows which track is 
in focus, or active, while the SEL button toggles between Expander/Gate controls. The 
subsequent six channel strips include knob control for the Expander/Gate parameter in 
the order they appear on the Dynamics window. From left to right in Channel Strips 2-7 the 
controls are: Threshold, Range, Ratio, Attack, Hold, and Release. 

Fairlight Expander/Gate control set

Fairlight Expander/Gate parameters 
in the Dynamics windows
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COMP: The Compressor control set includes all of the Compressor parameters as available 
in the Dynamics window. As with all of the other control sets, the Channel 1 position is 
where you’ll find the On/Off switch assigned to the SEL button. These subsequent controls 
from left to right include: Threshold, Ratio, Attack, Hold, and Release on the 2-5 knobs, and 
a Send/Listen SEL toggle for SideChain compression in the channel 6 position.

Fairlight Dynamics window, Compressor controls

Fairlight Compressor controls 
available via the Fairlight Mixer

LIM: Like the other dynamics control sets, the Limiter control set includes all Limiter 
parameter controls assigned to the encoder knobs in the order they appear in the 
Dynamics window. The Limiter controls include: On/Off, Threshold, Attack, Hold, 
and Release.

Fairlight Dynamics window, Limiter controls
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Fairlight 
Limiter controls 
available via the 
Fairlight Mixer 

Fairlight Dynamics 
Window, which 
includes Expander, 
Gate, Compressor, 
and Limiter. 

Compressor control set 
visual feedback in optional 
HDMI monitor. All Focus 
mode dynamics parameters 
grouped together in 
one section of the HDMI 
data screen. The active 
dynamics controls are 
highlighted in blue.
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INP: This is the Input button and mirrors the Path Settings controls available on the 
Input section of the Fairlight Mixer. These controls appear in the same order as the do in 
the Fairlight page: SOURCE, PATH Mic/Inst, Rec Level, Trim, and Direct Output. The INP 
control set maps Mic Gain to the Channel 3 knob, or hold ALT to use the same Knob for 
Rec Level adjustments.

 

Input control set mapping

Path Settings available in the Input section of the Fairlight Mixer

Input control set with 
Path visual feedback in 
optional HDMI monitor
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SEND: This control set uses the SEL buttons to toggle Bus Send 1 On/Off for each of 
the 12 channels. These send controls mirror the Bus Send controls available in the 
Fairlight Mixer. When active, the knob controls the Bus Send 1 Level, or press and hold ALT 
to control the Bus Send L/R Pan.

Send control set mapping

Bus Send window available 
in the Fairlight page Mixer

Send control set visual feedback 
in optional HDMI monitor

Fader Channel Strips 
The most prominent real estate on the Fairlight Desktop Console is dedicated to the fader channel 
strips. The upper section of these channel strips operate independently in Strip mode, or collectively 
for Focus mode tasks. The default operational mode of the console provides 12 fader channel strips, 
each with a Fader, Mute, Solo and Select (SEL) button, a rotary control knob for pan adjustments and 
a LCD Screen that displays channel information. Any changes applied to the channel strip controls are 
mirrored in the DaVinci Resolve Timeline and Mixer accordingly.

The desktop console remains in default mode for standard mixing operations unless one of the 
buttons in the control section is selected. For example, you may be using the faders and pan knobs 
on-the-fly to adjust track levels and panning during playback. Without stopping, you’d like to adjust 
the EQ for the active track. No problem, just press the EQ control button and the entire upper section 
of the channel strips, including the SEL buttons, knobs, and LCD screens, change function to the 
EQ focused mode. In EQ focused mode, the collective LCD screens, SEL switches, and knobs control 
specific EQ parameters that mirror the Fairlight Mixer’s EQ window controls. 

When you finish adjusting the EQ, simply unlatch the EQ control button, and the console returns to 
the default mixing functionality. You can switch between control modes as often as you like during 
playback, recording, or other mixing tasks. 

This section describes the default functionality of the fader channel strips. 
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12 fader channel 
strips with Fader, 
Control knob, SEL, 
Solo, and Mute 
buttons

Touch-Sensitive Faders 
The bottom-half of the Fader Channel Strip area comprises 12 identical touch-sensitive motorized 
faders that offer precision gain controls for 12 signal paths. These faders correspond with faders 
on the Fairlight page Mixer. Touching a fader results in realtime graphical and numeric feedback of 
the current level on the adjacent LCD screen. Additionally, each 100mm fader has a DC belt-driven 
coreless motor and offers precision touch-control fader automation. 

Faders can be reset to unity (0dB) by simply pressing the Control (CTL) button while touching a 
fader. Hold Control and swipe your hand along each of the twelve faders to reset them all in a 
single maneuver.

Channel Strip Control Buttons
Each channel strip also contains illuminated Mute, Solo, and Select status buttons for the individual 
channels. These toggle buttons can be pressed individually or swiped on or off. Highly-visual LED 
lights make it easy to spot which buttons are switched on or off at a glance, which is especially 
important in the middle of a mixing session. These channel strip buttons and their toggled states are 
mirrored in the DaVinci Resolve Edit and Fairlight page Mixers and Timeline track headers, as well as in 
the strip mode layout in the optional HDMI monitor. 

Channel Strip Control Buttons include: 

SEL: In default mode, this button can be used to select a track, VCA master, or 
bus master assigned to that channel strip. Press SEL once to select or de-select 
a track. You can select as many tracks as you need for a given task. Channel 
buttons, located to the right of the Channel Strip control buttons, can be used 
as modifiers to change the SEL switch functions.

Latch the AUTO channel modifier button to change the SEL switch function to 
Automation Write. 

Latch the REC channel modifier button to change the SEL switch function to 
Arm for recording. 
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In Focus mode, latch the ENAB channel modifier button to enable the SEL 
switches to be used as Track Select buttons.

SOLO: Use this button to hear only this channel during playback. 

Multiple tracks can be soloed simultaneously to isolate selective tracks for 
playback while all non-soloed tracks will be muted. 

Solo buttons work for the corresponding channel in both Strip and 
Focus modes. 

Use modifier keys for enhanced solo functionality;

Hold Control and press any Solo button to clear all soloed buttons. 

Hold Control and press any Solo button again to restore soloed tracks.

Hold ALT and press Solo to toggle on or off Solo Safe status. 

Tracks set to Solo Safe will always play, even if Solo is enabled for other tracks, 
and are easily identified by the blue-highlighted Solo status icon in the Fairlight 
page Mixer and Timeline track headers. 

MUTE: This button turns the channel off and on for playback. Mute buttons on 
the Desktop Console correspond with the Mute buttons on the Fairlight page 
Mixer and track headers. 

Desktop Console with active Mute, Solo, and Select buttons in the fader channel strips

Optional HDMI monitor display showing track status for the channels in Strip mode
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Channel Control Knobs
Each channel strip includes a touch-sensitive multi-function encoder knob with realtime graphical 
and numeric feedback of the current position on the adjacent LCD screen. The Channel Control knobs 
default to left-right (L/R) Pan controls and offer smooth precision rotary adjustments. The handy 
touch-control of these knobs is perfect for recording Pan automation because you can start recording 
data the instant you touch a knob and stop when you release it. Knob settings are mirrored in the 
corresponding Mixing window in DiVinci Resolve. 

Use modifier keys for enhanced control knob functionality:

Hold SHIFT in conjunction with the knob for refined incremental control. 

Hold ALT to switch from L/R Pan to front-back (F/B) panning and 
corresponding feedback on the LCD screen. 

Hold CTL and touch any knob to reset the designated parameter to the 
default value. 

LCD Screens
At the top of each channel strip you’ll find a high-resolution LCD color display that shows the Track 
or Bus name, color, metering up to 7.1.4 wide, bus assignments, and panning if in Default strip 
mode. The information displayed for each track directly correlates with the Fairlight page Mixer and 
track headers. 

Fader channel strip LCD 
screens showing track 
name, number, color, pan 
status, level meters, and 
VCA group number

Fairlight page track headers showing  
track name, number, color, and level meters

NOTE:  The LCD screens display different information based on the current Control mode in 
use on the Fairlight Desktop Console. You’ll find detailed images of the other Control modes 
later in this chapter. 
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Automation Buttons
The Fairlight Desktop Console includes automation controls designed to allow the operator to record 
every static and dynamic parameter change you make in the process of balancing, mixing, and 
sweetening the overall sound of your timeline in the Fairlight page. The six Automation buttons offer 
the same automation controls available in the Fairlight page Automation toolset. 

Automation buttons

Automation buttons include: 

ON: Use this button to turn automation mode on and off. 

STOP: Toggles the On-Stop mode through Event, Hold, or Return. 

MODE: This button toggles between Write or Trim action.

TCH: The Touch button toggles the automation touch mode through three recording 
options: Off, Latch, and Snap.

ENAB: Hold this button while touching any fader, pan knob, or Mute button to enable/
disable that parameter for automation recording. Additionally, the User button Mix User 
set offers additional enables in the Enables Quick Menu layout. 

CURV: Hold the Curve button and touch any fader strip control on a selected 
track to show its parameter’s automation curve on the selected channels in the 
Fairlight page Timeline. 
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Fairlight page Automation controls 

Automation writing fader automation data on the A3 track

Automation mirroring the Desktop Console, 
writing fader automation data on the A3 track

NOTE: Automation is only available in the DaVinci Resolve Fairlight page.  
For detailed information about Fairlight’s automation recording toolset and  
how it works in DaVinci Resolve, see Chapter 174, “Mix Automation.” 
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Channel Buttons
One way the Fairlight Desktop Console is able to pack enhanced functionality with minimal Channel 
strip buttons, is to repurpose the SEL button as needed for different workflows. Even in default mode, 
the channel select button (SEL) can easily be used as a switch for common strip mode functions. That’s 
where the Channel buttons come into play. The Channel buttons temporarily assign channel-specific 
button functions from the Fairlight page track headers and Mixer to the Channel Select button 
(SEL). When engaged, the Channel buttons turn the SEL button into a toggle switch that mirrors its 
functional counterpart on the Fairlight page. 

These functional override Channel buttons include ENAB, AUTO, and REC. Plus, there is an A/B channel 
button, as well as Left and Right Bank buttons for mapping and toggling through banks of tracks. 

The AUTO, REC, and ENAB channel SEL switch modifier buttons can be latched for extended use or 
engaged via momentary press, so you can quickly use the modified SEL switch and release to return 
to the task at hand. Pressing any of the focus mode Control buttons will automatically unlatch the 
Channel modifier button and reassign the SEL switches accordingly. 

Track header includes Automation 
Write and REC Arm buttons that mirror 
Channel Button functions.

Channel buttons
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Channel buttons include: 

AUTO: This button modifies the SEL buttons to switch the channel in and out 
of automation writing and can be used on-the-fly to punch in and punch out 
during playback. This functions the same as clicking the Automation Write 
button on the track header or channel strip in the Fairlight page Mixer. 

REC: Latch this button to assign the SEL switches as Arm buttons to quickly arm 
tracks for recording. 

ENAB: Use this SEL button modifier to temporarily override the Focus mode 
SEL switches and enable them to be used as Track Select buttons. 

A/B: Press the A/B button while the Views - Tracks quick menu is active to show 
six user-defined View presets of which tracks/buses are visible in the Timeline 
and Mixer. These View presets can be customized in the Tracks Index tracklist 
and are based on the tracks and busses currently marked as visible while a 
numbered User view is selected.  

BNK >: Bank Forward banks the faders to the right in groups of 12, or the next 
12 channels or buses in the Timeline from your starting position. 

Hold SHIFT while pressing this button to bank the faders one at a time. 
You can use this SHIFT banking option to create custom fader banks. 

Hold CTL and press the BNK > button to locate the first bus. 

Hold a fader while pressing the BNK> button to leave that channel on that strip.

< BNK: Bank Back banks to the previous set of 12 tracks or buses. 

Hold SHIFT while pressing this button to bank the faders one at a time in the 
relative direction. 

Hold CTL and press the < BNK button to locate the first track.

Hold a fader while pressing the < BNK button to leave that channel on that strip.

TIP:  When working with high track counts, you can quickly jump to the last track/first bus 
by pressing CTL+ BNK >. Once you have located the first bus, you can press < BNK to bank 
through your right-most tracks 12 at a time from the last track toward the first. To jump 
back to the first tracks, press CTL+ < BNK. 
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Monitoring Controls
The Monitoring controls on the right side of the Fairlight Desktop Console is where you control the 
listening levels for the Control Room and Studio speakers. These controls default to Control Room 
monitor levels and can be changed at any time using the Monitor knob and buttons. Hold the CANS 
button to re-target all of the Monitoring controls for studio monitoring. 

Fairlight Desktop 
Console Monitoring 
controls 

Monitoring Knob
Use this knob anytime during recording, playback, or mixing to adjust the Control Room or Studio 
listening levels. Changes to the Control Room levels are reflected in the DaVinci Resolve Timeline 
monitoring controls located in the upper-right corner of the Edit page and Fairlight page Timelines. 
If you are using an optional HDMI Monitor, you’ll see the monitoring controls in the upper-left corner 
of the screen. Sometimes the monitoring environment must be set to a standard level and not 
changed. This is called Fixed Level monitoring. For example, if your control room has been calibrated 
with a sound pressure level (SPL) meter, you will probably want to set a Fixed monitoring level. When 
fixed, the Control Room knob has no affect on the monitoring levels. When Fixed Level monitoring is 
toggled on, the listening level meter in the upper-right of the Timeline GUI turns from green to blue.

Control Room monitoring controls include: 

DIM: This button reduces the Control Room monitor volume by -15dB. Press to 
toggle Dim on or off. The DIM button state is mirrored in the DaVinci Resolve 
monitoring controls. When DIM is toggled on, the level slider in the onscreen 
monitoring controls turns yellow. Control Room levels automatically DIM during 
Studio talkback. Use the Monitoring knob to adjust the DIM level.

MUTE: Use this button to mute or unmute the Control Room monitors as 
well as turn on or off Fixed Level monitoring.

Press to mute or unmute Control Room monitoring.

Hold CTL and press Mute to switch on or off Fixed Level monitoring. 
When Fixed Level monitoring is switched on, the level slider in the onscreen 
monitoring controls turns blue.
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Hold CTL + SHIFT while turning the Monitoring Control Knob to adjust the 
fixed level.

SRC: Use this button to toggle between the last two selected monitor sources. 
Holding this Source button along with the associated USER button selects a 
specific bus for monitoring. For example, If you Hold SRC and press USER 2, 
the monitoring will change to bus 2, while holding SRC and pressing USER 5 will 
change the monitoring to bus 5.

SPKR: This button toggles between the last two selected monitor sets. Holding 
this Speaker button and pressing the associated USER button selects the 
specific monitor set. The two default speaker sets are MAIN and NEAR. Holding 
SPKR and pressing USER 2 will switch to the NEAR monitoring set, and holding 
SPKR and pressing USER 1 will return the Control Room monitoring to the MAIN 
speaker set. 

The Studio monitoring controls adjust the Studio monitoring circuit of a Fairlight accelerator 
card installed on your workstation. Hold the CANS button to target the monitoring controls 
for Studio monitoring.

Studio monitoring controls include: 

Studio knob: Hold CANS to use this to dial the monitoring level of the speakers 
in the Studio.

DIM: Hold CANS and press this button to reduce the Studio monitor volume 
by -15dB. 

MUTE: Hold CANS and use this button to mute or unmute Studio monitoring. 

SRC: Hold CANS while pressing this button to toggle between the last two 
selected Studio monitor sources.

SPKR: Hold CANS and press this button to toggle between the last two selected 
Studio monitor sets.

TALK: Either Momentary press or latch this button to engage a talkback 
microphone. When latched, the talkback mic remains live. 

Press and hold the talk button to use talkback without latching. In this case, 
the talkback mic will remain live only during the momentary-press and shut 
off when you release. Engaging talkback also DIMS the Control Room circuit. 
You can modify the talkback functionality and general purpose input and 
output (GPI/GPO) in the Talkback controls available in the Fairlight menu in 
DaVinci Resolve.
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Press CTRL + Talk to show or hide the Talkback Settings window. 

CANS: Hold this button to temporarily target all of the monitoring controls for 
Studio monitoring.

NOTE:  “Cans” is audio studio jargon for headphones and are part of most any recording 
studio monitoring setup. Often the producer, engineer, and clients sit in the control room 
and monitor the session via loudspeakers, while the talent, within the studio, monitors 
playback and performances via cans. 

Fairlight page monitoring controls

Search Dial and Transport Controls
Some of the most useful controls on the Desktop Console are the search dial and transport buttons 
which function exactly as expected for a professional audio control surface. The search dial and 
surrounding transport buttons offer a complete set of transport commands designed to let you keep 
your hand in one position while you quickly navigate the Timeline from end to end or anywhere in 
between in seconds. Additionally, the dial can be used for focused timeline zooming and scrolling. 

As a means of navigation, scrubbing, playback and zooming, the dial has four modes of operation that 
are initiated by the respective buttons located above and below the search dial. 

Search dial, Zoom 
and transport 
buttons
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Search dial operational modes include the following:

Jog : This is the search dial’s default operational mode. 

In Jog mode, the playhead movement is contingent on the movement of the 
dial, so you can freely jog forward or in reverse at variable speeds while turning 
the dial and stops when the dial is released. Jog mode is often used to scrub a 
specific area to focus on audible cues for mixing, editing, and trimming. 

If the transport is stopped, press Play to engage the dial. Then turn 
the dial to jog. 

If the “Always On” option is checked in System Preferences, the jog dial 
unconditionally controls the transport immediately whenever you move the 
dial, even during playback. This “always on” convenience does not affect the 
transport during recording, Shuttle or Scroll operations.

Hold CTRL while turning the jog dial to increase playhead movement. Release 
CTRL to return to standard jog speed.

Shuttle: In Shuttle mode, turning the dial forward (clockwise) or back (counter-
clockwise) starts playback in fast forward or rewind at variable speeds based on 
the amount the dial is turned. Releasing the dial while shuttling forward or back 
will continue constant playback at the current speed until the playhead reaches 
the beginning or end of the project.

In Shuttle mode, holding CTRL while turning the jog dial increases the speed 8X.

Scroll: In Scroll mode, the playhead position is controlled by the dial to quickly 
move earlier or later in the Timeline. 

Hold CTL while scrolling to move the playhead from the project start 
(first frame) to the project end (last frame) in a single rotation of the dial. 

Zoom: The Zoom button, which looks like a magnifying glass, is used in 
combination with the dial and modifier keys to offer numerous quick zooming 
and scaling options while you work.

The Zoom button can also be combined with the User buttons to show and 
map the onscreen User Mapping menu. 

Hold Zoom and turn the dial to change the horizontal scale of the Timeline on 
the computer screen. 

Hold CTL + Zoom and turn the dial to change the vertical scale of the Timeline, 
which in turn changes the height of the tracks and the subsequent number of 
tracks visible in the Timeline. 

Hold Shift + Zoom and turn the dial to move the current track selection to 
higher or lower tracks.

 X2
Double-press Zoom to zoom your entire program to fit within the current visible 
width of the Timeline. Double-press Zoom again to toggle back to the previous 
zoom level.
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Zoom + any User button toggles on or off the User Mapping menu onscreen. 
The User Mapping menu is a 2x3 grid that changes in real time by using the 
ALT and CTL modifier buttons. 

Hold Zoom + SEL button on Bus or VCA master to spill or unspill member tracks 
to neighboring faders, either to the left or right depending on the settings in 
the Setup-Console Quick Menu.

NOTE:  Horizontal scaling zooms around the playhead, while vertical zooming focuses on 
the active selected track.

In addition to the jog dial, you’ll find a set of five standard transport control buttons that can be used 
for recording, playback, and navigation. 

The transport buttons include: 

Record: When used in conjunction with Play starts and stops, 
recording switches the transport in and out of record mode for the 
record‑enabled channels. 

Fast Reverse: Depending on Control Panel options in System Preferences, 
this button either places the transport into rewind or jumps left. 

Hold CTL and press the Fast Reverse button to jump the playhead to the 
project start. 

Fast Forward: Depending on Control Panel options in System Preferences, 
this button either places the transport into fast forward or jumps right.

Hold CTL and press the Fast Forward button to jump the playhead to the 
project end. 

Stop: This button stops playback or recording. 

Play: Places the transport dial into the default jog mode.  
Press again starts playback.

Hold CTL and press Play to locate to the last play point and play again.

Control Panels Options in DaVinci Resolve Preferences
The Control Panels preferences offer several options to customize your Desktop Console transport 
controls, including:
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	— Use Fast Forward and Rewind as Jump: Check this option if you want use the Fast Forward and 
Rewind keys to jump to clips, fades, markers, or transients on the selected tracks. Choose the 
Jump navigation options in the Timeline Options menu in the Fairlight Page toolbar. 

	— Always in Jog: When this option is On, any movement of the dial will cause the transport to switch 
to Jog. Always in Jog affects the dial when the transport is not in motion and does not override 
Shuttle, Scroll, or Record operations. 

TIP:  Always in Jog is handy while previewing new material, editing, arranging, and 
organizing tracks. This is great because you can grab the dial and instantly navigate. 
However, when performing complex mixes and writing automation, it’s a good idea to turn 
this option off, so you can’t accidentally bump or nudge the dial while you work. 

Audio Console options in System Preferences

Timeline Options menu with navigation options, 
including: clips, fades, markers, and transients

Modifier and Undo Buttons
The modifier buttons are conveniently located in the lower-left corner of the console, just where 
you are accustomed to finding them on a standard computer keyboard. These versatile buttons add 
functionality to other controls throughout the console. There’s also an Undo button that you can use 
as often as needed while you work. 
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Modifier and 
Undo buttons

Modifier and Undo keys include: 

SHIFT: The Shift modifier key is used in conjunction with numerous other 
buttons and controls to expand functionality. For example, hold Shift while 
turning a Channel knob for refined control. Hold Shift + Zoom while turning the 
dial to move the current selection to higher or lower tracks. 

ALT: Use the ALT button to reveal alternative parameters or functions. 
A few examples of ALT modifier functions include: 

Hold ALT to change the Strip mode Pan control knob function from left/right 
panning to front/back panning. 

Hold ALT and press Solo to toggle Solo Safe status on or off. 

CTL: The Control button is the most commonly used modifier button and is the 
easiest to find without looking, since it is the first button in the lower-left corner 
of the console. A few examples of the CTL button’s uses include: 

Hold CTL while touching any Channel Control knobs or faders to reset them to 
the default value. 

Hold CTL while using the search dial to increase speed.

Hold CTL and Zoom while turning the dial to zoom vertically. 

Hold CTL and press UNDO to REDO one step.

Hold CTL and press Left Arrow to mark an In point. 

Hold CTL and press Right Arrow to mark an Out point
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UNDO: Use this button anytime you need to go back and Undo your last step. 
This works as expected, no surprises here. Just a reliable means of taking a step 
back if you make a mistake or get ahead of yourself and perform an operation 
you didn’t intend. And you can also hold CTL and press UNDO to REDO a step.

Arrow Keys
These Arrow keys serve a myriad of uses during your post production workflows, from moving the 
playhead one frame left or right with the Left and Right Arrows, to jumping clip to clip up or down the 
Timeline with the Up and Down Arrows. The Fairlight Desktop Console includes a set of four arrow 
keys that you can use for standard arrow movement, as well as console-specific operations.

Arrow keys 

Arrow buttons, clockwise from the top, include: 

Up Arrow: Use this button to move a selection up in a list, Media Pool or 
sound library. The Up Arrow is also used for navigation to move the playhead 
to the next clip, fade, marker, or transient in the Timeline. These “jump to” 
navigation functions are determined by the Navigation options in the Timeline 
Options menu. 

Hold Shift and press Up Arrow to move forward to the next marker.

Right Arrow: Used to move the playhead forward one frame or one second 
at a time. 

Press Right Arrow to move the playhead one frame forward.

Hold Shift and press Right Arrow to move one second forward. 

Hold CTL and press Right Arrow to mark an Out point.
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Down Arrow: Use this button to move a selection down in a list, Media Pool or 
Timeline. The Down Arrow is also used for navigation to move the playhead to 
the previous clip in the Timeline. Shift plus the Down Arrow button moves to the 
previous marker.

Left Arrow: Used to move the playhead back one frame or one 
second at a time. 

Press Left Arrow to move the playhead one frame back.

Hold Shift and press Left Arrow to move one second back. 

Hold CTL and press Left Arrow to mark an In point.

NOTE:  Once you set an In or Out point in the Timeline, you can use the dial to extend 
the selected range. To clear the In and Out points (Range), press Option-X on the 
computer keyboard.

User Buttons
The six sequentially numbered User buttons are user-defined quick keys that change operation 
depending on the mode and function in combination with other button groups. For example, a re-
recording mix engineer performs different tasks than the ADR engineer, so each professional would 
set up the User buttons to give them easy access to the functions and modes they need most for their 
workflow. User buttons can be used alone, or in combination with other buttons for specific functions 
and workflows. 

User buttons

At the time of this writing, the User buttons are mapped to six User sets, including Edit, Mix, Record, 
Views, Setup, and a blank unassigned User set.  Each of the six User Sets is then mapped to additional 
menu layouts each with six menu options related to that set. User button quick menus offer fast 
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mouse-free two-handed editing options, like those available in the Fairlight Audio Editor. The 
difference is that you look at the Quick Menu dialog on the computer screen to see which functions 
are assigned to the User buttons instead of the labels on the console keys. 

The current User Button Quick Menus are an early incarnation of this feature and will undergo visual 
GUI improvements and enhanced functionality in future updates. 

Working with the User Buttons and the Quick Menu Dialog
The Quick Menu is a dialog in the Fairlight page user interface that you can show or hide by holding 
Zoom and pressing any of the User buttons. What makes the Quick Menu dialog unique is its 2x3 grid 
design containing six user-defined buttons that can be toggled from the corresponding User buttons 
on the Desktop Console. To select an option from the Quick Menu, once you’ve chosen the desired 
User Set page, you simply press the User button that corresponds to the function you need. This 
innovative physical button-to-dialog button relationship makes it easy to learn the quick menus and 
functions as well as build lightning-fast muscle memory to trigger the actions while you work. 

Six User buttons in a 2x3 pattern and Quick Menu dialog with a 2x3 button grid that matches the 
User buttons; Quick Menu shows the User Sets menu and Edit set (User Button 1) option highlighted. 

NOTE:  The Quick Menu dialog can be moved anywhere on the Fairlight page interface, so 
you can see it at a glance, without obstructing view or workflow.

User Button and Quick Menu Functional Overview
The default Quick Menu layout is Edit, however you can change the layout anytime by pressing the 
appropriate modifier keys along with the corresponding User button. For ease of operation, you 
use the Zoom button to show or hide the Quick Menu, and the modifier keys to change layouts. It 
requires two modifier keys (ALT+CTL) to change to a different User set, and one modifier (ALT) to 
select a different submenu layout within the current User Set. This is similar to using a mouse to open 
a submenu in the Fairlight Page interface, or pressing Menu keys to reveal Menu Option keys on the 
Fairlight Audio Editor. Once you have selected a Quick Menu layout, such as Edit - Basic, you can then 
engage any of the six actions by pressing the corresponding User button. User Button layouts are 
identified by the name in the Quick Menu header. Hyphenated names represent the current User Set 
followed by the submenu layout. For example, EDIT - BASIC identifies the Edit User Set showing the 
Basic submenu layout of six different Edit actions that can be engaged by pressing the corresponding 
User button. 

	— Press Zoom plus any User button to Show the floating Quick Menu dialog 
on the Fairlight Page interface
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+ =

Six User buttons and the Edit-Basic User Set

	— Once the Quick Menu dialog is showing, it will remain on screen until you press Zoom plus 
a User button to close. You can also close the Quick Menu dialog by clicking the Close (x) 
button on the dialog. 

	— The Quick Menu retains the most recently used layout whenever you show or hide it. 

	— Press CTL + ALT to show the six User Sets including; Edit, Mix, Record, Views, Setup, and Blank.

=

Press CTL + ALT to view the six User Sets

	— To choose an option from the Quick Menu, press the User button in the same position. For 
example, in the Edit User Set, the Nudge submenu layout is in the same position as User 4, 
therefore, you press User 4 to choose the Edit-Nudge layout. The Edit-Nudge layout, in turn, 
offers two clip-based actions that can be engaged by pressing the corresponding User button. No 
modifier keys are needed to choose an option from the current user set layout, hence the name 
Quick Menu. 

+ =

	— Press ALT to show the submenu layouts for the current User Set. In this example, there are five 
Edit submenu layouts mapped to the first five buttons. 

=
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NOTE:  Quick Menu buttons that are blank have not been mapped to a function. The 
Edit Blank layout is the default User set when engaging the User Button layouts for 
the first time. With this layout, none of the User buttons are assigned to actions, and 
therefore, new users can avoid accidentally applying editing actions to the Timeline. 

	— To choose an option from the Quick Menu, press the User button in the same position. 
For example, In the Edit User Set, the Nudge submenu layout is in the same position as User 4, 
therefore, you press User 4 to choose the Edit-Nudge layout. The Edit-Nudge layout, in turn, 
offers two clip-based actions that can be engaged by pressing the corresponding User button. 
No modifier keys are needed to choose an option from the current user set layout, hence the 
name Quick Menu.

+ =

	— To quickly change to a different submenu options layout in the same Quick Menu User Set, press 
ALT to show the submenu option sets, then press the User button for the desired layout. In this 
example, to change from the Edit-Clip options to the Edit-Blank options, press ALT to see the 
different submenu options, and User 1 to choose the Basic option in the 1 position. 

=

+ =

	— To engage the options currently mapped to the Quick Menu, press the corresponding User 
button. For example, in the Edit-Basic Quick Menu, press User 1 to Cut, User 2 to Copy, User 3 to 
Paste, User 4 to Split, User 5 to Trim Head, and User 6 to Trim Tail. 

	— To hide the Quick Menu dialog, Press Zoom plus any User button.
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NOTE:  Once you incorporate User buttons and Quick Menu options into your 
everyday workflows, you’ll find that switching between layouts and engaging 
options is as effortless as using keyboard shortcuts or right-click menu options in the 
DaVinci Resolve interface. 

Edit User Set 
There are five Edit menu layouts: Blank, Basic, Level, Nudge, and Clip. Press ALT to show the different 
Edit menu layouts in the Quick Menu dialog. Press the associated User button to choose an Edit 
layout. In this case, the Blank button is in the top-left grid position, and the Edit Basic layout is in 
the User 2 position. Pressing User 2 button would select the Edit-Basic layout. Once selected, the 
button in the Quick Menu dialog is highlighted. Release Alt to show the selected Quick Menu layout 
with button-menu options related to specific Editing tasks. Similar to working with the Fairlight Audio 
Editor, the options on the EDIT-BASIC layout change from “Clip” to “Range” if a range is active in the 
Timeline. Additionally, the Shift and Control modifier keys offer secondary functions.

Edit Quick Menu layouts include 
Basic, Level, Nudge, and Clip. 

Edit-Blank Quick Menu layout (default) 

Edit-Basic Quick Menu layout 	 Edit-Basic Quick Menu layout  
for clip-based editing	 for range-based editing
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Edit-Level Quick Menu layout	� Edit-Level Quick Menu layout  
with CTL and Shift keys

Edit-Level Quick Menu layout 	 Edit-Level Quick Menu layout 
with Shift key	 with CTL key

Edit-Nudge Quick Menu layout 	 Edit-Clip Quick Menu layout

Edit Quick Menu layouts and button options include:

	— BLANK: This default layout has no actions assigned to the six User buttons. This is to prevent new 
users from accidentally editing their projects via User buttons. 

	— BASIC: Use to this button layout to place common fast-editing actions at your fingertips. Use 
the dial and transport controls with your right hand for navigation and selection, while quickly 
choosing editing actions via the User buttons with your left hand. 

	— Cut Clip/Cut Range: Press User 1 to cut the currently selected material and place it in the 
clipboard. The cut material maintains its relationship to the playhead in a semi-transparent 
form, so you can see exactly where it will be pasted as you move the playhead or selection to 
a new location. To Paste the clip, press the User 3 button. Alternatively, you can cut and paste 
clips on-the-fly by holding the User 1 button to cut, continue playback or move the playhead 
until the semi-transparent clip is in position, then release the User 1 button to paste. 

	— Copy Clip/Copy Range: Press User 2 to copy the currently selected material to the clipboard. 
Move the semi-transparent copied clip to position, then press the User 3 button to paste. 
Since this is a standard clipboard editing tool, you can paste additional copies of the material 
by pressing User 2 again. If you’d rather copy and paste during playback, press and hold User 
2 to copy the selection and release to paste. 

	— Paste: Press User 3 to paste the current clipboard material into the Timeline based on the 
selected tracks and playhead position. 

	— Split Clip/Split Range: Press User 4 to split the clip or range at the playhead position, 
creating a new edit point between two clips or at the range boundaries. The split editing 
action is based on the selected tracks and playhead position. 
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	— Trim Head: Press User 5 to erase the portion of the selected clip to the left of the playhead. 
Alternatively, press and hold User 5 while the playhead is over a selected clip to reveal all of 
the clip’s handles (unused frames) to the left of the playhead. While continuing to hold User 5, 
move the playhead along the extended clip to find a new starting frame. Release User 5 to 
trim the head of the clip to the new playhead position. 

	— Trim Tail: Press User 6 to erase the portion of the selected clip to the right of the playhead. 
Alternatively, press and hold User 6 while the playhead is over a selected clip to reveal all of 
the clip’s handles (unused frames) to the right of the playhead. Continue holding User 6 while 
moving the playhead to the last desired frame. Release User 6 to trim the clip’s tail to the new 
playhead position. 

NOTE:  Although you can manually click to select individual clips with a mouse while 
editing with a standard keyboard. Fairlight Console audio editing is centered around 
automatic clip selection based on the selected tracks and playhead position for fast, 
on-the-fly workflows. As the playhead passes over a clip on a selected track, that clip is 
automatically selected, thus allowing effortless Cut, Copy, Paste, and Trim functions at 
the touch of a button. 

	— LEVEL: As the name suggests, the options in this User Button menu are all based on controlling 
the selected clip’s level. Like the Edit-Basic options, the Edit-Level options are based on selection 
and playhead position. Additionally, modifier keys offer more User Button menu options. In most 
cases these expanded options are directly related to the default menu option so that you can 
quickly fine tune your actions as you go. 

	— Clip Level: Hold User 1 and turn the dial to increase or decrease the selected clip’s level. 
This affects the selected clip beneath the playhead and can be performed while the transport 
is stopped or during playback as the playhead passes over a clip in the selected track. 

	— Display Level: Hold User 1 + CTL and turn the dial to increase or decrease the waveform 
zoom level in the selected tracks. Changing the waveform display level does not change the 
volume levels of the affected clips or tracks.

	— Fade Head: Press User 3 to apply a fade from the playhead to the head of the selected clip.

	— Head Shape: Hold Shift + CTL to show the Head Shape menu option. Press User 3 and turn 
the dial to change the shape of the fade at the head of the clip.

	— Head X-Level: Hold CTL to show the Head X-Level menu option. Press User 3 and turn the 
dial to change the level curve of the fade or crossfade at the head of the clip beneath the 
playhead.

	— Head X-Point: Hold Shift to show the Head X-Point menu option. Press User 3 and turn the 
dial to change the height of the crosspoint in the crossfade at the head of the clip beneath 
the playhead.

	— Fade Tail: Press User 4 to apply a fade from the playhead to the tail of the selected clip.

	— Tail Shape: Hold Shift + CTL to show the Head Shape menu option. Press User 4 and turn the 
dial to change the shape of the fade at the head of the clip.

	— Tail X-Level: Hold CTL to show the Head X-Level menu option. Press User 4 and turn the dial 
to change the level curve of the fade or crossfade at the head of the clip beneath the playhead.

	— Tail X-Point: Hold Shift to show the Head X-Point menu option. Press User 4 and turn the 
dial to change the height of the crosspoint in the crossfade at the head of the clip beneath 
the playhead. 
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	— Top Layer/All Layers: Press User 5 to toggle between Top Layer and All Layers. When set 
to Top Layer, any clip level or editing actions that you apply to a stack of overlapping clips in 
audio track layers will only be applied to the top clip. When set to All Layers any editing actions 
applied to a clip with overlapping audio clips in layers will be applied to the entire stack of clips 
beneath the playhead. This function works, even when audio track layers are hidden.

	— NUDGE: This User Button menu layout focuses on refining the positions and timing of the clips. 

	— Nudge Left: Press User 1 to move the selected clip one frame at a time to the left.

	— Nudge Right: Press User 2 to move the selected clip one frame at a time to the right. 

	— Media Left: Hold CTL to show the secondary option and Press User 1 to move the media 
within the selected clip one frame at a time to the left without chaining the clip duration or 
position.

	— Media Right: Hold CTL to show the secondary option and Press User 2 the move the 
media within the selected clip one frame at a time to the right without chaining the clip 
duration or position.

	— CLIP: Use this menu layout for quick control of the selected clip.

	— Toggle Mutes: Press User 1 to mute (disable) the selected clip or clips beneath the playhead 
on selected tracks. Press User 1 again to un-mute (enable) the clip or clips. 

	— Reverse Clip: Press User 2 to reverse the clip beneath the playhead on the selected track. 
Press User 2 again to reverse again, so it plays forward. 

	— Inspect Clip: Press User 3 to show the Inspector panel in the Fairlight Page interface. 
Press User 3 again to hide the Inspector. 

Mix User Set 
There are six Mix menu layouts for working with mix automation: Basic, Punch, Preview, Copy/Paste, 
Enables and Faders To. Press ALT to show the different Mix menu layouts in the Quick Menu dialog. 
Press the associated User button to choose a Mix options layout. 

Mix Quick Menu layouts include Basic, Punch,  
Preview, Copy/Paste, Enables and Faders To. 

 

Mix-Basic Quick Menu layout 	 Mix-Punch Quick Menu layout

Mix-Preview Quick Menu layout 	 Mix-Copy/Paste Quick Menu layout
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Mix-Enables Quick Menu layout 	 Mix-Faders To layout

Mix Quick Menu layouts and buttons include:

	— BASIC: Use this submenu options layout to access common functions while previewing or working 
with previously recorded automation data. 

	— All Read: Press User 1 to get controls out of Write or Preview before the 
transport starts moving.

	— Copy Mix: Press User 3 to copy all automation data within the selected range to the clipboard. 
This is the first step in copying automation data from one track or bus to another.

	— Paste Mix: Press User 4 to paste data from a copied automation range into the range 
selection in the Timeline, based on enabled parameters in the Automation toolset. For 
example, if you copy a range of automation from the MUSIC 1 track, all of the automation data 
within that range is copied to the clipboard. However, if only the Fader and Pan parameters 
are enabled in the Automation toolset, only those automation curves will be pasted to the 
selected range on the Music 2 track in the Timeline. 

	— Erase Mix: Press User 5 to erase the automation data within the selected range.

	— PUNCH: As the name suggests, the options in this Mix layout offers range-based options to 
control when and where new automation data is written into an existing mix.

	— Auto In: Press User 1 to start an automation pass, pre-rolling, then punching In at the 
range start point. 

	— Auto Out: Press User 2 to start an automation pass, pre-rolling, then punching in at the 
range Out point.

	— Punch In: Press User 3 to switch automation from Preview or Read to Write during playback. 
Once you Punch In, all enabled parameters will remain in Write mode until you stop playback 
or press User 4 to Punch Out.

	— Punch Out: Press User 4 to stop writing Automation and enter Read mode during playback.

	— Auto Punch: Press User 5 performs an automation pass, pre-rolling, then punching In and 
Out at the range start and end points.

	— Join Mix: Press User 6 to punch into Automation Write with all enabled parameters during 
playback, with exactly the parameter values you had when Write last stopped. This is handy 
for making a second pass and finessing a section you just mixed.

	— PREVIEW: This Mix menu layout offers Preview-related mix options that allow you to suspend 
Automation Read or Write for enabled controls while you find new settings for them.

	— Preview: Press User 1 to switch on the Preview automation controls and audition new 
settings for the enabled controls without changing the recorded automation data. 

	— Fill Range: Press User 3 to perform and instant automation pass, writing the current values of 
all parameters that are in Preview mode through the range.
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	— Glide Range: Press User 4 to perform an instant automation pass that writes a glide 
through the range from the value at the start of the range to the current control level of the 
parameter, for all parameters that are in Preview mode.

	— Punch In: Press User 5 to switch from Preview to Write mode starting at the point where you 
press Punch In and applying the current control levels until you stop playback or press User 6 
to Punch Out. 

	— Punch Out: Press User 6 to stop writing automation and return to Preview 
mode during playback.

	— COPY/PASTE: Use this Mix menu layout to quickly copy and paste automation from one 
range to another.

	— Copy: Press User 1 to copy all automation data within a range.

	— Paste All: Press User 2 to paste all copied automation data to a range.

	— Paste EQ: Press User 3 to paste only the copied EQ automaton data to a range.

	— Paste Aux: Press User 4 to paste only the copied Aux buss automaton data to a range.

	— Paste Dyn: Press User 5 to to paste only the copied Dynamics automaton data from the built-
in Fairlight Dynamics processing on each track to a range. Dynamics include: Expander, Gate, 
Compressor, and Limiter automation. 

	— Paste Plugs: Press User 6 to paste only the copied plugins automaton data to a range.

	— ENABLES: Use this menu layout to quickly enable or disable automation recording for specific 
parameter sets. 

	— Write EQ: Press User 1 to enable or disable EQ automation.

	— Write Comp: Press User 2 to enable or disable Comp button automation.

	— Write Gate: Press User 3 to enable or disable Gate automation.

	— Write Limiter: Press User 4 to enable or disable Limiter button automation.

	— Write Aux: Press User 5 to enable or disable Aux automation. 

	— Write Plugins: Press User 6 to enable or disable Plugin automation.

	— FADES TO: Use this menu layout to remap faders to the first six sends. 

NOTE:  The Mix user set and subsequent Quick Menu options are only functional while 
the Automation toolset is On and showing in the Fairlight Page user interface.  Press 
the On button in the Automation area at the top of the Desktop Console to toggle 
Automation On or Off. The Faders To menu layout allows users to re-map faders to 
Sends 1-6 via the User keys and does not require Automation to be turned on. 

Record User Set
This user set offers the same recording options that are available in the Fairlight Audio Editor for both 
Manual and ADR recording. There are four Record Quick Menu layouts: Manual, Rate Clip, ADR List, 
and ADR Record.
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Record Quick Menu layouts include Manual,  
Rate Clip, ADR List, and ADR Record.

Record-Manual Quick Menu layout 	 Record-Rate Clip Quick Menu layout

Record-ADR List Quick Menu layout 	 Record-ADR Record Quick Menu layout

Record Quick Menu layouts and buttons include:

	— MANUAL: Use to this button layout to place common fast-editing actions at your fingertips. Use 
the dial and transport controls with your right hand for navigation and selection, while quickly 
choosing editing actions via the User buttons with your left hand. 

	— Record Here : Press User 1 to initiate the Record Here action from the current playhead 
position. When you engage Record Here, the playhead goes back the pre-roll duration, then 
punches into Record at the location where you issued the command.

	— Record Again: Press User 2 to repeat the last recording you made, both entry and exit, 
whether it was manually or automatically punched in.

	— Record Clip: Press User 3 to initiate the Record Clip manual recording method. After pre-roll, 
the playhead punches in and out to match the duration of the clip under the playhead on the 
selected track. If no clip is beneath the playhead, the transport moves forward to the next clip 
in the track and records there.

	— Record Range: Press User 4 to record the current range. With this manual recording method, 
the playhead includes a pre-roll and punches into Record at the Range In point, and then 
punches out at the Range Out point.

	— PunchIn Again: Press User 5 to engage Punch Again recording. Punch Again pre-rolls, then 
enters record at the exact same place as last time, whether it was manually or automatically 
activated. When entering this record operation, you still need to manually Punch Out. This 
allows you to get the same start point for recording but with a manual exit.

	— Rec Head: Press User 6 to enter the Record Head method, which pre-rolls, then starts 
recording at the head of the first clip to come beneath the playhead in the selected track. 
When entering this record operation, you still need to manually Punch Out.
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	— RATE CLIP: As the name suggests, the options in this User Button menu are all based on rating 
the ADR recordings from 1-Star (*) to 5-stars (*****). These ratings appear in the ADR Record 
panel Take list after each recorded take. 

	— * : Press User 1 to mark a 1-star rating on the selected take.

	— **: Press User 2 to mark a 2-stars rating on the selected take.

	— ***: Press User 3 to mark a 3-stars rating on the selected take.

	— ****: Press User 4 to mark a 4-stars rating on the selected take.

	— *****: Press User 5 to mark a 5-stars rating on the selected take.

	— Unrated: Press User 6 to remove star ratings.

	— ADR LIST: This ADR recording layout offers actions available in the ADR List panel. These actions 
are used for selecting and setting ADR cues. 

	— Prev Cue : Press User 1 to select the previous cue in the Cue list.

	— Next Cue: Press User 2 to select the next cue in the Cue list. 

	— Set Cue In: Press User 3 to set the current Timeline In point as the Cue In. 

	— Set Cue Out : Press User 4 to set the current Timeline Out point as the Cue Out. 

	— Edit Dialg : Press User 6 to highlight the text field and active text cursor in the ADR List panel 
so that you can type or edit the text for the current cue. 

	— ADR RECORD: Use this this ADR recording layout for rehearse and record options available in the 
ADR Record panel. 

	— Prev Cue: Press User 1 to select the previous cue in the Cue list.

	— Next Cue: Press User 2 to select the next cue in the Cue list. 

	— Play Cue: Press User 3 to play the currently selected take from the Take list (described below). 
If no take is selected, the most recently recorded one on top is played.

	— Rec. Cue: Press User 4 to initiate recording of the cue to the specified audio track, with cue 
beeps and video streamer cues. 

	— Rhrse Cue: Press User 5 to rehearse the selected cue. This runs the section of the Timeline 
specified by a cue without actually recording anything, giving the talent an opportunity to run 
through their dialog and practice their timing and delivery. Beeps and on-screen streamers 
are not played during a rehearsal.

	— Edit Dialg: Press User 6 to highlight the text field and active text cursor in the ADR List panel 
so that you can type or edit the text for the current cue.

Views User Set
This user set offers quick access to view options and track zoom views that can be toggled on or off as 
needed while you work. There are two View Quick Menu layouts: Misc and Tracks.

Views Quick Menu layouts include Misc and Tracks. 
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Views-Misc Quick Menu layout 

Views-Tracks Quick Menu layout		� Press A/B button to show custom Views-
Tracks User Quick Menu layout

Views Quick Menu layouts and buttons include:

	— MISC: Use to this button layout to quickly show or hide common enhanced view features that are 
also available in the Setup mode layout on the Fairlight Audio Editor. 

	— Toggle Layers : Press User 1 to show or hide Audio Track Layers.

	— Video Scrolr: Press User 2 to show or hide the Video Scroller. 

	— Mixer Link: Press User 3 to toggle on or off the Mixer Link feature. When Mixer Link is on, the 
Fairlight page mixer automatically scrolls to show the most recently selected track. 

	— Tracks: As the name suggests, the options in this User Button menu are all based on rating the 
ADR recordings from 1-Star (*) to 5-stars (*****). These ratings appear in the ADR Record panel 
Take list after each recorded take. 

	— 1 Trk : Press User 1 to vertically scale the Timeline tracks to show only the active track.

	— 2 Trks: Press User 2 to vertically scale the Timeline to show two tracks, 
including the active track. 

	— 4 Trks: Press User 3 to vertically scale the Timeline to show four tracks, including the active track.

	— 8 Trks : Press User 4 to vertically scale the Timeline to show eight tracks, including the active track.

	— 16 Trks: Press User 5 to vertically scale the Timeline to show sixteen tracks, 
including the active track.

	— All Trks: Press User 6 to vertically scale the Timeline tracks to show all tracks.

	— Tracks View Presets: Press the A/B button while the Views-Tracks Quick Menu is showing to see 
the Tracks View presets. Each of the six user-defined View presets can be used to quickly change 
which tracks/buses are visible in the Timeline and Mixer. These View presets can be customized 
in the Tracks Index tracklist and are based on the tracks and buses marked as visible when a 
numbered User View is selected. 

	— View 1 : A/B + 1 to scale the Timeline to show the View 1 preset.

	— View 2: A/B + 2 to scale the Timeline to show the View 2 preset. 

	— View 3: A/B + 3 to scale the Timeline to show the View 3 preset.

	— View 4 :A/B + 4 to scale the Timeline to show the View 4 preset.

	— View 5: A/B + 5 to scale the Timeline to show the View 5 preset.

	— View 6: A/B + 6 to scale the Timeline to show the View 6 preset.
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Setup User Set
This User set offers setup options that are available in the Fairlight Audio Editor setup mode. There are 
four Setup Quick Menu layouts: Misc, Jogger, Talkback and Console.

Setup Quick Menu layouts include Misc,  
Jogger, Talkback, and Console. 

Setup-Misc Quick Menu layout 		 Setup-Jogger Quick Menu layout

Setup-Talkback Quick Menu layout 	 Setup-Console Quick Menu layout

Setup Quick Menu layouts and buttons include:

	— MISC: Use to this button layout to quickly access common features that can enhance your Fairlight 
user experience. 

	— Normal Solo/Solo Follow: Press User 1 to toggle between Normal Solo and Solo Follow. 
When set to Normal Solo, pressing a Solo button on the Desktop Console or soloing a track 
on the Fairlight page results in the normal track solo behavior. When set to Solo Follow, solo 
is linked to track selection, so that any track you select or deselect will automatically solo or 
unsolo the corresponding track. 

	— Undo: Editor/Undo All: Press User 2 to toggle between Undo Editor and Undo All. This 
functionality is a matter of operator preference. When set to the default, Undo Editor, 
tasks performed in Mix mode, including recording and editing automation data, will not be 
undoable. You can, however, simply record new mixing data to override the previous data 
as needed. Latching this key enables the Undo All mode, which in turn will undo all actions 
including automation applied in Mix mode

	— Toggle Layers: Press User 3 to on or off Audio Track Layers.

	— CTI:Moving/CTI:Fixed: Press User 4 to choose whether the playhead (CTI) moves across the 
Timeline, or is fixed in place with the Timeline scrolling past.
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	— Preview:Mon/Preview:Track: Press User 5 to determine where preview monitoring goes 
when auditioning a sound and comes in handy when you need to preview a clip in the Media 
Pool or Sound Library. When toggled to Preview Track, you will put the track in Thru mode 
so it works like a live mic input and the sound you preview will be subject to the track’s fader 
levels, solo or mute state, and any processing applied to the track. If toggled to Preview Mon, 
the sound goes directly to the monitors without any processing or controls via the track’s 
channel strip in the mixer or console.

	— Write Paste: Press User 6 to automatically set controls to write when pasting from one 
channel to another. 

	— Jogger: As the name suggests, the options in this User Button menu are all based on Jog settings 
for the Search Dial. These options are identical to those found on the Fairlight Audio Editor.

	— Gear:13: Press User 1 and turn the dial to change the “gear ratio” when jogging between 1 
and 20. In other words, it determines how quickly the transport moves in response to turning 
the jog wheel. The lower the Gear number, the slower the transport will go; the higher the 
Gear number, the faster the transport will go. The default Gear setting is 13.

	— Rescale Jogger: Press User 2 to change the gear ratio based on the current zoom level so 
that three revolutions a second of the jog wheel reaches normal play speed.

	— Follow Zoom: Press User 3 to toggle Follow Zoom on or off. When on, the gear ratio of the jog 
wheel is affected by the Zoom setting. 

	— Jog DIM: Press User 4 to toggles Jog Dim on and off. When on, it causes the monitoring level to 
automatically dim during Loop Jog to the user-defined value set in the Monitor mode Dim level.

	— Loop Jog: Press User 5 to toggles Loop Jog on and off. When Loop Jog is on, the transport 
plays a small length of audio (between 5ms and 2000ms), repeatedly, at play speed. The loop 
moves as you jog the transport forward or backward. This is a great tool for editing, because 
it maintains the correct pitch of the audio, allowing you to hear clicks, pops, sibilants in the 
middle of words, and so on. Some of the other soft keys in this menu control additional 
Loop Jog parameters.

	— Width:80: Press User 6 and turn the dial to sets the width for the Loop Jog in milliseconds 
between 5ms and 2000ms. This is the amount of audio that is repeated in each loop. 
The default width is 80ms.

	— Talkback: This Setup layout offers three options to customize the Desktop Console 
Talkback functionality.

	— Smart Talk/Push-2 Talk: Press User 1 to toggle between the default unlatched Smart Talk 
option and the latched Push-2-Talk option. Smart Talk allows the user to either latch the Talk 
button for extended hands-free talkback, or Push-2-Talk with a momentary press on the 
Talk button. Latching this key toggles on the Push-2-Talk mode, which limits talkback to the 
momentary-press Push-2-Talk method similar to using a 2-way radio.

	— GPI>None/Talk/DIM: Press User 2 to toggle the Monitoring Controls for the general purpose 
input (GPI) between None, Talk plus DIM, or DIM only.

	— None/Talk/Armed/Record>GPO: Press User 3 to determine when the general purpose 
output (GPO) sends a signal during a session. This Quick Menu button toggles between Talk, 
None, Armed and Record.

	— Console: This Setup layout offers four options to customize the console functionality.

	— Mixer Link: Press User 1 to toggle Mixer Link on/off. When Mixer Link is on, the 
DaVinci Resolve Mixer GUI will scroll any newly selected tracks into view.
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	— Trim from Unity (0): Press User 2 to toggle Trim from Unity on/off. In automation Trim mode, 
when Trim from Unity is on, pressing the SEL key on any channel will re-locate the fader to the 
unity (0) position and stop playing back existing moves.

	— Spill: Left/Spill: Right: Fader Spill temporarily spills the member tracks of a master bus or VCA 
group to nearby faders and is a fast way to finesse member track levels while mixing. The User 
3 button determines the direction in which member tracks are temporarily mapped to the 
adjoining faders on the Fairlight Desktop Console. Press User 3 to toggle between Spill: Left 
and Spill: Right, which in turn dictates whether the member tracks of a bus are assigned to 
neighboring faders to the left or right of a bus when Spill is engaged in the Channel Fader panel. 

	— Spill: Tracks/Spill: Any: Press User 4 to toggle between Spill: Tracks/Spill: Any. When in the 
default (unselected) state, the Spill: Any option allows member tracks of a bus to be spilled 
to the nearest faders to the left or right, including faders assigned to Master buses and VCA 
groups. When toggled to the Spill: Tracks option, member tracks of a bus spill either left or 
right, starting with the nearest track fader in the designated direction. This option is useful if 
you need to maintain fader control of your buses while you spill their constituent tracks to the 
nearest track faders.

NOTE:  At the time of this documentation, the blank User Set and subsequent blank button 
options are not yet functional. Stay tuned for future updates. 

Fairlight Desktop Console 
Configurations 
There are three ways that you can configure the Fairlight Desktop Console with your DaVinci Resolve 
workstation:

As a standalone mixing controller, simply connect the Fairlight Desktop Console to your 
DaVinci Resolve computer for professional control of the Edit page Mixer as well as the Fairlight page 
recording, mixing, and automation workflows. 

Fairlight Desktop Console
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Add a second monitor via HDMI for enhanced visual feedback of the mixing parameters while you 
work with the console. This configuration gives you realtime graphical updates on the screen, similar 
to the Channel Control LCD in the full-sized modular Fairlight consoles. 

Fairlight Desktop Console connected to a second monitor via HDMI for enhanced visual feedback

Fairlight Desktop Console connected to a second monitor via HDMI with nearby 
computer screen to display the DaVinci Resolve interface and enhanced channel-
based visual feedback from the console on the HDMI screen

Connect to a Desktop Fairlight Audio Editor and DaVinci Resolve computer for control of nearly every 
function on the Fairlight Page interface. This expanded desktop configuration is similar to a 2-bay 
Fairlight modular console at about half the price. 
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Fairlight Desktop Console connected to a second monitor and the 
Fairlight Audio Editor with DaVinci Resolve computer screen

Performing Firmware Updates 
Some DaVinci Resolve updates, such as 17.2.1, require firmware updates to implement the 
improvements to the Fairlight Desktop Console. To use the DaVinci Control Panels Setup utility for 
the first time, you need to perform a custom install of the latest version of DaVinci Resolve and in 
the custom settings, check the option to install the DaVinci Control Panels utility.  Once installed, 
you can select any DaVinci Resolve panel connected to your system and perform network setup and 
firmware updates.

Updating firmware on a Fairlight Desktop Console:

1	 Quit DaVinci Resolve, if necessary. 

2	 Open the DaVinci Control Panels Setup utility. 

The DaVinci Control Panels Setup Utility

3	 In the DaVinci Control Panels Setup Utility, select the Fairlight Desktop Console.
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NOTE:  If you are working with the Fairlight Desktop Console or Desktop 
Fairlight Audio Editor, there will only be one panel from which to choose. 

4	 Click the circled icon below the panel name. 

5	 If there is a firmware update available, you will see an update dialog.

Firmware Update Available dialog

6	 Click Update to install the updated firmware on that panel. 

7	 Once the update is complete, click Done.  

8	 Close the DaVinci Control Panels Setup.

9	 Open DaVinci Resolve. 
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Chapter 182

Using the Fairlight 
Audio Editor
The Fairlight Audio Editor lets you quickly navigate large projects 
and precisely edit audio much faster than using a regular mouse 
and keyboard. 

Using the Audio Editor to control the Fairlight page provides fingertip access to nearly every 
Audio tool, function and workflow you’ll need to create incredible soundtracks within DaVinci Resolve. 
In addition to editing audio tracks, clips and waveforms, the Fairlight Audio Editor can also be used to 
set up, record, arrange, sweeten, mix and master your projects. 

Whether you are using a Fairlight Desktop Audio Editor or a Fairlight Audio Editor panel in a Fairlight 
console, the tools and functionality of both models are the same. This chapter covers details about the 
Fairlight Audio Editor’s powerful design features, controls, edit modes, multi-functional keys and how 
they work with DaVinci Resolve.Please refer to the previous Fairlight chapters for details on using the 
Fairlight page.
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About the Fairlight Audio Editor
Fairlight Audio Editor panels are designed to meet modern audio post production workflow 
demands while providing ease of use so that audio professionals can quickly and precisely execute 
both simple and demanding audio editing tasks. These dedicated Fairlight editing control panels 
are available in either desktop or console models. The difference is that the desktop model is a 
stand‑alone panel designed for audio editors working at individual computer workstations, while the 
console model has an extended frame that fits into the Fairlight console chassis and is then connected 
to all of the console’s modular panels. Both models are essentially the same panel, aside from how 
they are mounted, so if necessary, you can use a Console Audio Editor on your desktop, and likewise 
a Desktop Audio Editor can be connected to a Fairlight console that does not already include an 
Audio Editor component. 

Fairlight Audio Editor

With its modest size that fits any desk or workspace, the Fairlight Audio Editor keeps every function 
within reach for simple navigation as well as performing complex two-handed operations. Plus, 
the user-friendly design is easy to learn and master with a variety of highly visual, intuitive controls 
including: touch-sensitive control knobs, macro buttons, built-in Editor screen with soft buttons, 
number keypad, jog wheel, and a full QWERTY keyboard with multi-functional picture keys. 

The Fairlight Audio Editor is organized into six sections, each with a specialized set of controls that 
work in tandem with the Fairlight page interface to perform high-speed, audio tasks within your 
DaVinci Resolve project. 

Audio Editor Sections in Clockwise Order
On the upper-right of the Editor, you’ll find the Monitor section complete with knobs and buttons to 
control the level of the speakers in both the control room and studio as well as talkback. Below the 
Monitor section is a numeric keypad for entering timecode and go-to operations. The lower-right 
of the Editor includes an electronic jog wheel for full shuttle and jog transport control, along with 
a handy set of fixed transport buttons, Undo, Redo, Zoom and Shuttle playback and Jog response 
keys. To the left of the jog wheel and control buttons is the full-sized QWERTY keyboard with multi-
functional self‑labeling picture keys for nearly every audio action, tool, function, or workflow. Located 
directly above the keyboard is the built-in Editor screen which offers an interactive graphical display 
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of the signal processing parameters for the selected track or master bus. The Editor screen is 
surrounded by sixteen soft menu buttons and three touch-sensitive knobs on the left- and right-side 
of the screen for dial parameter control. Finally, along the top there is a row of 15 fixed buttons that 
include ESC and 14 user-defined Macro Quick keys.

Editor Screen 
with  

Soft Buttons  
and Knobs

QWERTY 
keyboard  

with Picture Keys

Macro Buttons
Monitor 
Controls

Numeric Keypad

Jog Wheel and 
Transport Buttons

Audio Editor Functional Overview
At face value, the control knobs, jog wheel, buttons, and keys function as expected, based on the 
current Audio Editor mode. However, the way you press keys and the addition of modifiers can place 
even more options at your fingertips, without the need for changing editing modes or mousing 
through menus on the Fairlight page interface. So, before diving into a detailed rundown of the 
Fairlight Audio Editor, it’s important to understand some of the multifaceted controls and functional 
nuances designed to minimize your keystrokes while maximizing your speed and productivity.

This section offers a quick overview of the types of controls, editing modes, transport and 
modifier keys, key-press options, as well as pointing out the designated Track Selection, Menu and 
DaVinci Resolve interface page keys. 

Types of Controls
A good starting point for getting to know the Fairlight Audio Editor is to acquaint yourself with the 
different types of physical controls. 

	— Jog Wheel: To quickly navigate, zoom, change clip levels and more, this fully integrated, highly 
responsive electronic dial offers smooth free rotation or clutch action control.

	— Knobs: When you want to make fast changes to specific parameters, these versatile knobs give 
you precision rotary control, as well as touch-sensitive input for enabling automation or resetting 
levels. The Audio Editor includes two fixed-parameter knobs with the monitoring controls and 
six multifunctional soft menu knobs around the Editor screen which are assigned to parameters 
based on the current Editor mode and active toolset. Holding the Shift modifier key changes the 
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gearing for finer controls, while holding the Control modifier key while touching one of these 
knobs will reset the knob’s current parameter to its default value. For example, if the Audio Editor 
is in Monitor mode, holding the Control key while touching the knob controlling Fixed Level resets 
the parameter to 0 dB. 

Jog wheel

Knob

Fixed keys

Picture keys

Soft menu buttons

Soft menu buttons

	— Fixed Keys: These keys are located along the top and right side of the Audio Editor. Unlike the 
multi-functional soft menu buttons and picture keys, the fixed keys have printed labels based 
on their designated purpose. Among the fixed keys you’ll find the Macro quick keys, Monitoring 
Control keys, Numeric keypad keys, Jog and Transport Control keys, along with Undo, Redo, 
Record, Zoom, and Enter. Fixed keys are white with black labels, with the exception of the two red 
Mute keys in the Monitoring controls. 

	— Soft Menu Buttons: Above and below the Editor screen are two rows of eight soft menu buttons 
for a total of 16 buttons used to either toggle or show alternate pages of controls in the Editor 
screen based on the current Editor mode. The upper row of soft menu buttons are always toggles, 
such as the EQ In or EQ Bypass, when the EQ parameters are active, or a Boom toggle that 
alternates between: Boom Post, Boom Pre and Boom Only when the Pan parameters are active. 
The eighth button in the upper row toggles between page 1 and page 2 of functionality assigned 
to the first seven soft menu buttons. The lower soft menu buttons control parameters assigned 
to the six knobs, with the middle six lower soft menu buttons controlling which primary set of 
parameters are assigned to the knobs, like Track Level, Left/Right and Front/Back controls when 
the Pan parameters are active in the Editor screen. The left and right lower soft menu buttons 
reveal alternative controls assigned knobs, such as the alternate Pan parameters, Rotate, Tilt and 
Up/Down, assigned to the right three knobs. 

	— Picture Keys: These self-labeling picture keys change their appearance and function dynamically, 
based on whatever the user is doing at that time and offer control for nearly every tool, panel, 
action, and task on the DaVinci Resolve Fairlight page. Additionally, the picture keys default to a 
standard QWERTY keyboard whenever user text input is needed (this setting is governed by the 
QWERTY: Auto/Off setting in the Setup mode), or when the DaVinci Resolve software displays a 
page other than Fairlight.
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Audio Editing Modes
To accommodate the numerous audio post production toolsets and workflows, the Fairlight Audio 
Editor includes six primary Editor modes that change the picture keyboard layout and Editor functions 
based on the operational task at hand. These six “mega” Editor modes are conveniently named after 
their toolsets as follows: 

	— Setup: This mode provides quick access to non-editing operational windows, view options, and 
functions such as opening the Bus Format and Bus Assign windows, toggling on and off audio 
track layers, and saving a project. 

	— Record: As you probably guessed, this mode presents the precision tools you’ll need to perform 
manual, punch-in and ADR recording. 

	— Monitor: Use this mode to quickly change your fixed monitoring levels, isolate speakers, buses 
or mains, switch to alternate speaker sets, toggle phase, and other control room playback 
monitoring functions. 

	— Macros: This mode presents 30 programmable Macro keys where you can record sequences of 
keystrokes for repetitive tasks to each Macro key. 

	— Mix: Transforms the Fairlight Audio Editor into a robust mixing tool with full control of Fairlight 
page Mixer functions like track EQ, Dynamics and Pan settings, copy and paste settings between 
tracks, as well as utilizing the full automation recording and editing toolset. 

	— Edit: This is where the Fairlight Audio Editor got its name and reputation for unparalleled speed 
and accuracy for every aspect of audio post editing from auditioning and syncing sound effects to 
checkerboard editing dialogue tracks on the fly. 

Editor mode keys: Setup, Record, Monitor, Macros, 
Mix, and Edit, with Mix mode currently active
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Transport, Modifier, and Escape Keys
While working with the Fairlight Audio Editor, you will always have access to the standard Transport, 
Modifier, and Escape keys, even while using the QWERTY keyboard for entering data. The Transport 
and Modifier keys are located at the bottom of the keyboard, and the Escape (ESC) key is at the top 
row of the editor with the Macro Quick keys. 

You’ll use the Transport keys: Rewind, Fast Forward, Play, Stop, and Record for navigation, playback 
and recording along with the jog wheel and its adjacent fixed transport keys. 

Transport keys: Rewind, Fast 
Forward, Play, Stop, and Record

Transport keys with Control 
modifier engaged to reveal Project 
Start and Project End keys 

Modifier keys: 
Shift, Control, 
Command, and ALT

Escape key

The standard modifier keys: Shift, Control, Command and Alt, work in conjunction with the QWERTY 
keys for default and user-defined keyboard shortcuts along with your mouse while operating other 
pages of DaVinci Resolve. When you are using the Fairlight Audio Editor to control the Fairlight page, 
the Control key (CTRL) is an essential modifier for revealing secondary functions on the self-labeling 
picture keys. For example, when you press the Control modifier key, the Rewind and Fast Forward 
transport keys become Project Start and Project End keys. Additionally, the Shift modifier key can be 
used in conjunction with the knobs for refined incremental parameter control. 
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Another important key that you’ll find on a standard computer keyboard as well as the Audio Editor 
is the Escape key. This key lives up to its name as an all-purpose “escape” that can be used at any 
time to exit an operation, action, data entry or menu without saving the changes since the last save. 
The Escape key works as an operational override for a variety of functions including: GoTo functions, 
naming clips, setting values in dialog boxes, opening, closing and saving files, and any time a Cancel 
button is shown in a dialog on the computer screen. 

As you learn your way around the Editor, you’ll soon appreciate the convenient locations 
of the Transport, Modifier and Escape keys in the lower-right, lower-left, and upper-left 
positions respectively.

NOTE:  If your Audio Editor is connected to a Fairlight console, the Control key on the Editor 
works in tandem with the Control buttons on the Fairlight Console Channel Control panel 
and Channel Fader panels to access secondary functions, parameters and controls. Also, 
there is an independent ALT key below the built-in Editor screen that is used to toggle 
between additional parameters on the left- and right-side of the screen. This ALT key is 
dedicated to the Editor Screen controls. 

Latch, Long, and Momentary Key Press Functions
Unlike standard keyboard and numeric keypad keys, which deliver the same result whether the keys 
are typed or held down, many Fairlight Audio Editor keys have multiple operational states which elicit 
different results depending on how you press or hold the key. The three types of key presses are: 

	— Latch: Quickly pressing and releasing a key, just as you would with normal typing, is referred to as 
latching and results in toggling on or off that key’s function.

	— Long-press: A long-press is performed by simply pressing a key longer than you would if you 
were simply typing it. When performing a long-press, you only need to press the key long enough 
to see the desired result, such as opening or closing a window on the Fairlight page GUI. Long-
presses are only slightly longer than typing, about 300 milliseconds, so they don’t slow you 
down, they just offer more functions within a fixed number of keys. These long-presses can be 
real time savers, and in many cases replace the need to reach for the mouse to click the Fairlight 
page interface.

	— Momentary hold: A momentary hold involves pressing and holding a key with one hand to reveal 
additional keys and functions that can be quickly latched with the other hand.

NOTE:  From this point forward, descriptions such as type or press indicate a latched 
operation, long-press means to press longer than usual until you see the desired result, and 
instructions to hold and release refer to momentary operations.
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Examples of Long-Press and Momentary Key Press Actions
Here are three examples of these types of button presses in action.

Signal Processing keys: Pan, EQ, Dynamics, 
Aux, and Plug-in with EQ key latched

Using a long-press to open or close GUI windows:

There are five signal processing picture keys, including Pan, EQ, Dynamics, Aux, and Plugin. These 
correspond with the graphical display in the built-in Editor screen as well as the Fairlight Mixer on the 
computer screen. If you latch one of these keys, such as EQ, the Editor screen displays EQ parameters 
for the selected track. In turn, these parameters can be controlled by the adjacent soft buttons and 
knobs without opening the GUI controls on the computer screen. However, long-pressing the EQ key 
both selects these controls and opens the EQ window on the computer screen. The EQ window will 
stay open until you long-press the EQ key again to close it. This works the same as double-clicking the 
EQ control on the Fairlight Mixer UI, and then clicking the Close button on the EQ window to close it. 

 

Editor screen displaying EQ processing controls assigned to adjacent soft buttons and knobs

3879Fairlight  |  Chapter 182  Using the Fairlight Audio Editor



DaVinci Resolve Fairlight interface displaying EQ window that can  
be opened and closed with a long-press on the EQ key

NOTE:  Once you open a signal processing window using a long-press, the GUI window will 
automatically change to follow the current latched signal processing displayed in the Editor 
Screen and vice versa. So if you open the EQ window with a long-press, then latch the Pan 
key, the GUI window on the computer screen will change to the Pan window and the Editor 
screen will display controls for the Pan signal processing. If you want to see more than one 
signal processing window at a time on the computer screen, you’ll need to double-click 
them independently with the mouse.

Using a momentary key press to briefly enter a different Editor mode:

Each Editor mode includes a picture key toolset unique to that mode, however, audio work is a fluid 
process that sometimes requires users to jump back and forth quickly between toolsets while they 
work. Rather than reach for the mouse to access a menu, panel, setting, or tool via the Fairlight page 
interface, you can momentarily jump into another mode to access the tool you need, then jump back 
and continue your current task. 

For example, you could be monitoring playback levels and recording automation data in Mix mode 
when you decide to reset the Loudness meters to check the section that is coming up. The Loudness 
Reset controls are accessed via the Monitor mode Editor Screen controls. To get to them, momentarily 
hold the Monitor mode button with your left hand to reveal the Monitor mode picture keys and 
Editor screen controls. With your right hand, quickly latch the Loudness soft key below the Editor 
screen to display the Loudness settings, then press the Reset Loudness toggle key above the Editor 
screen to reset the Loudness meters. Release the Monitor mode button to return to Mix mode 
without interruption in playback or automation recording. This type of momentary operation is one 
of the secrets to harnessing the Fairlight Audio Editor’s speed and power because at any time, in any 
workflow, you can momentarily jump to a different mode to access a key to do something else and 
return to the previous task without stopping. In fact, it is common to momentarily jump into the Setup 
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mode toolset while you work because that is where you’ll find keys to quickly toggle on and off track 
layers, show or hide the Video Scroller, set the playhead (CTI) to fixed or moving, as well as save your 
project and modify the Audio Editor’s playback controls.

Another advantage of momentary key presses is that they don’t change the latched state of the key 
you are holding. Working with momentary key presses requires a bit of skill to master, but it can 
greatly increase your overall speed and efficiency.

Using a momentary key press to reveal related menu option keys:

Latching the Play Jog key starts playback and unlatching the same key engages the jog wheel. 
Momentarily holding the Play Jog key reveals six related menu option keys in the picture keys along 
the left side of the jog wheel without changing the current latched or unlatched state of the Play Jog 
key. While momentarily holding the Play Jog key, you can quickly latch any of the menu option keys. 
When you release the Play Jog key, the menu option keys are no longer visible. This maneuver can 
easily be done with the right hand while controlling the jog wheel.

 

Track Selection Keys
Quickly identifying and selecting tracks and buses is a vital part of recording, editing, and mixing 
workflows. Therefore, the Fairlight Audio Editor includes a dedicated row of picture keys, at the top of 
the keyboard, for selecting either tracks or master buses.

Track Selection Keys
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Track Selection keys utilize the Fairlight Audio Editor’s unique self-labeling picture key technology 
to display each track’s user-defined name and color just as it appears in the Fairlight page Timeline. 
Additionally, the Track Selection keys change appearance to reflect their current state so that you can 
quickly identify which tracks are selected and which track is actively displayed in the built-in Editor 
screen. When multiple tracks are selected, the most-recently selected track is always the track actively 
displayed on the Editor screen. Track Selection keys also reflect each track’s status with a colored icon 
that indicates if the track has been muted (M), soloed (S), or armed for recording (R).

TIP:  Holding the CTRL key down reveals alternate commands, including Mute Clear and 
Solo Clear (to clear either Mute or Solo states from all tracks). Holding the CTRL key and 
pressing Mute Clear or Solo Clear a second time acts as a specialized undo/redo toggle 
to restore all tracks to their previous Mute or Solo state prior to being cleared. This is 
incredibly useful during mixing so that you can focus on a set of soloed tracks, un-solo them 
all simultaneously to hear them with the mix, then quickly return them to their soloed state.

Track Selection key states and appearance changes include:

	— Unlatched: The track is deselected, with the track’s color showing as a bar above the track’s name.

	— Latched: The track is selected, with the track’s color expanding over two thirds of the button.

	— Active: The active track can easily be identified by a white bar on the lower third of the key and 
the track’s color in the upper two thirds. Additionally, the active track’s name, track number, track 
color and signal processing parameters are displayed on the Editor screen.

ADA VO wFX and ROOM tracks are selected, Room track is active, PFX muted, 
MEDLAB 1 and MEDLAB 2 tracks are soloed, and the DRONE track is deselected.

Master buses showing in the Track Selection keys with 
Main 1 active and the main named 5.1 muted.

NOTE:  Pressing a Track Selection key is the same as clicking a track header or channel strip 
in the Fairlight page Mixer with your mouse. 

Pressing a Track Selection key does all of the following simultaneously: 

	— Latches or unlatches that Track Selection key with visual feedback accordingly. 

	— Selects or deselects that track in the Fairlight page Timeline and Mixer.
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	— Displays that track’s signal processing in the built-in Editor screen.

	— Tallies on or off that track’s Channel Select button and calls up that channel’s parameters on the 
Fairlight Console Channel Control panel, if you are working on a Fairlight console. 

The dedicated Track Selection keys are located in the top row of the picture keyboard, where the 
number keys would be on a standard keyboard. Here you’ll find 12 track selection keys as well as 
All Tracks, Page Up ( ^ ), and Page Down ( v ) keys. 

You can select multiple tracks by pressing additional Track Selection keys. However, there can only be 
one active track at a time and it’s always the last Track Selection key pressed. Like most Fairlight Audio 
Editor keys, the Track Selection keys include some unique selection nuances to improve your efficiency 
without the need for a mouse. 

Track Selection keys and key-press options:

	— Track Selection keys: There is one Track Selection key for each track in the Fairlight page 
Timeline. From left to right the first 12 keys are Track Selection keys that follow the order of the 
tracks in the Timeline from top to bottom. Press once to select or deselect a track. Select as many 
tracks as needed, one track at a time, by simply latching the corresponding Track Selection keys. 
Double-press any Track Selection key to deselect all other tracks and actively select the current 
track. Hold a Track Selection key, then double-press another Track Selection key to select both 
tracks as well as all contiguous tracks between them. In this case, the key that was double‑pressed 
will become the active track.

	— All Tracks: Press this key to quickly select or deselect all tracks in the Timeline. Long-press the 
All Tracks key to change the entire picture keyboard to Track Selection keys for up to 48 tracks 
from left to right top to bottom. When All Tracks is latched, you’ll also have the option to continue 
to show tracks, or display master buses such as the Mains, Submix and Aux buses, and VCA 
groups. Below the All Tracks key, on the far right side of the picture keyboard, you’ll see the Tracks 
and Masters keys. Here you can choose which type of feed is displayed in the top row of the 
picture keyboard. Tracks are all of the Timeline tracks, and Masters are the buses for mixing and 
output. Long-press the key again to return to the default picture keyboard with one row of 12 
Track Selection keys at the top. 

	— Page Up (  ): Pages up to display the previous 12 tracks in the top row of Track Selection keys, or 
the previous 48 tracks when the picture keyboard is set to display 48 Track Selection keys. Holding 
Ctrl- changes the Page Up key to a Bank button for loading a user-defined bank of tracks.

	— Page Down (  ): Pages down to display the next 12 tracks in the top row of Track Selection keys, 
or the next 48 tracks when the picture keyboard is set to display 48 Track Selection keys. Holding 
Ctrl- changes the Page Down key to a Bank button for loading a user-defined bank of tracks.

NOTE:  Hiding track visibility in the Timeline, using the Index, or using the Hide Track key 
on the Audio Editor hides a track from the Timeline and Mixer, but does not change the 
corresponding track’s state, output or Track Selection key. Additionally, in DaVinci Resolve 
16 and higher you can show all master buses including Mains, Subs and Aux buses as tracks 
in the Timeline as long as the Automation toolset is showing and the buses are marked 
visible in the Tracks Index. 
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Moving Track Selection with the Jog Wheel
Whether you select a single track or multiple tracks, you can quickly move the entire selection up 
or down with the use of the Move Selected picture key and the jog wheel. The Move Selected key is 
available in both the Record and Edit mode toolsets. This is incredibly useful when working with high 
track counts so that you can select a track or group of tracks much higher or lower in the Timeline 
without the need to grab your mouse to scroll. Simply hold the Move Select key while you turn the 
jog wheel clockwise to scroll the selection down to lower tracks, or counter-clockwise to scroll up 
to higher tracks. Keep in mind this only moves the selection and does not move the tracks or the 
contents of the tracks. 

Move Selected key 
available in Record 
mode and Edit mode 

Switching Pages
Although the Fairlight Audio Editor is designed to work exclusively with the Fairlight page in 
DaVinci Resolve, there may be times when you need to switch to a different page in DaVinci Resolve, 
such as importing and syncing audio files in the Media page, or rendering a finished mix in the 
Deliver page. The Menu key, located next to the modifier keys in the lower-left corner of the picture 
keyboard, lets you quickly access the QWERTY keyboard, or any of the other pages in DaVinci Resolve. 
A momentary-press on the Menu key reveals keys for each of the DaVinci Resolve pages in the 
order that they are listed at the bottom of the software interface: Media, Cut, Edit, Fusion, Color, 
Fairlight, and Deliver. There is also a QWERTY key to temporarily change the picture keys to a 
QWERTY keyboard.

 

Menu key next to Modifier keys in lower-left of keyboard; momentary-press on  
Menu key reveals QWERTY and DaVinci Resolve Page keys
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NOTE:  The Fairlight Audio Editor is designed to work with the Fairlight page. If you switch 
to a different page in DaVinci Resolve, you’ll need to use your computer keyboard and 
mouse for any operations in the user interface. While other pages are open, the Fairlight 
Audio Editor shows a QWERTY keyboard that you can use to trigger keyboard shortcuts 
while working on those pages, just like an ordinary computer keyboard. Once you return to 
the Fairlight page, the Audio Editor will resume working.

Fairlight Audio Editor
Now that you are familiar with the general layout, types of controls, Editor modes and key-press 
options in the Fairlight Audio Editor, it’s time to dive deeper into the different areas of operation and 
how everything works together. Keep in mind that the Fairlight Audio Editor is essentially an over-sized 
mouse designed specifically to control the DaVinci Resolve Fairlight page. Therefore, the better you 
understand the Fairlight page, the more proficient you’ll be with your Audio Editor panel. 

Please refer to the previous Fairlight chapters for detailed information on the software interface, 
tools, functions, and audio workflows. However, with the increased functionality and physical controls 
available on the Fairlight Audio Editor, there are some functions and workflow enhancements that are 
only available via the Editor panel. This section will give an overview of the entire Fairlight Audio Editor 
and focus more in-depth on unique features and functions that go beyond the standard keyboard and 
mouse options in the Fairlight page. 

Monitor Section
The Monitor section in the upper-right corner of the Fairlight Audio Editor panel is where you 
control playback levels for the Control Room and Studio speakers. Control Room monitor levels can 
be changed at any time using the Control Room knob. Adjusting these controls also adjusts the 
corresponding onscreen monitoring controls in DaVinci Resolve.

Control Room monitoring controls include: 

	— Control Room knob: this can be used to quickly dial the level of the speakers selected in the 
control room. You can select alternate control room speaker sets in the Monitor mode toolset.

	— DIM: This button reduces the Control Room monitor volume by a user-defined amount. Press to 
toggle Dim on or off. You can set the Dim level on the Editor screen in Monitor mode. 

	— MUTE: Use this button to mute or unmute the Control Room monitors. 

The Studio controls control the Studio monitoring circuit of a Fairlight Accelerator card installed on 
your workstation.

Studio monitoring controls include: 

	— Studio knob: Use this to dial the level of the speakers in the Studio.

	— Talk: Latch this button to toggle on or off a talkback microphone. When latched, the talkback 
mic remains live. Momentary-press the talk button to use talkback without latching, in this 
case, the talkback mic will remain live only during the momentary-press and shut off when you 
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release. Press Control with the Talk button to open or close the Talkback Settings window on the 
computer screen. Engaging Talk also dims the Control Room circuit. You can modify the talkback 
functionality and general purpose input and output (GPI/GPO) via the Talk Setup menu option 
keys in the Setup mode picture keys.

	— MUTE: Use this button to mute the Studio monitors.

 

Monitor controls	� Talkback Settings window, opened or closed 
by pressing Control with the Talk button 

User-defined Fixed Control Room and Dim levels
Sometimes the monitoring environment must be set to a standard level and not changed. This is 
called Fixed Level monitoring. For example, if your control room has been calibrated with a sound 
pressure level (SPL) meter, you will probably want to set a Fixed monitoring level. When fixed, 
the Control Room knob has no affect on the monitoring levels. You’ll find controls for Fixed Level 
monitoring on the built-in Editor screen in Monitor mode. Here you can also toggle on and off Fixed 
level monitoring and adjust the Dim level. When Fixed Level monitoring is toggled on, the listening 
level meter in the upper-right of the Timeline GUI turns from green to blue. 

To set and reset Fixed and Dim Control Room monitor levels:

1	 Latch or momentary-press the Monitor mode key to enter the Monitor toolset and show the 
Dim Level and Fixed Level controls on the left side of the Editor screen. 

2	 Use the top control knob to adjust the adjacent Dim level amount onscreen. As you turn the knob 
left or right, the Dim level GUI changes accordingly. 

3	 Use the middle knob to adjust the adjacent Fixed Level control using the GUI display in the 
Editor as a guide. 

4	 To toggle Fixed Level monitoring on or off, press the soft button directly above the Fixed Level On/
Off button on the Editor screen. This can be done anytime during playback, recording, or mixing 
sessions by simply using a momentary-press on the Monitor mode key then toggling on or off the 
Fixed Level On/Off soft button.

5	 Hold the Control key while touching a touch-sensitive knob to reset it to the default value. In this 
case, the default Dim level is -15dB and the default Fixed Level is 0.0dB. 
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6	 When finished, release the Monitor key If you were performing a momentary-press. Otherwise, 
simply latch a different Editor mode key to exit Monitor mode.

DIM Level Control

Monitoring and Loudness 
soft menu buttons

Monitor Mode Key

Fixed Level Toggle 
soft menu button

Fixed Level Control

TIP:  Setting monitor levels is an example of how different areas of the Fairlight Audio 
Editor work together to quickly achieve a goal. To further define an example, a user could 
be in the middle of a session and decide to change the Dim level. Without interrupting 
the current task, the user could momentarily hold the Monitor mode key with one hand 
and with the other hand, quickly adjust the Dim Level. When finished, the user only needs 
to release the Monitor key to resume whatever they were working on. Latching the Dim 
button on the Monitor controls will now reduce the Control Room monitors to the newly 
defined Dim level. 

Numeric Keypad
For the most part, the numeric keypad on the Fairlight Audio Editor is self explanatory and functions 
exactly the same as the numeric keypad on an extended keyboard for entering timecode and number 
values. There are, however a few specialized keys, such as Colon (:), Clear, and GoTo, that can be used 
to expedite timecode entry, set locators, and quickly move the playhead or clip to a specific time. 
Additionally, there are some user-definable operations, such as Review, where you can combine a 
momentary hold on the Review key plus a Number Key (1 to 9) to set the number of seconds you’d 
like the playhead to jump back for the Review operation. The timecode is displayed in the Timecode 
field in the upper-left corner of the Timeline on the computer display, so you can always see the new 
timecode values as you type.
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Numeric keypad 

Corresponding Timecode 
Display and Range buttons 
on Fairlight page Timeline

Numeric Keypad Keys: 

	— Number Keys 0 to 9 : Used for entering number values and timecode entry. Timecode entry 
requires latching the GoTo Key first. 

	— GoTo: When latched, the numeric keypad is in GoTo entry mode and numbers you enter 
determine where the playhead will move when you unlatch the GoTo key. Numeric entry can 
include numbers, timecode, or timecode increments. Positive numbers move forward in the 
Timeline and negative numbers move back. 

	— Use a momentary press on the GoTo key to jump to one of the three user-definable locator 
positions in the Timeline. 

	— Additionally, when the GoTo key is latched, the standard Play and Stop transport keys become 
GoTo Play and GoTo Stop keys. This can save a keystroke for the operator so they can type in 
timecode and immediately go to that location and play or stop without first unlatching the 
GoTo key.
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Transport controls while GoTo key is latched on the numeric keypad

	— Plus (+): Used in typing or to increment numbers. Typing a Plus before entering a numeric 
timecode value moves the playhead forward by that value. For example, latching the GoTo key, 
then typing +0500 and unlatching the GoTo key moves the playhead forward five seconds. When 
typing values with Plus or Minus keys, the values are entered as timecode from right to left. In this 
example, +0500 = move playhead 05:00 later.

	— Minus (-): This key is used in typing or to increment numbers. Typing a Minus before entering a 
number value moves the playhead forward by that value. For example, latching the GoTo key, then 
typing -0500 and unlatching the GoTo key moves the playhead back five seconds earlier in the 
Timeline. When typing values with Plus or Minus keys, the values are entered as timecode from 
right to left. In this example, -0500 = move playhead 05:00 earlier. 

	— Clear: Clears the current number or timecode entry while in GoTo entry mode. The Clear key can 
also be used to clear user-defined number values, such as locators. 

	— Colon (:): This key can be used to separate Hours:Minutes:Seconds:Frames in timecode entry, or 
as a numeric shortcut key that represents a timecode position and replaces 00 when entering 
timecode. When you type two numbers, a colon is automatically added before the third number. 
Likewise, typing two numbers followed by a colon also places the colon directly after the two 
numbers you just typed. This follows standard timecode entry rules for typing in timecode 
numbers. In this case, to substitute 00 with the colon key, you need to type a second colon. 
Subsequent typed colons in the same timecode entry event will automatically substituted 00.

The number of colons typed before or after a number indicates the timecode position of the number 
in the GoTo command. For example, latching GoTo then typing 02:::02 (zero, two, colon, colon, colon, 
zero, two), then unlatching GoTo moves the playhead to 02:00:00:02. Additionally, the Colon key is 
a real time saver for navigating to specific areas of the Timeline without the need to type the entire 
number. The position of the Colon in the numeric shorthand value typed determines if the numbers 
entered as timecode start from the right as frames, or if you keep the current timecode and move to a 
designated hour from the left. 
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For example, if the playhead is currently positioned at 01:00:00:00 and you latch GoTo, then type :20 
(colon, two, zero) when you unlatch GoTo, the playhead will move to 01:00:00:20. However, if you then 
latch GoTo and type 02: (zero, two, colon), then unlatch GoTo, the timecode entry is incremental from 
right to left, so the result is 01:00:02:00. 

TIP:  Timecode entry appears in the upper-left corner of the Fairlight Timeline on the 
computer screen. If you wish to change the timecode to display subframes, you can right-
click the timecode display and choose the display setting you wish from the drop-down 
menu. You can also open a floating Timecode window that displays the playhead position 
(CTI) from the Workspace menu.

Numeric Keypad Locators
The Fairlight Audio Editor includes three user-defined locators that are used to quickly move the 
playhead to a stored timecode location. These non-permanent locators are designed to use freely 
in editing and mixing, but are not saved with the project. A momentary-press on the GoTo key is 
required to use, set, or clear the locators, which are assigned to the 1, 2 and 3 keys on the numeric 
keypad. Navigating with locators is a fast and easy way to jump to key positions in the Timeline. Setting 
a locator based on the current timecode position is often the first and last operation when recording 
macros so that the macro can start and end at the current timecode position. At this time, locators are 
only available in the Fairlight Audio Editor.

To set one of the three user-defined locators:

1	 Move the playhead to the timecode position that you wish to save as a locator position. In this 
example you will assign the current playhead position to the first locator on the 1 key. 

2	 Momentary-press the GoTo key. This illuminates the 1, 2, and 3 keys on the numeric keypad. 
Continue to hold the GoTo key.

3	 Momentary-press the 1 key until it tallys on to show that it has been set. 

4	 Release both the GoTo and 1 keys. You can follow the same steps to set the second and third 
locators that are assigned to the number 2 and 3 keys. Locators can be set to new timecode 
positions anytime while you work and do not have to be cleared before setting a new location. 

To use a locator for navigation: 

1	 Momentary-press the GoTo key. The number keys, 1, 2, and 3 illuminate. In this example, you will 
go to locator number 2.

2	 Continue to press the GoTo key. Quickly press and release the 2 key. 

3	 Release the GoTo key. The playhead jumps to the second locator timecode position.

NOTE:  You need to first set a locator before it can be used. Locators are not 
saved with the project. 
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To clear all locators: 

1	 Momentary-press the GoTo and Clear keys. The number keys, 1, 2, and 3 illuminate, but continue 
pressing the GoTo and Clear keys. 

2	 Long press each of the 1, 2, and 3 number keys to tally them on.

3	 Release the GoTo and Clear keys. The locators are now clear and will not affect the playhead 
position until they are set to new timecode locations. 

Numeric keypad with Locator keys illuminated 
during momentary hold of the GoTo key

Jog Wheel with Fixed Keys 
and Soft Menu Picture Keys 
The jog wheel and surrounding Fixed keys offer a complete set of transport commands, designed to 
let you keep your hand in one position while editing. Here you can not only navigate the Timeline from 
end to end or anywhere in between in seconds, but also go from seeing all tracks to a focused zoom 
on a single clip at the sample level faster than you could reach over and pick up a traditional mouse.  

Shuttle/jog wheel with Fixed keys and default Play menu and Loop picture keys
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The combination of the jog wheel and Fixed keys offer standard and advanced playback and 
navigation options that can be defined in Setup mode and with the adjacent picture keys. The soft 
menu picture keys to the left of the jog wheel display menu options related to Fixed key and Shuttle 
functions. Since this section of the Fairlight Audio Editor includes such an extensive set of features and 
functionality, let’s start with the jog wheel as a means of navigation and playback, then move on to the 
Play menu picture keys, Fixed keys, and subsequent additional soft menu picture keys.

Shuttle/Jog Wheel
The jog wheel is the most versatile control on the Fairlight Audio Editor, and is designed for ease-of-
use with all of the associated keys within reach. As a means of navigation and playback, the wheel has 
two modes of operation, shuttle and jog, that are initiated by the respective Shuttle Position and Play 
Jog keys above the wheel. 

In Shuttle mode, turning the wheel forward (clockwise) or back (counter-clockwise) starts playback 
in fast forward or rewind at variable speeds based on the amount the wheel is turned. Releasing the 
wheel while shuttling forward or back will continue constant playback at the current speed until the 
playhead reaches the beginning or end of the project. 

In Jog mode, the playhead movement is contingent on the movement of the wheel, so you can freely 
jog forward or in reverse at variable speeds while turning the wheel and playback stops immediately 
when the wheel is released. Jog mode is generally used to scrub a specific area to focus on audible 
cues for editing and trimming, or for subframe loop-jog scrubbing to pinpoint issues and fine-tune 
edits. Shuttle mode is used to quickly navigate to a specific location or start playback at a variable 
speed. Additionally, the wheel can be used for common functions such as zooming, quickly scrolling 
track selection to different tracks, changing clip volume levels or even dialing the shape of clip fades.

TIP:  Holding CTRL and Play/Jog puts the wheel into Shuttle mode. This maneuver also 
initiates Free shuttle movement even if the Editor setup controls are set to Fixed Shuttle. 
Thus, pressing CTRL + Play/Jog is a common audio editor shortcut for Free Shuttle control. 
Additionally, holding CTRL while turning the jog wheel increases the speed 8X. Releasing 
CTRL returns the wheel to standard jog speed.

Soft Menu Picture Keys
The six picture keys to the left of the jog wheel display soft menu options when you momentarily 
press the Play/Jog, Rewind, Fast Forward, and Zoom keys. The default soft menu keys that are always 
available are the Play Menu and Loop keys. Latching the Play Menu key shows six specialized playback 
options and likewise a long-press on the Loop key shows the Loop Playback options keys that change 
the looped playback mode assigned to the Loop key.
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Latching the Play Menu key displays special play commands on the adjacent 
soft menu picture keys:

	— Play Again: Plays from the same place as the last time, such as the timecode where the transport 
last entered Play. This could also include Play and Record at the same time. This key is the same as 
the Play Menu key so when the Play Menu keys are not displayed, you can simply press Play Menu 
twice for Play Again.

	— Play Range: This operation plays from the In Point (beginning) to the Out Point (end) of a range in 
the Timeline. 

	— Play Clip: This plays the clip beneath the playhead on the active selected track. If there is no clip 
beneath the playhead, the next clip on selected track is played. 

	— Play In: Plays from one second before the In Point of a range in the Timeline. 

	— Play Out: Plays from one second before the Out Point of a range in the Timeline.

	— Exit: Exits the Play Menu.

A long-press on the Loop key displays the Loop Playback Options menu keys:

	— Loop Range: Loops playback around the marked range, from In Point to Out Point in the Timeline. 

	— Loop Clip: This operation loops playback around the clip beneath the playhead on the most-
recently-selected track. If there is not a clip beneath the playhead on the active track, the next clip 
in the track is played. If a track is not selected, this key has no affect on playback.

	— Loop +/- 1: This creates a two second playback loop around the current playhead position that 
starts one second before the playhead and ends one second after the playhead. 

	— Loop +/- 3: This creates a six second loop around the current playhead position that starts three 
seconds before the playhead and ends three seconds after.

	— Exit: Exits the Loop Options menu without changing the current loop playback mode.

(Left) Default soft menu keys with Play Menu key unlatched with Loop key set to Loop 
Clip, (Center) Play Menu key latched, showing Playback Options keys, (Right) Loop key 
latched, showing Loop Options menu for assigning Loop Playback mode 
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Fixed Keys in Clockwise Order Starting in the 
Upper-left Above the Jog Wheel:

	— Shuttle/Position: Latch this key to engage the wheel as a shuttle control for navigation and 
playback. Unlatch or press Stop to stop playback and disengage the shuttle wheel. While Shuttle 
is active, the Rewind and Fast Forward transport keys light up to indicate which direction the 
transport is moving. In the Setup mode, Editor Setup keys you can change the shuttle to either 
Free or Fixed mode. 

	— Free Shuttle mode: When engaged, the shuttle wheel turns freely clockwise or counter-
clockwise, can change direction instantaneously, and shuttles at variable speeds based on the 
amount and direction you turn the wheel. 

	— Fixed Shuttle mode: Turning the wheel forward or back starts fast-forward or reverse 
playback at a fixed speed with built-in stops whenever you change direction. 

	— Position mode: Hold the Shuttle/Position key while turning the wheel to quickly position 
the playhead (CTI) in the Timeline. In position mode, you can move the playhead from the 
beginning to the end of the Timeline in a single rotation of the wheel.

TIP:  When the shuttle is set to Fixed Shuttle mode you can temporarily override the 
fixed setting with a long-press on the Shuttle/Position key after it is latched. 

	— Review: This key jumps the playhead back a number of second, then plays. Press this key 
repeatedly to make multiple jumps. The default review jump back time is four seconds. You can 
change this setting to any number of seconds by long-pressing the Review button and pressing 
any button between one and nine on the numeric keypad. 

	— Rewind/Jump Back: This key can operate as either a Rewind key or Jump Back key. You can toggle 
between key functions in the Setup mode, Editor Setup option keys.

	— Rewind key: The operation works exactly as the Rewind key in the Transport keys section of 
the keyboard; you can press the Rewind key repeatedly to increase speed. 

	— Jump Back: Use this key to jump back to the previous target based on user selection in 
the Jump soft menu picture keys to the left of the shuttle wheel. Press and hold either the 
Fast Forward or Rewind key to choose jump to targets, including To Clip, To Mark, and To 
Fade from the soft menu picture keys. Jump Back moves to the previous Clip or Fade based on 
track selection. 

	— Fast Forward/Jump Forward: This key can operate as either a Fast Forward key or Jump Forward 
key. You can toggle between key functions in the Setup mode, Editor Setup option keys. Since 
there is already a dedicated Fast Forward key, as well as a shuttle wheel for engaging variable 
speed Fast Forward, this key is often set to Jump Forward instead.

	— Fast Forward: This operation works exactly as the Fast Forward key in the Transport 
keys section of the picture keyboard. You can press the Fast Forward key repeatedly to 
increase speed.

	— Jump Forward: You can use this key to Jump forward to the next target based on user 
selection in the Jump soft menu picture keys to the left of the shuttle wheel. Press and hold 
the Jump Forward key to choose jump to targets, including Clip, Marker, and Fade. Jump 
forward to the next Clip and Fade targets are based on track selection. Marker targets can be 
either Timeline markers or Clip markers. 
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Momentary-press on Rewind or Fast Forward fixed keys 
shows jump targets in the soft menu keys: To Clips, To Marks 
and To Fades; latch the jump targets you wish to use for 
navigation with the Jump Forward and Jump Back keys

	— Play/Jog: Use this key to start playback or engage the jog wheel for manual jog control. By 
default, the first press of the Play/Jog key engages the jog wheel. The second press latches the 
key in Play mode and starts playback. If the Play/Jog key is latched, unlatching the key re-engages 
the jog wheel. Once the key has been latched, it toggles between Play and Jog. To disable the jog 
wheel, press the Stop key. Press and hold Play/Jog to show the associated soft menu options in the 
adjacent picture keys on the left side of the jog wheel.

Play/Jog soft menu keys with Momentary-press on Play/Jog key:  
Loop Jog, Rescale Jogger, Jog DIM, Gear, Width, and Follow Zoom.
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	— Loop Jog: This key toggles Loop Jog on and off. When Loop Jog is on, the transport plays a 
small length of audio (between 5ms and 2000ms), repeatedly, at play speed. The loop moves 
as you jog the transport forward or backward. This is a great tool for editing, because it 
maintains the correct pitch of the audio, allowing you to hear clicks, pops, sibilants in the 
middle of words, and so on. Some of the other soft keys in this menu control additional Loop 
Jog parameters.

	— Rescale Jogger: Use this key to change the gear ratio based on the current zoom level so that 
three revolutions a second of the jog wheel reaches normal play speed. 

	— Jog DIM: Toggles Jog Dim on and off. When on, it causes the monitoring level to automatically 
dim during Loop Jog to the user-defined value set in the Monitor mode Dim level. 

	— Gear: This changes the “gear ratio” when jogging between 1 and 20. In other words, it 
determines how quickly the transport moves in response to turning the jog wheel. You 
can change the Gear ratio by pressing the Gear key while turning the jog wheel. The lower 
the Gear number, the slower the transport will go; the higher the Gear number, the faster the 
transport will go.

	— Width: Sets the width for the Loop Jog in milliseconds between 5ms and 2000ms. This is the 
amount of audio that is repeated in each loop. You can set this amount by holding the Width 
key and turning the jog wheel. 

	— Follow Zoom: This toggles Follow Zoom on or off. When on, the gear ratio of the jog wheel is 
affected by the Zoom setting. The default setting for this control is toggled on. 

	— Record: Latch this key along with the Play key in the standard Transport keys to begin recording to 
the armed track or tracks. Press the Stop key to stop recording. To arm a track for recording, press 
and hold the Record key, then press the Track Selection key for the track you want to arm. Tracks 
must be patched to an input before they can be armed for recording. 

	— Stop: As you may have guessed, this key stops playback or recording. 

	— Up: You can use this key to move the track selection up to the previous track in the Timeline. 

	— Down: Use this key to move the track selection down to the next track in the Timeline. 

	— Redo: Reverses the effect of the last Undo. This can be used repeatedly to step forward through 
the editing history. 

	— Undo: Reverses the effect of the last edit and can be used repeatedly to step back through the 
editing history. Also returns to the location and track selection of the edit being undone. A list of 
the actions can be seen in the Edit menu > History. There you can also Open History Window to 
see a full edit history list. 

NOTE:  Undo and Redo works on all editing actions while in Editing mode. While in 
Mix mode, you can choose either Undo All or Undo Editor. The default Undo setting 
for mixing is Undo Editor, which limits Undo to editing functions and disables Undo 
for mixing and automation in Mix mode. The Undo settings can be changed in the 
Setup mode. For more information about Undo and Redo operations in DaVinci Resolve,  
see Chapter 1, “Introduction to DaVinci Resolve.” 
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	— Zoom: The Zoom key in combination with the jog wheel and modifier keys offers numerous quick 
zooming and scaling options while you work. 

	— Hold Zoom and turn the jog wheel to change the horizontal scale of the Timeline on the 
computer screen. 

	— Hold Control + Zoom and turn the jog wheel to change the vertical scale of the Timeline, 
which in turn, changes the height of the tracks and the subsequent number of tracks visible 
in the Timeline. Horizontal scaling always zooms around the playhead, while vertical zooming 
focuses on the active selected track. 

	— Double-tap Zoom to zoom your entire program to fit within the current visible 
width of the Timeline.

	— Press and hold Zoom to show the Zoom menu option keys in the adjacent picture keys. These 
Zoom menu option keys are a fast way to change vertical scaling while zooming horizontally 
with the jog wheel for dynamic scaling while you work. 

These options are:

1 Track Vertically scales the Timeline tracks to show only the active track.

2 Tracks Vertically scales the Timeline to show two tracks, including the active track. 

4 Tracks Vertically scales the Timeline to show four tracks, including the active track. 

8 Tracks Vertically scales the Timeline to show eight tracks, including the active track. 

16 Tracks
Vertically scales the Timeline tracks to show sixteen tracks, including the 
active track. 

All Tracks Vertically scales the Timeline tracks to show all tracks.

	— Hold Control + Zoom to show a secondary set of Zoom menu option keys, 
including the following: 

32 Tracks Vertically scales the Timeline to show 32 tracks, including the active track. 

48 Tracks Vertically scales the Timeline tracks to show 48 tracks, including the active track.

U1 Scales the Timeline to a user-defined view.

U2 Scales the Timeline to a user-defined view.

U3 Scales the Timeline to a user-defined view.

U4 Scales the Timeline to a user-defined view.
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Zoom soft menu picture keys, including 1 Track, 
2 Tracks, 4 Tracks, 8 Tracks, 16 Tracks, and All Tracks

	— Enter: When using the Fairlight Audio Editor for Cut, Copy, and Paste operations, the Enter key 
functions as a Paste key. Additionally, the Enter key completes and executes many operations. 
For example, if you are renaming a track using the QWERTY picture keyboard, pressing Enter after 
typing the name updates the track name, clears the keyboard, and returns to the previous 
Editor mode. 

NOTE:  In DaVinci Resolve 16.2 and later, a second Zoom button was added to the left side 
of the picture keyboard while in Mix and Edit mode, so editors can easily reach it with either 
the left or right hand while working.

The Review, Shuttle mode, Rewind, and Fast Forward keys can all be customized and used in a 
variety of ways.

To change the Review jump back amount, do the following:

1	 Momentary-press the Review key to illuminate the current Review setting in the numeric keypad.

2	 Long-press a different number of seconds from 1 to 9 on the numeric keypad until it tallys on to 
set a new review duration. 

3	 Release the number and the Review key.

a)	 Free Shuttle mode: When engaged, the shuttle wheel turns freely clockwise or counter-
clockwise, can change direction instantaneously, and shuttles at variable speeds based on the 
amount and direction you turn the wheel. 

b)	 Fixed Shuttle mode: Turning the wheel forward or back starts fast-forward or reverse 
playback at a fixed speed with built-in stops whenever you change direction.
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To toggle Shuttle mode between Free Shuttle and Fixed Shuttle, do the following:

1	 Latch or Momentary-press the Setup mode key. 

2	 Latch the Editor Mode key in the Setup toolset to show the Editor Mode menu option keys.

3	 In the Editor Mode menu option keys, latch or unlatch the Shuttle option key to toggle between 
Shuttle Fixed and Shuttle Free settings. 

To toggle the Rewind and Fast Forward keys to Jump keys or vice versa, do the following:

1	 Latch or Momentary-press the Setup mode key. 

2	 Latch the Editor Mode key in the Setup toolset to show the Editor Mode menu option keys.

3	 In the Editor Mode menu option keys, latch the Mode Wind key to toggle on Mode Jump. The Fixed 
Rewind and Fast Forward keys above the jog wheel are now set as Jump keys. 

4	 If the Fixed Rewind and Fast Forward keys are in Jump mode, you can toggle them to Wind mode 
by following steps 1 and 2, then unlatch the Mode Jump key to toggle it back to Mode Wind. 

To set a user-defined Zoom view in the Timeline.

1	 Momentary-press the Zoom and CTRL keys. 

2	 In the soft menu picture keys, long-press one of the user keys (U1, U2, U3, or U4) until the main 
picture keyboard shows all tracks.

3	 In the picture keyboard, latch the track selection keys for all of the tracks you would like to include 
in the user-defined view. 

4	 At the bottom of the picture keyboard, momentary-press the Menu key and the Fairlight key to 
exit the user Zoom setup mode. 

5	 You can repeat steps 1-3 for each of the four user-defined Zoom view keys. 

To use a user-defined Zoom view in the Timeline.

1	 Momentary-press the Zoom and CTRL keys. 

2	 In the soft menu picture keys to the left of the jog wheel, press the user view key 
(U1, U2, U3, or U4) to choose that view. 

3	 Release the Zoom and CTRL keys. 

4	 Latch or unlatch track selection keys to add or remove them from the current zoomed view.

Self-Labeling Picture Keyboard
The picture keyboard offers six different key layouts based on the six Editor modes. It also functions 
as a QWERTY keyboard for typing and data entry. Each Editor mode includes a specialized toolset of 
keys, unique to that mode. If you are familiar with the Fairlight page in DaVinci Resolve, the picture 
key functions are self-explanatory as they are clearly labeled with text and icons. For even easier 
identification, you can change the appearance of the picture keys to text only in the Editor Setup 
options on the Setup mode keyboard toolset by toggling the Icon Buttons key to reflect as Text Only. 

Since there are hundreds of picture key tools for nearly every function on the Fairlight Page in 
DaVinci Resolve, this section will focus on the types of picture keys, the different Editor mode toolsets, 
and keys in each Editor mode that offer tools and options that are only available in the Fairlight 
Audio Editor. 
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Types of picture keys: 

	— Editor Mode Keys: These keys determine the current mode of operation in the Fairlight Audio 
Editor. There can only be one active mode at a time, however, you can momentarily jump into 
a different mode to choose a setting, tool, or task, then jump back to the current mode. These 
modes include: Setup, Record, Monitor, Macro, Mix, and Edit. 

	— Menu and Menu Option Keys: Pressing or latching a Menu Key reveals a group of Menu Option 
keys adjacent to the latched Menu key. In most cases the Menu Option keys remain visible until 
you unlatch the parent menu key. For example, in Edit mode, you can latch the Track Menu key 
to show seven Track Menu-related option keys, including Unlock Height, Lock Micro, Lock Mini, 
Lock Large, Track Safe, Hide Track, and Un-Hide All. These options are also available when you 
right-click a track’s header, or click the Visibility icons on the Tracks pane of the Index Panel in 
the Fairlight page. When the picture keys are in Text Only mode, the Menu keys can be easily 
identified by the colored tag in the upper-left corner of the key. 

NOTE:  At this time, there is not an Un-Hide all tracks function on the Index panel in the 
Fairlight page. However, you can click your mouse on the Hide icon and drag it down 
over other hidden tracks to quickly swipe on or off track visibility. The Un-Hide All key is 
an example of a feature that is only available in the Fairlight Audio Editor. 

	— Toolset Group Keys: These are groups of similar operation keys that are placed together within 
an Editor mode toolset. For example, in Mix mode there is a group of Paste tools for pasting 
attributes from one track to others, including Paste EQ, Paste Dynamics, Paste Aux, Paste Path, 
Paste Plugins, and Paste All. This toolset group offers the same options that are available in the 
Paste Attributes sub-menu options in the Edit menu and right-click menu on a Track Header. 

	— Toggles: Toggle keys choose between a pair of options, often On or Off. In some cases, toggle 
keys toggle through multiple options. For example, in Record mode, the OSC key toggles 
the Oscillator on or off. However, the Input Monitor mode key toggles between all five Input 
Monitoring modes: Input, Auto, Record, Mute, and Repro. You can also latch the Input Monitor 
key to show the five input monitoring modes as menu option keys, similar to a drop-down menu. 
These same Input Monitoring modes are available via the Fairlight > Input Monitoring Style menu. 

	— Open/Close: These keys open or close the associated panel or window on the Fairlight page 
interface. If pressing the key opens the panel or window, pressing the key again closes it, in 
most cases. 

	— Action: Action keys cause an immediate result when pressed, such as Mark In, Mark Out, 
Trim Head, and Trim Tail in Edit mode. 

	— Secondary Functions: Instead of reaching for the mouse for some commonly used operations, 
you can simply press the Control modifier key to reveal them as secondary functions in the picture 
keyboard. For example, press the Control key to transform the Mix, Edit, and Monitor mode keys 
into toggle keys to Show/Hide the Mixer, Index, and Meters panels respectively on the Fairlight 
page. Having the option to quickly show and hide these panels can really speed up your workflow. 
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Selecting a Clip vs a Range
The Fairlight page in DaVinci Resolve has two prioritized selection options for recording and editing 
functions, both of which use track selection to determine the contents included in the selection. 

	— Clip selection: Selects clips beneath the playhead on a selected track or tracks. The exception 
is if clips are manually selected with the mouse. Clips that have been manually selected with the 
mouse are outlined in red and override selection based on the playhead and selected tracks. 
Clip selection is ideal If you only wish to edit a single clip or clips beneath the playhead on 
selected tracks. 

	— Range Selection: Involves setting In and Out points in the Timeline by either using the In and 
Out keys, or marking either In or Out and moving the playhead to create a range. Marking a range 
automatically toggles on the Range key. Range selection allows you to select a portion of a clip 
or multiple clips on all of the the selected tracks. When the Range key is latched, recording and 
editing operations may include all selected tracks within the range. If no tracks are selected, all of 
the timeline material within the Range boundary will be selected. This is useful if you are copying 
or cutting and pasting an entire range of the Timeline and pasting it elsewhere in the Timeline.

As you learn the different Record and Edit mode toolsets, remember that they will change based on 
the state of the Range key and the type of selection you have at the time of the operation. 

Range key unlatched and Range key latched 

Range selection within the selected track and clip selection 
of the clip beneath the playhead on the selected track
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Setup Mode Toolset
The Setup mode toolset is for the behind-the-scenes setup of operational elements that in many 
cases are set up when you start a project and left alone for the duration of the project. Here you’ll 
find specialized keys for setting up the Audio Editor’s functionality, toggling controls, or opening and 
closing settings windows that would otherwise require a mouse and menu selections on the Fairlight 
page. There are also some specialized setup keys that are only available on the Audio Editor, where 
you may wish to momentarily jump into Setup mode to enable or disable functions, then jump back to 
your current task. 

Setup mode default toolset

Setup mode keys for new features or enhanced features only 
available in the Fairlight Audio Editor:

	— Video Online/Offline: When toggled On (Online) the playhead is sync locked to the current video 
timecode in the Timeline. When toggled off (Offline), the playhead moves freely, and can be used 
to go to another area of the Timeline or Media Pool to add or edit a clip. Toggling this key back 
On (Online), returns the playhead to the exact position it was prior to going offline. This is a great 
way to temporarily move the transport offline so that you can go to a clip in another part of the 
Timeline, use the playhead as a sync point to copy or cut the clip, then toggle the Video back 
Online to jump the playhead and copied clip to the previous timeline location. 

	— Display Setup: This menu key reveals Display Setup Source keys to accommodate all of 
the Fairlight LCD screens on a console. Each Source key toggles between DATA, HDMI and 
SDI as needed.

	— Fader Spill: Temporarily spilling the member tracks of a master bus or VCA group to nearby 
faders is a fast way to finesse member track levels while mixing. Use this menu key to reveal two 
menu Spill option keys that determine the type of fader channel and direction in which member 
tracks are temporarily mapped to the adjoining faders on the Fairlight Channel Fader panel.

	— Spill Left/Spill Right: This menu options key toggles between Spill: Left and Spill: Right, which 
in turn dictates whether the member tracks of a bus are assigned to neighboring faders to 
the left or right of a bus when Spill is engaged in the Channel Fader panel. 

	— Spill Any/Spill Tracks: When in the default (unlatched) state, the Spill: Any menu option allows 
member tracks of a bus to be spilled to the nearest faders to the left or right, including faders 
assigned to Master buses and VCA groups. When latched to the Spill: Tracks option, member 
tracks of a bus spill either left or right, starting with the nearest track fader in the designated 
direction. This option is useful if you need to maintain fader control of your buses while you 
spill their constituent tracks to the nearest track faders.
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NOTE:  Fader spill is engaged on the Channel Fader panel with a momentary-press on 
the Bank/Flip key, then latching the call button on a bus channel in the current fader 
bank. For more detailed instructions on using Fader Spill and creating custom Fader 
Banks, see Chapter 184, “Modular Fairlight Consoles.” 

	— DL Off: This is the Decklink Offset key that lets you offset the Decklink Output so the picture 
and audio are in sync. Momentary press the DL Offset key and turn the jog wheel to increase or 
decrease the frame offset between 0 and 7 frames. This feature is also available in the Fairlight, 
Video I/O Offset section of the the DaVinci Resolve User Preferences. 

	— ADV In Jog: Latch this key to apply the Decklink Output offset while playback is in Jog or Shuttle 
mode. This feature is also available as a checkbox in the Fairlight section of the DaVinci Resolve 
User Preferences. 

Fairlight - Video I/O Offset settings in DaVinci Resolve User 
Preferences that mirror the DL Offset and ADV in Jog picture 
key functions on the Audio Editor

	— Talk Setup: This menu key reveals three menu option toggle keys to customize the Editor’s 
Talkback functionality:

	— Smart Talk/Push-2-Talk: This key toggles between the default unlatched Smart Talk option 
and the latched Push-2-Talk option. Smart Talk allows the user to either latch the Talk button 
for extended hands-free talkback, or Push-2-Talk with a momentary press on the Talk button. 
Latching this key toggles on the Push-2-Talk mode, which limits talkback to the momentary-
press Push-2-Talk method similar to using a 2-way radio. 

	— GPI: Talk/DIM/None: This key toggles the Monitoring Controls for the general purpose input 
(GPI) between None, Talk plus DIM, or DIM only.

	— GPO: Talk/None/Armed/Record: Use this menu options key to determine when the general 
purpose output (GPO) sends a signal during a session. This key toggles between Talk, None, 
Armed and Record. 
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Console Setup menu option keys

	— Console Setup: This menu key reveals toggle keys to customize the Editor functionality, including:

	— Write Paste: Toggle this key on if you want controls automatically placed in Write mode when 
pasting from one channel to another.

	— Common Macros/Mixer Macros: Use this key to choose whether the 14 macro quick keys 
remain the same (common) for both Edit and Mix modes, or if they change to macros 1-14 for 
Edit mode and 15-28 for Mix mode.

	— Mode Jump/Wind: This key toggles between Jump and Wind modes for the Rewind and Fast 
Forward keys above the jog wheel. 

	— Mixer Follows/Mixer Link: Use this key to toggle the mixer between Follows and Link modes. 
When Mixer Link is toggled on, the mixer updates to show selected tracks in the Timeline. 
(Corresponding Resolve Preference > User > Fairlight.)

	— Always Jog: When this key is toggled On, any movement of the jog wheel will cause the 
transport to switch to Jog. Always Jog affects the wheel when the transport is not in motion 
and does not override Shuttle, Scroll, or Record operations.  

	— Trim from 0: Toggles on Trim from Unity (0). You can use this in Mix mode while trimming 
fader automation. When toggled on, if automation is set to trim, faders armed to write will 
rest at unity where they can be manually adjusted from that position to trim the existing 
automation curve.

	— Shuttle Fixed/Shuttle Free: This key toggles between Fixed or Free Jog Shuttle mode. 

	— Jump/Wind: This key toggles between Jump and Wind modes for the Rewind and Fast Forward 
keys above the jog wheel. 

	— Icon Buttons/Text Only: Use this key to toggle the picture keys between Icon and Text 
or Text only. 

	— ALT Layout: Latch this key to switch from the Normal layout to a new alternative text-only 
keyboard layout. This new Alt text-picture key layout shows keys that are relevant to the current 
task, with keys grouped toward the middle and lower rows of the keyboard for easy access. In 
this layout, the Editor Mode keys are located in the center of the the lower two rows of the picture 
keyboard. They are easy to spot with white text labels and a white line at the bottom of each mode 
key. The alternative layout also utilizes the six soft menu picture keys to the left of the jog/shuttle 
wheel for toolset group keys based on the current Editor mode and task at hand. 

To return to the normal layout of the picture keyboard, do the following: 

1	 Press the white SETUP mode key, if necessary. 

2	 Press the yellow UTILS (Utilities) key. To reveal the Utilities menu options keys in the row above the 
UTILS key. The yellow tag in the upper-left corner of the UTILS key indicates it is a menu key.

3	 Press the orange ALT LAYOUT menu options key to return to the normal layout.
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Alt Layout with the SETUP mode key latched and the UTILS menu key on the far right unlatched 

Alt Layout with the UTILS menu key latched and subsequent menu options 
keys in the row above including the latched Alt Layout key

NOTE:  You’ll find pictures of each of the Alt Layout toolsets later in this chapter.

Additional enhanced features only available in the Fairlight Audio Editor:

	— Call Follows key: In addition to selecting a track, there are other criteria for making a track active 
and “calling” its information into the Editor screen and corresponding Channel Control bay if you 
are on a Fairlight Audio Editor connected to a Fairlight console. These Call Follows menu options 
depend on the physical buttons, touch‑sensitive knobs, and faders on the Fairlight console. 
The Call Follows menu key offers five Call Option keys that can be used alone or in combination to 
determine which track or master bus is active:

	— Current Track: When toggled on, the most recently selected track is the active track.

	— Fader Touch: When toggled on, touching a fader on the Fader panel makes it active.
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	— Pan Touch: When toggled on, touching the Pan knob on the Fader panel makes it the 
active track.

	— Inline Touch: When toggled on, touching any touch sensitive knob on the Channel Control 
panel, while set to Inline mode, calls that track and makes it active.

	— Solo Button: Latching the Solo button on the Fader panel makes it active. Using a mouse 
or the Solo button on the Fairlight Audio Editor does not “call” the track active. Only the Solo 
button on the Fairlight Fader Control panel works in this scenario. 

	— Undo Editor/Undo All: This key is a matter of operator preference. When set to the default 
(unlatched), Undo Editor, tasks performed in Mix mode, including recording and editing 
automation data, will not be undoable. You can, however, simply record new mixing data to 
override the previous data as needed. Latching this key enables the Undo All mode, which in turn 
will undo all actions including automation applied in Mix mode. 

	— CTI Fixed/Moving: This key lets you choose whether the playhead (CTI) moves across the 
Timeline, or is fixed in place with the Timeline scrolling past.

	— Preview Track/Mon: This key determines where preview monitoring goes when auditioning a 
sound and comes in handy when you need to preview a clip in the Media Pool or Sound Library. 
When toggled to Preview Track, you will put the track in Thru mode so it works like a live mic 
input and the sound you preview will be subject to the track’s fader levels, solo or mute state, and 
any processing applied to the track. If toggled to Preview Mon, the sound goes directly to the 
monitors without any processing or controls via the track’s channel strip in the mixer or console. 

	— Normal Solo/Solo Follows: This lets you customize how the Solo commands work. 
Normal Solo/Solo Follows is a bypass toggle for the Call Follows, Solo Button option. If the Call 
Follows, Solo Button menu options key is latched, and the Normal Solo/Solo Follows key is latched, 
soloing a track in the Audio Editor or Channel Fader panel “calls” that track’s information into 
the Editor display on the Audio Editor, and the Channel display in a Fairlight Console Channel 
bay. Unlatching the Normal Solo/Solo Follows key bypasses the Solo Call feature and returns 
Solo functionality to Normal Solo behavior, as the name suggests.

Using the Playhead as a Sync Point indicator to sync  
sound to picture using Video Online/Offline key:

1	 With the Video Online/Offline key latched on, move the Playhead to the desired frame in the 
Timeline. For this example, let’s make it the frame where a door slams closed in the Viewer.

2	 Unlatch the Video Online/Offline key so that it is offline.

3	 Move the playhead to another location in the Timeline where there is a door closing sound effect 
that you’d like to copy. 

4	 Select the track with the clip you want to copy, and move the playhead over the frame that you 
want to sync with the door closing frame. 

5	 In Edit mode, press the Copy Clip key. 

6	 Latch the Video Online/Offline key so that it is Online. The playhead jumps to the previous location 
using the playhead as a sync point to match the door closing audio clip to the video frame of the 
door closing.

7	 If necessary, press the Track Selection key for the track where you wish to paste the synced clip.

8	 Press the Enter key to paste the clip.
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Record Mode Toolset
The Record mode toolset is where you do your recording and offers specialized toolsets for both 
Manual and ADR recording. There are keys for every recording feature available on the Fairlight page 
including keys to open and close the Patch Input/Output window and ADR panels as well as rate 
takes without needing your mouse. Latch the ADR List, ADR Record or ADR Setup keys to open the 
associated panels on the computer screen. When either the ADR List or ADR Record keys are latched, 
you’ll see picture keys for each interface button in the associated workflows. For example, latching 
the ADR Record key reveals a set of seven specialized keys for ADR Recording, including Previous Cue, 
Next Cue, Previous Take, Next Take, Rehearse Cue, Record Cue, and Play Cue. These keys work exactly 
the same as using a mouse and keyboard on the ADR Record panel in the Fairlight page interface. 

The Fairlight Audio Editor includes a special set of Manual recording options that are only available on 
the Editor. These options use either playhead, clip, or range boundaries, as well as user-defined pre-
roll and post-roll that can be set in the User Preferences, Editing panel. 

NOTE:  When recording in the Fairlight page, tracks must be armed before recording, and 
only tracks with inputs patched to them can be armed. Luckily, there is a key in the Record 
Mode toolset for opening the Patch Input/Output window. Use a momentary press on the 
Record key and Latch a Track Selection Key to arm that track. 

Record mode default toolset

Record Mode Manual Recording special toolset keys include:

	— Record Here: Playhead goes back the pre-roll duration, then punches into Record at the location 
where you issued the command. This can be useful when you zoom in to find the exact timecode 
position where you want to punch in to record, then simply issue this command by pressing the 
Record Here key and the system does everything for you.

	— Record Range: The playhead includes a pre-roll and punches into Record at the Range In point, 
and then punches out at the Range Out point. 

	— Record Clip: After pre-roll, the playhead punches in and out to match the duration of the clip 
under the playhead on the selected track. If no clip is beneath the playhead, the transport moves 
forward to the next clip in the track and records there. 

	— Record Again: Pressing this key repeats the last recording you made, both entry and exit, 
whether it was manually or automatically punched in.
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	— Punch In Again: The system pre-rolls, then enters record at the exact same place as last time, 
whether it was manually for automatically activated. When entering this record operation, you still 
need to manually punch out. This allows you to get the same start point for recording but with a 
manual exit.

	— Record Head: Pre-rolls, then starts recording at the head of the first clip to come beneath the playhead 
in the selected track. When entering this record operation, you still need to manually punch out. 

Monitor Mode Toolset
As the name suggests, this mode is for setting up your monitor system. In most cases, this is set up at 
installation, but there are also controls for setting up the monitors for a particular session and quickly 
switching between different sources, including external sources, speaker sets, and surround formats. 
You can even mute any of the current speakers by latching its associated picture key marked with a 
Speaker icon. 

Monitor mode default keys showing Control Room monitoring 

Monitor mode keys for enhanced features only available in the Fairlight Audio Editor:

	— C/R / Studio toggle: This key toggles the Monitor mode keys between Control Room (C/R) and 
Studio monitoring keys. 

	— Phase: Hold this key and press any speaker button to toggle its phase.

	— Alt Source: Use this key to toggle between the Main system bus and the most recently selected 
Alternative source. The standard monitoring source is the Main system bus. However, you can 
choose many other sources, including other system buses or external sources, such as a CD player. 
The system remembers the last non-standard source that you chose as the Alternative source. 

	— Mono Comp: If your current speaker set is not mono, you can press this button to monitor 
playback in mono. 

	— Stereo Comp: If the current speaker format is not stereo, you can press this key to monitor the 
playback in stereo. 

Macros Mode Toolset
Macros are programmable keys where you can record sequences of keystrokes. The Macro mode 
toolset includes 30 programmable Macro keys, as well as Delete, Rename, and Record keys for 
recording and managing your macros. The first 14 Macro keys are also assigned to the Macro quick-

3908Fairlight  |  Chapter 182  Using the Fairlight Audio Editor



keys at the top of the Audio Editor’s display (Pad). Macros can record any keystroke on the Fairlight 
Audio Editor, including a momentary press to enter a different mode and keypresses in that mode 
during the momentary press. For example, it is common, when recording a macro, that you start in 
the mode with the first key you want to record, then momentary-press the Macro mode key to enter 
Macro mode just long enough to start recording the macro. Upon releasing the Macro mode key, the 
first key you press on the original mode will be the first one recorded. 

The most important thing to remember when recording macros is that they are reliable once created, 
but have no context except what you program. It’s a good idea to think of the starting and ending 
context for your macro prior to recording. For example, if the macro requires moving clips from 
one track to an empty track, make sure you create the new track before executing the macro. If the 
macro uses jump keys, make sure you have them set up ahead of time and so on. It is up to the user 
to remember a starting point and ending point, if relevant. Once a macro has been recorded, the 
associated quick key at the top of the Editor lights up to show that it is available as a macro.

Macro mode keys

NOTE:  To prevent accidentally recording, renaming or deleting a Macro key, the Macro 
action keys require a momentary press plus a numbered Macro key. 

Macro Mode action keys:

	— Delete: Press and hold this key and press a Macro key to delete the macro.

	— Rename: Press and hold this key and press a Macro key to open the User Macros dialog and 
rename the macro.

	— Record: Press and hold this key and press a numbered Macro key to record. Press Control and 
the Menu key to stop recording. The Menu modifier key changes to Menu (rec) when recording a 
macro and Stop Recording when you press the Control modifier key while recording a macro. 

Standard modifier keys in Macros mode and Macros action keys, including Delete, Rename, and Record
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Menu becomes Menu Record key during macro recording and Stop 
Record when Control key is pressed during macro recording

Recording a Macro:

1	 Set up the Editor for whatever steps you plan to record in the Macro and latch that mode.

2	 Momentarily press the Macros mode key to enter that mode temporarily. 

3	 Do not release the Macros key.

4	 With the other hand, in the Macro mode toolset, momentarily press the Record key and the 
numbered Macro key that you want to record. Release the Record and numbered Macro key.

5	 Release the Macros mode key to return to the latched Editor mode. 

6	 Press the keys one at a time as needed to complete the steps that you want to record to 
the macro.

7	 Stop playback, if necessary. 

8	 Press the Control key and press the Stop Recording key in the modifiers section of the keyboard. 

NOTE:  You can take as long as you need to record a macro, and if you make a mistake you 
can either delete the macro or re-record it using the Delete or Record keys.

Example of recording a simple macro to move a clip from one track to the track below: 

1	 Prepare the Editor for recording the first macro. In this case, press the Edit mode key and latch the 
A1 track selection key to select that track. Move the playhead over the first clip in the track. 

2	 Momentary press the Macros key with the left hand. Do not release the Macros mode key.

3	 In the Macros toolset, press the Record key and the Macro 1 key, to initiate recording of the 
Macros 1 key. Release both keys. The Macros keys disappear from view in the Macros toolset. 

4	 Release the momentary press on the Macros key to return to the Edit mode. The next keypress 
will be the first recorded to the Macro 1.

5	 Press the Cut Clip key to cut the clip on the selected track beneath the playhead.

6	 Press the Down key to the left of the jog wheel to move the track selection, and the shadow of the 
clip that was cut, down one track. 

7	 Press the Enter key to paste the clip.

8	 Press the Up key next to the jog wheel to move the selection back up to the A1 track.

9	 Press the Control modifier to change the Menu key to a Recording Stop key. Press the 
Recording Stop key.
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From this point forward, pressing the Macro 1 key in the Macros Mode toolset, or the Macros 1 quick 
key at the top of the Editor will perform the macro of cutting a clip on one selected track and moving it 
to the track below then returning to the original track. With this macro, you could easily use jump keys 
to move down the Timeline a clip at a time, and move any clips that need to go to the A2 track with the 
press of the Macro 1 key. 

NOTE:  You could also use this same macro to move a clip from any selected track to the 
track below because it contains the Up and Down arrow keys instead of specified track 
selection keys. Additionally, you could take this macro idea to a whole new level and include 
jump keys and fades at the edges of the clips as you edit. 

Renaming a Macro key

1	 Enter the Macros mode toolset.

2	 Long-press the Rename key and press the Macro key that you want to rename. 

3	 In this case Macro 1. Release both keys.

4	 The picture keyboard changes to QWERTY keys and the User Macros dialog opens on the 
computer screen. 

5	 Type a new name for the Macro and press Return.

6	 The Macro is named in the Macro mode keys. 

User Macros dialog on Computer screen

Named Macro 1 in the Macros Mode keys
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TIP:  If you are going to name your macros, it’s a good idea to give them a brief but literal 
name to help you remember the macro’s function. In the above example, the macro was 
named A1 to A2 because it was designed to move a clip from the A1 track to the A2 track. 

Mix Mode Toolset
Whether you are using the Fairlight Audio Editor with your computer, or as part of a Fairlight Console, 
the Editor’s Mix mode offers easy access to a powerful array of mixing and automation tools. Here 
you can copy and paste EQ, Dynamics, Aux, Path, Plugins or all of the above to other tracks and buses 
as well as automate any parameter. The heart of the Mix mode toolset is the Mix On/Off key. Latching 
Mix On brings all of Fairlight’s powerful automation tools and menu options to the picture keyboard 
so you can control every aspect of your automation without ever reaching for the mouse. If you are 
familiar with Fairlight’s mixing and automation tools in DaVinci Resolve, you’ll have no trouble finding 
your way around this toolset because there is a picture key for every switch, toggle, menu, and sub-
menu option available in the Fairlight page’s robust automation toolset. 

The functionality of each specialized key is exactly the same as using the software alone. However, the 
advantage of mixing with the Fairlight Audio Editor or a Fairlight Console is that you’ll have physical 
controls including touch-sensitive knobs for precision automation recording and mixing maneuvers 
without the distraction of a mouse and menus.

NOTE:  For a detailed rundown of the Fairlight Automation tools and features, please refer 
to Chapter 174, “Automation Recording.” 

Mix Mode keys with Mix On latched; the automation toolset showing and Copy/Paste unlatched 

The Mix Mode automation keys are organized and grouped as action keys, toggles and menus with 
related submenu keys with the same tools and menu choices that you’ll find on the Fairlight page and 
Fairlight menu in DaVinci Resolve. 

Mix Mode toolset toggles, groups, and menu keys:

	— Copy/Paste: This key automatically toggles on when automation is turned off. You can manually 
latch this key while the automation toolset is showing. When latched, the Copy/Paste key reveals 
the Copy and Paste toolset group. 
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	— Copy and Paste Toolset Group: When the Mix On key is unlatched, the Copy/Paste key latches, 
and you will see a Copy key next to a toolset with six paste action keys, including Paste EQ, 
Paste DYN, Paste AUX, Paste PATH, Paste PLUGS, and Paste ALL. These keys are all used to copy 
attributes from the active track and paste them on a selected track. To use these keys, press the 
Copy key to copy all of the track attributes for the active track. Select another track and choose the 
Paste action key that corresponds with the attributes you want to paste to the newly selected track. 

	— Mix ON: This key toggles on or off the Automation toolset. When toggled on, the Copy/Paste key 
toggles off and the Copy and Paste toolset group switches to the automation specific toolset such 
as the Mix, Punch Menu, and Preview menu keys.

	— Automation Menu keys: Enable, Mix list, Mix Menu, Punch Menu, and Preview Menu all reveal 
a set of submenu option keys when latched. The subsequent option keys offer the exact same 
options available on the Fairlight page interface. For example, latching the Enable menu key 
reveals ten option keys that represent each of the ten Enable buttons on the Fairlight page 
Automation toolbar, in the exact order that they appear onscreen. The Enable option keys are 
as follows from left to right: Write FADER, Write MUTE, Write PAN, Write EQ, Write COMP, Write 
LIMITER, Write AUX, Write PLUGINS, Write MISC, including a dedicated All button. 

	— Open/Close GUI window keys: The Patch, Mix List, and Presets keys open and close the 
corresponding windows on the computer screen. 

	— Toggles: The Touch and @Stop keys toggle between the different Touch and Stop automation 
modes when toggled.  The Touch toggles between OFF, LATCH, and SNAP while the @Stop key 
toggles between RETURN, EVENT, and HOLD.

	— Preview Menu: Switches the Automation controls into Preview mode for auditioning settings 
without writing new automation data and offers Preview menu option keys including; Fill Range, 
Glide Range, Punch In, and Punch Out. 

	— Safe Menu: This automation option provides the ability to specify an active automation zone with 
Active In and Active Out keys where the system does not receive timecode automation outside of 
the specified range. When Safe automation mode is active, automation Read and Write functions 
are only available within the active range and are disabled outside of the designated activesw range. 

	— Write Quick Keys: Write FADER, Write MUTE, Write PAN. These keys can be used to quickly enable 
the three most common Automation parameters.

Edit Mode Toolset
If you’re read the previous Fairlight chapters, you’re already familiar with the Audio Editing tools and 
menu options. The Edit mode toolset includes over twenty specialized picture keys for adding, moving, 
editing, and trimming clips in the Timeline. The keys represent all of the audio editing options available 
in the Fairlight page via the Edit and Trim menus as well as a handful of tools that are only available 
in the Audio Editor. You’ll also find keys to open, preview, and edit clips from the Sound Library and 
Media Pool. 

Fairlight audio editing is by nature fast and fluid, even when you are working with the software and 
computer alone. Where the Fairlight Audio Editor enhances the process is that with the combination 
of the jog wheel and Edit mode action keys, you can move and edit clips at incredible speeds and even 
edit clips on the fly without ever picking up your hands. In fact, the Fairlight Audio Editor is designed 
for two-handed operations. The added functionality of two-handed workflows really comes into play 
when working in the Edit mode. 
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EXAMPLE:  With your left hand, you can easily select tracks and press action keys, while 
you use your right hand to drive the jog wheel controls and press the Enter key to paste 
material that its copied to the clipboard. 

The Edit mode action keys work off of two principals: removing material you don’t want to keep in 
the Timeline, or moving material to another location. To remove material, you use tools that erase or 
trim. To move material, you use the Clipboard tools that cut or copy and therefore store the material 
in memory to be pasted elsewhere. When you cut or copy material, a semi‑transparent version of the 
Clipboard clip appears in the Timeline and can be moved to another track or location and pasted. 
Another consideration when editing is to determine if you are modifying the head, tail, whole clip, or a 
range containing only part of a clip or multiple clips. All audio edits are non-destructive and reversible 
with the Undo key.

NOTE:  For more details about the fundamentals of editing audio clips in the Fairlight page, 
please refer to Chapter 171, “Editing Basics in the Fairlight Page.” 

Edit mode keys

Default Edit mode actions and associated keys include: 

	— Cut: Cut Head, Cut Clip, Cut Tail keys all cut the material based on the selected track, clip and 
playhead position and place the removed material in the clipboard for pasting with the Enter key. 
For more fluid editing, hold down a Cut key, such as Cut Tail, and use the jog wheel to move the 
cut portion of the clip to a new location, then release the Cut Tail key to automatically paste the cut 
clip in the new position. 

	— Copy: Copy Head, Copy Clip, Copy Tail keys all copy the material based on the selected track, clip 
and playhead position and place the copied material in the clipboard for pasting with the Enter key.

	— Trim: Trim Head, Trim Tail uses the playhead’s position to remove the current clip’s head or tail. 
You can also press and hold Trim Head or Trim Tail while using the jog wheel to extend either the 
head or tail of the current clip. While doing this, you see the full waveform the clip you’re trimming 
as you turn the jog wheel, but when you release the Trim Head or Trim Tail button, the Head or 
Tail of the selected clip appears trimmed at the current frame at the playhead.

	— Split: The Split key splits the clip at the playhead position creating a new edit point 
between two clips.
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	— Fade: The Fade Head and Fade Tail keys add fades respectively from the playhead to the 
head or tail of a clip.

	— Erase: Erase clip deletes the clip from the Timeline.

	— Batch Fades: Long-press this key to open the Batch Fades Settings window or press to execute 
Batch Fades for the current audio clip or range selection.

NOTE:  For a detailed rundown of the Batch Fades Settings window, see Chapter 171, 
“Editing Basics in the Fairlight Page.”

Edit mode actions when Range is active:

	— Cut Range: Use this key to cut all clips and partial clips within the range on the selected track 
or tracks. The Cut Range key replaces the Cut Clip key when Range is toggled on. This cuts clips 
within the range on all selected tracks.

	— Copy Range: Use this key to copy all clips and partial clips within the range on the selected track 
or tracks. The Copy Range key replaces the Copy Clip key when Range is toggled on. This copies 
clips on all selected tracks within the range.

	— Split Range: This key splits any clips lying across the range boundaries into two pieces at the 
range In Point and Range Out Point. This affects clips at the range boundaries on selected tracks.

	— Erase Range: Erase Range deletes the range from the Timeline. This Erase Range key replaces the 
Erase Clip key when Range is toggled on.

NOTE:  For ease of use and quick mastery, the Edit mode action keys are logically grouped 
in pairs or trios so that keys involving the head of a clip are first and tails are last. For 
example, the Cut Head, Cut Clip, and Cut Tails keys are grouped together as a trio. Placing 
three fingers over those keys make it easy to remember the first key is the head, middle key 
is the full clip, and last key is the tail. 

In addition to the default Edit mode action keys, there is also a set of refinement action keys that can 
be used to finesse edits, fades, and clip positions. The refinement action keys require the Control 
modifier key as well as the jog wheel in most cases. These refinement action keys are logically placed 
for quick decisions so you can first execute an edit and then refine it without lifting your left hand or 
searching for a refinement key. 

Control modifier-based editing refinement actions and associated keys include: 

	— Erase: Erase Head and Erase Tail keys appear on the same keys as Cut Head and Cut Tail so that 
you can quickly choose between a cut, which keeps the material in the clipboard and erasure of 
the material, with the touch of your left Pinky finger on the Control key. 

	— Fade: Head X-Level and Tail X-Level keys appear on the Fade Head and Fade tail keys so that 
you can first add a fade, then press Control and use the same key to refine the fade level with 
the jog wheel. Additionally, long-press SHIFT to reveal Head XPoint and Tail XPoint that can be 
changed with the jog wheel or long-press CTRL + SHIFT to use the jog wheel to refine Head Shape 
and Tail Shape. 
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	— Slip: Slip Head, Slip Clip, and Slip Tail keys are located on the same keys as Copy Head, Copy Clip, 
and Copy Tail. That way you can seamlessly copy, move, and paste material to a new location, then 
hold the Control key while pressing the respective Slip key, and turn the jog wheel to refine the 
Head, Clip position or Tail based on the jog movement of the playhead. 

	— Trim: The Trim Clip refinement tool shares a key with the Split Clip key so that you can split a clip at 
the playhead position, then hold Control and the same key while using the jog wheel to refine the 
position of the edit point created by the split. 

	— Clip Level: This key plus the jog wheel and the Control modifier key adjusts the Display level of the 
selected clip’s waveform.

	— Jog Wheel: To place the playhead (CTI) at either the In or Out point of a range, use Control plus 
the jog wheel. Hold Control while turning the jog wheel to the left to move the playhead to the In 
point. Hold Control while turning the jog wheel to the right to move the playhead to the Out point.

Edit mode keys for enhanced features only available in the Fairlight Audio Editor:

The Edit mode tools work exactly as expected if you are familiar with the Fairlight page in 
DaVinci Resolve. There are, however, a few specialized keys that don’t have counterpart tools in the 
Fairlight page. These unique tools perform valuable time-saving tasks.

	— Clip Level: This key is both a Menu and Jog Wheel modifier key. Hold the Clip Level key to reveal 
seven option keys to raise or lower the selected clip’s volume up +/- 3 dB. Incremental menu 
options keys from left to right include: -3dB, -2dB, -1dB, 0dB, +1dB, +2dB, +3dB. As a Jog Wheel 
modifier key, hold the Clip Level key with the left hand and turn the jog wheel with the right hand 
to raise or lower the clip’s volume level dynamically based on the amount and direction that you 
turn the wheel. This can be performed on the fly during playback, so you can dial up or down 
the volume level of any clip on the selected track as the playhead passes over the clip. Clip level 
changes can also be applied to multiple clips on multiple selected tracks simultaneously. 

NOTE:  At the time of this printing, The Edit page in DaVinci Resolve includes a Clip 
menu option and keyboard shortcuts for incremental decibel changes, however there is 
no comparable shortcut, or menu in the Fairlight page.

	— Reverse Clip: This key is available as one of the Clip Menu action keys. When pressed, this key 
reverses the clip beneath the playhead on the selected track. This creative sound design tool is 
also available in the Record mode Clip Menu toolset.

	— Range Menu Keys: A momentary-press on the Range key revels six invaluable Range-defined 
tools for speeding up your tasks. Although they are also available in the Record and Mix mode 
toolsets, you will primarily use them in Edit mode. 

	— Copy Segment: This action key copies all timeline material within a marked range.

	— Paste Segment:This key pastes a copied segment to a new timeline location based on the 
playhead position.

	— Previous Gap: Use this key to extend a range by moving the range In Point to the previous gap in 
the selected track or tracks. 

	— Next Gap: Use this key to extend a range by moving the range Out Point to the next gap in the 
selected track or tracks. 
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	— Fill: Fills the current range on a track from end to end with the clipboard clip. Without the need to 
cut, copy and paste, Fill automatically duplicates the clipboard clip, with a slight overlap and fade 
to stitch together background noise or room tone within the marked range.

	— B/F Fill: Back/Front Fill works exactly the same as Fill, except that it reverses the audio in every 
second copy of the clipboard used for filling. Alternating the direction of the stitched clips is useful 
for creating a seamless background sound because the waveform is continuous.

Alternate Picture Key Toolsets
In the Alternate picture key layout mode, all of the picture keys are text only, with the Editor mode keys 
arranged in the lower center white text. The menu keys are easy to spot with yellow text and a mark in 
the upper left corner. Alternate Edit, Monitor, and Mix mode toolsets include action keys in the six soft 
keys to the left of the jog wheel for quick access. For example, in Edit mode, the Cut, Copy, Erase, Fade, 
Nudge, and Trim action keys are all located in the upper-left corner of the picture keyboard, while the 
action keys associated with the active action key appear in the picture keys near the jog wheel. For 
example, if the Copy action key is latched, the Copy Clip, Copy Head, and Copy Tails keys are available 
near the jog wheel. If you latch the Cut action key, the middle keys near the jog wheel change to Cut 
Clip, Cut Head, and Cut Tail.

Alternate picture key toolsets include the same keys as the default normal layout. The difference is 
the location of the keys, how they are grouped, and the additional usage of the picture keys near the 
jog wheel. 

Alternate Macro toolset

Alternate Setup toolset
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Alternate Record toolset

Alternate Monitor toolset with Phase, Main/Near Speaker selection, 
and Alt Source keys available near the jog wheel

Alternate Mixer toolset with Mix On unlatched, Copy/Paste latched, 
and Copy/Paste keys available near the jog wheel

Alternate Mixer toolset with Mix On latched and Mix automation keys available near the jog wheel
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Alternate Editor toolset with Copy latched and Copy action keys available near the jog wheel

TIP:  One way to get to know your way around the Audio Editor keyboard is to start with 
knowing how to perform a task in the Fairlight page using a mouse and standard keyboard. 
Then, consider which Editor mode category the task belongs to, and find the associated 
keys from there. Making the transition from mouse and keyboard to the Audio Editor is a 
journey of discovery where you will find numerous ways to execute different tasks, shortcut 
keys and advanced controls and options that can increase your speed and productivity 
exponentially the longer you use it.

Editor Screen with Soft Controls
The Editor screen, located above the picture keyboard, displays all signal processing and mixing 
information related to the most-recently-selected (active) track or master bus. It also displays labels 
and visual feedback for the soft keys and knobs that surround the screen. Additionally, the ALT key 
below the screen extends its functionality with an alternative set of parameters when necessary. This 
is where you can quickly view and adjust various mixing parameters associated with the active track 
or master bus. Whether you select a track manually with a mouse click, press the associated Track 
Selection key on the Audio Editor, or latch a Channel Select button on the Fairlight Channel Control 
panel, the most-recently-selected track’s parameters appear in the Editor screen. 

These parameters include Level and Pan, EQ, Dynamics and AUX, and Plugin parameters that 
correspond with the active track of bus. The graphical display for signal processing remains the same 
in the Editor screen for nearly all Editor modes and types of signal processing, except for Monitor 
mode and Aux signal processing.

As you learn your way around the Fairlight Audio Editor you’ll soon find that glancing at the Editor 
screen is akin to glancing at your dashboard while you drive your car. Following this example, your 
primary computer screen is like your windshield where you can always see what is happening 
as you drive the Fairlight Console or Audio Editor. However, like a dashboard, you can glance at 
the Editor screen at any time to see which track or master bus is selected, as well as the current 
signal processing settings. Also, like your car’s dashboard, you can reach out and change settings 
for any of the interactive graphical parameters by simply choosing that element and modifying the 
adjacent controls. 
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At this time there are five different Editor Screen layouts that you will encounter while you work 
with the Fairlight Audio Editor, including Clip EQ, Standard Mixing, Plugin, Aux sends, and Monitor 
mode layouts. 

The Clip EQ layout gives you soft menu controls of the 4-Band EQ parameters for the selected 
clip when you latch the Clip EQ key. The Clip EQ key is one of the Clip Menu option keys available 
in the Record and Edit mode toolsets. Here you have all the same EQ controls that are available 
in the Clip Inspector in DaVinci Resolve. Along the top of the the second page of Clip EQ controls 
(shown above), you’ll find new Clip EQ preset options that are not currently available in the 
Fairlight page UI. These options include; Save Preset, Apply Preset, Copy, and Paste.

Standard Mixing layout used in all Editor modes, except Monitor, or when the Aux controls are 
showing. At a glance you can see that the Pan controls are active based on the illuminated soft button 
in the bottom row with the bright red line over the Pan label adjacent to the latched button.

Plugin layout used to control first plugin on the selected track and is available in all Editor modes. except 
Monitor mode and when Aux controls are showing. The Plugin Editor screen controls include a three page 
layout. Page 1 provides the Insert IN toggle to bypass the plugin. Page 2, shown above, has toggle options 
to Reset the plugin as well as options to Save, Load, and Apply presets, Automate, and Lock the plugin. Page 
3 offers Mapping mode where the user can map specific plugin parameters to the six Editor rotary knobs.
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Aux layout showing send levels and panning for up to 24 Aux channels simultaneously. In this 
example, the sends for Aux 1 and Aux 3 are enabled (green) for the active track, while Aux 2 has been 
disabled for this track. The soft buttons along the top enable the different Aux channels for the active 
track. Red text over black labels indicate which Aux channels and soft buttons are toggled On. 

Monitoring mode layout with visual feedback for Dim and Fixed levels, Control Room, Loudness, and Studio 
meters, as well as a graphical representation of the speaker configuration and listening environment.

Visual Feedback between 
Soft Controls and the Editor Screen
The Editor screen offers highly visual feedback that is easy to follow and corresponds with the identical 
controls in the Fairlight page, as well as the visual feedback on the Channel bay if you are working 
with a Fairlight Console. When looking at the soft buttons and touch-sensitive knobs, here are some 
guidelines to help you recognize their current state and options:

	— Soft buttons and knobs around the Editor screen directly control the closest on-screen parameter. 

	— The soft buttons above and below the screen have three visual states; Bright, dim and off. 

	— At a glance all soft buttons with adjacent controls are illuminated (dim), while soft buttons without 
controls are black (off). 

	— The upper row of soft buttons are toggles that either toggle a parameter On/Off or toggle 
between options, such as the type of curve for EQ filtering. The last soft button on the top row 
toggles between pages of controls. 

	— Soft buttons above the Editor screen brighten when active or latched on, and the corresponding 
soft menu control onscreen shows in black with red text. 

	— Soft buttons below the Editor screen display alternative pages of controls assigned to the 
left and right knobs. 
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	— It is easy to identify which page of controls is active because the latched soft button below the Edit 
screen is illuminated along with the adjacent label that is also marked with a bright red line.

	— When you touch one of the knobs to adjust the current settings, the background of the 
corresponding visual feedback onscreen darkens. 

	— You can reset any of the parameters controlled by a touch-sensitive knob by pressing the Control 
key then touching the knob. 

	— Hold Shift while turning a knob for fine incremental control.

	— The first and last soft buttons on the bottom row are modifier keys that offers momentary control 
of additional parameters for the controls for the knobs when available. For example, when the 
Aux controls are shown in the Editor screen, the knobs control the send level. While, a momentary 
press on the modifier soft button changes the knob controls to the Aux channel Pan settings. 

Visual cues, like the red line over the illuminated soft button below the screen and the darkened 
parameter control next to the active knob on the left of the screen, indicate which EQ parameters 
are currently assigned to the control knobs, as well as which touch-sensitive knob is in use 

Macro Quick Keys
The top row of the Fairlight Audio Editor is dedicated to the Macros quick keys. Here you’ll find Macro 
quick keys for triggering each of the first 14 programmed macros. Once a Macro key has been 
recorded in the Macro mode layout, the associated Macro quick key illuminates to show it can be 
used to trigger the corresponding macro. These are a fast way to use macros as you work, without 
switching to the Macro mode toolset. 

Escape and 14 Macro quick keys at the top of the Fairlight Audio Editor for the first 14 macros
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Chapter 183

Fairlight Studio Utility
To configure your Fairlight console for your studio, you’ll need to 
use the Fairlight Studio Utility. This utility is specifically designed to 
connect multiple Fairlight panels as a single studio console. 
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Configuring the Fairlight Panels
To configure your Fairlight console for your studio there are two utilities that are included in 
the DaVinci Resolve installer. The utilities are called Fairlight Studio Utility and DaVinci Control 
Panels Setup Utility. 

DaVinci Resolve Installation 

To connect a single panel unit, such as the Fairlight Desktop Console or Fairlight Desktop Audio 
Editor, to your DaVinci Resolve system you only need to the DaVinci Control Panels Setup Utility. 
This utility is also used for updating firmware on all DaVinci Resolve Control Panels, including 
desktop and multi-panel consoles. If a DaVinci Resolve update includes a control panel firmware 
update, you’ll be notified as such upon launch and directed to perform the update for each panel 
via the DaVinci Control Panels Setup Utility. 

To set up and connect a multi-panel console, such as a 2-bay Fairlight console, you’ll need to use 
the Fairlight Studio Utility. To install DaVinci Resolve, launch the DaVinci Resolve Installer and 
follow the onscreen prompts. When the installation reaches the Installation Type page, choose 
Custom install and be sure to select DaVinci Control Panels in the custom Install options.
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Customize install

 

Install DaVinci Control Panels

DaVinci Control Panels Setup and Fairlight Studio Utilities installed 
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Updating your Fairlight Panels’ Firmware
It’s a good idea to regularly check our website for new software updates.

When a new version of DaVinci Resolve is installed, you may be prompted to update your 
panels’ firmware. To update the firmware for each control panel in the DaVinci Control 
Panel update, select each panel in the home page, click the Update button and follow the 
prompts to update each panel. 

DaVinci Control Panel Setup
DaVinci Control Panel Setup Utility can be connected to the Fairlight panels via USB or Ethernet using 
DHCP. If you are not using a DHCP server, you can set the network settings to a fixed IP address via 
USB. More information for changing network settings is found later in this chapter. 

When configuring the Fairlight console for your studio, the first step is to name each module using the 
DaVinci Control Panel Setup Utility. This lets you easily identify each panel by clicking on the “identify 
me’ checkbox. 

To assign a custom name to each panel: 

1	 Launch the DaVinci Control Panel Setup Utility.

The currently selected panel will be visible on the setup 
utility home screen. Navigate to each installed unit by 
clicking on the arrows on each side of the home screen.

2	 Select a panel on the home screen and click on the Settings icon. You can also click the panel’s 
image to open the setup window. 

3	 In the Setup panel under Label, you will see the Label: text box that identifies the current panel 
by name, starting with “Blackmagic” and followed by the default panel name, such as “Fairlight 
Console Channel Fader.”
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Default panel names always start with ‘Blackmagic.’

4	 Change the name in the text box and click Save. You can visually identify each modular panel 
installed in your console by clicking on the ‘identify’ checkbox. This will illuminate features on 
the panel. 

DaVinci Control Panel Setup controls include the following:

	— Setup: These settings include Label, Software version, and the Identify this device checkbox. 

	— Studio: Displays the Group name of the multi-panel studio. 

	— Network: Use these settings to manually change the settings. When changing network settings, 
you will need to connect the panel to your computer via USB.

	— Display: Changes the brightness of the Fairlight panel’s LCDs, or the brightness of the 
LCD monitor. Drag the slider to decrease or increase the brightness.

Changing Network Settings
If you need to change the network settings for each module manually, you can change the setting in 
the Network settings of the DaVinci Control Panels Setup utility. When changing network settings, you 
will need to connect the panel to your computer via USB. 

To change network settings:

1	 Open the DaVinci Control Panels Setup utility. Click on the Fairlight panel icon displayed on the 
home page to open the settings for that panel. 

2	 In the Network settings, choose either DHCP or Static IP, depending on your network.

3	 Type a new address in the IP address, Subnet Mask, and Gateway text boxes as needed. 

When the IP address is set correctly, the panel will be accessible on your network. 

Repeat the same process for each Fairlight panel via USB. 
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NOTE:  For more information about the DaVinci Control Panel Setup Utility, see Chapter 5, 
“DaVinci Control Panels Setup.” 

Fairlight Studio Utility
This utility is used to add Fairlight panels to a user-defined Fairlight console configuration. Once 
the multi-panel console is configured, you can name it and connect it as a single studio unit to your 
DaVinci Resolve System. 

After setting up your Fairlight panels in the DaVinci Control Setup utility, assign each module to your 
Fairlight Console using the Fairlight Studio Utility. This configures your console as a studio, telling 
DaVinci Resolve exactly where each panel is in your Fairlight console so the Fairlight page can control 
them all properly and display their controls on the appropriate LCD monitors.

Stand alone panels, such as the Fairlight Desktop Console or the Fairlight Audio Editor, do not need to 
be added to a studio configuration to be selected by DaVinci Resolve. If you have only a Desktop Audio 
Editor or Desktop Console in your studio, go to the next section, “Selecting your Fairlight Console in 
DaVinci Resolve,” and follow the instructions there to select the editor in DaVinci Resolve. 

When using the Fairlight Studio Utility for the first time, you will choose the type of studio console, 
then add the connected panels to the console in the utility. 

To set up a Fairlight Console for each studio:

1	 Launch the Fairlight Studio Utility. 

2	 Select the number of bays in your Fairlight console and click Next. This will open a configuration 
screen where panels are assigned to the corresponding chassis slots in each bay. 

Choose the type of studio 
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3	 In the configuration screen, click on the top left slot to assign a Fairlight Console LCD Monitor. From 
the list of modules, select the desired monitor for the corresponding slot by clicking on its icon. 

Click the empty slot to see a list of available panels 

Choose the type of console

4	 Click Add.

LCD Monitor is added to the console in the Fairlight Studio Utility
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The panel will be assigned to the corresponding slot on your Fairlight console. You can now 
follow the same procedure to assign all the other panels to the corresponding positions in the 
configuration utility. If you select the wrong module by mistake, all you need to do is click on the 
module in the group to reveal its options, and then click the ‘X’ icon to remove it. 

As you configure each panel, you can confirm it corresponds to the correct position in the console 
by clicking on the panel in the group to reveal its options, and then clicking the Light Bulb icon.  

Your Fairlight console is now configured as a studio and you can change the name of the studio by 
clicking in the Untitled Studio text box, typing a new name, and pressing the Return key to confirm. 
This makes it easier to identify each studio if you have multiple studios installed in your facility. 

Each panel can be identified by the custom name you entered when labeling the panel in the 
DaVinci Control Panel Setup utility. You can also click on the Light Bulb icon for each panel to 
visually identify it. When clicking on the light bulb, features will illuminate on the relevant panel. 

Untiled Studio 

User defined name set to Studio 1

NOTE:  You can change the Group Name of a multi-panel console at any time in the name 
field of the Fairlight Studio Utility.
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Selecting your Fairlight Console in DaVinci Resolve 
Once your Fairlight Console is set up, you can select it in the DaVinci Resolve System Preferences, 
Control Panels settings. 

To select a Fairlight Console in DaVinci Resolve:

1	 Launch DaVinci Resolve. 

2	 In the menu bar at the top of the screen, select DaVinci Resolve > Preferences. 

DaVinci Resolve Preferences menu 

3	 In the Control Panels menu, choose the Fairlight Console from the ‘Select this console for Fairlight’ 
drop-down menu. 

Studio 1 console selected in the Control Panels Audio Console 
settings in the DaVinci Resolve System Preferences

4	 Click Save.

The preferences window will close. Your console is ready to use with DaVinci Resolve. 

5	 Restart DaVinci Resolve, if necessary, to use the Fairlight Console. 
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Chapter 184

Modular 
Fairlight Consoles
The modular Fairlight consoles make it easier to perform audio editing, recording, and mixing tasks 
by providing professional audio controls for nearly every function and feature in the DaVinci Resolve 
Fairlight page. 

Additionally, using a Fairlight console to control the Fairlight page is vastly more efficient and 
ergonomic than working with a traditional mouse and keyboard. This is especially important when your 
audio post-production job requires long hours doing complex, focused, and often repetitive work. 

This chapter covers details about the different modular Fairlight console components, the available 
console configurations, and how they work with DaVinci Resolve. 

NOTE:  To set up a modular Fairlight console to work with your DaVinci Resolve system, you 
first must perform a custom installation of DaVinci Resolve and check the box to include the 
Fairlight Control Panels utility. 

For complete setup and installation instructions, refer to the Fairlight Console Assembly 
Instruction Manual. DaVinci Resolve 17.2.1 requires a firmware update for each of the 
modular panels. See instructions for updating the firmware via the Fairlight Control Panels 
utility at the end of this chapter.
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About the Fairlight 
Console Components 
Fairlight consoles are a modular design that let you build your console to suit your production 
requirements. Within each console, four different Fairlight console components work together as 
Fairlight page control panels in a stand-alone chassis. These modular console components are either 
channel bay panels or audio-editing bay panels, and are paired with an adjoining Fairlight LCD Monitor 
component. The channel bay components work in tandem to control specific parameters on tracks, 
buses, and mains and include the Fairlight Console Channel Control, the Fairlight Console Channel 
Fader, and the Fairlight Console LCD Monitor that is used as a dedicated channel control screen. 
The audio editing bay components consist of the Fairlight Audio Editor and adjacent Fairlight Console 
LCD Monitor, which mirrors your computer screen and displays the DaVinci Resolve interface. 

Four different Fairlight console configurations range in size from 2-bay to 5-bay, with each bay 
spanning the width of a console module. The primary difference between the Fairlight consoles is the 
number of channel bays they contain. For example, a standard Fairlight console 2-bay comes with one 
set of channel bay panels plus one set of audio editing bay panels for a total of three control panels 
and two LCD screens, while a standard 5-bay console includes enough panels to fill four channel bays 
and one editing bay for a total of nine control panels and five LCD screens. 

Fairlight Console LCD Monitor
High resolution screen with 

HDMI, SDI and ethernet inputs.

Fairlight Console Audio Editor
Hardware control  panel for 

high speed audio editing.

Fairlight Console Chassis Bay
Modular cast steel chassis available in 2, 

3, 4 and 5 bay configurations.

Fairlight Console Channel Fader
Motorized fader panel with 12 channel 

strips and controls buttons.

Fairlight Console Channel Control
Dual function control knobs and 
buttons for each channel strip.
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Because you will still need to control your computer and other software functions from the 
console, it is also important to have a wireless keyboard and mouse within reach. To accommodate 
wireless computer controls, Fairlight consoles include a Channel Control Blank and an Infill module. 
The Channel Control Blank fits in the Channel Control slot between the Audio Editor and editing LCD 
monitor, and easily holds a full-sized wireless computer keyboard. The Fairlight console Infill module 
provides a convenient flat surface for a wireless mouse, track-pad, or notebook. You can place the Infill 
module at the left or right of any bay within the console chassis. The most common Infill position is on 
the right side of the audio editing bay; however, a left-handed sound designer may prefer to place the 
Infill set on the left side of the editing controls. 

Fairlight Console 2, 3, 4 and 5-bay

Each self-contained modular console is designed to meet the demands of modern work flow 
ergonomics and ease of use so that audio editors, sound designers, and re-recording mixers can 
quickly and accurately complete both simple and highly complex audio post-production tasks with 
minimal fatigue. 

Fairlight Console 
LCD monitor

Fairlight Console 
Channel Control

Fairlight Console 
Channel Fader 

Fairlight Console 
Audio Editor 

Standard Fairlight Console 2-bay 
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This chapter provides details and functions descriptions of each console component and should be 
read in conjunction with the previous Fairlight chapters to get the best from your console. 

For professional sound editors working on tight deadlines, the Fairlight Audio Editor, gives you quick 
access controls for high speed, precision audio editing. This dedicated Fairlight editing control panel 
is available in either desktop or console models. It’s easy to learn and master with a variety of highly 
visual, intuitive controls including touch-sensitive control knobs, macro buttons, LCD editor screen, 
number pad, electronic clutch-action shuttle, and a full keyboard with multi-functioning keys. 

Fairlight Audio Editor 

For high-resolution viewing of your DaVinci Resolve interface as well as channel controls, meters, 
video, and more, you’ll use the Fairlight Console LCD Monitor. These custom designed LCD monitors 
fit perfectly at the top of each console bay to form a bridge of screens at just the right angle for 
comfortable viewing while you work. Each modular LCD monitor includes switchable inputs from 
console screen to HDMI or SDI inputs for flexible display of plugins and reference video.

Fairlight Console LCD Monitor displaying the Master mode
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Fairlight Console LCD Monitor displaying the DaVinci Resolve UI

The Fairlight Console Channel Control is a multi-functional panel that works in conjunction with the 
Fairlight Console Channel Fader and LCD Monitor to provide 12 groups of touch-sensitive control 
knobs, buttons, and visual feedback for each of the 12 fader channels. These controls offer instant 
access to the parameters available in the DaVinci Resolve Fairlight page Mixer. 

Fairlight Console LCD Monitor
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Fairlight Console Channel Control 

Fairlight Audio Console Fader Control

For precision recording, mixing, and mastering, the Fairlight Console Channel Fader module offers 12 
touch-sensitive motorized faders and Pan knobs with corresponding Fader Channel Control buttons, 
automation controls, and bank buttons for mapping tracks and buses to the 12 faders. 
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Fairlight Console Audio Editor
The legendary Fairlight Console Audio Editor lets you quickly navigate large projects and precisely 
edit audio much faster than using a regular mouse and keyboard. The Fairlight Console Audio Editor 
has an identical feature set and controls as the Fairlight Desktop Audio Editor. The difference is that 
the Console Audio Editor is connected to all the console’s control panels, so recording, playback, 
and editing functions are reflected on the corresponding channel bays and vise versa. For example, 
if a track is called in the Fader Panel, it is also loaded in the Audio Editor’s built-in display. Another 
example is if a track button is selected in the Audio Editor, the track is also selected in the Fairlight 
Page interface on the Editing LCD monitor, and the corresponding selection button shows active in 
the In-Line Channel Control Extension buttons as well as the Channel Control LCD monitor. A Fairlight 
Desktop Audio Editor can also be connected to a Fairlight console that does not include an Audio 
Editing bay. 

For details on the Fairlight Console Audio Editor’s features and functions, see Chapter 181, “ Using the 
Fairlight Desktop Console.”

Fairlight Console Audio Editor

Although the three channel bay components are separate modules, they work together in tandem as 
a single multifaceted unit to display and control various channel parameters. The Channel Fader panel 
offers traditional channel mixing controls, while the multi functional Channel Control panel focuses 
on controlling specific parameters as needed as well as how they are displayed on the Channel 
LCD monitor. 

Channel Control Modes 
Within a Fairlight channel bay, the Channel Control panel works in three distinct channel control 
modes. These modes, in turn, change the functions of the multipurpose channel control knobs and 
buttons as well as the corresponding display in the LCD module: 
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Channel Control components set to In-Line mode
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	— In-line: This mode effectively separates the knobs and buttons on the channel control module 
into 12 groups that line up vertically with the 12 faders on the channel fader control. As the name 
suggests, in-line mode shows each set of parameters in a line that continues from the fader 
channels up through the channel controls and into the display on the LCD monitor. In-line Display 
buttons on the right side of the Channel Control panel determine which in-line parameters are 
shown. This mode is common in live recording so that the operator can easily see and control 
parameters of multiple microphone inputs simultaneously. 
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Channel Control components in Channel mode

	— Channel: Use Channel mode to control up to 192 parameters on one channel. In channel 
mode, the 12 groups of controls on the channel control module are used collectively to adjust 
parameters for a specific channel from left to right as displayed on the LCD Monitor. In Channel 
mode, there are several ways to choose which channel is displayed, including the Channel Call 
buttons on the Channel Fader panel, the Channel Select buttons on Channel Control panel, the 
Call Follows menu, the edit controller, or by selecting a track in the Fairlight page Timeline or 
Mixer. This is the most common channel control mode in audio post production, as it provides 
quick access to all parameter controls for a specific track. 
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Channel Control components in Master mode 

	— Master: This mode utilizes all channel controls to adjust parameters for the buses and main 
output. In Master mode, the 12 groups of controls on the channel control panel adjust the 
adjacent main output parameters displayed on the LCD. The channel controls in Master mode are 
organized from left to right in order of processing. Master mode is commonly used while mixing 
and mastering soundtracks. 
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Fairlight Console Channel Control
The secret to managing high track counts for large projects is the Fairlight Console Channel Control 
because it provides instant knob-per-function access to channel parameters along with real-time high 
resolution visual feedback on-screen. The Fairlight Console Channel Control module fits directly below 
the LCD monitor so that you can always see the graphical representation of each parameter as it is 
modified with the adjacent channel controls. There are four types of channel controls organized in 
three areas of the panel. 

On the far left and right sides of the panel, you’ll find dual-function Channel Display buttons that 
determine the current channel control mode and which parameters are displayed on the LCD monitor. 

The middle of the panel contains 12 groups of multi functional Channel Control buttons and knobs 
that align with the 12 faders on the Channel Fader panel. The knobs are used to adjust parameter 
values, while the control buttons act as toggles, On/Off, or In/Out switches for active parameters. 

The fourth type of controls are the In-Line Channel Extension Buttons, which are arranged in groups 
of six below each of the 12 channel control groups. Here you’ll find dedicated channel-specific buttons 
for functions available in the Fairlight page Mixer and Timeline track headers. 

Channel Control 
buttons and 
knobs for each 
corresponding 
fader channel

In-Line Channel  
Extension buttons

In-Line Channel  
Display buttons

Channel  
Display  
buttons

The primary display controls for the channel control components are the dual-function channel 
display buttons located on the left and right sides of the Channel Control panel. These bi-colored LED 
buttons determine the channel mode and current parameters displayed on-screen. There are a total 
of 16 display buttons split evenly into groups of eight buttons on each side of the panel. On the left 
side of the panel, you’ll find eight channel display buttons used to select the channel control mode 
as well as display plugins and automaton parameters; while the display buttons on the right side of 
the panel are used to show the in-line channel parameters found in the Fairlight page Mixer, such as 
Pan, EQ, and Dynamics. The top and bottom display buttons are identical on both sides of the panel to 
provide easy access to the CTL (control) and ALT (alternate) functions for selecting secondary display 
features, resetting parameters to default values, and showing alternate controls in the LCD. 

The default color for all display buttons is yellow, except for the Control button, which is always blue. 
When the Control button is pressed, inactive display buttons with secondary functions turn blue or 
purple. Active display buttons remain in their active state color until another display button is selected. 
For example, if a secondary function is selected, that display button remains purple as long as it is 
active, while the other display buttons return to yellow when the Control button is released. 
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Left side of panel, Channel display buttons from top to bottom: 

Channel  
Display  
buttons

CTL: This display button is the same as the Control modifier key on the computer keyboard 
and can be used to switch to the secondary functions for the dual-function display buttons 
below. The handy blue color makes it easy to locate and use as needed, to switch inactive 
display buttons to their secondary functions. Additionally, holding the Control button 
while touching one of the knobs or faders will reset any of the touch-sensitive controls to 
their default values. For example, holding the Control button while touching a fader or 
Aux send knob resets the value to 0 dB and is the Fairlight Console Control equivalent to 
double‑clicking the mouse on a fader or knob in the Fairlight page GUI. 

There are a total of three conveniently located Control buttons on a Channel Control bay; 
two on the Channel Control panel, and one on the Channel Fader panel.

MSTR/U1: This button is used to set the channel controls to Master mode which displays 
all the system bus controls for the Main output bus on the LCD monitor, while all the 
adjacent channel control buttons and knobs are dedicated to controlling the busing 
parameters as displayed. The secondary U1 function is not implemented in this version of 
the software. 

PLUG/U2: Use this button to show active plugins on the LCD monitor and allocate controls 
for the plugin parameters to the corresponding channel controls. The Plug function as well 
as the secondary U2 function are not implemented in this version of the software. 

CHAN/U3: To change the channel controls display mode to Channel mode, use this 
button. Once in Channel mode the channel control buttons and knobs control the 
parameters for a single channel. Use Control + CHAN to get to the channel’s Aux Sends. 
If multiple channels are selected, you’ll see parameters for the last track selected or called. 
In this version of the software, the secondary U3 function is not implemented. 

ENAB/COPY: To quickly enable parameters for automation, you can hold this button and 
touch any channel control button, knob, or fader. The alternative function, COPY, is used 
to copy parameters between channels by simply touching the control knob or fader where 
you’d like to copy the specific parameter values. At the time of this writing, these functions 
are not yet implemented. 

CURVE: When you want to display a parameter’s automation curves on the active track in 
the Timeline, hold this button and touch any channel control or the fader, mute, or pan pot 
on the Channel Fader panel. 
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SPLL: SPLL is not used in this version of the software. 

ALT: To access additional display button options or alternate parameter controls on any 
channel control, use this modifier button. 

Right side of panel, In-Line Channel display buttons from top to bottom: 

In-Line Channel  
Display buttons

CTL: Use this button to select the secondary functions for the dual-function display 
buttons below. Also, holding the Control button while touching one of the knobs or faders 
will reset any of the touch-sensitive controls to their default values. This is one of three 
identical Control buttons on the channel control components set, and it works the same 
as pressing the Control modifier key on a computer keyboard. 

PAN/PATH: This button displays all the in-line surround panning controls including Left/
Right, Front/Back, Down/Up, and Spread. Press the ALT display button to see the alternate 
Rotate, Tilt, Divergence, and LFE controls. Hold the Control button and press the PAN/
PATH button to display the Path setting controls, including Record level, Trim, Insert, and 
Direct Out. Press ALT while the PATH controls are active to see the alternate Path controls: 
Mic Gain, Group, and the Direct Output Pre/Post fader switch. These Path settings are the 
same as the controls in the Path Settings window available via the Track Input drop-down 
menu on the Fairlight page Mixer. 

EQ/FILT: To control the In-Line channel parametric Equalizer (EQ), use this button without 
a modifier to display four frequency bands, including High Frequencies (HF), High-Middle 
Frequencies (HMF),Low-Middle Frequencies (LMF), and Low Frequencies (LF). Press 
the ALT button for Gain control of each of the four bands. Use the Control key for the 
secondary button function to display and modify the two channel filters for High-pass, 
Low-pass, High-shelf or Low-shelf filtering. While in EQ/FILT In-Line display mode, the 
Channel Control touch-sensitive knobs are used to sweep Frequencies or Gain, and the 
Channel Control buttons toggle between Bell, Notch, High Pass Filter (HPF), Low Pass Filter 
(LPF), High Shelf (Hi-Sh), and Low Shelf (Lo-Sh) filtering curves. The functionality of EQ/ FILT 
works the same as using the Channel EQ window available on the Fairlight page Mixer. 
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AUX/AUX: This button displays in-line controls for Aux sends 1 to 16 in sequential groups 
of 4 Aux buses at a time. You can toggle between Aux 1-4 and 5-8 by pressing the Aux key 
again. Hold Control while this button is active to display controls for Aux sends 9 to 16. 
Pressing the Aux key while holding Control will toggle between Aux 9-12 or 13-16. Press 
the ALT button for the alternate Pre/Post fader controls for the Aux send. 

COMP/U1: This is for In-Line Dynamics controls for the Compressor, including: Threshold, 
Attack, Hold, and Release. Use this button without a modifier. Press the ALT button for 
the alternate Ratio controls. Hold Control and press any of the dynamics display buttons: 
COMP, LIM, or EXP to access the Makeup gain controls. The secondary U1 function is not 
implemented in this version of the software. 

LIM/U2: To display the In-Line Limiter controls, use this button. Without a modifier, you’ll 
see the limiter controls, including Threshold, Attack, Hold, and Release. Hold Control 
and press LIM to access the Makeup gain controls. The secondary U2 function is not 
implemented in this version of the software. 

EXP/U3: This display button is for the in-line Expander/Gate controls. The unmodified 
Expander controls include Threshold, Attack, Hold, and Release. Press the ALT button 
to switch to the alternate Gate controls, including Ratio, Range, Hold, and Release. Hold 
Control and press EXP/U3 to access the Makeup gain controls. The secondary U3 feature is 
not implemented in this version of the software. 

ALT: This is the alternate option modifier button and functions the same as the ALT/Option 
key on the computer keyboard. To access additional display button options or an alternate 
control on any channel control, use this button. 

NOTE:  Non-functioning Channel Display buttons, such as PLUG and ENAB, remain unlit. 
These buttons will be operational in future software updates. 

Channel Display buttons

Channel Control buttons
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The left-side Channel Display buttons without modifiers and with 
Control button pressed to show secondary functions

Pan Settings window in the Fairlight page interface, available in the Mixer
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Path Settings window in the Fairlight page interface, 
available in the Mixer, Input drop-down menu
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The right-side In-Line Channel Display buttons 
with Pan/Path button pressed and corresponding 
Pan controls in the Channel Control LCD
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Channel Control Buttons and Channel Control Knobs 
Spanning the middle of the Channel Control panel, you’ll find 12 parallel groups of multi functional 
channel controls that align with the 12 faders on the Channel Fader panel. Within each of the 12 
groups are four highly visible LED buttons and four touch-sensitive rotary knobs. If you touch knobs 
with Control held this will reset the value, and if you turn a knob with Shift held you will have fine 
control for the parameter. 

Since the functions of these buttons and knobs change based on the channel display mode and 
selected channel and active parameters, these “soft” controls remain unlabeled, and are identified by 
the corresponding controls on an adjacent LCD monitor. Additionally, each channel control button is 
illuminated with bi-colored LEDs to make it easy to identify active buttons, parameters, and groups of 
controls at a glance. 
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3

1	

The right-side In-Line Channel 
Display buttons with ALT + 
Pan/Path button pressed and 
corresponding ALT-Pan controls 
in the Channel Controls LCD

2	

The right-side InLine Channel 
Display buttons with CTRL + 
Pan/Path button pressed and 
corresponding Path controls in 
the Channel Controls LCD

3	

The right-side In-Line Channel 
Display buttons with ALT + CTRL 
+ Pan/Path button pressed and 
corresponding ALT-Path controls 
in the Channel Controls LCD
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In-line EQ display mode 
showing four red In/
Out toggle switches 
and four dial controls 
on each channel 
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Channel Control buttons appear red or green when they are matched to a parameter on the Channel 
LCD monitor, and can be used as either toggles, On/Off, or In/Out switches for the adjacent parameter 
on-screen. Similar parameters will all have the same colored buttons while the Channel Controls are set 
to In-Line mode. However, in Channel or Master display mode, you’ll see alternating rows or groups of 
red or green buttons to separate the different parameter groups as shown on the Channel display. 

In-line Pan display mode 
showing one green In/Out 
toggle switch and four dial 
controls for each channel 
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Channel display mode 
showing alternating 
colored buttons to 
separate parameter 
groups and unlit 
buttons where there 
are no matching 
on‑screen parameters
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Additionally, Channel Control buttons brighten to show that they have been pressed, or remain unlit 
and therefore without color when there is no corresponding parameter with a switch in the current 
channel display mode. 

In-Line Channel Extension Buttons 
Along the bottom of the Channel Control panel are 12 groups of six In-Line Channel Control Extension 
buttons that match the buttons at the bottom of the Channel LCD Monitor. These dedicated LED 
buttons are toggle switches for channel-specific controls like Insert, Select, Solo Safe, and Arm. In-Line 
Channel Control Extension buttons are always available, regardless of the channel control mode, and 
correspond with similar functions in the Mixer or Timeline track headers on the Fairlight page. 
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In-Line Channel Extension buttons, clockwise from the top left:

Insert: Insert In enables routing of up to six VST plugins or one hardware effect per 
channel from Blackmagic Design’s Fairlight audio interface hardware to outboard 
effects boxes and back again. This button can be toggled to enable/disable 
insert routing. 

Safe: This button toggles on Solo Safe mode the same as Command-Option-clicking 
a Solo button on the Fairlight page. Tracks set to Solo Safe will always play, even if 
Solo is enabled for other tracks, and are easily identified by the blue-highlighted 
Solo button. 

Rec: Arms the track for recording. This is the same as clicking the Arm button [R] on 
the corresponding Timeline track header or Mixer channel strip on the Fairlight page 
Timeline. Tracks must be patched to a microphone or another source input prior 
to arming.

Comp: Toggles on or off the channel compression. 

Eq: Toggles on or off channel EQ. 

Select: This button selects a channel in the Fairlight Console Channel Control bay 
and is the same as clicking a Timeline track header or channel strip in the Mixer on 
the Fairlight page. You can select multiple tracks by pressing additional Channel 
Select buttons. 

In-line Channel Extension buttons displayed at the bottom of the Channel LCD
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In-line Channel Extension buttons that represent the physical 
switches for the corresponding buttons on the LCD above

NOTE:  You can only have a Channel Control panel for a bay that also has the Channel fader 
and Channel LCD monitor. 
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Fairlight Console Channel Fader 
In addition to 12 Channel strips complete with designated control buttons, touch-sensitive faders, and 
pan knobs, the Fairlight Console Channel Fader panel includes an LCD display of channel information 
and eight display buttons for bank selection and mapping of up to 144 tracks and buses to the 12 
faders. The Fairlight Console Channel Fader panel works in tandem with DaVinci Resolve and the 
Fairlight Channel Control module for completing professional audio post-production work flows using 
traditional mixing controls. 
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Fader Bank Display buttons

LCD Fader Channel displays 

Fader Channel Control buttons

Faders

Rotary Pan knobs

LCD Fader Channel Display 
At the top of each channel strip you’ll find a high-resolution color display that shows the track 
name,track color, level, and pan status. If the channel is part of a VCA group, the VCA group number 
appears above the meters. The information displayed for each track directly correlates with the 
Fairlight page Mixer and track headers. 

LCD Fader Channel Displays showing track name, number, 
color, pan status, level meters, and VCA group number. 
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Rotary Knob 
Below the LCD display on each channel strip you’ll find the touch-sensitive rotary knob designated 
as the panoramic potentiometer, or pan pot for short. This versatile dial control is assigned to Left-
Right track panning by default, but may also be assigned to other parameters. Press the Control 
button while you press and release the 2/FDR button to use the rotary knob to control the last-used 
alternate parameter. This is especially usefully during automation or complex mixing procedures when 
you need to keep alternative parameters, like the Ratio for your Compressor, within easy reach of 
the faders. Like all touch-sensitive controls on the Fairlight console components, holding the Control 
button and touching the knob resets the parameter to the default value, and if you turn the knob with 
Shift held you’ll have fine control. 

Fader Channel Control Buttons 
Each channel strip includes four dedicated control buttons for common channel-specific mixing 
functions. These brightly colored LED buttons are easy to read, logically placed above each fader, and 
can be used independently or in combination with other channels. 
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Fader Channel 
Control buttons 

LCD Fader Channel Display, Fader Pan knobs, 
and Fader Channel control buttons. 

SOLO: Use this button to select only this channel for playback. Multiple tracks can 
be soloed simultaneously to isolate selective tracks for playback while all non-soloed 
tracks will be muted. Pressing Solo while holding the Control button clears all soloed 
track buttons, and pressing Control again restores soloed tracks. Solo buttons on the 
Channel Fader panel correspond with the Solo buttons on the Fairlight page Mixer and 
track headers. 

MUTE: This button turns the channel off and on for playback. Mute buttons on the 
Channel Fader panel correspond with the Mute buttons on the Fairlight page Mixer and 
track headers. 
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CALL: As the name suggests, the Channel Call button simply calls up a track’s parameters 
in the Channel Control panel and LCD monitor while in Channel display mode. Additionally, 
the Channel Call button loads the channel into the built-in Audio Editor display, regardless 
of the channel control mode. Using the Channel Call button is a fast way to work with 
a channel’s parameters, plus you can quickly press other Call buttons to change focus 
from track to track for detailed comparison and control. Channel Call on the Fader Panel 
is similar to the Select button at the bottom of the Channel Control panel; the difference 
is that the Select button also selects the track in the Fairlight page Timeline and Mixer, 
which enables additional editing options. Using the Call button while tracks are selected 
does not change the state of the selected tracks. Call buttons are also used for manually 
mapping banks of channel faders and spilling the member tracks of a master bus to 
nearby faders.

Call buttons tally on or off when pressed and change color based on the current task 
as follows:

Yellow Call buttons: The default color and indicate standard call functionality. When the 
Call buttons are yellow, only one Call button can be tallied on at at time.

Red Call buttons: Appear when fader mapping is engaged. Auto fader mapping, 
automatically maps faders to groups of 12 channels in sequential order. When in manual 
fader mapping mode, you can use the red Call buttons in the Fader panel, or the track 
selection keys showing in the picture keyboard to manually assign channels to the 12 
faders for each fader bank. 

Green Call buttons: Indicate master buses and VCA groups in the current fader bank 
when using the Fader Spill function or isolated fader channels with locked positions when 
fader lock is active engaged. If fader spill is active, pressing a green Call button spills the 
member channels of a bus or VCA group to the neighboring faders according to the Fader 
Spill option keys in the Setup mode layout on the Audio Editor. Call buttons for locked 
channels also turn green when engaging the fader lock feature that isolates any fader in 
the current fader bank by holding Control and the 6/LOCK Fader Control Display button 
and pressing a call button in the active bank.  

AUTO: When automation controls are active, the AUTO button arms this channel for 
automation, preview, write, and trim. Like the Solo and Mute buttons, the Auto button on 
the Fader Panel corresponds with the Auto buttons on the Fairlight page Mixer and track 
headers. Automation buttons turn amber when automation is active. 

Touch-Sensitive Faders 
The bottom-half of the Fader Panel comprises 12 touch-sensitive motorized faders that offer precision 
gain controls for 12 signal paths. These faders correspond with faders on the Fairlight page Mixer, and 
can be mapped to 12 different fader banks using the Bank Display buttons located on the left side of 
the Fader Panel. Additionally, each 100mm fader can be assigned to control other channel parameters 
like send levels, channel trim, or record levels. Holding the Control button while touching a fader 
resets it to the default position, which is 0 dB. 
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Faders 

Fader Bank Display Buttons 
On the left side of the Channel Fader module are seven multicolored LED Bank Display buttons that 
are used to display, map, bus, set, and lock banks of channels to the 12 faders on the panel. The top 
two buttons are CTL (control) and BANK, which are modifier buttons used to access secondary button 
functions or additional fader banks for the subsequent numbered Fader Bank Display buttons. 

Each of the six numbered Fader Bank Display buttons serve three functions, including load a primary 
fader bank, load an additional fader bank when pressed with the Bank modifier button, or perform 
a secondary function when the Control button is pressed. You can easily identify the blue Control 
button at the top of the Fader Bank Display buttons, while the other seven buttons are yellow in their 
normal state, and blue or purple when the secondary function is selected via the Control button. 

With the Fader Bank Display buttons, you can map each of the 12 fader banks with 12 different faders 
to control a total of 144 tracks and buses to the 12 faders. The more Fairlight Console Channel Fader 
panels you have in your console, the more faders and tracks you can control. For example, the Fairlight 
Console 5.bay, is designed for high-end mixing and mastering with four Fader Panels to control up to 
576 channels and busses at a time. 
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Fader Bank display buttons and touch-
sensitive fader with Bank 1 selected, and with 
the secondary button functions available 
while the Control button is pressed.
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Fader Bank Display 
buttons

Fader Bank Display Buttons from top to bottom: 

CTL: This button selects secondary functions for the seven display buttons below and 
works the same as the Control key on the computer keyboard or the two identical Control 
display buttons on the Channel Control panel. 

BANK/FLIP: You can use the Bank button to switch between the primary fader set for 
each of the numbered bank buttons labeled 1 to 6, or the additional fader set for the 
same numbered buttons to show banks 7 to 12. Without a modifier, the Bank button is 
yellow along with the numbered bank buttons below. When pressed, the yellow Bank 
button brightens to indicate that it is latched, and the active numbered bank button also 
brightens to indicate which additional fader set has been loaded. The secondary FLIP 
function, via the Control button, is used to spill the member tracks of a master bus or VCA 
group to the neighboring faders. 

1/POT: The 1 button chooses Fader Set 1 without a modifier or Fader Set 7 when 
selected with the Bank button. The alternate POT function for this button has not been 
implemented. 

2/FDR: The 2 button chooses Fader Set 2 without a modifier or Fader Set 8 when selected 
with the Bank button. Pressing and releasing the 2/FDR button while Control is pressed 
toggles between normal mode where the fader controls channel level, and secondary 
mode where the fader controls the last-used alternative parameter. 

3/MAP: The 3 button chooses Fader Set 3 without a modifier or Fader Set 9 when selected 
with the Bank button. If Control is pressed, the 3/MAP button enters the secondary Fader 
Mapping tool for the current fader set on the Audio Editor. 
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4/BUS: The 4 button chooses Fader Set 4 without a modifier or Fader Set 10 when 
selected with the Bank button. Pressing Control along with the 4/BUS button toggles the 
secondary Bus mode on and off. When Bus mode is on, the system puts all used buses on 
as many faders as needed to accommodate all non-zero format buses. Pressing a Fader 
Bank display button from 1 to 6 returns control to the appropriate fader set. 

5/MSET: The 5 button chooses Fader Set 5 without a modifier or Fader Set 11 when 
selected with the Bank button. The MSET function has not been implemented.  

6/LOCK: The 6 button chooses Fader Set 6 without a modifier or Fader Set 12 when 
selected with the Bank button. Hold Control plus the 6/LOCK button to engage the lock 
setup. When active, you can press the call button for any track or bus fader in the current 
fader bank to “lock” that fader channel position on the Fader panel. While lock setup is 
active, call buttons tally green to indicate that channel has an isolated (locked) fader. You 
can lock/isolate up to 12 faders per fader panel. To unlock faders, hold Control-6/LOCK 
and unlatch the green call buttons. 

NOTE:  You can temporarily isolate faders from banking by actively touching and holding an 
individual fader or group of faders while changing fader banks. These “Sticky” faders will be 
cleared from isolation when the user changes fader banks without holding the fader.

Manually mapping faders to banks:

1	 In the Fader Bank Display buttons, press CTRL and the 3/Map key to enter fader mapping mode. 
You’ll know that you entered bank mapping mode because all of the Call buttons turn red. The 
bank mapping is set to Auto mode by default, which automatically maps channels to faders in 
sequential order in groups of 12 up to 144. When you enter channel mapping mode, the top four 
rows of picture keys in the Audio Editor change to track selection keys, while the bottom row of 
picture keys shows the following dedicated channel mapping function keys: 

	— Exit: Exits the channel mapping mode.

	— Delete: Deletes the channel assigned to the active channel indicated by the tallied 
red Call button. 

	— Blank: Leaves a blank fader bank beneath the active red Call button. This is useful for 
adding a space between groups of similar tracks such as dialogue, background sound effects, 
and music.

	— Insert: As the name suggests, this key inserts an unassigned fader in the position of the 
active red Call button. 

2	 In the bottom row of the picture keyboard, press the first key (MODE:Auto/MODE:Manual) to 
toggle the fader mapping to Manual mode. 
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3	 Press the red Call button on the fader you would like to assign, then choose a channel from the 
track selection buttons on the adjacent picture keys in the Audio Editor. Once you assign a track or 
bus to a fader, the next fader to the right becomes active with a red tallied Call button so that you 
can continue assigning faders sequentially. This automatic call selection also applies to the Delete, 
Blank, and Insert manual mapping functions. 

4	 Select up to 12 track selection keys to assign to the current fader bank. Use the Bank display 
buttons to manually assign additional banks as needed. 

5	 When you are finished mapping tracks to faders, press the Exit button in the bottom row of 
picture keys. Once you exit manual mapping mode, the picture keyboard layout returns to the 
current mode.

Example of Fader Bank 1 in Auto Mapping Mode

Fader Bank 1 in 
Auto mapping mode 
showing sequential 
tracks 1-12
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Fader Bank 1 in 
Auto mapping mode 
showing sequential 
tracks 1-12 with 
red Call buttons 
to indicate bank 
mapping mode is 
engaged and the 
first fader channel’s 
Call button is active
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Picture keyboard in Auto Fader Bank mapping mode

Auto Fader Bank mapping action keys in the  
lower left corner of the picture keyboard
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Example of Fader Bank 1 in Manual Mapping Mode

Fader Bank 1 in 
Manual mapping 
mode showing the 
custom mapping: 

A21, blank, A30, A40, 
and DIALOG to the 
first five tracks
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Fader Bank 1 in 
Manual mapping 
mode showing 
custom mapping: 

A21, blank, A30, A40, 
and DIALOG mapped 
to the first five faders; 
red Call buttons 
indicate bank mapping 
is engaged, with 
the first fader’s Call 
button active

Manual Fader Bank mapping action keys in 
the bottom row of the picture keyboard
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Spilling bus member tracks to nearby faders:

1	 In the Fader Bank Display buttons, select a fader bank that contains at least one bus. Buses 
include main, submix, Aux buses, and VCA groups.

2	 Momentarily press and hold the Bank/Flip key to change the yellow Call buttons to green Call 
buttons on the bus fader channels. 

3	 Press the green Call button for the bus fader you wish to spill to the neighboring faders. Once 
spilled, the Bank/Flip button turns purple to indicate that the current fader bank is displaying 
spilled faders for the active bus. 

4	 To modify the fader spill direction or type of fader that is temporarily remapped, use the Fader 
Spill options keys available in the Setup mode picture key toolset. 

Fader Spill option keys include: 

	— Fader Spill: Use this menu key to reveal two menu Spill option keys that determine the type of 
fader channel and direction in which member tracks are temporarily mapped to the adjoining 
faders on the Fairlight Channel Fader panel.

	— Spill Left/Spill Right: This menu options key toggles between Spill:Left and Spill:Right, which in 
turn dictates whether the member tracks of a bus are assigned to neighboring faders to the left 
or right of a bus when Spill is engaged in the Channel Fader panel.

	— Spill Any/Spill Tracks: When in the default (unlatched) state the Spill:Any menu option allows 
member tracks of a bus to be spilled to the nearest faders to the left or right, including faders 
assigned to Master buses and VCA groups. When latched to the Spill:Tracks option, member tracks 
of a bus spill either left or right starting with the nearest track fader in the designated direction. 
This option is useful if you need to maintain fader control of your buses while you spill their 
constituent tracks to the nearest track faders.

Fader Spill and Fader Spill option keys available in 
Setup Mode toolset on the Audio Editor Picture keys
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Fader Bank 5 with 
Main 1, Sub 1, and Sub 
2 buses assigned to 
the last three faders; 
yellow Call buttons 
indicate standard 
channel bank display 
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Bank/Flip Bank 
Display Button 
momentarily held 
to display the buses 
within the active track; 
these buses (in the 
right 3 channels) can 
be easily identified by 
the green Call buttons

Channel LCD displays 
Sub 2 bus, including 
A8, A10, A11, and 
A12, spilled on the 
nearest tracks to the 
left of the Sub 2 bus 
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Purple Bank/Flip 
button indicates 
there is a spilled bus 
in the current bank. 
In this case, Bank 5 is 
showing, with Sub 2 
spilled to the left of 
the the other buses, 
and includes A8, A10, 
A11, and A12 as the 
member tracks that 
comprise Sub 2. 

NOTE:  While a bus fader is spilled, you may still use the standard bank display buttons to 
display any of the other banks normally.

To un-spill a bus fader:

1	 In the Fader Bank Display buttons, press the Bank button that contains the spilled bus. 

2	 Momentarily hold the Bank/Flip button to reveal green Call buttons for the bus faders. The spilled 
fader’s green Call button will be tallied on. 

3	 Press the active green Call button to un-spill the fader.

NOTE:  You can only spill bus member tracks to faders within the same fader bank. Use the 
Fader Spill option keys in the Audio Editor Setup mode toolset to spill either left or right 
within the current bank of 12 faders. Additionally, if you press the Bank/Flip button on a 
bank without any bus faders, you will not see any green Call buttons or subsequent bus 
faders to spill.
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Sub 2 bus with active 
(tallied) green Call 
button, which indicates 
it has been spilled to 
neighboring faders 
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Fairlight LCD Monitors 
Standard Fairlight consoles include one high-resolution 1920 x 1080 Fairlight LCD Monitor for each 
bay. These custom designed LCD monitors align perfectly along the top of the console, forming an 
embedded eye-level monitor bridge that spans the width of the console. 

Fairlight LCD Monitor

Each Fairlight LCD Monitor is paired with either Channel Control modules as a dedicated channel 
control display, or the Audio Editing module as a dedicated DaVinci Resolve GUI edit screen. 
Additionally, the switchable HDMI and SDI inputs on the back of each screen allow flexible display of 
plugins and reference video. 

Fairlight Console 3-bay with three Fairlight LCD monitors  
forming a display bridge across the top of the console
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Fairlight Console Configurations 
The Fairlight console can be purchased with all the standard panels as a bundle, or customized to 
meet specialized production requirements. With the Fairlight console’s unique modular design, you 
always get the flexibility to place the Audio Editor, Infill module, and Channel Component sets, in 
whichever order works best for you. 

Each bundled console includes a console chassis ranging in size from 2-bay to 5-bay, an LCD Monitor 
component for each bay, one Fairlight Audio Editor, and a set of Fairlight Channel bay components for 
each additional bay. For custom configurations, you choose the chassis size, and then purchase the 
console components individually. 

Before purchasing a console, it is important to consider the size of your workspace as well as your 
current and future audio post-production needs. For example, if you have a mid-sized mixing stage 
and are primarily working on short-form projects like commercials and trailers, a standard Fairlight 
Console 3-bay may work well. However, if you have the room, a customized Fairlight Console 4-bay 
chassis may work better in the long run because you’ll also have room to grow in the future for larger 
feature-length productions. Plus, empty console bays can be filled with custom machined Fairlight 
Console Blanks that add valuable flat surface space for assistant audio editors and mixers. 

Standard Fairlight Console 3-bay
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Additionally, you can add a Fairlight Console LCD Monitor in the 4th bay to display video playback or 
plugins, and even add a Fairlight Channel Rack Kit to the channel section to mount standard 19-inch 
equipment such as the Fairlight Audio Interface or Blackmagic Design Smart View duo to your bay. 

NOTE:  For more information about the Fairlight Console Chassis, bundles, and hardware 
options, go to the Fairlight Console page on the Blackmagic Design website. https://www.
blackmagicdesign.com/products/davinciresolve/ 

Additional Fairlight Hardware 
To effectively connect to and operate a Fairlight console with DaVinci Resolve Studio, you’ll also need 
a supported audio interface and PCIe audio card. If you are using a Mac or PC without a PCIe slot, 
you’ll also need an expansion box to connect the PCIe card to your computer, and a supported audio 
interface. You can use 3rd-party devices or purchase the Fairlight products designed specifically for 
the Fairlight consoles, including, the Fairlight PCIe Audio Accelerator, Fairlight Audio Interface and the 
Fairlight PCIe MADI Upgrade. 

Fairlight Audio Interface

Fairlight PCIe Audio Accelerator				   Fairlight PCIe MADI Upgrade

Fairlight HDMI Monitor Interface
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NOTE:  For more information about the Fairlight PCIe Audio Accelerator, Fairlight Audio 
Interface and the Fairlight PCIe MADI Upgrade, go to the Fairlight Console page on the 
Blackmagic Design website. www.blackmagicdesign.com/products/davinciresolve/

Performing Firmware Updates 
Some DaVinci Resolve updates, such as 17.2.1, require firmware updates to implement the 
improvements to the Fairlight panels. Users can update all of their Fairlight Console panels in a matter 
of minutes via the DaVinci Control Panels Setup utility. 

Updating firmware on a 2-bay modular console:

1	 Quit DaVinci Resolve, if necessary.  

2	 Open the DaVinci Control Panels Setup utility. 

3	 In the DaVinci Control Panels Setup Utility, select a panel. 

4	 Click the circled icon below the panel name. 

NOTE:  If you are working with the Fairlight Desktop Console or Desktop Fairlight Audio 
Editor there will only be one panel from which to choose. 
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5	 If there is a firmware update available, you will see an update dialog.

Firmware Update Available dialog

6	 Click Update to install the updated firmware on that panel. 

7	 Once the update is complete, click Done.  

8	 Repeat this firmware update process for each control panel connected to your system. 

9	 When all of your panels are updated, close the DaVinci Control Panels Setup.

10	 Open DaVinci Resolve.  

NOTE:  To use DaVinci Control Panels Setup utility for the first time, you need to perform a 
custom install of the latest version of DaVinci Resolve, and in the custom settings, check the 
option to install the DaVinci Control Panels utility. Once installed, you can select any panel 
connected to your system and perform network setup and firmware updates.
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